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CHAPTER 1

Preambul

Acest document este ghidul de utilizare original al QGIS. Programele s, i echipamentele descrise în prezentul
document reprezintă, în cele mai multe cazuri, mărci comerciale înregistrate, s, i, prin urmare, fac obiectul cerint,elor
legale. QGIS este condit,ionat de Licent,a Publică Generală GNU. Găsit,i mai multe informat,ii pe pagina de casă a
QGIS, http://www.qgis.org.

Detaliile, datele s, i rezultatele din acest document au fost scrise s, i verificate în concordant,ă cu cele mai bune
cunos, tint,e ale autorilor s, i editorilor. Cu toate acestea, sunt posibile unele gres, eli, în ceea ce prives, te cont,inutul.

Prin urmare, datele nu sunt supuse plăt,ii unor drepturi sau garant,ii. Autorii s, i editorii nu au nici o responsabilitate
sau răspundere pentru es, ecurile s, i consecint,ele utilizării acestora. Raportarea posibilelor gres, eli este întotdeauna
binevenită.

Acest document a fost creat cu reStructuredText s, i este disponibil sub formă de cod sursă reST prin intermediul
github s, i on-line ca HTML s, i PDF via http://www.qgis.org/en/docs/. De asemenea, versiunile traduse ale aces-
tui document pot fi descărcate în mai multe formate, din zona de documentare a proiectului QGIS. Pentru mai
multe informat,ii despre cum putet,i contribui la acest document s, i cu privire la traducere, vă rugăm să vizitat,i:
http://qgis.org/en/site/getinvolved/index.html.

Link-urile din acest document

Acest document cont,ine link-uri interne s, i externe. Efectuarea unui clic pe o legătură internă permite deplasarea
în cadrul documentului, în timp ce un clic pe un link extern deschide o adresă de internet. Într-un document
PDF, link-urile interne s, i externe sunt albastre s, i sunt gestionate de către navigatorul implicit al sistemului. În
formularele HTML, navigatorul le afis, ează s, i le gestionează pe ambele în mod similar.

Autori s, i editori ai Ghidurilor de utilizare, instalare s, i dezvoltare:

Tara Athan Radim Blazek Godofredo Contreras Otto Dassau Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Carson J.Q. Farmer Tyler Mitchell K. Koy Lars Luthman
Claudia A. Engel Brendan Morely David Willis Jürgen E. Fischer Marco Hugentobler
Larissa Junek Diethard Jansen Paolo Corti Gavin Macaulay Gary E. Sherman
Tim Sutton Alex Bruy Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Andy Schmid Hien Tran-Quang

Copyright (c) 2004 - 2014 Echipa de dezvoltare a QGIS

Internet: http://www.qgis.org

Licent,a acestui document

Se acordă permisiunea de copiere, distribuire s, i/sau de modificare a acestui document sub termenii GNU Free
Documentation License, versiunea 1.3 sau orice versiune ulterioară, publicată de către Free Software Foundation;
fără Sect,iunile Fixe s, i fără Textele Copert,ilor. O copie a acestei licent,e este inclusă în Anexa Licent,a GNU pentru
Documentat,ia liberă.
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CHAPTER 2

Convent,ii

Această sect,iune descrie stilurile uniforme care vor fi folosite pe parcursul acestui manual.

2.1 Convent,iile GUI

Stilurile convenite pentru GUI sunt destinate imitării aspectului unui GUI. În general, un stil va reflecta aspectul
non-hover, astfel încât un utilizator poate scana vizual GUI-ul, pentru a găsi ceva care arată similar instruct,iunilor
din manual.

• Opt,iuni de Meniu: Layer → Add a Raster Layer or Settings → Toolbars → Digitizing

• Instrument: |mActionAddRasterLayer| Adaugă un Strat Raster

• Buton : [Salvare ca Implicit]

• Titlul Casetei de Dialog: Layer Properties

• Fila: General

• Caseta de bifare: Render

• Buton Radio: SRID Postgis EPSG ID

• Selectare număr:

• Selectare s, ir:

• Selectare fis, ier:

• Selectare culoare:

• Cursor:

• Introducere Text:

O umbră indică o componentă GUI pe care se poate face clic.

2.2 Convent,ii pentru Text s, i Tastatură

Acest manual include, de asemenea, stiluri pentru text, comenzi pentru taste, s, i codificări pentru indicarea
diferitelor entităt,i, cum ar fi clasele sau metodele. Aceste stiluri nu corespund aspectului efectiv al vreunui text
sau vreunei codificări din QGIS.

• Hiperlegături: http://qgis.org

• Combinat,ii de taste: Apăsarea combinat,iei Ctrl+B, înseamnă t,inerea apăsată a tastei Ctrl s, i apoi apăsarea
tastei B.
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• Numele Fis, ierului: lakes.shp

• Numele Clasei: NewLayer

• Metoda: classFactory

• Server: myhost.de

• Text Utilizator: qgis --help

Liniile de cod sunt indicate printr-un font cu lăt,ime fixă:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Instruct,iuni specifice platformelor

Secvent,ele GUI s, i mici cantităt,i de text pot fi formatate într-o linie de genul următor: Facet,i clic pe File

QGIS → Quit to close QGIS. Aceasta indică faptul că pe Linux, Unix s, i pe platformele Windows, ar trebui să
facet,i clic mai întâi pe meniul File, apoi pe Quit, în timp ce pe platformele Macintosh OS X trebuie să facet,i clic
mai întâi pe meniul QGIS, apoi pe Quit.

Cantităt,i mai mari de text pot fi formatate ca o listă:

• Facet,i asta

• Facet,i aia

• Facet,i altceva

sau ca paragrafe:

Facet,i acest lucru s, i asta s, i asta. Apoi facet,i acest lucru s, i asta s, i asta, s, i asta s, i asta s, i asta, s, i asta s, i asta s, i
asta.

Facet,i aia. Apoi facet,i acest lucru s, i aia s, i aia, s, i aia s, i aia s, i aia, s, i aia s, i aia s, i aia, s, i aia s, i aia s, i aia, s, i aia s, i
aia s, i aia.

Capturile care apar în ghidul de utilizare au fost create pe platforme diferite; platforma este indicat printr-o pic-
togramă specifică, pozit,ionată la sfârs, itul titlului figurii.
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CHAPTER 3

Cuvânt înainte

Bine at,i venit în lumea minunată a Sistemelor de Informat,ii Geografice (GIS)!

QGIS is an Open Source Geographic Information System. The project was born in May of 2002 and was estab-
lished as a project on SourceForge in June of the same year. We’ve worked hard to make GIS software (which
is traditionally expensive proprietary software) a viable prospect for anyone with basic access to a personal com-
puter. QGIS currently runs on most Unix platforms, Windows, and OS X. QGIS is developed using the Qt toolkit
(https://www.qt.io) and C++. This means that QGIS feels snappy and has a pleasing, easy-to-use graphical user
interface (GUI).

QGIS îs, i propune să fie un GIS prietenos cu utilizatorul, oferind funct,ii s, i caracteristici comune. Scopul init,ial
al proiectului a fost de a realiza un vizualizator de date GIS. QGIS a ajuns în punctul în care acesta este utilizat
de tot mai mult,i utilizatori pentru vizualizarea zilnică a datelor GIS. QGIS suportă un număr mare de formate de
date raster s, i vectoriale, cu posibilitatea de adăugare us, oară a suportului pentru noile formate, prin intermediul
arhitecturii de plugin-uri.

QGIS este distribuit sub Licent,a Publică Generală GNU (GPL). Dezvoltarea QGIS sub această licent,ă atestă că
putet,i inspecta s, i modifica codul sursă s, i garantează că, utilizatorul va avea întotdeauna acces la un program de
GIS gratuit, s, i care poate fi modificat în mod liber. Ar trebui să fi primit deja o copie completă a licent,ei alături de
aplicat,ia QGIS, pe care o putet,i găsi, de asemenea, în Anexa Licent,a Publică Generală GNU.

Tip: Documentat,ie la-zi
Cea mai recentă versiune a acestui document poate fi întotdeauna găsită în zona de documentare a site-ului QGIS
de la http://www.qgis.org/en/docs/.
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CHAPTER 4

Funct,iuni

QGIS oferă multe funct,ionalităt,i GIS comune, oferite de caracteristicile de bază s, i de plugin-uri. Un scurt rezumat
pentru s, ase categorii generale de caracteristici s, i plugin-uri este prezentat mai jos, urmat de o primă incursiune în
consola Python integrată.

4.1 Vizualizarea datelor

Putet,i vizualiza s, i suprapune datele raster s, i vectoriale în diferite formate s, i proiect,ii, fără conversia într-un format
intern sau comun. Formatele acceptate includ:

• Tabelele s, i vederile activate spat,ial folosesc PostGIS, SpatiaLite, MS SQL Spatial s, i Oracle Spatial, formate
vectoriale acceptate de biblioteca OGR, inclusiv fis, iere shape ESRI, MapInfo, SDTS, GML s, i multe altele.
Vedet,i sect,iunea Lucrul cu Datele Vectoriale.

• Formatele raster s, i imaginile acceptate de biblioteca GDAL (Geospatial Data Abstraction Library), cum ar
fi GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG s, i multe altele. Vedet,i sect,iunea Lucrul cu
Datele Raster.

• Date raster s, i vectoriale GRASS din bazele de date GRASS (locat,ie/set de hărt,i). Parcurget,i sect,iunea
Integrarea GRASS GIS.

• Date spat,iale online, servite de Servicii Web OGC, inclusiv WMS, WMTS, WCS, WFS, s, i WFS-T.
Parcurget,i sect,iunea Lucrul cu date OGC.

4.2 Explorarea datelor s, i compunerea hărt,ilor

Putet,i compune hărt,i, apoi să explorat,i în mod interactiv datele spat,iale prin intermediul interfet,ei grafice pri-
etenoase. Printre cele mai multe instrumente utile disponibile în GUI se includ:

• Navigatorul QGIS

• Reproiectarea Din-Zbor

• DB Manager

• Compozitorul de Hărt,i

• Panoul de Vizualizare

• Semne de carte Spat,iale

• Instrumente de adnotare

• Identificarea/selectarea entităt,ilor

• Editarea/vizualizarea/căutarea atributelor

• Etichetarea entităt,ilor, definită cu ajutorul datelor
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• Instrumente de simbologie definită cu ajutorul datelor, pentru rastere s, i vectori

• Compozit,ia hărt,ilor pentru atlas, folosind straturile cu graticule

• Săgeata Nordului, scara grafică s, i eticheta drepturilor de autor pentru hărt,i

• Suport pentru salvarea s, i restaurarea proiectelor

4.3 Crearea, editarea, gestionarea s, i exportul datelor

Putet,i crea, edita, gestiona s, i exporta în diverse formate straturile raster sau vectoriale. QGIS oferă următoarele:

• Instrumente de digitizare pentru formatele acceptate de OGR s, i straturile vectoriale GRASS

• Abilitatea de a crea s, i edita fis, iere shape s, i straturi vectoriale GRASS

• Plugin-ul de georeferent,iere pentru geocodarea imaginelor

• Instrumente GPS de import s, i de export pentru formatul GPX, s, i de convertit alte formate GPS în GPX, sau
de descărcat/încărcat direct într-o unitate GPS (Pe Linux, s-a adăugat usb: la lista de dispozitive GPS.)

• Suport pentru salvarea s, i editarea datelor OpenStreetMap

• Abilitatea de a crea tabele de baze de date spat,iale din fis, ierele shape, cu ajutorul plugin-ului DB Manager

• Gestionarea îmbunătăt,ită a tabelelor bazei de date spat,iale

• Instrumente pentru gestionarea tabelelor cu atribute vectoriale

• Opt,iunea de a salva capturile de ecran ca imagini georeferent,iate

• Instrumentul DXF-Export cu capacităt,i sporite pentru exportul stilurilor s, i a plugin-urilor pentru a efectua
funct,ii similare CAD

4.4 Analiza datelor

Putet,i efectua analiza datelor spat,iale asupra bazelor de date s, i a altor formate acceptate de OGR. QGIS oferă în
prezent instrumente de analiză vectorială, es, antionare, geoprocesare, s, i de gestionare a bazei de date s, i a geome-
triei. Putet,i utiliza, de asemenea, instrumentele integrate GRASS, care includ funct,ionalitatea GRASS completă a
mai mult de 400 de module. (Consultat,i sect,iunea Integrarea GRASS GIS.) Sau, putet,i lucra cu Plugin-ul Process-
ing, care oferă un cadru de analiză geospat,ială puternic, care apelează algoritmi nativi din QGIS sau tert,i, cum ar
fi GDAL, SAGA, GRASS, fTools s, i mai mult. (Parcurget,i sect,iunea Introducere.)

4.5 Publicarea hărt,ilor de pe Internet

QGIS poate fi folosit ca s, i client WMS, WMTS, WMS-C sau WFS s, i WFS-T, s, i ca server WMS, WCS sau WFS.
(Vedet,i sect,iunea Lucrul cu date OGC.) În plus, putet,i publica datele pe Internet, folosind un server de web UMN
MapServer sau GeoServer.

4.6 Extinderea funct,ionalităt,ii QGIS prin intermediul plugin-urilor

QGIS poate fi adaptat nevoilor dumneavoastră speciale cu arhitectură de plugin-uri extensibile s, i biblioteci care
pot fi folosite pentru a crea plugin-uri. Putet,i crea chiar noi aplicat,ii cu C++ sau Python!
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4.6.1 Plugin-uri de bază

Plugin-urile de bază includ:

1. Captura Coordonatelor (Captura coordonatelor mouse-ului în CRS-uri diferite)

2. DB Manager (Schimbare, editare s, i vizualizare straturi s, i tabele din/în bazele de date; execută interogările
SQL)

3. Convertorul Dxf2Shp (Conversia fis, ierelor DXF în fis, iere shape)

4. eVIS (Vizualizarea evenimentelor)

5. fTools (Analiza s, i gestionarea datelor vectoriale)

6. Instrumente GDAL (Integrează Instrumentele GDAL în QGIS)

7. Georeferenţiere GDAL(Adăugarea în rastere a informat,iilor de proiect,ie folosind GDAL)

8. Instrumente GPS (Încărcarea s, i importul datelor GPS)

9. GRASS (Integrarea GRASS GIS)

10. Hărt,i calorice (Generarea hărt,ilor calorice raster, din datele de tip punct)

11. Plugin-ul de Interpolare (Interpolarea bazată pe vertecs, ii unui strat vectorial)

12. Metasearch Catalogue Client

13. Editarea Offline (Permite editarea offline şi sincronizarea cu baza de date)

14. Oracle Spatial GeoRaster

15. Processing (fostul SEXTANTE)

16. Analiza Terenurilor Raster (Analiza terenurilor geomorfologice raster)

17. Plugin-ul Road Graph (Analiza celei mai scurte căi dintr-o ret,ea)

18. Pluginul de Interogare spaţială

19. Verificatorul de Topologie (Găsirea erorilor topologice din straturile vectoriale)

20. Plugin-ul de Statistici Zonale (Calculează numărul, suma, s, i valoarea medie a unui raster, pentru fiecare
poligon al unui strat vectorial)

4.6.2 Plugin-urile Externe Python

QGIS oferă un număr tot mai mare de plugin-uri externe, scrise în Python, care sunt furnizate de către comunitate.
Aceste plugin-uri rezidă în depozitul oficial de plugin-uri, s, i pot fi instalate cu us, urint,ă cu ajutorul Instalatorului
de Plugin-uri Python. Parcurget,i sect,iunea Dialogul Plugin-urilor.

4.7 Consola Python

Pentru editarea script-urilor, este avantajoasă utilizarea consolei integrate Python, care poate fi deschisă din
meniul: Pluginuri → Consola Python. Consola se deschide ca o fereastră de utilităt,i non-modală. Pentru
interact,iunea cu mediul QGIS, există variabila qgis.utils.iface, care este o instant,ă a QgsInterface.
Această interfat,ă permite accesul la canevasul hărt,ii, la meniuri, bare de instrumente s, i la alte părt,i ale aplicat,iei
QGIS. Putet,i crea un script, apoi să-l glisat,i s, i să-l fixat,i în fereastra QGIS, acesta fiind executat în mod automat.

Pentru mai multe informat,ii despre lucrul cu consola Python, s, i despre programarea plugin-urilor s, i a aplicat,iilor
bazate pe QGIS, vă rugăm să consultat,i PyQGIS-Developer-Cookbook.

4.7. Consola Python 9
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4.8 Probleme Cunoscute

4.8.1 Limitarea numărului de fis, iere deschise

Dacă deschidet,i un proiect QGIS mare s, i suntet,i sigur că toate straturile sunt valide, dar unele straturi sunt marcate
ca fiind eronate, putet,i gestiona, probabil, această problemă. Linux (s, i alte sisteme de operare, de asemenea) are o
limită pentru fis, ierele deschise de către un proces. Limitele resurselor sunt per-proces s, i sunt mos, tenite. Comanda
internă ulimit, modifică limitele numai pentru procesul curent; noua limită va fi mos, tenită de către orice proces
copil.

Putet,i vedea toate informat,iile ulimit curente, tastând

user@host:~$ ulimit -aS

Putet,i vedea numărul curent acceptat de fis, iere deschise per proces, folosind următoarea comandă în consolă

user@host:~$ ulimit -Sn

Pentru a modifica limitele pentru o sesiune existentă , at,i putea utiliza ceva de genul

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Pentru a remedia definitiv problema

Pe majoritatea sistemelor Linux, limitele resurselor sunt stabilite de modulul pam_limits, în conformitate
cu setările cont,inute în /etc/security/limits.conf sau /etc/security/limits.d/*.conf. Ar
trebui să putet,i edita acele fis, iere dacă avet,i privilegiul de root (de asemenea, prin intermediul sudo), dar va trebui
să vă conectat,i din nou pentru ca schimbările să aibă efect.

Mai multe informat,ii:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en
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CHAPTER 5

Ce este nou în QGIS 2.14

Această versiune cont,ine noi caracteristici s, i extinde interfat,a programatică fat,ă de versiunile anterioare. Vă
recomandăm să folosit,i această versiune în locul versiunilor anterioare.

Această versiune include sute de erori remediate s, i multe caracteristici noi s, i îmbunătăt,iri aduse aplicat,iei QGIS
2.8, care vor fi descrise în acest manual. At,i putea parcurge, de asemenea, jurnalul schimbărilor vizuale de la:

• http://qgis.org/en/site/forusers/visualchangelog210/index.html

• http://qgis.org/en/site/forusers/visualchangelog212/index.html

• http://qgis.org/en/site/forusers/visualchangelog214/index.html
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CHAPTER 6

Not,iuni de bază

Acest capitol oferă o privire de ansamblu rapidă asupra instalării QGIS, a descărcării câtorva date es, antion de pe
pagina web QGIS s, i asupra rulării unei prime s, i simple sesiuni de vizualizare a straturilor raster s, i vectoriale.

6.1 Instalare

Instalarea QGIS este foarte simplă. Pentru MS Windows s, i Mac OS X sunt disponibile pachete de instalare
standard. Pentru mai multe distribut,ii de pachete binare GNU/Linux (rpm si deb) există depozite software care
pot fi adăugate managerului de instalare. Cele mai recente informat,ii cu privire la pachetele binare se pot obt,ine
de pe site-ul web QGIS la http://download.qgis.org.

6.1.1 Instalarea de la sursă

Dacă dorit,i să construit,i QGIS de la sursă, vă rugăm să consultat,i instruct,iunile de instalare. Acestea sunt
distribuite alături de codul sursă QGIS într-un fis, ier numit INSTALL. Le putet,i găsi, de asemenea, online la
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Instalarea pe un suport extern

QGIS vă permite să definit,i o opt,iune --configpath, care suprascrie calea implicită pentru configurarea uti-
lizatorului (de exemplu, ~/.qgis2 sub Linux) s, i, de asemenea, fort,ează QSettings să utilizeze acest director.
Acest lucru vă permite, de exemplu, să efectuat,i o instalare de QGIS pe o unitate flash, împreună cu toate plugin-
urile s, i setările. Consultat,i sect,iunea Meniul Sistemului pentru informat,ii suplimentare.

6.1.3 Date es, antion

Ghidul utilizatorului cont,ine exemple bazate pe setul de date exemplu, al QGIS.

Programul de instalare Windows are opt,iunea de descărcare a setului de date es, antion QGIS. Dacă este bifată,
datele vor fi descărcate în folderul My Documents propriu, în sub-folderul GIS Database. Putet,i utiliza
Windows Explorer pentru a muta acest dosar în orice altă locat,ie convenabilă. Dacă nu at,i selectat caseta pentru
instalarea setului de date es, antion pe durata instalării init,iale QGIS, putet,i alege următoarele:

• Utilizat,i datele GIS pe care le avet,i deja

• Descărcat,i datele es, antion de la http://qgis.org/downloads/data/qgis_sample_data.zip

• Dezinstalat,i QGIS s, i reinstalat,i-l cu opt,iunea de descărcare a datelor bifată (recomandat numai dacă solut,iile
anterioare nu au avut succes)

Pentru GNU/Linux s, i Mac OS X, nu există încă pachete de instalare disponibile ca rpm, deb sau
dmg. Pentru a utiliza setul de date es, antion, descărcat,i fis, ierul qgis_sample_data, ca arhivă ZIP, de la
http://qgis.org/downloads/data/ s, i dezarhivat,i-l pe sistemul dvs.
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Setul de date Alaska cuprinde toate datele GIS care sunt utilizate pentru exemple s, i capturi de ecran în ghidul
utilizatorului; include, de asemenea, o mică bază de date GRASS. Proiect,ia datelor es, antion pentru setul de date
QGIS este Alaska Albers cu suprafet,e egale cu picioare ca unităt,i. Codul EPSG este 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Dacă intent,ionat,i să utilizat,i QGIS ca interfat,ă grafică pentru GRASS, putet,i găsi o select,ie de
locat,ii pentru exemple (de exemplu, Spearfish sau South Dakota) pe site-ul oficial GRASS GIS,
http://grass.osgeo.org/download/sample-data/.

6.2 Deschiderea QGIS

6.2.1 Pornirea s, i Oprirea QGIS

Lansarea în execut,ie a aplicat,iei QGIS are loc în acelas, i mod cu al celorlalte aplicat,ii. Aceasta înseamnă că putet,i
starta QGIS prin:

• introducerea cuvântului qgis în linia de comandă, presupunând că aplicat,ia QGIS a fost adăugată în vari-
abila PATH, sau că vă aflat,i în dosarul său de instalare

• folosirea meniului Aplicat,ii, dacă se utilizează un binar precompilat, din meniul Start sau Dock

• dublu clic pe pictograma din folderul Aplicat,iilor sau pe o scurtătură de pe ecran.

• dublu clic pe un fis, ier de proiect QGIS existent (.qgs). Ret,inet,i că în acest mod se va deschide, de aseme-
nea, s, i proiectul

Pentru a închide QGIS, efectuat,i clic pe:

• opt,iunea meniului Proiect → Închidere QGIS, sau folosit,i combinat,ia de taste Ctrl+Q.

• QGIS → Închidere QGIS, sau folosit,i combinat,ia de taste Cmd+Q.

• sau prin utilizarea cruciulit,ei ros, ii, din colt,ul din dreapta sus al interfet,ei principale a aplicat,iei.

6.2.2 Opt,iunile liniei de comandă

În sect,iunea anteriouară at,i învăt,at deja cum să pornit,i QGIS. Vom vedea că, în plus, QGIS oferă s, i unele opt,iuni
pentru linia de comandă.

QGIS suportă diverse opt,iuni atunci când rulează din linia de comandă. Pentru a obt,ine o listă de opt,iuni,
introducet,i qgis --help în linia de comandă. Expresia utilizată pentru QGIS este:
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qgis --help
QGIS - 2.6.0-Brighton ’Brighton’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don’t check for new version of QGIS at startup
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--authdbdirectory path] use the given directory for authentication database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--dxf-export filename.dxf] emit dxf output of loaded datasets to given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-preset visiblity-preset] layer visibility preset to use for dxf output
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Tip: Exemplu de folosire a argumentelor în linia de comandă
Putet,i lansa QGIS prin specificarea unuia sau a mai multor fis, iere de date din linia de comandă. De exemplu,
presupunând că vă aflat,i în directorul qgis_sample_data, putet,i stabili ca un strat vectorial s, i un fis, ier raster
să fie încărcate o dată cu lansarea QGIS, folosind următoarea comandă: qgis ./raster/landcover.img
./gml/lakes.gml

Opt,iunea liniei de comandă --snapshot

Această opt,iune vă permite să creat,i o captură, în format PNG, a vizualizării curente. Acest lucru este foarte util
atunci când avet,i o mult,ime de proiecte s, i dorit,i să generat,i capturi din datele proprii.

În prezent, se generează un fis, ier PNG cu 800x600 pixeli. Acest lucru se poate face din linia de comandă utilizând
argumentele --width and --height. Un nume de fis, ier poate fi adăugat după --snapshot.

Opt,iunea liniei de comandă --lang

Pe baza limbii dvs., QGIS selectează localizarea corectă. Dacă dorit,i să schimbat,i limba, putet,i specifica un cod
de limbă. De exemplu„ --lang=it rulează QGIS în limba italiană.

Opt,iunea liniei de comandă --project

De asemenea, este posibilă startarea QGIS cu un fis, ier de proiect existent. Trebuie doar să adăugat,i opt,iunea de
linie de comandă --project urmat de numele proiectului dvs., după care QGIS va deschide toate straturile din
fis, ierul încărcat.
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Opt,iunea liniei de comandă --extent

Pentru a începe cu o extindere de hartă specifică, folosit,i această opt,iune. Trebuie să adăugat,i valorile casetei de
încadrare, separate prin virgulă, în ordinea următoare:

--extent xmin,ymin,xmax,ymax

Opt,iunea liniei de comandă --nologo

Acest argument în linie de comandă ascunde ecranul de întâmpinare, de la deschiderea QGIS.

opt,iunea liniei de comandă --noversioncheck

Nu verificat,i la start existent,a unei noi versiuni de QGIS

Opt,iunea liniei de comandă --noplugins

Dacă avet,i probleme la pornire cu plugin-urile, putet,i evita încărcarea lor la lansare, folosind această opt,iune.
Acestea vor fi în continuare disponibile din Managerul de Plugin-uri. Opt,iunea liniei de comandă
--customizationfile

Folosind acest argument în linia de comandă, putet,i defini un fis, ier de personalizare GUI, care va fi utilizat la
pornire.

Opt,iunea liniei de comandă --nocustomization

Folosind acest argument în linia de comandă, personalizarea existentă a GUI-ului nu va fi aplicată la pornire.

Opt,iunea liniei de comandă --optionspath

Putet,i avea mai multe configurat,ii, apoi să decidet,i pe care să o folosit,i atunci când QGIS pornes, te cu această
opt,iune. Consultat,i Opţiuni pentru a afla unde stochează sistemul de operare fis, ierele de setări. În prezent, nu
există nici o modalitate de a specifica unui fis, ier unde să scrie setările; prin urmare, putet,i crea o copie a fis, ierului
de setări originale s, i să-l redenumit,i. Opt,iunea specifică locat,ia directorului cu setările. De exemplu, pentru a
utiliza fis, ierul de setări /path/to/config/QGIS/QGIS2.ini, folosit,i opt,iunea:

--optionspath /path/to/config/

Opt,iunea liniei de comandă --configpath

Această opt,iune este similară cu cea de mai sus, dar în plus suprascrie calea implicită pentru configurarea utiliza-
torului (~/.qgis2) s, i fort,ează QSettings să utilizeze acest director, de asemenea. Acest lucru vă permite, de
exemplu, să efectuat,i o instalare de QGIS pe o unitate flash, împreună cu toate plugin-urile s, i setările.

Opt,iunea liniei de comandă --authdbdirectory

Din nou, această opt,iune este similară cu cea de mai sus, dar defines, te calea către directorul în care va fi stocată
baza de date de autentificare.

Opt,iunea liniei de comandă --code

Această opt,iune poate fi utilizată pentru a rula un fis, ier Python, imediat ce s-a lansat QGIS.

De exemplu, atunci când avet,i un fis, ier Python denumit load_alaska.py, cu următorul cuprins:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Presupunând că suntet,i în directorul în care rezidă fis, ierul load_alaska.py, putet,i lansa QGIS, apoi putet,i
încărca fis, ierul landcover.img s, i să denumit,i stratul ‘Alaska’, folosind următoarea comandă: qgis --code
load_alaska.py

Opt,iunea liniei de comandă --dxf-*
Aceste opt,iuni pot fi folosite pentru a exporta proiectul QGIS într-un fis, ier DXF. Sunt disponibile mai multe
opt,iuni:

• –dxf-export: numele fis, ierului DXF, în care se vor exporta straturile;
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QGIS User Guide, Release 2.14

• –dxf-extent: extinderea fis, ierului DXF final;

• –dxf-symbology-mode: aici pot fi folosite mai multe valori: none (fără simbologie), symbollayer (simbologia
stratului simbol), feature (simbologia entităt,ii);

• –dxf-scale-deno: numitorul scării simbologiei;

• –dxf-encoding: codificarea fis, ierului;

• –dxf-preset: aleget,i vizibilitatea prestabilită. Aceste presetări sunt definite în arborele stratului, v. Panoul
Straturilor.

6.3 Sesiune Demonstrativă: Încărcarea straturilor raster s, i vecto-
riale

Acum, că avet,i QGIS instalat s, i un set de date es, antion disponibile, am dori să vedem o sesiune QGIS scurtă s, i
simplă de exemplificare. Vom vizualiza un raster s, i un strat vectorial. Vom folosi:

• stratul raster landcover, adică qgis_sample_data/raster/landcover.img

• s, i stratul vectorial lakes, adică qgis_sample_data/gml/lakes.gml.

1. Pornit,i QGIS, as, a cum at,i putut vedea în Pornirea s, i Oprirea QGIS

2. Clic pe pictograma de Adăugare Strat Raster.

3. Răsfoit,i folderul qgis_sample_data/raster/, selectând fis, ierul landcover.img s, i făcând clic
pe [Deschidere].

4. Dacă fis, ierul nu este listat, verificat,i caseta Fis, iere de tipul din partea de jos a ferestrei de dialog,
dacă este setată pe tipul adecvat, în acest caz “Erdas Imagine Images (*.img, *.IMG)”.

5. Apoi facet,i clic pe pictograma Adăugare Strat Vectorial.

6. Fis, ier ar trebui să fie ales ca Tip Sursă în noul dialog de Adăugare strat vectorial. Apoi, facet,i clic pe
[Răsfoire] pentru a selecta stratul vectorial.

7. Navigat,i către folderul qgis_sample_data/gml/, selectat,i Geography Markup Language [GML]
[OGR] (*.gml *.GML) din caseta de Filtrare , apoi selectat,i fis, ierul GML lakes.gml s, i facet,i
clic pe [Open]. În fereastra dialogului de Adăugare strat vectorial, facet,i clic pe [OK]. Se va deschide
dialogul Selectorului Sistemului de Coordonate de Referint,ă, având selectat NAD27 / Alaska Alberts, după
care apăsat,i pe [OK].

8. Mărit,i un pic zona cu lacuri pe care o preferat,i.

9. Dublu clic pe stratul lakes din legenda hărt,ii pentru a deschide fereastra de dialog Properties.

10. Clic pe fila Stil, apoi selectat,i albastru ca s, i culoare de umplere.

11. Clic pe fila Etichetelor, apoi selectat,i Afis, area etichetelor pentru acest strat, pentru a activa etichetarea. În
lista Etichetare cu aleget,i câmpul “NAMES”, ca s, i câmp pentru etichete.

12. Pentru a îmbunătăt,i lizibilitatea etichetelor, putet,i adăuga un tampon alb în jurul lor, făcând clic pe Buffer

în lista din stânga, bifând Draw text buffer, s, i alegând 3 ca mărime a tamponului.

13. Clic [Aplicare]. Verificat,i dacă rezultatul arată bine, iar apoi facet,i clic pe [OK].

Putet,i vedea cât este de us, oară vizualizarea straturilor raster s, i vectoriale în QGIS. Haidet,i să parcurgem sect,iunile
următoare, pentru a afla mai multe despre funct,iunile disponibile, despre caracteristici s, i setări, s, i cum să le
folosit,i.
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6.4 Proiecte

Starea sesiunii dvs. de QGIS este considerată un proiect. QGIS lucrează cu un singur proiect, la un moment dat.
Setările sunt considerate ca fiind, fie per-proiect sau implicit pentru noi proiecte (a se vedea sect,iunea Opţiuni).

QGIS poate salva starea spat,iului de lucru într-un fis, ier proiect, folosind opt,iunile de meniu Project → Save

sau Project → Save As.... În cazul în care fis, ierul proiect încărcat pe disc a fost modificat între timp, în mod
implicit QGIS vă va întreba dacă dorit,i să suprascriet,i modificările în fis, ierul de proiect. Acest comportament este

setat prin bifarea opt,iunii Întreabă dacă este necesară salvarea modificările aduse datelor atunci când este
cazul, din meniul Setări → Opt,iuni → Generalităt,i.

Încărcat,i proiectele salvate într-o sesiune QGIS, folosind Project → Open..., Project → New from template
sau Project → Open Recent →.

La pornire, în locul unui canevas alb, este prezentată o listă de capturi cu numele s, i calea fiecăruia dintre cele mai
recente proiecte (până la zece). Aceasta este o cale facilă s, i rapidă de rememorare a proiectelor anterioare, un
dublu clic deschizând proiectul selectat. Dacă dorit,i să creat,i un proiect nou, trebuie doar să adăugat,i noi straturi,
iar lista va dispărea.

Dacă dorit,i să anulat,i sesiunea s, i să începet,i de la zero, aleget,i Project → New. Oricare dintre aceste opt,iuni
de meniu vă va solicita să salvat,i proiectul existent, în cazul în care au fost efectuate modificări de la momentul
deschiderii lui sau de la momentul ultimei salvări.

Tipurile de informat,ii salvate într-un fis, ier proiect includ:

• Straturile adăugate

• Straturile care pot fi interogate

• Proprietăt,ile stratului, inclusiv simbolizarea s, i stilurile

• Proiect,ia pentru vizualizarea hărt,ii

• Ultima extindere vizualizată

• Compozitoare de Hărt,i

• Elementele Compozitorului de Hărt,i cu setări

• Setările Atlasului Compozitorului de Hărt,i

• Setări de digitizare

• Relat,iie Tabelei

• Macrocomenzile Proiectului

• Stiluri implicite ale proiectului

• Setările Plugin-urilor

• Setările QGIS server din fila de setări OWS a proprietăt,ilor proiectului

• Interogările stocate în DB Manager

Fis, ierul proiect este salvat în format XML, astfel încât este posibilă editarea fis, ierului în afara QGIS, dacă vă
pricepet,i. Formatul de fis, ier a fost actualizat de mai multe ori, comparativ cu versiunile anterioare de QGIS.
Fis, ierele de proiect din versiunile QGIS mai vechi, este posibil să nu mai funct,ioneze corect. Pentru a realiza

acest lucru, în fila Generalităt,ilor din Settings → Options ar trebui să bifat,i opt,iunea Avertizare la deschiderea
unui fis, ier de proiect, salvat cu o versiune mai veche de QGIS.

Ori de câte ori salvat,i un proiect în QGIS, se va face o copie de rezervă a fis, ierului de proiect având extensia
.qgs~.
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6.5 Rezultat

Există mai multe moduri de a produce rezultate din sesiunile dvs. de QGIS. Am prezentat una deja în sect,iunea
Proiecte, salvând-o ca fis, ier proiect. Iată o exemplificare a altor moduri de a produce fis, iere de ies, ire:

• Opt,iunea de meniu Project → |mActionSaveMapAsImage| Save as Image deschide o fereastră de dialog în
care putet,i selecta numele, calea s, i tipul imaginii (PNG, JPG s, i multe alte formate). Un fis, ier world cu
extensia PNGW sau JPGW, salvat în acelas, i folder, va georeferent,ia imaginea.

• Opt,iunea de meniu Project → DXF Export ... deschide un dialog în care putet,i defini ‘Modul simbologiei’,
‘Scara simbologiei’ s, i straturile vectoriale pe care dorit,i să le exportat,i în DXF. Folosind ‘Modul simbolo-
giei’ simbolurile din Simbologia QGIS originală pot fi exportate cu mare fidelitate.

• Opt,iunea de meniu Project → New Print Composer... deschide o fereastră de dialog în care putet,i as, eza
în pagină s, i imprima canevasul hărt,ii curente (v. sect,iunea Compozitorul de Hărt,i).
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CHAPTER 7

QGIS GUI

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: Interfat,a QGIS cu datele es, antion pentru Alaska

Note: Aspectul ferestrelor (bara de titlu, etc) poate fi diferit, în funct,ie de sistemul de operare s, i de managerul de
ferestre.

Interfat,a grafică a QGIS GUI este împărt,ită în cinci:

1. Bara de Meniuri

2. Bare de instrumente

3. Panouri

4. Vizualizare Hartă

5. Bara de Stare

Aceste cinci componente ale interfet,ei QGIS sunt descrise mai detaliat în următoarele sect,iuni. Două sect,iuni
suplimentare vor prezenta combinat,iile de taste pentru comenzile rapide s, i ajutorul contextual.
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7.1 Bara de Meniuri

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Des, i cele mai multe opt,iuni de meniu au un instrument corespunzător, s, i invers, meniurile nu sunt organizate
similar barelor de instrumente. Bara de instrumente care cont,ine instrumentul, este listată după fiecare opt,iune
de meniu, sub formă de casetă de bifare. Unele opt,iuni de meniu apar numai dacă pluginul corespunzător este
încărcat. Pentru mai multe informat,ii despre instrumentele s, i barele de instrumente, vedet,i sect,iunea Bare de
instrumente.

Note: QGIS is a cross-platform application meaning that though it provides you with the same tools, they may be
placed in different menus according to the operating system specification. The lists below show the most common
location and precise when there is a variation.

7.1.1 Proiect

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Nou Ctrl+N vedet,i Proiecte Proiect

Deschidere Ctrl+O vedet,i Proiecte Proiect
Nou după s, ablon → vedet,i Proiecte
Deschidere proiect recent → vedet,i Proiecte

Salvare Ctrl+S vedet,i Proiecte Proiect

Salvare Ca... Ctrl+Shift+S vedet,i Proiecte Proiect

Salvare ca Imagine... vedet,i Rezultat
Export DXF... vedet,i Rezultat

Proprietăt,ile Proiectului... Ctrl+Shift+P vedet,i Proiecte

Nou Compozitor de Hărt,i Ctrl+P vedet,i Compozitorul de Hărt,i Proiect

Managerul de compozit,ii... vedet,i Compozitorul de Hărt,i Proiect
Compozitoare de Hărt,i → vedet,i Compozitorul de Hărt,i

Ies, ire din QGIS Ctrl+Q

Under Mac OSX, the Exit QGIS command corresponds to QGIS → Quit QGIS (Cmd+Q).
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7.1.2 Editare

Meniul Opt,iunilor Scurtătură Referint,ă Bara de
Instrumente

Anulare Ctrl+Z vedet,i Digitizare avansată Digitizare
Avansată

Refacere Ctrl+Shift+Zvedet,i Digitizare avansată Digitizare
Avansată

Decupare entităt,i Ctrl+X vedet,i Digitizarea unui strat
vectorial existent

Digitizare

Copiere entităt,i Ctrl+C vedet,i Digitizarea unui strat
vectorial existent

Digitizare

Lipire Entităt,i Ctrl+V vedet,i Digitizarea unui strat
vectorial existent

Digitizare

Lipes, te entităt,ile ca → vedet,i Lucrul cu Tabela de
Atribute

Adăugare Entitate Ctrl+. vedet,i Digitizarea unui strat
vectorial existent

Digitizare

Mutare Entităt,(i) vedet,i Digitizarea unui strat
vectorial existent

Digitizare

S, tergere Select,ie vedet,i Digitizarea unui strat
vectorial existent

Digitizare

Rotire Entităt,(i) vedet,i Digitizare avansată Digitizare
Avansată

Simplificare Entitate vedet,i Digitizare avansată Digitizare
Avansată

Adăugare Inel vedet,i Digitizare avansată Digitizare
Avansată

Adăugare Parte vedet,i Digitizare avansată Digitizare
Avansată

Umplere Inel vedet,i Digitizare avansată Digitizare
Avansată

S, tergere Inel vedet,i Digitizare avansată Digitizare
Avansată

S, tergere Parte vedet,i Digitizare avansată Digitizare
Avansată

Remodelare Entităt,i vedet,i Digitizare avansată Digitizare
Avansată

Decalare Curbă vedet,i Digitizare avansată Digitizare
Avansată

Divizare Entităt,i vedet,i Digitizare avansată Digitizare
Avansată

Divizare Părt,i vedet,i Digitizare avansată Digitizare
Avansată

Îmbinare Entităt,i Selectate vedet,i Digitizare avansată Digitizare
Avansată

Îmbinare Atribute pentru
Entităt,ile Selectate

vedet,i Digitizare avansată Digitizare
Avansată

Instrumentul Nod vedet,i Digitizarea unui strat
vectorial existent

Digitizare

Rotirea Simbolurilor Punctelor vedet,i Digitizare avansată Digitizare
Avansată
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After activating Toggle editing mode for a layer, you will enable the Add Feature icon in the Edit menu
depending on the layer type (point, line or polygon).

7.1.3 Editare (extra)

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Adăugare Entitate vedet,i Digitizarea unui strat vectorial existent Digitizare

Adăugare Entitate vedet,i Digitizarea unui strat vectorial existent Digitizare

Adăugare Entitate vedet,i Digitizarea unui strat vectorial existent Digitizare
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7.1.4 Vizualizare

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Deplasare Hartă vedet,i Transfocare s, i Deplasare Navigare în interiorul
hărt,ii

Deplasează Harta spre
Select,ie

Navigare în interiorul
hărt,ii

Mărire Ctrl++ vedet,i Transfocare s, i Deplasare Navigare în interiorul
hărt,ii

Mics, orare Ctrl+- vedet,i Transfocare s, i Deplasare Navigare în interiorul
hărt,ii

Selectare → see Salvarea s, i deselectarea
entităt,ilor

Atribute

Identificare Entităt,i Ctrl+Shift+Ivedet,i Identificare entităt,i Atribute
Măsurare → vedet,i Măsurarea Atribute

Sumar Statistic vedet,i Panoul Sumarului Statistic Atribute

Transfocare la nivelul
Hărt,ii

Ctrl+Shift+F Navigare în interiorul
hărt,ii

Transfocare la nivelul
Stratului

Navigare în interiorul
hărt,ii

Transfocare la nivelul
Select,iei

Ctrl+J Navigare în interiorul
hărt,ii

Nivelul de Mărire
Anterior

Navigare în interiorul
hărt,ii

Nivelul de Mărire
Următor

Navigare în interiorul
hărt,ii

Zoom To Native
Resolution

Navigare în interiorul
hărt,ii

Decorat,ii → vedet,i Decorat,iuni
Mod de previzualizare →

Map Tips vedet,i Meniul de Afis, are Atribute

Semn de Carte Nou... Ctrl+B vedet,i Semne de Carte Spat,iale Atribute

Afis, are Semne de Carte Ctrl+Shift+Bvedet,i Semne de Carte Spat,iale Atribute

Actualizare F5 Navigare în interiorul
hărt,ii

Panouri → a se vedea Panouri s, i Bare de
Instrumente

Bare de Instrumente → a se vedea Panouri s, i Bare de
Instrumente

Comută în Modul Ecran
Complet

F11

Under Linux KDE, Panels →, Toolbars → and Toggle Full Screen Mode are rather placed in Settings menu.

Preview mode → is not available under Mac OS X.
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7.1.5 Strat

Meniul Opt,iunilor Scurtătură Referint,ă Bara de
Instrumente

Creează Strat → vedet,i Crearea noillor straturi
Vectoriale

Gestiune
Straturi

Adaugă Strat → vedet,i Formatele de Date Acceptate Gestiune
Straturi

Încapsulare Straturi s, i Grupuri... vedet,i Imbricarea Proiectelor
Adăugare din Fis, ierul cu
Definit,iile Stratului...

Copiere stil vedet,i Salvarea s, i Partajarea
Proprietăt,ilor Stratului

Lipire stil vedet,i Salvarea s, i Partajarea
Proprietăt,ilor Stratului

Deschide Tabela de Atribute vedet,i Lucrul cu Tabela de Atribute Atribute

Comută Editarea vedet,i Digitizarea unui strat vectorial
existent

Digitizare

Salvează Modificările aduse
Stratului

vedet,i Digitizarea unui strat vectorial
existent

Digitizare

Editări Curente → vedet,i Digitizarea unui strat vectorial
existent

Digitizare

Salvează Ca... vedet,i Salvarea stratului într-un fis, ier
Salvează ca Fis, ier cu Definit,ii de
Strat...

Elimină Strat/Grup Ctrl+D

Duplicare Strat(uri)
Setează Vizibilitatea Scării
Straturilor
Setează CRS-ul statului(-urilor) Ctrl+Shift+C
Setează CRS-ul proiectului din
cel al Stratului
Proprietăţi... vedet,i Dialogul Proprietăt,ilor

Vectoriale
Filtrare... vedet,i Constructorul de Interogări

Etichetare vedet,i Meniul Etichetelor

Adaugă la Vizualizare Ctrl+Shift+O Gestiune
Straturi

Adaugă Totul la Vizualizare

Elimină Totul din Vizualizare

Arată Toate Straturile Ctrl+Shift+U Gestiune
Straturi

Ascunde Toate Straturile Ctrl+Shift+H Gestiune
Straturi

Arată Straturile Selectate

Ascunde Straturile Selectate
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7.1.6 Setări

Meniul Opt,iunilor Scurtă-
tură

Referint,ă Bara de
Instrumente

CRS
Personalizat...‘

vedet,i Sistem Personalizat de Coordonate de
Referint,ă

Managerul de stiluri... vedet,i Managerul de Stiluri
Configurare

scurtături...
Personalizare... vedet,i Personalizare
Opt,iuni... vedet,i Opţiuni

Opt,iuni de Acros, are... vedet,i Setarea Tolerant,ei Acros, ării s, i
Căutarea Razei

Under Linux KDE, you’ll find more tools in Settings menu such as Project Properties, Panels →, Toolbars →
and Toggle Full Screen Mode.

7.1.7 Plugin-uri

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Manage and Install Plugins... vedet,i Dialogul Plugin-urilor
Consola Python Ctrl+Alt+P

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.8 Vector

Meniul Opt,iunilor Scurtă-
tură

Referint,ă Bara de
Instrumente

Open Street Map → vedet,i Încărcarea Vectorilor
OpenStreetMap

Instrumente de Analiză → vedet,i Plugin-ul fTools

Instrumente de Cercetare → vedet,i Plugin-ul fTools

Instrumente de Geoprocesare → vedet,i Plugin-ul fTools

Instrumente de Geometrie → vedet,i Plugin-ul fTools

Instrumente de Managementul
Datelor →

vedet,i Plugin-ul fTools

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.9 Raster

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente
Raster calculator... vedet,i Calculatorul Raster
Align Raster... vedet,i Alinierea Rasterelor

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.
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7.1.10 Bază de date

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente
Bază de Date → vedet,i Plugin-ul DB Manager Baza de Date

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.11 Web

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente
Metasearch vedet,i MetaSearch Catalogue Client Web

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.12 Procesare

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Bară de instrumente vedet,i Instrumentarul

Modelator Grafic... vedet,i Modelatorul grafic

Istoric s, i jurnal... vedet,i Managerul istoricului

Opt,iuni... vedet,i Configurarea cadrului de procesare

Vizualizatorul de rezultate... vedet,i Configurarea Aplicat,iilor Externe

Commander Ctrl+Alt+M vedet,i QGIS Commander

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.13 Ajutor

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

|mActionHelpContents| Cont,inutul fis, ierului de Ajutor
F1 Ajutor

Ce reprezintă? Shift+F1 Ajutor
Documentat,ie API
Raportat,i o problemă
Avet,i nevoie de suport comercial?

Pagina de Casă QGIS Ctrl+H

Check QGIS Version

About

QGIS Sponsors

7.1.14 QGIS

This menu is only available under Mac OS X and contains some OS related commands.
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Meniul Opt,iunilor Scurtătură Referint,ă
Preferinţe
Despre QGIS
Hide QGIS
Show All
Hide Others
Închidere QGIS Cmd+Q

Preferences and About QGIS are the same commands as Settings → Options and Help → About. Quit QGIS
corresponds to Project → Exit QGIS under the other platforms.

7.2 Panouri s, i Bare de Instrumente

From the View menu (Settings under KDE), you can switch on and off QGIS widgets (Panels →) or toolbars
(Toolbars →). You can (de)activate any of them by right-clicking the menu bar or a toolbar and choose the item
you want. Each panel or toolbar can be moved and placed wherever you feel comfortable with in QGIS interface.
The list can also be extended with the activation of Core or external plugins.

7.2.1 Bare de instrumente

Bara de instrumente oferă acces la cele mai multe dintre funct,ii ca s, i meniurile, plus câteva instrumente supli-
mentare pentru a interact,iona cu harta. Fiecare element din bara de instrumente are disponibilă o fereastră de tip
pop-up. T, inet,i mouse-ul deasupra elementului s, i va fi afis, ată o scurtă descriere a funct,ionalităt,ii instrumentului.

Every toolbar can be moved around according to your needs. Additionally, they can be switched off using the
right mouse button context menu, or by holding the mouse over the toolbars.

Figure 7.2: Meniul barei de instrumente

30 Chapter 7. QGIS GUI



QGIS User Guide, Release 2.14

Tip: Restaurare bare de instrumente
If you have accidentally hidden a toolbar, you can get it back by choosing menu option View → Toolbars → (or
Settings → Toolbars → under Linux KDE). If for some reason a toolbar (or any other widget) totally disappears
from the interface, you’ll find tips to get it back at restoring initial GUI.

7.2.2 Panouri

QGIS provides by default many panels to work with.

Figure 7.3: Meniul Panourilor

Some of these panels are described below while others may be found in different parts of the document, namely:

• Browser Panel

• Advanced Digitizing Panel

• Spatial Bookmarks Panel

• GPS Information Panel

• Tile Scale Panel

• Identify Panel

• User Input Panel

Panoul Straturilor

The layers panel lists all the layers in the project. The checkbox in each legend entry can be used to show or hide
the layer. The toolbar in the layers panel allows you to:

• Adaugă un nou grup

• Gestionează Vizibilitatea: controlează vizibilitatea straturilor s, i combinarea straturilor presetate
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• Filter Legend by Map Content: only the layers that are set visible and whose features intersect the current map
canvas have their style rendered in the layers panel. Otherwise, a generic NULL symbol is applied to the
layer. Based on the layer symbology, this is a convenient way to identify which kind of features from which
layers cover your area of interest.

• Filter Legend by Expression: helps you apply an expression to remove from the selected layer tree styles that
have no feature satisfying the condition. This can be used for example to highlight features that are within
a given area/feature of another layer. From the drop-down list, you can edit and clear the expression set.

• Expand All or Collapse All layers and groups in the layers panel.

• and Remove Layer/Group currently selected.

The button allows you to add Presets views in the legend. Presets are a way to save and easily restore a
combination of layers with their current style. To add a preset view, just set visible the layers you want, with their
desired symbology, and click on button. Choose Add Preset... from the drop-down menu and give a name to
the preset. The added preset is listed at the bottom of the drop-down menu and is recalled by clicking on it.

The Replace Preset → option helps you overwrite a preset content with the current map view while the Remove
Current Preset button deletes the active preset.

Toate presetările adăugate sunt, de asemenea, prezente în harta compozitorului, pentru a vă permite să creat,i un
aspect al hărt,ii pe baza opiniilor dumneavoastră (a se vedea Proprietăt,i principale).

Note: Tools to manage the layers panel are also available to layout the map and legend items of the print composer

Un strat poate fi selectat s, i deplasat în sus sau în jos în legendă, pentru a schimba ordinea Z. Ordinea Z stabiles, te
că straturile enumerate mai aproape de partea de sus a legendei sunt desenate peste straturile enumerate mai jos.

Note: Acest comportament poate fi suprascris de către panoul Layer Order.

Layers in the legend window can be organized into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Selectat,i mai multe straturi, facând clic dreapta în fereastra legendei s, i aleget,i Grupul Selectat.

Pentru a scoate un strat dintr-un grup, putet,i să-l traget,i în afară, sau să facet,i clic dreapta pe el s, i să aleget,i Make
to toplevel item. Grupurile pot fi, de asemenea, imbricate în interiorul altor grupuri.

Caseta grupului va afis, a sau ascunde toate straturile din grup cu un singur clic.

Cont,inutul meniul contextual, afis, at în urma apăsării butonului drept al mouse-ului, depinde de tipul vectorial sau

raster al elementul selectat din legendă. Pentru straturile vectoriale GRASS, Toggle editing nu este disponibil.
Parcurget,i sect,iunea Digitizarea s, i editarea unui strat vectorial GRASS pentru informat,ii cu privire la editarea
straturilor vectoriale GRASS.

Below are listed available options in context menu depending on the selected item.
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Opţiune Strat Vectorial Strat Raster Grup

Zoom to Layer/Group

Arată în Vederea Generală

Transfocare la Rezolut,ia Nativă (100%)

Întinde, Folosind Extinderea Curentă

Eliminare

Duplicare

Setează Vizibilitatea Scării Stratului

Setare CRS pentru Strat/Grup

Obt,ine CRS-ul Proiectului din Strat

Stiluri →
Copiere Stil

Paste Style

Open Attribute Table

Toggle Editing

Editări Curente → (in Edit mode)

Salvează Ca...

Salvează ca Fis, ier cu Definit,ii de Strat...

Filtru

Show Feature Count

Proprietăt,i

Mută la primul nivel

Redenumire

Grup Selectat

Proprietăt,i

Set Group WMS Data

Mutually Exclusive Group

Add Group

Enabling the Mutually Exclusive Group option you can make a group have only one layer visible at the same
time. Whenever a layer within the group is set visible the others will be toggled not visible.

Este posibilă selectarea mai multor straturi sau grupuri, în acelas, i timp, t,inând apăsată tasta Ctrl în timp ce
selectat,i straturile cu butonul din stânga al mouse-ului. Putet,i muta apoi toate straturile selectate într-un nou grup,
în acelas, i timp.

You may also delete more than one layer or group at once by selecting several items with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

Editing vector layer style

From the Layers panel, you have shortcuts to easily and quickly edit the layer rendering. Right-click on a vector
layer and select Styles –> in the list in order to:

• see the currently applied styles to the layer. In case you defined many styles for the layer, you can switch
from one to another and have your layer rendering automatically updated in the map canvas.

• copy the current style, and when applicable, paste a copied style from another layer
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• rename the current style, add a new one (which is actually a copy of the current one) or delete the current
style (when multiple styles available).

Note: The previous options are also available for raster layer.

Whether the features in the vector layer have all the same unique symbol or they are classified (in that case, the
layer is displayed in a tree structure with each class as sub-item), the following options are available at layer level
or class level:

• a Edit Symbol... button to open the Selectorul de simboluri dialog and update any property (symbol, size,
color...) of the layer or feature symbol. Double-clicking on a feature does also open the Symbol Selector
dialog.

• a Selectorul de Culoare widget with a Color Wheel from which you can click a color and have it automat-
ically update the symbol fill color. For convenience, Recent colors are available at the bottom of the color
wheel.

• a Show All Items and Hide All Items to toggle on or off the visibility of all the classes of features.
This avoids (un)checking items one by one.

Tip: Quickly share a layer style
From the context menu, copy the style of a layer and paste it to a group or a selection of layers: the style is applied
to all the layers that are of the same type (vector vs raster) as the original layer and, in case of vector, have the
same geometry type (point, line or polygon).

Lucrul cu ordonarea independentă a straturilor din Legendă

There is a panel that allows you to define an independent drawing order for the layers panel. You can activate it in
the menu Settings → Panels → Layer Order Panel. This feature allows you to, for instance, order your layers in

order of importance, but still display them in the correct order (see figure_layer_order). Checking the Control
rendering order box underneath the list of layers will cause a revert to default behavior.

Figure 7.4: Define a legend independent layer order
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Panoul Sumarului Statistic

This panel can show some statistics on a specific vector layers. The panel allows users to choose:

• the vector layer;

• the column or the expression;

• filter statistics to selected features;

• refresh the informations;

• the statistics information to display with the bottom right button;

Panoul Vederii Generale din QGIS

In QGIS, you can use an overview panel that provides a full extent view of layers added to it. Within the view is
a rectangle showing the current map extent. This allows you to quickly determine which area of the map you are
currently viewing. Note that labels are not rendered to the map overview even if the layers in the map overview
have been set up for labelling. If you click and drag the red rectangle in the overview that shows your current
extent, the main map view will update accordingly.

Panoul pentru Mesajele Jurnalului

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

Panoul de Anulare/Refacere

For each layer being edited, this panel shows the list of actions done, allowing to quickly undo a set of actions by
simply selecting the action listed above.

7.3 Vizualizare Hartă

Also called Map canvas, this is the “business end” of QGIS — maps are displayed in this area. The map displayed
in this window will depend on the vector and raster layers you have chosen to load (see sections that follow for
more information on how to load layers). The map view can be panned, shifting the focus of the map display
to another region, and it can be zoomed in and out. Various other operations can be performed on the map as
described in the label_toolbars description above. The map view and the legend are tightly bound to each other —
the maps in view reflect changes you make in the legend area.

Tip: Mărirea Hărt,ii folosind Rotit,a Mouse-ului
Putet,i utiliza rotit,a mouse-ului pentru a mări sau a mics, ora harta. Plasat,i cursorul mouse-ului în interiorul hărt,ii,
s, i mis, cat,i rotit,a înainte (dinspre dvs.) pentru a mări, s, i înapoi (înspre dvs.) pentru a mics, ora. Transfocarea are loc
din pozit,ia cursorului mouse-ului. Putet,i personaliza comportamentul de transfocare al rotit,ei mouse-ului folosind
meniul filei Map tools de sub Settings → Options.

Tip: Deplasarea Hărt,ii folosind Săget,ile s, i Bara de Spat,iu
Putet,i utiliza tastele cu săget,i pentru a deplasa harta. Plasat,i cursorul mouse-ului în interiorul hărt,ii s, i apăsat,i tasta
săget,ii din dreapta pentru deplasarea înspre est, tasta săget,ii din stânga pentru deplasarea înspre vest, tasta săget,ii
de sud pentru deplasarea înspre nord s, i tasta săget,ii din jos pentru deplasarea înspre sud. Putet,i deplasa harta
folosind bara de spat,iu sau rotit,a mouse-ului: este suficient să mutat,i mouse-ul în timp ce t,inet,i apăsată bara de
spat,iu sau t,inând apăsată rotit,a mouse-ului.
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7.4 Bara de Stare

The status bar provides you with general information about the map view, and actions processed or available and
offers you tools to manage the map view.

On the left side of the status bar, you can get a summary of actions you’ve done (such as selecting features in
a layer, removing layer) or a long description of the tool you are hovering over (not available for all tools). On
startup, the bar status also informs you about availability of new or upgradeable plugins (if checked in Plugin
Manager settings).

In case of lengthy operations, such as gathering of statistics in raster layers or rendering several layers in map
view, a progress bar is displayed in the status bar to show the current progress of the action.

The Coordinate option shows the current position of the mouse, following it while moving across the map
view. You can set the unit (and precision) to use in the project properties, General tab. Click on the small button

at the left of the textbox to toggle between the Coordinate option and the Extents option that displays in map
units, the coordinates of the current lower leftmost and upper rightmost points of the map view, as you pan and
zoom in and out.

Pe lângă afis, area coordonatelor are loc s, i afis, area Scării. Acesta prezintă scara hărt,ii vizualizate. Dacă are loc o
transfocare, QGIS vă arată scara actuală. Există un selector de scară, care vă permite să aleget,i între predefined
and custom scales care vor fi atribuite vizualizării hărt,ii.

În partea dreaptă a scării se poate defini o rotat,ie în sensul acelor de ceasornic, pentru vizualizarea hărt,ii, în grade.

On the right side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being
rendered to the map view (see section Randare).

To the right of the render functions, you find the Current CRS: icon with the EPSG code of the current project
CRS. Clicking on this lets you Enable ‘on the fly’ CRS transformation properties for the current project and apply
another CRS to the map view.

Finally, the Messages button opens the Log Messages Panel which informs you on underlying process (QGIS
startup, plugins loading, processing tools...)

Tip: Calculează Scara Corectă a Canevasului Hărt,ii
When you start QGIS, the default CRS is WGS 84 (epsg 4326) and units are degrees. This means that QGIS
will interpret any coordinate in your layer as specified in degrees. To get correct scale values, you can either
manually change this setting, e.g. to meters, in the General tab under Project → Project Properties, or you can

use the Current CRS: icon seen above. In the latter case, the units are set to what the project projection specifies
(e.g., +units=us-ft).

Note that CRS choice on startup can be set in Settings → Options → CRS.
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CHAPTER 8

Instrumente generale

8.1 Combinat,ii de taste

QGIS oferă, pentru multe entităt,i, scurtături implicite de la tastatură. Le putet,i găsi în sect,iunea Bara de Meniuri.
În plus, opt,iunea de meniu Setări → Configurare Scurtături... vă permite să modificat,i combinat,iile de taste
implicite s, i să adăugat,i noi combinat,ii pentru funct,ionalităt,ile QGIS.

Figure 8.1: Definirea opt,iunilor pentru scurtături

Configurarea este foarte simplă. Trebuie doar să selectat,i o funct,ie din listă s, i facet,i clic pe:

• [Change] and press the new combination you want to assign as new shortcut

• [Set none] to clear any assigned shortcut

• or [Set default] to backup the shortcut to its original and default value.

După ce at,i terminat configurarea, o putet,i salva su b formă defis, ier XML, apoi să o încărcat,i într-o altă instalare
QGIS.

8.2 Ajutor contextual

Când avet,i nevoie de ajutor pe un anumit subiect, putet,i accesa ajutorul contextual prin intermediul butonului
[Ajutor], disponibil in cele mai multe dialoguri — vă rugăm să ret,inet,i că plugin-urile tert,e pot avea pagini web
dedicate.
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8.3 Randare

În mod implicit, QGIS face toate straturile vizibile de fiecare dată când canevasul hărt,ii este actualizat. Între
evenimentele care declans, ează o actualizare de canevas sunt incluse:

• Adăugarea unui strat

• Deplasare s, i transfocare

• Redimensionarea ferestrei QGIS

• Schimbarea vizibilităt,ii unuia sau mai multor straturi

QGIS permite controlarea procesului de randare în mai multe moduri.

8.3.1 Randarea Dependentă de Scară

Randarea dependentă de scară vă permite să specificat,i scările minimă s, i maximă la care un strat va fi vizibil.
Pentru a seta o randare dependentă de scară, deschidet,i Properties printr-un dublu-clic pe stratul din legendă.

În fila General, facet,i clic pe caseta :guilabel:‘Scale dependent visibility‘pentru a activa funct,ia, apoi setat,i
valorile pentru scările minimă.s, i maximă.

Putet,i determina valorile scării, transfocând mai întâi la nivelul pe care dorit,i să-l utilizat,i, s, i observând valoarea
scării din bara de stare QGIS.

8.3.2 Controarea Randării Hărt,ilor

Randarea hărt,ii poate fi controlată în diverse moduri, as, a cum este descris mai jos.

Suspendarea Randării

Pentru a suspenda randarea, facet,i clic pe caseta Render din colt,ul din dreapta jos al barei de stare. În cazul

în care caseta Render nu este bifată, QGIS nu redesenează canevasul ca răspuns la oricare din evenimentele
descrise în sect,iunea Randare. Exemple de momente când s-ar putea suspenda randarea:

• Adăugarea mai multor straturi s, i simbolizarea lor înainte de desenare

• Adăugarea unuia sau a mai multor straturi mari, s, i stabilirea dependent,ei de scară înainte de desenare

• Adăugarea unuia sau a mai multe straturi mari, s, i transfocarea la o vizualizare specifică înainte de desenare

• Orice combinat,ie a celor de mai sus

Bifarea casetei Randare activează randarea s, i provoacă o reîmprospătare imediată a canevasului hărt,ii.

Setarea Opt,iunilor de Adăugare a Stratului

Putet,i seta o opt,iune pentru a încărca mereu noi straturi, fără a le desena. Acest lucru înseamnă că stratul va fi
adăugat la hartă, dar caseta sa de vizibilitate din legendă va fi debifată din oficiu. Pentru a seta această opt,iune,

selectat,i opt,iunea de meniu Settings → Options, apoi facet,i clic pe fila Rendering. Debifat,i caseta În mod
implicit, straturile nou adăugate pe hartă ar trebui să fie vizibile. Orice strat adăugat ulterior pe harta va fi stins
(invizibil), în mod implicit.
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Oprirea Randării

Pentru a opri desenarea hărt,ii, apăsat,i tasta ESC. Acest lucru va opri reîmprospătarea canevasului, lăsând harta
part,ial desenată. Este posibil să dureze ceva timp între apăsarea tastei ESC s, i momentul în care desenarea hărt,ii
se opres, te.

Note: În acest moment nu este posibilă oprirea randării — acest lucru a fost dezactivat în portarea de Qt4, din
cauza problemelor s, i a defectelor Interfet,ei cu Utilizatorul (UI).

Influent,area Calităt,ii Randării

QGIS are o opt,iune de influent,are a calităt,ii randării hărt,ii. Aleget,i opt,iunea de meniu Setări → Opt,iuni, facet,i

clic pe fila Randare, apoi selectat,i sau deselectat,i caseta care Face ca liniile să apară mai put,in zimt,ate, cu
pret,ul unei reduceri a vitezei de desenare.

Accelerează randarea

Există două setări care vă permit să îmbunătăt,i viteza de randare. Deschidet,i dialogul opt,iunilor QGIS folosind
Setări → Opt,iuni, fila Randare, apoi bifând sau debifând următoarele casete:

• Se foloses, te memoria tampon, acolo unde este posibil, pentru a se accelera redesenarea

• Straturile se randează în paralel, utilizând mai multe nuclee CPU s, i Maximum de nuclee utilizate.

• The map renders in the background onto a separate image and each Map Update interval, the content
from this (off-screen) image will be taken to update the visible screen representation. However, if rendering
finishes faster than this duration, it will be shown instantaneously.

• With Enable Feature simplification by default for newly added layers, you simplify features’ geometry
(less nodes) and as a result, they quickly display. Be aware that you can also face rendering inconsistencies.

8.4 Selectorul de Culoare

The select color dialog will appear whenever you push the icon to choose a color. The
features of this dialog depends on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options → General menu. When checked, the color dialog used is the one of the OS being used. Otherwise,
QGIS custom color chooser is used.

This dialog has four different tabs which allow you to select colors by color ramp, color wheel, color swatches

or color picker (not available under ).

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. There is also an opacity slider to set transparency level. On the lower
left part of the dialog you can see a comparison between the current and the new color you are presently selecting
and on the lower right part you have the option to add the color you just tweaked into a color slot button.

Tip: Dynamically change the color with the live-updating option
Check the Use live-updating color chooser dialogs option in the General Settings to have the color applied to your
items as you change color parameters in the QGIS custom color chooser dialog.
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Figure 8.2: Fila de selectare a gamei de culori

With color ramp or with color wheel, you can browse to all possible color combinations. There are other

possibilities though. By using color swatches you can choose from a preselected list. This selected list is populated
with one of three methods:

• Culori recente,

• Standard colors, a user-defined list of colors set under Settings → Options → Colors menu

• or Project colors, a user-defined list of colors set under Project → Project Properties → Default Styles.

Figure 8.3: Color selector switcher tab

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by OSX.
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Tip: preluare rapidă a culorii + copiere/lipire culori
You can quickly choose from Recent colors, from Standard colors or simply copy or paste a color by clicking the

drop-down arrow that follows the color box.

Figure 8.4: Meniul rapid al selectorului de culoare

8.5 Modurile de Fuziune

QGIS offers different options for special rendering effects with these tools that you may previously only know
from graphics programs. Blending modes can be applied on layers, on features but also on print composer items:

• Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with the
pixel beneath it. The colors aren’t mixed.

• Lighten: This selects the maximum of each component from the foreground and background pixels. Be
aware that the results tend to be jagged and harsh.

• Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This mode
is most useful for mixing the texture of one item with another item (e.g., you can use a hillshade to texture
another layer).

• Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works best
if the top pixels aren’t too bright; otherwise the effect is too extreme.

• Addition: This blend mode simply adds pixel values of one item with the other. In case of values above
one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

• Darken: This creates a resultant pixel that retains the smallest components of the foreground and back-
ground pixels. Like lighten, the results tend to be jagged and harsh.

• Multiply: Here, the numbers for each pixel of the top item are multiplied with the corresponding pixels for
the bottom item. The results are darker pictures.

• Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used to tweak and
colorise underlying layers.

• Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light parts
become lighter and dark parts become darker.

• Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge. This
is supposed to emulate shining a soft light onto an image.

• Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a very
intense light onto an image.

• Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to always get
a positive value. Blending with black produces no change, as the difference with all colors is zero.
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• Subtract: This blend mode simply subtracts pixel values of one item from the other. In case of negative
values, black is displayed.

8.6 Transfocare s, i Deplasare

QGIS dispune de instrumente de deplasare sau transfocare în zona de interes.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys.

8.6.1 Transfocarea s, i deplasarea cu ajutorul rotit,ei mouse-ului

Putet,i apăsa rotit,a mouse-ului pentru deplasare în interiorul ferestrei principale; de asemenea, putet,i utiliza rotit,a
mouse-ului pentru a mări sau a mics, ora harta. Plasat,i cursorul mouse-ului în interiorul hărt,ii, s, i mis, cat,i rotit,a
înainte (dinspre dvs.) pentru a mări, s, i înapoi (înspre dvs.) pentru a mics, ora. Transfocarea are loc din pozit,ia
cursorului mouse-ului. Putet,i personaliza comportamentul de transfocare al rotit,ei mouse-ului folosind meniul
filei Instrumentelor hărt,ii de sub Setări → Opt,iuni.

8.6.2 Deplasarea cu ajutorul tastelor cu săget,i

Putet,i utiliza tastele cu săget,i pentru a deplasa harta. Plasat,i cursorul mouse-ului în interiorul hărt,ii s, i apăsat,i tasta
săget,ii din dreapta pentru deplasarea înspre est, tasta săget,ii din stânga pentru deplasarea înspre vest, tasta săget,ii
de sud pentru deplasarea înspre nord s, i tasta săget,ii din jos pentru deplasarea înspre sud.

De asemenea, putet,i utiliza bara de spat,iu pentru a produce temporar deplasări ale hărt,ii. Tastele PgUp s, i PgDown
vor determina mărirea sau mics, orarea hărt,ii.

8.7 Măsurarea

QGIS provides four means of measuring geometries:

• the interactive measurement tools ,

• measuring in the Field Calculator,

• derived measures in the Identificare entităt,i tool,

• and a vector analysis tool: Vector → Geometry Tools → Export/Add Geometry Columns

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. The first three measuring
tools behave equally to global project settings:

If “on the fly” CRS transformation is enabled, the default measurement metric is - different from most other GIS -
ellipsoidal, using the ellipsoid defined in File → Project properties → General. This is true both when geographic
and projected coordinate systems are defined for the project. If you want to calculate the projected / planimetric
area or distance using cartesian maths, the measurement ellipsoid has to be set to “None / Planimetric” (File →
Project properties → CRS). However, with a geographic (= unprojected) CRS defined for the data and project, area
and distance measurement will be ellipsoidal. If “on the fly” CRS transformation is disabled, the measurement
metric is planimetric when the project coordinate system is projected and ellipsoidal when the project coordinate
system is unprojected / geographic.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools →
Export/Add Geometry Columns. Here, measurement is by default planimetric except if you choose the ellipsoidal
measure.
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8.7.1 Măsurarea interactivă a lungimii, a ariei s, i a unghiurilor

Toate modulele de măsurare utilizează setările de acros, are ale modulului de digitizare. Acest lucru este util atunci
când se dores, te măsurarea de-a lungul liniilor sau a suprafet,elor din straturile vectoriale.

Pentru a selecta un instrument de măsurare, facet,i clic pe , apoi selectat,i instrumentul pe care dorit,i să-l
utilizat,i.

În mod implicit, Măsurare Linie: QGIS poate măsura distant,ele reale dintre punctele date, în conformitate cu
un elipsoid definit. Putet,i defini o bandă elastică, o culoare, unităt,ile de măsură preferate (metri sau picioare)
s, i unităt,ile unghiului (grade, radiani s, i gon) din aleget,i opt,iunea de meniu Settings → Options → Map Tools.
Instrumentul vă permite apoi să facet,i clic pe punctele de pe hartă. Lungimea fiecărei entităt,i, precum s, i totalul,
apare în fereastra de măsură. Pentru a opri măsurarea, facet,i clic pe butonul din dreapta al mouse-ului. Ret,inet,i
că putet,i schimba interactiv unităt,ile de măsură în dialogul de măsurare. El suprascrie Unităt,ile de măsurare
preferate din opt,iuni. Există o sect,iune de informat,ii în fereastra de dialog, care arată care dintre setările CRS-ului
sunt utilizate în timpul calculelor de măsurare.

Figure 8.5: Măsurarea Distant,ei

Measure Area: Zonele pot fi, de asemenea, măsurate. În fereastra de măsură, va apărea dimensiunea zonei
acumulate. În plus, instrumentul de măsură se va acros, a la stratul curent selectat, cu condit,ia ca tolerant,a de
acros, are a stratului să fie setată (a se vedea sect,iunea Setarea Tolerant,ei Acros, ării s, i Căutarea Razei). Astfel, dacă
vret,i să măsurat,i exact o linie sau un poligon, mai întâi setat,i-i tolerant,a, apoi selectat,i stratul. Apoi, când se vor
utiliza instrumentele de măsurare, fiecare clic de mouse (în funct,ie de tolerant,ă) se va acros, a la acel strat.

Figure 8.6: Măsurarea Ariei

Measure Angle: Putet,i măsura, de asemenea, unghiurile. Cursorul va lua forma unei cruciulit,e. Facet,i clic pentru
a desena primul segment al unghiului pe care dorit,i să-l măsurat,i, apoi deplasat,i cursorul pentru a desena unghiul
dorit. Măsura acestuia va fi afis, ată într-o fereastră de tip pop-up.

8.8 Salvarea s, i deselectarea entităt,ilor

Bara de instrumente a QGIS dispune de mai multe unelte pentru selectarea entităt,ilor în canevasul hărt,ii. Pentru a

selecta una sau mai multe entităt,i, este suficient să facet,i clic pe s, i să aleget,i instrumentul:
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Figure 8.7: Măsurarea Unghiului

• Select Features by area or single click to select feature(s) either by simple click or by rectangle

• Selectare Entităt,i după un Poligon

• Selectare Entităt,i în Mod Liber

• Selectare Entităt,i după o Rază

Pentru a deselecta toate entităt,ile facet,i clic pe Deselectarea Entităt,ilor din Toate Straturile.

Selectarea entităt,ilor prin utilizarea unei expresii permite utilizatorului să selecteze o entitate cu ajutorul dialogului expre-
siei. Vedet,i capitolul Expresii pentru unele exemple.

Utilizatorii pot salva entităt,ile selectate într-un Nou Strat Vectorial, din Memorie sau într-un Nou Strat Vecto-
rial, folosind Editare → Copiere Entităt,i s, i apoi Editare → Lipire Entităt,i ca... în formatul dorit.

8.9 Configurarea suprascrierii definită de date

Beside many options in the vector layer properties dialog or settings in the print composer, you can find a
Data defined override icon. Thanks to expressions based on layer attributes or item settings, prebuild or custom functions
and variables, this tool allows you to set dynamic value for the concerned parameter. When enabled, the value
returned by this widget is applied to the parameter regardless its normal value (checkbox, textbox, slider...).

Clicking the Data defined override icon shows:

• a Description ... that indicates if it is enabled, which input expected, valid input type and the current
definition,

• an entry to list the Field type available,

• an entry to list the Variable available,

• Edit ... button to create or edit the expression to use,

• butoanele Lipire s, i Copiere,

• Clear button to remove the setup.

Tip: When the data-defined override option is setup correctly the icon is yellow or ; if it is broken, the
icon is red or .

Parametrii care pot fi utilizat,i cu instrumentele de definire cu ajutorul datelor sunt:

• Parametrii pentru stil s, i simboluri

• Parametrii etichetelor

• Parametrii compozitorului
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8.10 Identificare entităt,i

Instrumentul de Identificare vă permite să interact,ionat,i cu canevasul hărt,ii, s, i să obt,inet,i, într-o fereastră pop-up,
informat,ii despre entităt,i. Pentru a identifica entităt,ile, utilizat,i Vizualizare → Identificare entităt,i sau Ctrl +

Shift + I, sau facet,i clic pe pictograma Identificare entităt,i din bara de instrumente a Atributelor.

QGIS offers two ways to identify features with the Identify features tool:

• left click will identify features according to the mode set in the Identify results panel

• right click will fetch all the snapped features from all the visible layers. This will open a context menu,
allowing the user to choose more precisely the features to identify.

Dacă facet,i clic pe mai multe entit(ăt,i), dialogul de Identificare rezultate va lista informat,iile despre toate
entit(ăt,ile) selectate. Vizualizarea implicită constă într-un arbore în care primul element este numele stratului,
având în subordine toate entit(ăt,ile) identificate. Fiecare entitate este descrisă de numele unui câmp, alături de
valoarea sa. Primul câmp este cel stabilit în Proprietăt,i → Afis, are. Apoi urmează restul informat,iilor despre
entitate.

Această fereastră poate fi setată pentru a afis, a câmpuri personalizate, dar, în mod implicit, ea va afis, a trei tipuri de
informat,ii:

• Act,iuni: Act,iunile pot fi adăugate ferestrelor de identificare a entităt,ilor. Act,iunea se va lansa atunci când
facet,i clic pe eticheta act,iunii. În mod implicit, se adaugă doar o act,iune, s, i anume vizualizarea
formularului entităt,ii pentru editare.

• Derived: This information is calculated or derived from other information. This includes the feature id,
its length or perimeter and area in map units depending on its geometry, the count of spatial parts and the
number of the clicked part in case of multi-geometry, the count of vertices in the feature and the number of
the closest one to the point clicked. It also reports the X and Y (and Z/M if available) coordinate values of
both clicked point and feature closest vertex.

• Atributele datelor: Aceasta este lista câmpurilor s, i valorilor atributelor, pentru entitatea pe care s-a efectuat
click.

Figure 8.8: Dialiogul de identificare a entităt,ilor

În partea de sus a ferestrei, avet,i s, apte pictograme:

• Expandare arbore

• Restrângere arbore

• Default behavior to define whether next identified features information should be collapsed or expanded

• Vizualizarea formularului entităt,ii
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• Clear Results

• Copy selected feature to clipboard

• Se imprimă răspunsul HTML selectat

În partea de jos a ferestrei, avet,i casetele Mod s, i Vizualizare. Cu ajutorul casetei Mod putet,i defini straturile din
care se va efectua identificarea:

• ‘Stratul curent’ : sunt identificate doar entităt,ile din stratul selectat. Stratul poate să nu fie vizibil pe canevas.

• ‘Top down, stop at first’: for only features from the upper visible layer.

• ‘De sus în jos’: pentru toate entităt,ile din straturile vizibile. Rezultatele sunt afis, ate în panou.

• s, i ‘Select,ia stratului’. : deschide un meniu contextual, în care utilizatorul va selecta stratul din care se vor
identifica entităt,ile. Operează similar unui clic-dreapta. Numai entităt,ile selectate se vor afis, ate în panoul
cu rezultate.

Vizualizarea poate fi setată ca ‘Arbore’, ‘Tabel’ s, i ‘Graf’. Ultimele două pot fi setate pentru straturile raster.

The identify tool allows you to auto open a form. If checked, each time a single feature is identified QGIS will
open a form showing its attributes. This is a handy way to quickly edit a feature’s attributes.

Alte funct,ii pot fi găsite în meniul contextual al elementului identificat. De exemplu, din meniul contextual putet,i:

• Vizualiza formularul entităt,ii

• Transfocare pe entitate

• Copia entităt,i: Copierea tuturor entităt,ilor geometrice s, i a atributelor

• Activează select,ia entităt,ilor: Adaugă entitatea identificată la select,ie

• Copia valoarea atributului: Copie doar valoarea atributului pe care facet,i clic

• Copiere atribute entitate: Copiază atributele entităt,ii

• S, terge rezultatele: Elimină rezultatele din fereastră

• Elimina evident,ierea: Anulează evident,ierea entităt,ilor de pe hartă

• Evident,iază tot

• Evident,iere strat

• Activa stratul: Aleget,i un strat pentru a fi activat

• Afis, a proprietăt,ile straturilor: Deschide fereastra de proprietăt,i a unui strat

• Expandează tot

• Restrânge tot

8.11 Instrumente de Adnotare

Instrumentul Text Annotation din bara de instrumente a atributelor oferă posibilitatea de a plasa text formatat
într-un balon, pe canevasul hărt,ii QGIS. Folosit,i instrumentul Adnotare Text, apoi facet,i clic pe canevasul hărt,ii.

Efectuând dublu clic pe element se va deschide un dialog cu diverse opt,iuni. Cu ajutorul editorului de text se va
introduce textul formatat s, i alte setări de elemente. De exemplu, apare opt,iunea de a pozit,iona elementul pe hartă
(atribuindu-i un simbol de marcare) sau de a-l pozit,iona pe ecran (neavând legătură cu harta). Elementul poate fi
deplasat prin pozit,ionarea pe hartă (prin glisarea marcajului) sau prin deplasarea numai a balonului. Pictogramele
sunt parte a temei GIS, ele fiind utilizate, în mod implicit, s, i în alte teme.

Instrumentul Move Annotation vă permite să deplasat,i adnotarea pe canevasul hărt,ii.
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Figure 8.9: Dialogul de adnotare text

8.11.1 Adnotări de tip html

Html Annotation din bara de instrumente a atributelor oferă posibilitatea de plasare a cont,inutului unui fis, ier html
într-un balon, pe canevasul hărt,ii QGIS. Folosind instrumentul de Adnotare Html, facet,i clic pe canevasul hărt,ii,
s, i adăugat,i calea către fis, ierul HTML în fereastra de dialog.

8.11.2 Adnotări SVG

Adnotarea SVG din bara de instrumente a atributelor, oferă posibilitatea de plasare a unui simbol SVG într-un
balon, pe canevasul hărt,ii QGIS. Folosind instrumentul de Adnotare SVG, facet,i clic pe canevasul hărt,ii, s, i adăugat,i
calea către fis, ierul SVG în fereastra de dialog.

8.11.3 Adnotări de tip formular

În plus, putet,i crea propriile dvs. formulare de adnotare. Instrumentul Formular de Adnotare este util pentru a afis, a
atributele unui strat vectorial într-un formular personalizat în Qt Designer (a se vedea figure_custom_annotation).
Acesta este similar cu formularul proiectat pentru instrumentul Identify features, dar va fi afis, at într-un el-
ement de adnotare. Vedet,i, de asemenea, acest videoclip al lui Tim Sutton, pentru mai multe informat,ii:
https://youtu.be/0pDBuSbQ02o?t=2m25s .

Note: Dacă apăsat,i Ctrl+T, atât timp cât instrumentul Annotation este activ (deplasare adnotare, adnotare text,
formular de adnotare), starea de vizibilitate a elementelor este inversată.

8.12 Semne de Carte Spat,iale

Semnele de carte spat,iale vă permit să “marcat,i” o locat,ie geografică s, i să revenit,i la ea mai târziu. Marcajele sunt
salvate pe calculator, ceea ce înseamnă că acestea sunt disponibile din orice proiect aflat pe acelas, i computer.

8.12.1 Crearea unui Semn de Carte

Pentru a crea un semn de carte:

8.12. Semne de Carte Spat,iale 47

https://youtu.be/0pDBuSbQ02o?t=2m25s


QGIS User Guide, Release 2.14

Figure 8.10: Formulare de adnotare personalizate în qt designer

1. Deplasare sau transfocare în zona de interes.

2. Selectat,i opt,iunea de meniu View → New Bookmark sau apăsat,i Ctrl-B. Marcajul nou creat se va deschide
în panoul marcajelor spat,iale.

3. Introducet,i un nume descriptiv pentru marcaj (până la 255 de caractere).

4. Apăsat,i Enter pentru a adăuga marcajul, sau efectuat,i clic oriunde.

Ret,inet,i că putet,i avea mai multe marcaje cu acelas, i nume.

8.12.2 Lucrul cu Marcaje

Pentru a utiliza sau pentru a gestiona marcajele, selectat,i opt,iunea de meniu Vizualizare → Afis, are Marcaje.
Panoul Marcajelor Geospat,iale vă permite să:

• Transfocare pe Marcaj: selectat,i marcajul dorit făcând clic pe el, apoi pe Transfocare pe Marcaj. Putet,i
transfoca, de asemenea, la un marcaj, efectuând un dublu-clic pe el.

• S, tergerea unui Marcaj: selectat,i marcajul, apoi facet,i clic pe S, tergere Marcaj. Confirmat,i alegerea dvs.

• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks pull down menu in the Spatial Bookmarks dialog. All the bookmarks are trans-
ferred.

8.13 Imbricarea Proiectelor

Dacă dorit,i să încorporat,i cont,inutul din alte fis, iere de proiect în proiectul dumneavoastră, putet,i alege Layer →
Embed Layers and Groups.

8.13.1 Încapsularea straturilor

Urmatorul dialog vă permite să încorporat,i straturile din alte proiecte. Iată un mic exemplu:

1. Apăsat,i pentru a căuta un alt proiect din setul de date Alaska.
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2. Selectat,i fis, ierul de proiect relations.qgs. Putet,i vedea cont,inutul proiectului (v. fig-
ure_embed_dialog).

3. Apăsat,i Ctrl s, i facet,i clic pe straturile airports s, i regions. Clic pe [OK]. Straturile selectate sunt
încorporate în legendă s, i în cadrul hărt,ii.

Figure 8.11: Selectat,i straturile s, i grupurile pentru încapsulare

Atât timp cât straturile încapsulate sunt editabile, nu le putet,i schimba proprietăt,ile, cum ar fi stilul s, i etichetarea.

8.13.2 Eliminare straturi încapsulate

Facet,i clic dreapta pe stratul încorporat, apoi selectat,i Eliminare.

8.14 Decorat,iuni

Decorat,iile din QGIS includ o Grilă, Eticheta Drepturilor de Autor, Săgeata Nordului s, i Scara Grafică. Adăugarea
acestor elemente cartografice reprezintă activitatea de ‘decorare’ a hărt,ii.

8.14.1 Grilă

Grid vă permite să adăugat,i o ret,ea de coordonate s, i să coordonat,i adnotările din canevasul hărt,ii.

Figure 8.12: Dialogul Grilei

1. Selectat,i din meniul View → Decorations → Grid. Se va lansa dialogul (vedet,i figure_decorations_1).
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2. Activează caseta Enable grid s, i stabilit,i definit,ii de grile în funct,ie de straturile încărcate în canevasul
hărt,ii.

3. Activat,i caseta Draw annotations s, i stabilit,i definit,iile adnotărilor în conformitate cu straturile încărcate
în canevasul hărt,ii.

4. Clic pe [Aplicare] pentru a verifica dacă arată as, a cum at,i dorit, sau pe [OK] dacă totul este în regulă.

8.14.2 Eticheta Drepturilor de Autor

Copyright label adaugă pe hartă o etichetă a drepturilor de autor, folosind textul preferat.

Figure 8.13: Dialogul Drepturilor de Autor

1. Selectat,i din meniul View → Decorations → Copyright Label. Se va lansa dialogul (see fig-
ure_decorations_2).

2. Asigurat,i-vă că este bifată caseta Enable Copyright Label.

3. Introducet,i textul pe care dorit,i să-l plasat,i pe hartă. Putet,i folosi HTML, as, a cum se arată în exemplu.

4. Aleget,i pozit,ionarea etichetei cu ajutorul casetei combinate Pozit,ionare .

5. Putet,i rafina plasarea elementului, prin setarea pe Orizontală s, i/sau Verticală a Marginii fat,ă de Conturul
(Canevasului). Aceste valori pot reprezenta o distant,ă în Milimetri, Pixeli sau ca Procentaj din lăt,imea
sau înălt,imea canevasului hărt,ii.

6. Putet,i schimba culoarea care va fi aplicată.

7. Clic pe [Aplicare] pentru a verifica dacă arată as, a cum at,i dorit, sau pe [OK] dacă totul este în regulă.

În exemplul de mai sus, care este implicit, QGIS plasează un simbol cu drepturi de autor, urmat de dată, în colt,ul
din dreapta jos al canevasului hărt,ii.

8.14.3 Săgeata Nordului

|north_arrow| North Arrow plasează o săgeată a nordului pe canevasul hărt,ii. În prezent, există doar un singur stil
disponibil. Putet,i regla unghiul săget,ii, sau să lăsat,i aplicat,iei QGIS sarcina de determinare automată a direct,iei.
Dacă optat,i pentru QGIS, aplicat,ia va face tot posibilul pentru a presupune cel mai bun mod de orientare a săget,ii.
Pentru plasarea săget,ii avet,i patru opt,iuni, corespunzătoare celor patru colt,uri ale canevasului hărt,ii. Putet,i rafina
plasarea elementului, prin setarea pe Orizontală s, i/sau Verticală a Marginii fat,ă de Conturul (Canevasului). Aceste
valori pot reprezenta o distant,ă în Milimetri, Pixeli sau ca Procentaj din lăt,imea sau înălt,imea canevasului hărt,ii.
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Figure 8.14: Dialogul Săget,ii Nordului

8.14.4 Scara Grafică

Scale Bar adaugă o simplă scară grafică în canevasul hărt,ii. Putet,i controla stilul s, i pozit,ionarea, precum s, i
etichetarea bării.

Figure 8.15: Dialogul Scării Grafice

QGIS acceptă afis, area scării numai în aceleas, i unităt,i ca s, i cadrul hărt,ii. Deci, în cazul în care unităt,ile straturilor
dvs. sunt în metri, nu vet,i putea crea o scară în picioare. În mod similar, dacă utilizat,i grade zecimale, nu putet,i
crea o scară care să afis, eze distant,a în metri.

Pentru a adăuga o scară grafică:

1. Selectat,i meniul View → Decorations → Scale Bar. Fereastra de dialog se lansează (vedet,i fig-
ure_decorations_4).

2. Asigurat,i-vă că este bifată caseta Enable scale bar.

3. Aleget,i stilul din caseta Scale bar style .

4. Selectat,i culoarea barei Color of bar sau folosit,i culoarea neagră, implicită.

5. Setat,i Dimensiunea barei .

6. Opt,ional, bifat,i Rotunjire numerică automată, în urma redimensionării pentru a afis, a valori us, or de citit.

7. Aleget,i pozit,ionarea din caseta combinată Placement .

8. Putet,i rafina plasarea elementului, prin setarea pe Orizontală s, i/sau Verticală a Marginii fat,ă de Conturul
(Canevasului). Aceste valori pot reprezenta o distant,ă în Milimetri, Pixeli sau ca Procentaj din lăt,imea
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sau înălt,imea canevasului hărt,ii.

9. Clic pe [Aplicare] pentru a verifica dacă arată as, a cum at,i dorit, sau pe [OK] dacă totul este în regulă.

Tip: Setările Decorat,iunilor
Când salvat,i un proiect .qgs, orice modificări pe care le-at,i adus Grilei, Săget,ii Nordului, Scării Grafice s, i
drepturilor de autor, vor fi salvate în cadrul proiectului s, i vor fi restaurate data viitoare când încărcat,i proiectul.

8.15 Autentificarea

QGIS has facility to store/retrieve authentication credentials in a secure manner. Users can securely save cre-
dentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and safely referenced by their ID tokens in project or settings files. For more information
see Sistem de Autentificare.

A master password needs to be set up when initializing the authentication system and its portable database.

8.16 Salvarea stratului într-un fis, ier

Layers (raster or vector) can be saved in another format with the Save As... feature in the layer contextual menu
(by right-clicking in the layer in the layer tree) or in the Layer → Save As... menu.

The Save As dialog shows several parameters to change the behaviour when saving the layer. Common parameters
(raster and vector) are:

• Format

• Nume de fis, ier

• CRS

• Add save file to map to add the new layer to the canvas

• Extent (possible values are layer, Map view or custom extent)

• Create (for raster), Layer or Custom (for vector) Options which allow you to change some advanced options.
Advanced user can see the driver documentation in gdal-ogr documentation.

Totus, i, unii parametri sunt specifici formatelor raster s, i vector:

• Parametrii specifici rasterelor:

– Rezoluţiea (orizontală s, i verticală)

– Crearea piramidei

– Modul de ies, ire (date brute sau imagine randată)

• Parametrii specifici vectorilor:

– Codificare

– Salvare doar a entităt,ilor selectate

– Trecere peste crearea de atribute

– Symbology export: can be used mainly for DXF export and for all file formats who manage OGR
feature styles (see note below) as DXF, KML, tab file formats:

* No symbology: default style of the application that reads the data

* Feature symbology: save style with OGR Feature Styles (see note below)

* Symbol Layer symbology: save with OGR Feature Styles (see note below) but export the same
geometry multiple times if there are multiple symbology symbol layers used
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– Geometrie:

* se fort,ează utilizarea multi-geometriilor,

* adaugă dimensiunea z,

* add or remove a geometry column with the drop-down list. This is not linked with the current
geometry type of the layer. You can add an empty geometry column to an attribute table, remove
the geometry column of a spatial layer.

Note: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some format
can handle this kind of information. KML, DXF and TAB files format are such format. For advanced user, you
can read the OGR Feature Styles specification document.

Note: Despre fişierele DXF
Vector layers can be exported to DXF files using another tool, the DXF Export ... in Project. The windows allow
the user to choose the layer file, the symbology mode (see the note above), the symbology scale, the encoding, the
visibility preset and the layers to include in the DXF file.

As an option, you can Use the layer title as name if set or Export features intersecting the current map extent.

8.17 Use of variables for dynamic content

Putet,i defini variabile personalizate pentru utilizarea în expresii. Variabilele pot fi definite la nivelul global al
aplicat,iei, la nivel de proiect, la nivelul stratului s, i la nivelul compozit,iei. Similar regulilor CSS, variabilele pot fi
suprascrise - de exemplu, o variabilă la nivel de proiect va rescrie orice variabilă setată la nivel de aplicat,ie. Putet,i
folosi aceste variabile pentru a construi s, iruri de text sau alte expresii personalizate folosind caracterul @ înainte
de numele variabilei. De exemplu, crearea, în compozitor, a unei etichete cu acest cont,inut:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Va produce o etichetă care arată în felul următor:

This map was made using QGIS 2.14. The project file for this map is:
/gis/qgis-user-conference-2015.qgs

You can manage global variables from the Settings → Options menu, and project level variables from Project
properties (including adding your own custom variables).

Note: you can read more information and find examples here Exploring variables in QGIS 2.12, part 1, part 2
and part 3.
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Figure 8.16: Editarea variabilei la nivel de proiect
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CHAPTER 9

QGIS Configuration

QGIS is highly configurable through the Settings menu. Choose between Project Properties, Options and Cus-
tomization.

Note: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described below could be in the Project or the Settings
menu.

9.1 Proprietăţi Proiect

In the properties window for the project under Settings → Project Properties (kde) or Project →
Project Properties (Gnome, OS X or Windows), you can set project-specific options.

• In the General menu, the general settings let you:

– give a title to the project beside the project file path

– choose the color to use for features when they are selected

– choose the background color: the color to use for the map canvas

– set whether the path to layers in the project should be saved as absolute (full) or as relative to the
project file location. You may prefer relative path when both layers and project files can be moved or
shared or if the project is accessed from computers on different platforms.

– choose to avoid artifacts when project is rendered as map tiles. Note that checking this option can lead
to performance degradation.

Calculating areas and distances is a common need in GIS. However, these values are really tied to the
underlying projection settings. The Measurements frame lets you control these parameters. You can indeed
choose:

– the ellipsoid to use: it can be an existing one, a custom one (you’ll need to set values of the semi-major
and semi-minor axis) or None/Planimetric.

– the units for distance measurements for length and perimeter and the units for area measurements.
These settings, which default to the units set in QGIS options but then overrides it for the current
project, are used in:

* Bara de actualizare a câmpului din tabela de atribute

* Operat,iunile din calculatorul de câmpuri

* Identify tool derived length, perimeter and area values

* Unitatea implicită se afis, ează în dialogul de măsurare
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The Coordinate display allows you to choose and customize the format of units to use to display the mouse
coordinate in the status bar and the derived coordinates shown via the identify tool.

Finally, you can define a project scale list, which overrides the global predefined scales.

Figure 9.1: Fila Generalităt,ilor din fereastra cu Proprietăt,ile Proiectului

• The CRS menu enables you to choose the Coordinate Reference System for this project, and to enable
on-the-fly re-projection of raster and vector layers when displaying layers from a different CRS.

• With the Identify layers menu, you set (or disable) which layers will respond to the identify tool. By default,
layers are set queryable.

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colors assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to define information about the QGIS Server WMS and WFS capabilities,
extent and CRS restrictions.

• The Macros menu is used to edit Python macros for projects. Currently, only three macros are available:
openProject(), saveProject() and closeProject().

• Meniul Relat,iilor este folosit pentru a defini relat,iile 1:n. Relat,iile sunt definite în fereastra proprietăt,ilor
proiectului. O dată ce există relat,ii pentru un strat, un nou element de interfat,ă cu utilizatorul, de tip formular
(de exemplu, atunci când se identifică o entitate s, i se deschide formularul acesteia) va lista entităt,ile aferente.
Acest lucru oferă o modalitate puternică de a exprima, de exemplu, istoria inspect,iilor de-a lungul unei
conducte sau a unui segment de drum. Putet,i afla mai multe despre suportul pentru relat,iile 1:n în Sect,iunea
Crearea relat,iilor one to many.
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Figure 9.2: Setările macro din QGIS

9.2 Opţiuni

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can customize your options are described below.

9.2.1 Meniu General

Aplicat,ie

• Select the Style (QGIS restart required) and choose between ‘Oxygen’,’Windows’,’Motif’,’CDE’,
‘Plastique’ and ‘Cleanlooks’ ( ).

• Defines, te Tema pictogramei . În prezent, este posibilă doar valoarea ‘default’.

• Defines, te Dimensiunea pictogramei .

• Define the Font. Choose between Qt default and a user-defined font.

• Schimbă Durata mesajelor temporizate sau a dialogurilor .

• Ascundere fereastră de întâmpinare

• Afis, ează sfaturi la pornire

• Titluri îngros, ate pentru casetele grupurilor

• Stilizare QGIS pentru casetele grupurilor

• Se foloses, te fereastra nativă de alegere a culorii

• Se foloses, te fereastra interactivă de alegere a culorii

• Custom side bar style

• Suport experimental de rotat,ie a canevasului (este necesar restartul)

Fis, ierele proiectului
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• Open project on launch (choose between ‘New’, ‘Most recent’ and ‘Specific’). When choosing

‘Specific’ use the to define a project.

• Create new project from default project. You have the possibility to press on Set current project as
default or on Reset default. You can browse through your files and define a directory where you find your
user-defined project templates. This will be added to Project → New From Template. If you first activate

Create new project from default project and then save a project in the project templates folder.

• :guilabel:‘Se solicită salvarea modifcărilor din proiect s, i din sursa de date, atunci când este necesar

• Se solicită confirmarea atunci când un strat va fi eliminat

• Avertizare la deschiderea unui fis, ier de proiect salvat cu o versiune de QGIS mai veche

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.2.2 Meniul Sistemului

Mediu

Variabilele de mediu ale sistemului pot fi acum vizualizate, iar multe dintre ele pot fi configurate în grupul Envi-
ronment (v. figure_environment_variables). Acest lucru este util pentru platforme, cum ar fi Mac, unde interfat,a
unei aplicat,ii nu mos, tenes, te în mod obligatoriu variabilele de mediu ale utilizatorului. De asemenea, este util s, i
la stabilirea/vizualizarea variabilelor de mediu pentru seturile de instrumente externe, controlate de instrumentele
Processing (ex.: SAGA, GRASS), s, i pentru a depana ies, irile provenite din anumite sect,iuni ale codului sursă.

• Use custom variables (restart required - include separators). You can [Add] and [Remove] variables.
Already-defined environment variables are displayed in Current environment variables, and it’s possible to

filter them by activating Show only QGIS-specific variables.

Căile plugin-urilor

[Adăugat,i] sau [Eliminat,i] :Căil(e) către bibliotecile suplimentare cu plugin-uri C++‘

9.2.3 Meniul Surselor de Date

Atributele şi tabela entităt,ii

• Deschidere tabelă de atribute într-o fereastră detas, abilă (este necesară restartarea QGIS)

• Copy geometry in WKT representation from attribute table. When using Copy selected rows to clipboard

from the Attribute table dialog, this has the result that the coordinates of points or vertices are also copied
to the clipboard.

• Attribute table behavior . There are three possibilities: ‘Show all features’, ‘Show selected features’
and ‘Show features visible on map’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Representation for NULL values. Here, you can define a value for data fields containing a NULL value.

Gestiunea surselor de date

• Scanează elementele valide din navigator . Se poate alege ‘Verificare extensie’ sau ‘Verificare
cont,inut fis, ier’.
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Figure 9.3: Variabilele de mediu ale sistemului din QGIS
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• Scanează cont,inutul fis, ierelor compresate (.zip) din fereastra navigatorului . Sunt posibile ‘Nu’,
‘Scanare de bază’ s, i ‘Scanare completă’.

• Prompt for raster sublayers when opening. Some rasters support sublayers — they are called subdatasets
in GDAL. An example is netCDF files — if there are many netCDF variables, GDAL sees every variable
as a subdataset. The option allows you to control how to deal with sublayers when a file with sublayers is
opened. You have the following choices:

– ‘Always’: Always ask (if there are existing sublayers)

– ‘If needed’: Ask if layer has no bands, but has sublayers

– ‘Never’: Never prompt, will not load anything

– ‘Load all’: Never prompt, but load all sublayers

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Adăugare straturi PostGIS printr-un dublu clic s, i selectarea modului extins

• Adăugare straturi Oracle printr-un dublu clic s, i selectarea modului extins

• Execută expresiile pe server, dacă este posibil

• create transaction groups automatically whenever possible (Experimental). When this mode is turned
on, all (postgres) layers from the same database are synchronised in their edit state, i.e. when one layer is
put into edit state, all are, when one layer is committed or one layer is rolled back, so are the others. Also,
instead of buffering edit changes locally, they are directly sent to a transaction in the database which gets
committed when the user clicks save layer.

Calea Ascunsă fat, ă de Navigator

Acest control grafic listează toate folderul pe care at,i decis să-l ascundet,i de panoul Navigatorului. Eliminarea
unui dosar din listă îl va face disponibil în panoul Navigatorului.

9.2.4 Meniul de Randare

Comportamentul randării

• În mod implicit, noile straturi adăugate hărt,ii ar trebui să fie afis, ate

• Se foloses, te memoria tampon, acolo unde este posibil, pentru a se accelera redesenarea

• Straturile se randează în paralel, utilizând mai multe nuclee CPU

• Max nuclee de utilizat

• Intervalul de reactualizare a hărt,ii (implicit 250 ms)

• Activează simplificarea implicită a entităt,ilor, pentru straturile nou adăugate

• Pragul de Simplificare

• Simplificarea are loc la furnizor, dacă este posibil

• Scara maximă la care stratul ar trebui să fie simplificat

Calitatea randării

• Liniile vor apărea mai put,in zimt,ate, cu pret,ul unei pierderi de performant,ă la desenare

Rastere

• With RGB band selection, you can define the number for the Red, Green and Blue band.
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Îmbunătăţirea contrastului

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limitele reducerii numărului cumulat de pixeli

• Multiplicator pentru Abaterea Standard

Depanare

• Actualizează canevasul hărt,ii

9.2.5 Meniul Culorilor

This menu allows you to add some custom color that you can find in each color dialog window of the renderers.
You will see a set of predefined colors in the tab: you can delete or edit all of them. Moreover you can add the
color you want and perform some copy and paste operations. Finally you can export the color set as a gpl file or
import them.

9.2.6 Meniul Canevasului s, i Legendei

Aspectul implicit al hărt,ii (suprascris de proprietăt,ile proiectului)

• Definirea Select,iei culorii s, i a Culorii Fundalului.

Legenda stratului

• Double click action in legend . You can either ‘Open layer properties’ or ‘Open attribute table’ with
the double click.

• Sunt posibile următoarele Stiluri pentru elementul de tip legendă:

– Capitalizarea Numelor Straturilor

– Nume de straturi îngros, ate

– Nume de grupuri îngros, ate

– Afis, ează numele atributului de clasificare

– Creează pictogramele rasterului (poate dura mult)

9.2.7 Meniul Instrumentelor pentru Hartă

Acest meniu oferă unele opt,iuni referitoare la comportamentul Instrumentului de identificare.

• Search radius for identifying and displaying map tips is a tolerance factor expressed as a percentage of the
map width. This means the identify tool will depict results as long as you click within this tolerance.

• Evident,ierea culorii permite alegerea culorii pe care ar trebui să o aibă o entitate atunci când este evident,iată.

• Buffer determines a buffer distance to be rendered from the outline of the identify highlight.
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• Minimum width determines how thick should the outline of a highlighted object be.

Instrumentul de măsură

• Defines, te Culoarea benzii elastice a instrumentelor de măsurare

• Definire Număr de zecimale

• Keep base unit to not automatically convert large numbers (e.g., meters to kilometers)

• Preferred distance units (‘Meters’, ‘Feet’, ‘Nautical Miles’, ‘Degrees’ or ‘Map Units’ )

• Preferred area units (‘Square meters’, ‘Square feet’, ‘Square yards’, ‘Hectares’, ‘Map Units’ ...)

• Preferred angle units (‘Degrees’, ‘Radians’, ‘Gon/gradians’, ‘Minutes of arc’ ...)

Deplasare s, i transfocare

• Define Mouse wheel action (‘Zoom’, ‘Zoom and recenter’, ‘Zoom to mouse cursor’, ‘Nothing’)

• Definire Factor de mărire pentru rotit,a mouse-ului

Scări predefinite

Here, you find a list of predefined scales. With the and buttons you can add or remove your personal
scales. You can also import or export scales from/to a .XML file. Note that you still have the possibility to remove
your changes and reset to the predefined list.

9.2.8 Meniul Compozitorului

Valori implicite pentru compozit,ie

You can define the Default font here.

Aspectul grilei

• Definit,i Stilul grilei (‘Solid’, ‘Puncte’, ‘Cruciulit,e’)

• Definit,i Culoarea grilei

Grilă s, i de ghidaje implicite

• Definit,i Spat,ierea grilei .

• Definit,i Decalajul grilei pentru x s, i y

• Definit,i Tolerant,a acros, ării .

9.2.9 Meniul de Digitizare

Creare entitate

• Suprimă ferestrele pop-up cu atribute, după fiecare caracteristică creată

• Se reutilizează ultimele valori introduse ale atributelor

• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Bandă elastică

• Defines, te Lăt,imea liniei s, i Culoarea liniei pentru Banda Elastică

Acros, are
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• Deschidere opt,iuni de acros, are într-o fereastră detas, abilă (este necesară restartarea QGIS)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Defines, te Tolerant,a de acros, are implicită, în unităt,i de hartă sau în pixeli

• Defines, te Raza de căutare pentru editarea vertecs, ilor, în unităt,i de hartă sau în pixeli

Simbolurile vertexului

• Arată simbolurile numai pentru entităt,ile selectate

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

• Defines, te Dimensiunea simbolului pentru vertex

Instrument pentru curba de decalare

The next 3 options refer to the Offset Curve tool in Digitizare avansată. Through the various settings, it is possible
to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Îmbinare stiluri

• Segmentele cvadrantului

• Miter limit

9.2.10 Meniul GDAL

GDAL is a data exchange library for raster files. In this tab, you can Edit create options and Edit Pyramids Options
of the raster formats. Define which GDAL driver is to be used for a raster format, as in some cases more than one
GDAL driver is available.

9.2.11 Meniul CRS-ului

CRS-ul implicit pentru noile proiecte

• Nu permite activarea ‘din zbor’ a reproiectării

• Activează reproiectarea automată ‘din zbor’, atunci când straturile au CRS-uri diferite.

• În mod implicit, activează reproiectarea ‘din zbor’

• Select a CRS and Noile proiecte vor începe întotdeauna cu acest CRS

CRS-ul pentru noile straturi

This area allows you to define the action to take when a new layer is created, or when a layer without a CRS is
loaded.

• Se cere CRS-ul

• Utilizează CRS-ul proiectului

• Utilizează CRS-ul implicit

Transformări de datum implicite

• Cerere de transformare a datum-ului, atunci când nu este definit unul implicit

• If you have worked with the ‘on-the-fly’ CRS transformation you can see the result of the transformation in
the window below. You can find information about ‘Source CRS’ and ‘Destination CRS’ as well as ‘Source
datum transform’ and ‘Destination datum transform’.

9.2. Opţiuni 63



QGIS User Guide, Release 2.14

9.2.12 Meniul Limbii

• Suprascrie limba sistemului s, i Limba care se va folosi în locul acesteia

• Informaţii despre limba sistemului activ

9.2.13 Autentificare

In the Authentication tab you can set authentication configurations and manage PKI certificates. See Sistem de
Autentificare for more details.

9.2.14 Meniul Reţelei

Generalităt,i

• Definit,i Adresa de căutare WMS ca fiind, în mod implicit, http://geopole.org/wms/search?search=\%1\&type=rss

• Definire Timpul de as, teptare pentru cererile de ret,ea (ms) - implicit este 60000

• Definire Perioada de expirare prestabilită pentru plăcut,ele WMS-C/WMTS (ore) - implicit este 24

• Define Maximum de încercări, în cazul erorilor de obt,inere a plăcut,ei

• Definire User-Agent

Setările memoriei tampon

Definirea Directorului s, i a unei Dimensiuni pentru memoria tampon.

• Se foloses, te proxy pentru accesul web s, i se definesc ‘Gazda’, ‘Portul’, ‘Utilizatorul’, and ‘Parola’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy is determined based on the application proxy set using

– Socks5Proxy: Generic proxy for any kind of connection. Supports TCP, UDP, binding to a port (in-
coming connections) and authentication.

– HttpProxy: Implemented using the “CONNECT” command, supports only outgoing TCP connections;
supports authentication.

– HttpCachingProxy: Implemented using normal HTTP commands, it is useful only in the context of
HTTP requests.

– FtpCachingProxy: Implemented using an FTP proxy, it is useful only in the context of FTP requests.

Excluding some URLs can be added to the text box below the proxy settings (see Figure_Network_Tab).

If you need more detailed information about the different proxy settings, please refer to the manual of the under-
lying QT library documentation at http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Tip: Folosirea Proxi-urilor
Using proxies can sometimes be tricky. It is useful to proceed by ‘trial and error’ with the above proxy types, to
check to see if they succeed in your case.

Putet,i modifica opt,iunile în funct,ie de necesităt,i. Pentru a se activa, unele dintre schimbări pot necesita o repornire
a QGIS.

• Setările sunt salvate într-un fis, ier text: $HOME/.config/QGIS/QGIS2.conf

• Putet,i găsi setările în: $HOME/Library/Preferences/org.qgis.qgis.plist

• Setările sunt stocate în registru sub: HKEY\CURRENT_USER\Software\QGIS\qgis
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Figure 9.4: Setările proxy din QGIS
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9.3 Personalizare

The customization dialog lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you want to provide your end-users with a ‘light’ version of QGIS, containing only the icons, menus or
panels they need.

Note: Pentru aplicarea modificărilor, trebuie să repornit,i QGIS.

Figure 9.5: Dialogul de Personalizare

Ticking the Enable customization checkbox is the first step on the way to QGIS customization. This enables
the toolbar and the widget panel from which you can uncheck and thus disable some GUI items.

Elementul configurabil poate fi:

• a Menu or some of its sub-menus from the Bara de Meniuri

• un întreg Panou (see Panouri s, i Bare de Instrumente)

• the Status bar described in Bara de Stare or some of its items

• a Toolbar: the whole bar or some of its icons

• or any widget from any dialog in QGIS: label, button, combobox...

With Switch to catching widgets in main application, you can click on an item in QGIS interface that you want to be hidden
and QGIS automatically unchecks the corresponding entry in the Customization dialog.

Once you setup your configuration, click [Apply] or [Ok] to validate your changes. This configuration becomes
the one used by default by QGIS at the next startup.

The modifications can also be saved in a .ini file using Save To File button. This is a handy way to share a

common QGIS interface among multiple users. Just click on Load from File from the destination computer in
order to import the .ini file. You can also run command line tools and save various setups for different use cases
as well.

Tip: Restaurează cu us, urint, ă setările QGIS predefinite
The initial QGIS GUI configuration can be restored by one of the methods below:

• unchecking Enable customization option in the Customization dialog or click the Check All button

• pressing the [Reset] button in the QSettings frame under Settings → Options menu, System tab

• launching QGIS at a command prompt with the following command line qgis --nocustomization

• setting to false the value of UI → Customization → Enabled variable under Settings → Options menu,
Advanced tab.
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In most cases, you need to restart QGIS in order to have the change applied.
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CHAPTER 10

Lucrul cu Proiect,ii

QGIS permite utilizatorilor să definească un CRS (sistem de coordonate de referint,ă) global s, i la nivel de proiect,
pentru straturi fără un CRS predefinit. De asemenea, permite utilizatorului să definească sisteme de coordonate
de referint,ă personalizate s, i acceptă proiect,ia din-zbor (OTF) a straturilor vectoriale s, i raster. Toate aceste entităt,i
permit utilizatorului să afis, eze straturi cu CRS-uri diferite s, i să le suprapună în mod corespunzător.

10.1 Privire de ansamblu asupra Suportului Proiect,iei

QGIS has support for approximately 2,700 known CRSs. Definitions for each CRS are stored in a SQLite database
that is installed with QGIS. Normally, you do not need to manipulate the database directly. In fact, doing so may
cause projection support to fail. Custom CRSs are stored in a user database. See section Sistem Personalizat de
Coordonate de Referint,ă for information on managing your custom coordinate reference systems.

The CRSs available in QGIS are based on those defined by the European Petroleum Search Group (EPSG) and
the Institut Geographique National de France (IGNF) and are largely abstracted from the spatial reference tables
used in GDAL. EPSG identifiers are present in the database and can be used to specify a CRS in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project
Properties dialog under the Project (Gnome, OS X) or Settings (KDE, Windows) menu.

10.2 Specificat,ii Globale de Proiect,ie

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This
default can be changed via the [Select...] button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_1. This choice will be saved for use in subsequent
QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

Opt,iunile prezentate în figure_projection_1 sunt:

• Se cere CRS-ul

• Utilizează CRS-ul proiectului
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Figure 10.1: Fila CRS din Dialogul Opt,iunilor QGIS

• Utilizează CRS-ul implicit, afis, at mai jos

If you want to define the coordinate reference system for a certain layer without CRS information, you can also
do that in the General tab of the raster and vector properties dialog (see Meniu General for rasters and Meniu
General for vectors). If your layer already has a CRS defined, it will be displayed as shown in Meniul general din
fereastra de proprietăt,i a stratului vectorial.

Tip: CRS-ul din Legenda Hărt,ii
Right-clicking on a layer in the Map Legend (section Panoul Straturilor) provides two CRS shortcuts. Set layer
CRS takes you directly to the Coordinate Reference System Selector dialog (see figure_projection_2). Set project
CRS from Layer redefines the project CRS using the layer’s CRS.

10.3 Definirea Din Zbor (OTF) a Reproiectării

QGIS supports OTF reprojection for both raster and vector data. However, OTF is not activated by default. To use

OTF projection, you must activate the Enable on the fly CRS transformation checkbox in the CRS tab of the

Project Properties dialog.

Există trei căi de a face asta:

1. Selectat,i Proprietăt,ile Proiectului din Proiect (Gnome, OSX) sau din meniul Setări (KDE, Windows).

2. Clic pe pictograma CRS status, din colt,ul din dreapta-jos al barei de stare.
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3. Turn OTF on by default in the CRS tab of the Options dialog by selecting Enable ‘on the fly’ reprojection
by default or Automatically enable ‘on the fly’ reprojection if layers have different CRS.

If you have already loaded a layer and you want to enable OTF projection, the best practice is to open the CRS

tab of the Project Properties dialog, select a CRS, and activate the Enable ‘on the fly’ CRS transformation

checkbox. The CRS status icon will no longer be greyed out, and all layers will be OTF projected to the CRS
shown next to the icon.

Figure 10.2: Dialogul Proprietăt,ilor de Proiect,ie

The CRS tab of the Project Properties dialog contains five important components, as shown in Figure_projection_2
and described below:

1. Enable ‘on the fly’ CRS transformation — This checkbox is used to enable or disable OTF projection.
When off, each layer is drawn using the coordinates as read from the data source, and the components de-
scribed below are inactive. When on, the coordinates in each layer are projected to the coordinate reference
system defined for the map canvas.

2. Filter — If you know the EPSG code, the identifier, or the name for a coordinate reference system, you can
use the search feature to find it. Enter the EPSG code, the identifier or the name.

3. Recently used coordinate reference systems — If you have certain CRSs that you frequently use in your
everyday GIS work, these will be displayed in this list. Click on one of these items to select the associated
CRS.

4. Sisteme de coordonate de referint, ă ale lumii — Aceasta este o listă a tuturor CRS-urilor acceptate de
QGIS, inclusiv sistemele de coordonate de referint,ă Geografice, Proiectate s, i Personalizate. Pentru a defini
un CRS, alegându-l din listă, prin extinderea nodului corespunzător, s, i prin selectarea CRS-ului. CRS-ul
activ este preselectat.

5. PROJ.4 text — This is the CRS string used by the PROJ.4 projection engine. This text is read-only and
provided for informational purposes.

Tip: Dialogul cu Proprietăţile Proiectului
If you open the Project Properties dialog from the Project menu, you must click on the CRS tab to view the CRS
settings.
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Deschiderea ferestrei de dialog, apăsând pe pictograma CRS status va aduce automat fila CRS în prim-plan.

10.4 Sistem Personalizat de Coordonate de Referint,ă

If QGIS does not provide the coordinate reference system you need, you can define a custom CRS. To define a

CRS, select Custom CRS... from the Settings menu. Custom CRSs are stored in your QGIS user database. In
addition to your custom CRSs, this database also contains your spatial bookmarks and other custom data.

Figure 10.3: Dialogul CRS-urilor Personalizate

Defining a custom CRS in QGIS requires a good understanding of the PROJ.4 projection library. To begin, refer to
“Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

Acest manual descrie utilizarea proj.4 s, i a utilitarelor aferente, pentru linia de comandă. Parametrii cartografici
utilizat,i cu proj.4 sunt descris, i în manualul de utilizare, fiind identici cu cei utilizat,i de QGIS.

P entru a defini un utilizator CRS, dialogul de Definire a Sistemului de Coordonate de Referint,ă necesită doar doi
parametri:

1. Un nume descriptiv

2. Parametrii cartografici în format PROJ.4
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Pentru a crea un nou CRS, facet,i clic pe butonul Adăugare CRS nou, apoi introducet,i un nume descriptiv s, i
parametrii CRS.

Notat,i că Parametrii trebuie să înceapă cu un bloc +proj=, pentru a reprezenta noul sistem de coordonate.

You can test your CRS parameters to see if they give sane results. To do this, enter known WGS 84 latitude and
longitude values in North and East fields, respectively. Click on [Calculate], and compare the results with the
known values in your coordinate reference system.

10.5 Transformări de datum implicite

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

În fila CRS de sub Setări → Opt,iuni putet,i:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• editarea unei liste de transformări de datum implicite.

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.
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CHAPTER 11

Navigatorul QGIS

• Controlul grafic al Navigatorului QGIS
• Navigatorul QGIS ca aplicat,ie desktop

QGIS Browser is available as a standalone application and as a panel in QGIS Desktop. It lets you easily navigate
in your filesystem and manage geodata. You can have access to common vector files (e.g., ESRI shapefiles
or MapInfo files), databases (e.g., PostGIS, Oracle, SpatiaLite or MS SQL Spatial) and OWS/WCS|WMS|WFS
connections. You can also view your GRASS data (to get the data into QGIS, see Integrarea GRASS GIS).

11.1 Controlul grafic al Navigatorului QGIS

To activate QGIS Browser, right-click on QGIS toolbar and check Browser Panel or select it from View →
Panels or Settings → Panels (kde). In the Browser panel, you can now browse in your filesystem, databases and
web services and get your data into the map view with a simple drag-and-drop or double-click.

You can also open a QGIS project directly from the Browser panel by double-clicking its name or by drag-and-
drop into the map view.

În partea de sus a panoului, vet,i găsi câteva pictograme care vă pot ajuta:

• Add Selected Layers. You can also add data into the map view by selecting Add Layer or Add selected
layers in the context menu.

• Actualizează arborele navigatorului

• search for specific data. Enter a search word or wildcard and the browser will filter the tree to only
show paths to matching DB tables, filenames or folders – other data or folders won’t be displayed. See the
Browser Panel(2) example on the figure_browser_panels. The comparison can be case-sensitive or not. It
can also be set to:

– normal: return any item containing the search text

– using wildcard(s): fine tune the search using ? and/or * characters to specify the position of the search
text

– utilizând o expresie regulată

• Restrânge întregul arbore

• Enable and disable properties widget. When toggled on, a new widget is added at the bottom of the
panel showing, if applicable, metadatas of the selected item

Right-click an item in the browser tree helps you to:
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• in case of file or table, display its metadata or open it in your project. Tables can even be renamed, deleted
or truncated

• in case of folder, bookmark it into your favourites, hide it from the browser tree. Hidden folders can be
managed from the Settings → Options → Data Sources tab

• actualizare, redenumire s, i s, tergere schemă.

De asemenea, putet,i importa fis, ierele în baze de date, sau să copiat,i tabelele dintr-o schemă/bază de date într-alta,
printr-o simplă glisare. Pentru a evita defilarea îndelungată pe durata glisării, este disponibil un al doilea panou în
navigator. Este suficient să selectat,i fis, ierul s, i să-l glisat,i de la un panou la altul.

Figure 11.1: Panourile Navigatorului QGIS unul lângă altul

11.2 Navigatorul QGIS ca aplicat,ie desktop

It’s also possible to run the QGIS Browser as a standalone application. Like the Browser panel, the standalone
Browser helps you navigate through your filesystem and manage your geodata. It also helps you preview or create
them and open them in a QGIS project by drag-and-drop.

Startat,i navigatorul QGIS

• Introducet,i “qbrowser” în linia de comandă.

• Startat,i Navigatorul QGIS folosind meniul Start sau scurtăturile de pe desktop.

• Navigatorul QGIS este disponibil din folderul Aplicat,iilor dvs.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the standalone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see vectormetadatamenu). With the Preview tab, you
can have a look at your files without importing them into your QGIS project. It’s also possible to preview the
attributes of your files in the Attributes tab.
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Figure 11.2: Navigatorul QGIS ca aplicat,ie desktop
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CHAPTER 12

Lucrul cu Datele Vectoriale

12.1 Formatele de Date Acceptate

QGIS uses the OGR library to read and write vector data formats, including ESRI shapefiles, MapInfo and Mi-
croStation file formats, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial and MSSQL Spatial databases, and
many more. GRASS vector and PostgreSQL support is supplied by native QGIS data provider plugins. Vector
data can also be loaded in read mode from zip and gzip archives into QGIS. As of the date of this document, 69
vector formats are supported by the OGR library (see OGR-SOFTWARE-SUITE in Literatură s, i Referint,e Web).
The complete list is available at http://www.gdal.org/ogr/ogr_formats.html.

Note: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL/OGR installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
vector into QGIS. Other untested formats can be loaded by selecting *.*.

Lucrul cu datele vectoriale GRASS este descris în Sect,iunea Integrarea GRASS GIS.

This section describes how to work with several common formats: ESRI shapefiles, PostGIS layers, SpatiaLite
layers, OpenStreetMap vectors, and Comma Separated data (CSV). Many of the features available in QGIS work
the same, regardless of the vector data source. This is by design, and it includes the identify, select, labelling and
attributes functions.

Note: QGIS supports (multi)point, (multi)line, (multi)polygon, CircularString, CompoundCurve, CurvePolygon,
MultiCurve, MultiSurface feature types, all with Z and/or M values.

You should note also that some driver doesn’t support some of these feature types like CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface feature type. QGIS will convert them to (multi)polygon feature.

12.1.1 Loading a layer from a file

To load a layer from a file (like a Shapefile, a Mapinfo or a dxf layer), click on the Add Vector Layer toolbar
button; or type Ctrl+Shift+V. This will bring up a new window (see figure_vector_1).

From the available options check File. Click on [Browse]. That will bring up a standard open file dialog (see
figure_vector_2), which allows you to navigate the file system and load a shapefile or other supported data source.

The selection box Filter allows you to preselect some OGR-supported file formats.

You can also select the encoding for the file if desired.

Selectând un fis, ier shape din listă s, i făcând clic pe [Open], acesta se va încărca în QGIS. Figure_vector_3 prezintă
QGIS după încărcarea fis, ierului alaska.shp.

Tip: Culorile Stratului
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Figure 12.1: Add Vector Layer Dialog

Figure 12.2: Open an OGR Supported Vector Layer Dialog
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Figure 12.3: QGIS with Shapefile of Alaska loaded

Când adăugat,i un strat de hartă, acestuia i se atribuie o culoare aleatorie. La adăugarea mai multor straturi,
fiecăruia i se atribuie culori diferite.

Once a file is loaded, you can zoom around it using the map navigation tools. To change the style of a layer, open
the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the legend
and choosing Properties from the context menu. See section Meniul Stilului for more information on setting
symbology of vector layers.

Tip: Încărcat,i stratul s, i proiectul din unităt,ile externe, montate pe OS X
On OS X, portable drives that are mounted beside the primary hard drive do not show up as expected under File
→ Open Project. We are working on a more OSX-native open/save dialog to fix this. As a workaround, you can
type /Volumes in the File name box and press Enter. Then you can navigate to external drives and network
mounts.

Note: DXF files containing several geometry types (point, line and/or polygon), the name of the layer will be
made from <filename.dxf> entities <geometry type>.

Note: You can also drag and drop the file(s) into the Layers Panel from either the files browser or the QGIS
Browser panel. If the layer contains several geometry types, a new windows will ask you to select the sublayer.
This often occurs with GPX, Mapinfo or DXF files format.

Loading specific directory based layer

To load some specific format like ArcInfo Binary Coverage, UK. National Transfer Format, as well as the raw
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TIGER format of the US Census Bureau or OpenfileGDB, click on the Add Vector Layer toolbar button or press
Ctrl+Shift+V to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type

filter Files of type to the format you want to open, for example ‘Arc/Info Binary Coverage’. Navigate to the
directory that contains the coverage file or the file, and select it.

Fis, ierele shape ESRI

The ESRI shapefile is still one of the most used vector file format in QGIS. However, this file format has some
limitation that some other file format have not (like Geopackage, spatialite). Support is provided by the OGR
Simple Feature Library (http://www.gdal.org/ogr/).

Un shapefile constă de fapt din mai multe fis, iere. Următoarele trei sunt necesare:

1. fis, ierul .shp care cont,ine geometriile entităt,ii

2. fis, ierul .dbf care cont,ine atributele în format dBase

3. fis, ierul index .shx

Shapefiles also can include a file with a .prj suffix, which contains the projection information. While it is very
useful to have a projection file, it is not mandatory. A shapefile dataset can contain additional files. For further
details, see the ESRI technical specification at http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Îmbunătăt,irea Performant,ei Fis, ierelor Shape

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Folosit,i aces, ti pas, i pentru a crea indexul:

• Load a shapefile by clicking on the Add Vector Layer toolbar button or pressing Ctrl+Shift+V.

• Open the Layer Properties dialog by double-clicking on the shapefile name in the legend or by right-clicking
and choosing Properties from the context menu.

• În fila General, facet,i clic pe butonul [Create Spatial Index].

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

12.1.2 Fis, iere cu Text Delimitat

Tabular data is a very common and widely used format because of its simplicity and readability – data can be
viewed and edited even in a plain text editor. A delimited text file is an attribute table with each column separated
by a defined character and each row separated by a line break. The first row usually contains the column names. A
common type of delimited text file is a CSV (Comma Separated Values), with each column separated by a comma.

Astfel de fis, iere de date pot cont,ine, de asemenea, informat,ii pozit,ionale, în două forme principale:

• Ca s, i coordonate ale punctelor din coloane separate

• Ca s, i reprezentare Well-Known Text (WKT) a unei geometrii

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:
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1. Fis, ierul trebuie să aibă un rând antet delimitat, de nume de câmpuri. Aceasta trebuie să fie prima linie din
fis, ierul text.

2. Rândul antet trebuie să cont,ină câmp(urile) cu definit,ia geometriei. Aceste câmp(uri) pot avea orice nume.

3. Coordonatele X s, i Y (dacă geometria este definită prin coordonate) trebuie să fie specificate ca numere.
Sistemul de coordonate nu este important.

Ca un exemplu de fis, ier text valid, vom importa fis, ierul elevp.csv, cu datele de elevat,ie ale punctelor, care vine
cu setul de date es, antion din QGIS (v. sect,iunea Date es, antion):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Unele elemente de ret,inut despre fis, ierul text:

1. Exemplul de fis, ier text foloses, te ; (punct s, i virgulă) ca delimitator. Orice caracter poate fi folosit pentru a
delimita câmpurile.

2. Primul rând constituie antetul. Acesta cont,ine câmpurile X, Y s, i ELEV.

3. Nu se folosesc ghilimele (") pentru delimitarea câmpurilor de text.

4. Coordonatele X sunt cont,inute în câmpul X.

5. Coordonatele Y sunt cont,inute în câmpul Y.

Alte informat,ii valoroase pentru utilizatori avansat,i

Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
three examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Delimited Text supports also Z and M coordinates in geometries:

LINESTRINGM(10.0 20.0 30.0, 11.0 21.0 31.0)

Încărcarea unui fis, ier cu texte delimitate

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text_1.

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To
enable QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter
by activating Custom delimiters, or by activating Regular expression delimiter and entering text into the
Expression field. For example, to change the delimiter to tab, use \t (this is a regular expression for the tab
character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.

12.1. Formatele de Date Acceptate 83



QGIS User Guide, Release 2.14

Figure 12.4: Dialogul Textului Delimitat

La final, introducet,i un nume de strat (cum ar fi elevp), as, a cum se arată în figure_delimited_text_1. Pentru a
adăuga stratul pe hartă, facet,i clic pe [OK]. Fis, ierul cu text delimitat se comportă acum ca oricare alt strat de hartă
din QGIS.

There is also a helper option that allows you to trim leading and trailing spaces from fields — Trim fields.

Also, it is possible to Discard empty fields. If necessary, you can force a comma to be the decimal separator

by activating Decimal separator is comma.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionally, you can enable:

• Se foloses, te un index spat,ial pentru a îmbunătăt,i performant,a afis, ării s, i pentru selectarea spat,ială a
entităt,ilor.

• Foloses, te indexul subsetului.

• Watch file to watch for changes to the file by other applications while QGIS is running.

12.1.3 Date OpenStreetMap

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides support for OSM
data.

Încărcarea Vectorilor OpenStreetMap

QGIS integrates OpenStreetMap import as a core functionality.
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• To connect to the OSM server and download data, open the menu Vector → Openstreetmap → Load data.
You can skip this step if you already obtained an .osm XML file using JOSM, Overpass API or any other
source.

• The menu Vector → Openstreetmap → Import topology from an XML file will convert your .osm file into
a SpatiaLite database and create a corresponding database connection.

• The menu Vector → Openstreetmap → Export topology to SpatiaLite then allows you to open the database
connection, select the type of data you want (points, lines, or polygons) and choose tags to import. This

creates a SpatiaLite geometry layer that you can add to your project by clicking on the Add SpatiaLite Layer

toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu (see section
Straturile SpatiaLite).

12.1.4 Straturi PostGIS

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Crearea unei conexiuni stocate

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu, or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Name: Un nume pentru această conexiune. Acesta poate fi identic cu cel al Bazei de Date.

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can
be defined in pg_service.conf. Check the Service connection file section for more details.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Numărul portului pe care îl ascultă serverul bazei de date PostgreSQL. Portul implicit este 5432.

• Database: Numele bazei de date.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speed-ups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Disable: Se încearcă doar o conexiune SSL necriptată.

– Allow: Se încearcă o conexiune SSL. Dacă aceasta nu reus, es, te, se încearcă o conexiune non-SSL.

– Prefer (implicit): Se încearcă o conexiune SSL. Dacă aceasta nu reus, es, te, se încearcă o conexiune
non-SSL.

– Require: Se încearcă doar o conexiune SSL.

• Username: Numele utilizatorului care va fi utilizat pentru conectarea la o bază de date.

• Password: Parola utilizată împreună cu Numele de utilizator pentru conectarea la baza de date.

Opt,ional, putet,i activa următoarele casete:

• Salvare Nume de utilizator
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• Salvare Parolă

• Căutare numai în coloanele_de_geometrie ale tabelului

• Nu se rezolvă tipul coloanelor nerestrict,ionate (GEOMETRY)

• Căutare numai în schema ‘public’

• De asemenea, se listează tabelele fără geometrie

• Foloses, te metadatele tabelei de estimare

După ce s-au setat tot,i parametrii s, i toate opt,iunile, putet,i testa conexiunea, făcând clic pe butonul [Test Connect].

Tip: Utilizarea tabelul metadatelor estimate, pentru a accelera operat,iunile
When initializing layers, various queries may be needed to establish the characteristics of the geometries stored
in the database table. When the Use estimated table metadata option is checked, these queries examine only a
sample of the rows and use the table statistics, rather than the entire table. This can drastically speed up operations
on large datasets, but may result in incorrect characterization of layers (eg. the feature count of filtered layers
will not be accurately determined) and may even cause strange behaviour in case columns that are supposed to be
unique actually are not.

Încărcarea unui strat PostGIS

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course, this requires having data in PostgreSQL. See section Importarea Datelor în PostgreSQL for a discussion
on importing data into the database.

Pentru a încărca un strat PostGIS, efectuat,i următorii pas, i:

• If the Add PostGIS layers dialog is not already open, selecting the Add PostGIS Layer... option from the
Layer menu or typing Ctrl+Shift+D opens the dialog.

• Aleget,i conexiunea din lista verticală s, i facet,i clic pe [Connect].

• Selectat,i sau deselectat,i De asemenea, se listează tabelele fără geometrie.

• Optionally, use some Search Options to define which features to load from the layer, or use the [Build
query] button to start the Query builder dialog.

• Găsit,i strat(urile) pe care dorit,i să le adăugat,i în lista de straturi disponibile.

• Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.
See section Constructorul de Interogări for information on using the PostgreSQL Query Builder to further
define the layer.

• Clic pe butonul [Add] pentru a adăuga stratul la hartă.

Tip: Straturi PostGIS
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Service connection file

The service connection file allows PostgreSQL connection parameters to be associated with a single service name.
That service name can then be specified by a client and the associated settings will be used.
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It’s called .pg_service.conf under *nix systems (GNU/Linux, macOS etc.) and pg_service.conf on
Windows.

The service file looks like:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Note: There are two services in the above example: water_service and wastewater_service. You can
use these to connect from QGIS, pgAdmin etc. by specifying only the name of the service you want to connect to
(without the enclosing brackets). If you want to use the service with psql you need to do something like export
PGSERVICE=water_service before doing your psql commands.

Note: You can find all the parameters here

Note: If you don’t want to save the passwords in the service file you can use the .pg_pass option.

On *nix operating systems (GNU/Linux, macOS etc.) you can save the .pg_service.conf file in the user’s
home directory and the PostgreSQL clients will automatically be aware of it. For example, if the logged user is
web, .pg_service.conf should be saved in the /home/web/ directory in order to directly work (without
specifying any other environment variables).

You can specify the location of the service file by creating a PGSERVICEFILE environment variable (e.g. run
the export PGSERVICEFILE=/home/web/.pg_service.conf command under your *nix OS to tem-
porarily set the PGSERVICEFILE variable)

You can also make the service file available system-wide (all users) either by placing it at pg_config
--sysconfdir‘‘**/.pg_service.conf** or by adding the ‘‘PGSYSCONFDIR environ-
ment variable to specify the directory containing the service file. If service definitions with the same name exist
in the user and the system file, the user file takes precedence.

Warning: There are some caveats under Windows:
• The service file should be saved as pg_service.conf and not as .pg_service.conf.
• The service file should be saved in Unix format in order to work. One way to do it is to open it with

Notepad++ and Edit -> EOL Conversion -> UNIX Format -> File save.
• After adding an environment variable you may also need to restart the computer.

Unele detalii despre straturile PostgreSQL

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
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key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS dialog
before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer. If this
occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either a
primary key or with a unique constraint, preferably indexed).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases. It can make sense to disable this option when you use expensive views.

Tip: Se copiază baza de date PostGIS, care cont,ine straturile salvate de QGIS
If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands, and
the default layer styles as saved by QGIS fail to restore afterwards, you need to set the XML option to DOCUMENT
and the restore will work.

QGIS allows to filter features already on server side. Check the Execute expressions on postgres server-side if
possible (Experimental) checkbox to do so. Only supported expressions will be sent to the database. Expressions
using unsupported operators or functions will gracefully fallback to local evaluation.

12.1.5 Importarea Datelor în PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the DB Manager plugin and the
command line tools shp2pgsql and ogr2ogr.

DB Manager

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Plugin-ul DB Manager for more information.

shp2pgsql

PostGIS includes an utility called shp2pgsql that can be used to import shapefiles into a PostGIS-enabled database.
For example, to import a shapefile named lakes.shp into a PostgreSQL database named gis_data, use the
following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

This creates a new layer named lakes_new in the gis_data database. The new layer will have a spatial
reference identifier (SRID) of 2964. See section Lucrul cu Proiect,ii for more information on spatial reference
systems and projections.

Tip: Exportarea seturilor de date din PostGIS
Like the import tool shp2pgsql, there is also a tool to export PostGIS datasets as shapefiles: pgsql2shp. This is
shipped within your PostGIS distribution.

ogr2ogr

Besides shp2pgsql and DB Manager, there is another tool for feeding geodata in PostGIS: ogr2ogr. This is part
of your GDAL installation.

Pentru a importa un strat în PostGIS, efectuat,i următorii pas, i:
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ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

This will import the shapefile alaska.shp into the PostGIS database postgis using the user postgres with the
password topsecret on host server myhost.de.

Note that OGR must be built with PostgreSQL to support PostGIS. You can verify this by typing (in )

ogrinfo --formats | grep -i post

If you prefer to use PostgreSQL’s COPY command instead of the default INSERT INTO method, you can export

the following environment variable (at least available on and ):

export PG_USE_COPY=YES

ogr2ogr does not create spatial indexes like shp2pgsl does. You need to create them manually, using the normal
SQL command CREATE INDEX afterwards as an extra step (as described in the next section Îmbunătăt,irea
Performant,ei).

Îmbunătăt,irea Performant,ei

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can im-
prove the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on each layer
in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed up spatial searches
of the data (GiST index information is taken from the PostGIS documentation available at http://postgis.net).

Tip: You can use the DBManager to create an index to your layer. You should first select the layer and click on
Table > Edit table, go to Indexes tab and click on [Add spatial index].

Sintaxa pentru crearea unui index GIST este:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Note that for large tables, creating the index can take a long time. Once the index is created, you should perform
a VACUUM ANALYZE. See the PostGIS documentation (POSTGIS-PROJECT Literatură s, i Referint,e Web) for
more information.

Următorul este un exemplu de creare a unui index GIST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$
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12.1.6 Straturile vectoriale traversează 180 |grade| longitudine

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_4, the tiny point on the far left of the map canvas (Chatham Islands) should be within the grid, to
the right of the New Zealand main islands.

Figure 12.5: Map in lat/lon crossing the 180° longitude line

A work-around is to transform the longitude values using PostGIS and the ST_Shift_Longitude function. This
function reads every point/vertex in every component of every feature in a geometry, and if the longitude coordi-
nate is < 0°, it adds 360° to it. The result is a 0° - 360° version of the data to be plotted in a 180°-centric map.

Figure 12.6: În cazul trecerii peste 180 |grade| longitudine se aplică funct,ia ST_Shift_Longitude

Utilizare

• Importat,i datele în PostGIS (Importarea Datelor în PostgreSQL) folosind, de exemplu, plugin-ul DB Man-
ager.

• Use the PostGIS command line interface to issue the following command (in this example,
“TABLE” is the actual name of your PostGIS table): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• If everything went well, you should receive a confirmation about the number of features that were updated.
Then you’ll be able to load the map and see the difference (Figure_vector_5).

12.1.7 Straturile SpatiaLite

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer

toolbar button, or by selecting the Add SpatiaLite Layer... option from the Layer menu, or by typing
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Ctrl+Shift+L. This will bring up a window that will allow you either to connect to a SpatiaLite database
already known to QGIS, which you can choose from the drop-down menu, or to define a new connection to a new
database. To define a new connection, click on [New] and use the file browser to point to your SpatiaLite database,
which is a file with a .sqlite extension.

If you want to save a vector layer to SpatiaLite format, you can do this by right clicking the layer in the legend.
Then, click on Save as.., define the name of the output file, and select ‘SpatiaLite’ as format and the CRS. Also,
you can select ‘SQLite’ as format and then add SPATIALITE=YES in the OGR data source creation option field.
This tells OGR to create a SpatiaLite database. See also http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

Crearea unui nou strat SpatiaLite

Dacă dorit,i să creat,i un nou strat SpatiaLite, vă rugăm să consultat,i sect,iunea Crearea unui nou strat SpatiaLite.

Tip: Plugin-urile de gestionare a datelor SpatiaLite
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

12.1.8 Straturile MSSQL Spatial

QGIS also provides native MS SQL support. The first time you load MSSQL Spatial data, begin by clicking

on the Add MSSQL Spatial Layer toolbar button or by selecting the Add MSSQL Spatial Layer... option from the
Layer menu, or by typing Ctrl+Shift+M.

12.1.9 Straturile Oracle Spatial

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. QGIS now has support for such layers.

Crearea unei conexiuni stocate

The first time you use an Oracle Spatial data source, you must create a connection to the database that

contains the data. Begin by clicking on the Add Oracle Spatial Layer toolbar button, selecting the Add Oracle
Spatial Layer... option from the Layer menu, or typing Ctrl+Shift+O. To access the connection manager, click
on the [New] button to display the Create a New Oracle Spatial Connection dialog. The parameters required for
a connection are:

• Name: Un nume pentru această conexiune. Poate fi identic cu cel al Bazei de Date.

• Database: SID-ul sau SERVICE_NAME-ul instant,ei Oracle.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Numărul portului pe care îl monitorizează serverul bazei de date Oracle. Portul implicit este 1521.

• Username: Numele utilizatorului care va fi utilizat pentru conectarea la baza de date.

• Password: Parola utilizată împreună cu Numele de utilizator pentru conectarea la baza de date.

Opt,ional, putet,i activa următoarele casete:
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• Save Username Indicates whether to save the database username in the connection configuration.

• Salvarea Parolei stabiles, te dacă parola bazei de date se va salva în setările conexiunii.

• Only look in meta data table Restricts the displayed tables to those that are in the
all_sdo_geom_metadata view. This can speed up the initial display of spatial tables.

• Only look for user’s tables When searching for spatial tables, restrict the search to tables that are owned
by the user.

• De asemenea, se listează tabelele fără geometrie Indică faptul că, de asemenea, tabelele fără geometrie
ar trebui să fie enumerate în mod implicit.

• Use estimated table statistics for the layer metadata When the layer is set up, various metadata are
required for the Oracle table. This includes information such as the table row count, geometry type and
spatial extents of the data in the geometry column. If the table contains a large number of rows, determining
this metadata can be time-consuming. By activating this option, the following fast table metadata operations
are done: Row count is determined from all_tables.num_rows. Table extents are always determined
with the SDO_TUNE.EXTENTS_OF function, even if a layer filter is applied. Table geometry is determined
from the first 100 non-null geometry rows in the table.

• Listează doar tipurile de geometrie existente Va lista doar tipurile de geometrie existente s, i nu propune
adăugarea altora.

Warning: In the Authentication tab, saving username and password will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Sistem de Autentificare for more details.

După ce s-au setat tot,i parametrii s, i toate opt,iunile, putet,i testa conexiunea, făcând clic pe butonul [Test Connect].

Tip: Securitatea s, i Setările Utilizatorilor QGIS
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk.
Passwords are saved in clear text in the system configuration and in the project files! Your customized settings for
QGIS are stored based on the operating system:

• Setările sunt stocate în directorul de casă din ~/.qgis2.

• Setările sunt stocate în registru.

Încărcarea Stratului Oracle Spatial

Once you have one or more connections defined, you can load layers from the Oracle database. Of course,
this requires having data in Oracle.

Pentru a încărca un strat Oracle Spatial, efectuat,i următorii pas, i:

• If the Add Oracle Spatial layers dialog is not already open, click on the Add Oracle Spatial Layer toolbar
button.

• Aleget,i conexiunea din lista verticală s, i facet,i clic pe [Connect].

• Selectat,i sau deselectat,i De asemenea, se listează tabelele fără geometrie.

• Optionally, use some Search Options to define which features to load from the layer or use the [Build
query] button to start the Query builder dialog.

• Găsit,i strat(urile) pe care dorit,i să le adăugat,i în lista de straturi disponibile.
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• Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.
See section Constructorul de Interogări for information on using the Oracle Query Builder to further define
the layer.

• Clic pe butonul [Add] pentru a adăuga stratul la hartă.

Tip: Straturile Oracle Spatial
În mod normal, un strat Oracle Spatial este definit printr-o intrare în tabela USER_SDO_METADATA.

12.2 Biblioteca Simbolurilor

12.2.1 Managerul de Stiluri

Biblioteca Simbolurilor este locul în care utilizatorii pot crea simboluri generice, pentru a fi utilizate în di-
verse proiecte QGIS. O putet,i deschide prin apelarea meniului Setări → Managerul de Stiluri, sau din fila Stil
a Proprietăt,ilor stratului vectorial. Aceasta permite utilizatorilor să:

• creeze, să editeze s, i să elimine simboluri

• organizeze simbolurile în grupuri personalizate

• exporte s, i să importe simboluri.

Figure 12.7: Managerul de Stiluri

Grupuri obis, nuite s, i grupuri inteligente

You can organize symbols into different categories. These categories, listed in the panel at the left, can be static
(called Group) or dynamic (named Smart Group). A group is smart when its symbols are dynamically fetched
according to conditions set. See figure_symbol_2:

Pentru a crea un grup, facet,i clic-dreapta pe un grup existent sau pe directorul principal al Grupurilor, din partea

stângă a ferestrei. Putet,i selecta, de asemenea, un grup s, i să facet,i clic pe butonul de Adăugare element. Noul grup
va fi un sub-grup al celui selectat.

Crearea Grupurilor Inteligente este similară cu crearea unui grup, dar în schimb vet,i selecta Grupuri In-
teligente. Caseta de dialog permite utilizatorului să aleagă expresia de selectare a simbolurilor, pentru a putea
apărea în grupul inteligent (simbolul poate cont,ine unele etichete, poate fi membru al unui grup, cont,ine un s, ir
de caractere în numele său, etc.). Orice simbol care îndeplines, te condit,i(ile) introduse, este adăugat automat la
grupul inteligent.
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Figure 12.8: Crearea unui Grup Inteligent

Pentru a elimina un grup sau un grup inteligent, facet,i clic-dreapta pe grup s, i aleget,i Eliminare Grup, sau selectat,i-l

s, i apoi apăsat,i butonul Eliminare Grup.

Spre deosebire de grupurile inteligente, care preiau în mod automat simbolurile care le apart,in, grupurile simple
sunt completate de către utilizator. Pentru a adăuga un simbol într-un grup, facet,i clic dreapta pe un simbol, apoi
aleget,i Aplicare group s, i numele grupului. Există un al doilea mod de a adăuga mai multe simboluri unui grup:

doar selectat,i un grup, apoi facet,i clic pe s, i selectat,i Simbolurile Grupului. Toate simbolurile afis, ează o casetă
de bifare, care permite adăugarea simbolului în grupurile selectate. Când at,i terminat, putet,i face clic pe acelas, i
buton s, i apoi selectat,i Încheiere Grupare.

Toate simbolurile care nu sunt plasate sub un grup personalizat apart,in unui grup implicit, denumit Negrupate.

Adăugare, Editare s, i Eliminare Simbol.

Selecting a group returns in the right panel, if applicable, the list of symbols of the group (including its subgroups).
These symbols are organized in four different tabs:

• Marcajul, pentru simbolurile de tip punct

• Linia, pentru simbolurile de tip linie

• Umplerea pentru simbolurile de tip poligon

• s, i Gama de Culori

To delete a symbol you no longer need, just select it and click Remove item (also available through right-click).
The symbol will be deleted from the local symbols database.

The symbol list can be modified by adding new symbols with Add item button or modifying existing ones with
Edit item. See ‘The Symbol Selector‘_ for further information.

Partajare simboluri

The Share item tool, at the right bottom of the Style Library dialog, offers options to easily share symbols with
others: users can indeed export their symbols and import symbols to their library.

Exportare simboluri

You can export the selected symbols to PNG, SVG or XML file formats. Exporting to PNG or SVG (both not
available for color ramp symbols) creates a file for each selected symbol, and the SVG folder can be added to
SVG Paths in Settings → Options to e.g. share these symbols on a network. The XML format generates a single
file containing all the selected symbols. This file can then be imported in another user’s style library.

Importare simboluri
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Putet,i extinde biblioteca de simboluri prin importarea de noi simboluri. Trebuie doar să aleget,i Import din
lista verticală, situată în partea de jos din dreapta a dialogului. În noul dialog, va trebui să:

• indicat,i sursa simbolurilor (acesta poate fi o adresă URL sau un fis, ier .xml situat pe disc),

• indicat,i numele grupului în care dorit,i să punet,i simbolurile,

• selectat,i simbolurile pe care dorit,i să le adăugat,i în biblioteca dvs.,

• apoi, să apăsat,i Import.

Ret,inet,i că opt,iunile de import s, i de export sunt disponibile, de asemenea, prin intermediul unui clic-dreapta.

Figure 12.9: Importare simboluri

Gama de Culori

The Color ramp tab in the Style Manager presents different types of color ramps you can use to style layers.

To create a custom color ramp, activate the Color ramp tab and click the Add item button. The button reveals a
drop-down list to choose the ramp type: Gradient, Random, colorBrewer, or cpt-city.

The first three have options for number of steps and/or multiple stops in the color ramp. You can use the Invert
option while classifying the data with a color ramp. See figure_symbol_4 for an example of custom color ramp
and figure_symbol_4a for the cpt-city dialog.

Opt,iunea cpt-city deschide un nou dialog cu sute de teme incluse ‘din start’.

12.2.2 Selectorul de simboluri

The Symbol selector is the main dialog to design a symbol. You can create or edit Marker, Line or Fill Symbols.

Pentru fiecare tip de simboluri, vet,i găsi întotdeauna aceeas, i structură de dialog:

• at the top left side a dynamic symbol representation, updated as soon as symbol properties evolve

• under the symbol representation, the symbol tree shows symbol layers that are combined afterwards to shape
a new global symbol. A symbol can consist of several Symbol layers. Settings will be shown later in this
chapter.

• în dreapta putet,i seta unii parametri care se aplică simbolului global:
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Figure 12.10: Exemplu de gradient de culoare personalizat, cu multiple opriri

Figure 12.11: dialogul cpt-city cu sute de game de culori
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Figure 12.12: Designing a Marker symbol

– unitatea: acesta constă în milimetri, pixeli sau unităt,i de hartă

– transparenţă

– color: when this parameter is changed by the user, its value is echoed to all unlocked sub-symbols
color

– size and rotation for marker symbol

– width for line symbol

Note that the Data-defined override button beside the last layer-related parameters is inactive until the
symbol is applied to a layer. Once the symbol is connected to a layer, this button offers access to the size
assistant dialog which helps to create proportional or multivariate analysis rendering.

• under these parameters are displayed items of the symbols library you can choose from. This list of symbols
can be filtered by selecting a group in the drop-down list just above.

According to the level selected in the symbol tree, you’ll get enabled different tools at the bottom of the dialog to
:

• add new symbol layer: you can imbricate as many symbols as you want

• remove the selected symbol layer

• lock colors of symbol layer: a locked color stays unchanged when user changes the color at the global
(or upper) symbol level

• duplicate a (group of) symbol layer(s)

• move up or down the symbol layer

• apply special effects to the symbol layer

• save the designed symbol into your symbol library

• or choose in the Advanced drop-down list, to clip features to canvas extent.

Tip: Ret,inet,i că, o dată ce at,i setat dimensiunea în nivelurile inferioare din dialogul Straturilor simbolului,
mărimea întregului simbol poate fi schimbată, pentru primul nivel, cu ajutorul meniului Dimensiune (pentru sim-
bolurile de tip figură) sau a meniului Lăt,ime (pentru simbolurile de tip figură). Dimensiunea nivelurilor inferioare
se modifică în mod corespunzător, în timp ce se păstrează raportul dimensiunilor.
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Mai multe setări detaliate sunt disponibile atunci când facet,i clic pe nivelul inferior din arborele Simbolului. Putet,i
schimba proprietăt,ile pentru fiecare dintre Straturile simbolului s, i, în funct,ie de tipul simbolului, vet,i obt,ine setări
diferite.

Simbolurile Marcajului

Simbolurile marcajului au mai multe tipuri de straturi simbol:

• Simbol elipsoidal

• Simbol de tip caracter

• Simbol simplu (implicit)

• Simbol SVG

• Simbolul câmpului vectorial

Pentru fiecare simbol de tip figură putet,i utiliza următoarele opt,iuni:

• Symbol layer type: Avet,i opt,iunea de a utiliza markeri Ellipse, markeri de fonturi, markeri Simpli, markeri
SVG s, i markeri Vector Field.

• culori

• Dimensiune

• Stilul conturului

• Lăţimea conturului

• Unghiul

• Offset X,Y: Putet,i schimba simbolul din direct,iile X sau Y.

• Punctul de ancorare

• Proprietăt,i definite cu ajutorul datelor ...

Simbolurile Liniei

Simbolurile marcajului linie au numai două tipuri de strat simbol:

• Linia marcajului

• Linie simplă (implicită)

Tipul implicit de strat pentru un simbol desenează o linie simplă, pe când celălalt afis, ează un marcaj de tip punct,
în mod regulat, pe linie. Putet,i alege diferite locat,ii: vertexul, ultimul s, i primul vertex, intervalul sau pe fiecare
punct al curbei. Pozit,ia marcajului poate fi decalată de-a lungul liniei. În cele din urmă, rotat,ia permite schimbarea
orientării simbolului.

Următoarele setări sunt disponibile:

• culoare

• Lăt,imea penit,ei

• Decalaj

• Stilul penit,ei

• Îmbinare stiluri

• Stilul capătului

• Se foloseşte un model de haşurare predefinit

• Unitatea modelului de haşurare
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• Proprietăt,i definite cu ajutorul datelor ...

Simboluri Poligonale

Simbolurile marcajelor poligonale cont,in, de asemenea, mai multe tipuri de straturi simbol:

• Umplere de tip centroid

• Umplere cu gradient

• Umplere cu model din linii

• Umplere cu model din puncte

• Umplere cu imagine raster

• Umplere cu SVG

• Umplere de tip shapeburst

• Umplere simplă (implicită)

• Conturul: Linia marcajului (la fel ca marcajul liniei)

• Conturul: Linie simplă (la fel ca marcajul liniei)

Următoarele setări sunt disponibile:

• Culori pentru margine s, i umplere.

• Stilul de umplere

• Stilul marginii

• Lăt,imea marginii

• Decalaj X,Y

• Proprietăt,i definite cu ajutorul datelor ...

Cu ajutorul casetei de culori putet,i glisa culoarea de la un buton la altul, o putet,i copia s, i lipi, o putet,i alege de ori-
unde, dintr-o paletă, dintr-o culoare recentă sau una standard. Caseta combinată vă permite să atas, at,i transparent,ă
unei entităt,i. De asemenea, este suficient să facet,i clic pe buton pentru a deschide fereastra de dialog a paletei.
Ret,inet,i că putet,i importa culoarea chiar din alte softuri externe, cum ar fi GIMP.

Folosind ‘Umplere cu o imagine raster’ putet,i acopri un poligon cu o imagine raster divizată în plăci. Opt,iunile
includ numele de fis, ier (definit cu ajutorul datelor), opacitate, dimensiunea imaginii (în pixeli, mm sau unităt,i de
hartă), modul coordonatelor (entitate sau vizualizare), s, i rotat,ia.

Tipul de Strat pentru Simbol ‘Umplere cu Gradient’ vă permite să aleget,i între setarea a Două culori s, i a unui

Interval de culori. Avet,i posibilitatea să utilizat,i Centroidul entităt,ii ca s, i Punct de referint,ă. Toate Tipurile
de Straturi pentru Simbol ‘Umplere cu Gradient’ sunt disponibile, de asemenea, s, i în meniul Simbol al Randării
pe Categorii sau Grade, s, i în meniul Proprietăt,ilor regulilor al Renderului bazat pe reguli.

Altă posibilitate este de a alege ‘umplerea shapeburst’, care este o umplere cu gradient tamponat, în care un gradi-
ent este desenat dinspre marginile unui poligon înspre centrul acestuia. Parametrii configurabili includ distant,a de
la margine până la umbră, utilizarea unei game de culori sau a unor gradient,i simpli, cu două culori, estomparea
opt,ională a umplerii s, i aplicarea unor decalaje.

Este posibilă desenarea liniilor unui poligon doar în interiorul altui poligon. Folosind ‘Contur: Linie simplă ‘,

bifat,i Desenează liniile numai în interiorul poligonului.

Notă: Atunci când tipul de geometrie este poligon, putet,i alege să dezactivat,i decuparea automată a lini-
ilor/poligoanelor, după extinderea canevasului. În unele cazuri, această tăiere duce la o simbolică nefavorabilă
(de exemplu, umplerea centroidului are loc acolo unde trebuie să fie întotdeauna centroidul entităt,ii).
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12.3 Dialogul Proprietăt,ilor Vectoriale

The Layer Properties dialog for a vector layer provides general settings to manage appearance of layer features
in the map (symbology, labeling, diagrams), interaction with the mouse (actions, map tips, form design). It also
provides information about the layer.

To access the Layer Properties dialog, double-click on a layer in the legend or right-click on the layer and select
Properties from the pop-up menu.

Tip: Comutarea rapidă între diferite reprezentări ale straturilor
Using the Styles → Add combobox at the bottom of the Layer Properties dialog, you can save as many combi-
nations of layer properties settings (symbology, labeling, diagram, fields form, actions...) as you want. Then,
simply switch between styles from the context menu of the layer in Layers Panel to automatically get different
representations of your data.

12.3.1 Meniu General

Utilizat,i acest meniu pentru a efectua setările generale pentru stratul vectorial. Există mai multe opt,iuni
disponibile:

Informat,ii despre strat

• Modificat,i numele afis, at al stratului în displayed as

• Definit,i Stratul sursă al stratului vectorial

• Define the Data source encoding to define provider-specific options and to be able to read the file

Sistem de Coordonate de Referint,ă

• Specify the coordinate reference system. Here, you can view or change the projection of the specific vector
layer.

• Create a Spatial Index (only for OGR-supported formats)

• Actualizare informat,ii despre extinderea unui strat

• Vizualizat,i sau modificat,i proiect,ia stratului vectorului specificat, făcând clic pe Specificare ...

Vizibilitate în funcţie de scară

You can set the Maximum (inclusive) and Minimum (exclusive) scale, defining a range of scale in which features

will be visible. Out of this range, they are hidden. The Set to current canvas scale button helps you use the current
map canvas scale as boundary of the range visibility.

Constructorul de Interogări

Under the Provider Feature Filter frame, the Query Builder allows you to define a subset of the features in the
layer using a SQL-like WHERE clause and to display the result in the main window. As long as the query is
active, only the features corresponding to its result are available in the project. The query result can be saved as a
new vector layer.

Constructorul de Interogări este accesibil prin termenul eponim din partea de jos a meniului Generalităt,i, din
proprietăt,ile stratului. În Subsetul entităt,ilor, facet,i clic pe butonul [Constructorului de Interogări] pentru a
deschide Query builder. De exemplu, dacă avet,i un strat regions cu un câmp TYPE_2, putet,i selecta numai
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Figure 12.13: Meniul general din fereastra de proprietăt,i a stratului vectorial
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regiunile care sunt împumutate în caseta Furnizorului specific expresiilor de filtrare a Constructorului de In-
terogări. Figure_attributes_2 prezintă un exemplu de Constructor de Interogări populat cu stratul regions.shp
din datele es, antion ale aplicat,iei QGIS. Sect,iunile Câmpurile, Valorile s, i Operatorilor ajută la construirea in-
terogărilor similare SQL.

Figure 12.14: Constructorul de Interogări

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it where the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

Singura except,ie apare dacă stratul de dvs. este parte a unei baze de date, caz în care folosirea unui subset vă va
împiedica să editat,i stratul.

12.3.2 Meniul Stilului

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You
can use tools that are common to all vector data, as well as special symbolizing tools that were designed for the
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different kinds of vector data. However all types share the following dialog structure: in the upper part, you have a
widget that helps you prepare the classification and the symbol to use for features and at the bottom the Randarea
stratului widget.

Tip: Exportare simbologie vectorială
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files.
Just open the right mouse menu of the layer and click on Save As... to specify the name of the output file and its
format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology → or as
Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Randarea entităt,ilor

The renderer is responsible for drawing a feature together with the correct symbol. Regardless layer geometry
type, there are four common types of renderers: single symbol, categorized, graduated and rule-based. For point
layers, there are a point displacement and a heatmap renderers available while polygon layers can also be rendered
with the inverted renderer.

There is no continuous color renderer, because it is in fact only a special case of the graduated renderer. The
categorized and graduated renderers can be created by specifying a symbol and a color ramp - they will set the
colors for symbols appropriately. For each data type (points, lines and polygons), vector symbol layer types are
available. Depending on the chosen renderer, the dialog provides different additional sections.

Note: If you change the renderer type when setting the style of a vector layer the settings you made for the
symbol will be maintained. Be aware that this procedure only works for one change. If you repeat changing the
renderer type the settings for the symbol will get lost.

Render cu Simbol Unic

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. See
Selectorul de simboluri for further information about symbol representation.

Figure 12.15: Proprietăt,ile liniei cu simbol unic

Tip: edit symbol directly from layer panel
If in your Layers Panel you have layers with categories defined through categorized, graduated or rule-based style
mode, you can quickly change the fill color of the symbol of the categories by right-clicking on a category and
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choose the color you prefer from a color wheel menu. Right-clicking on a category will also give you access to
the options Hide all items, Show all items and Edit symbol.

Renderul Categorisit

The Categorized Renderer is used to render all features from a layer, using an user-defined symbol whose
aspect reflects the value of a selected feature’s attribute. The Categorized menu allows you to select:

• The attribute (using the Column listbox or the Set column expression function, see Expresii chapter)

• The symbol (using the Selectorul de simboluri dialog) which will be used as default for each class

• The range of colors (using the Color ramp listbox) from which color applied to the symbol is selected

Then click on Classify button to create classes from the distinct value of the attribute column. Each class can be
disabled unchecking the checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_symbology_2 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Figure 12.16: Categorized Symbolizing options

Tip: Selectează s, i modifică simboluri multiple
The Symbology allows you to select multiple symbols and right click to change color, transparency, size, or width
of selected entries.

Tip: Match categories to symbol name
In the [Advanced] menu, under the classes, you can choose one of the two first actions to match symbol name to
a category name in your classification. Matched to saved symbols match category name with a symbol name from
your Style Manager. Match to symbols from file match category name to a symbol name from an external file.
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Renderul Gradat

The Graduated Renderer is used to render all the features from a layer, using an user-defined symbol whose
color or size reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, it allows you to select:

• The attribute (using the Column listbox or the Set column expression function)

• The symbol (using the Symbol selector dialog)

• Formatul legendei s, i precizia

• Metoda utilizată pentru a schimba culoarea sau dimensiunea simbolului

• The colors (using the color Ramp list) if the color method is selected

• The size (using the size domain and its unit

Then you can use the Histogram tab which shows an interactive histogram of the values from the assigned field or
expression. Class breaks can be moved or added using the histogram widget.

Note: You can use Statistical Summary panel to get more information on your vector layer. See Panoul Sumarului
Statistic.

Back to the Classes tab, you can specify the number of classes and also the mode for classifying features within
the classes (using the Mode list). The available modes are:

• Equal Interval: each class has the same size (e.g. values from 0 to 16 and 4 classes, each class has a size of
4);

• Quantile: each class will have the same number of element inside (the idea of a boxplot);

• Natural Breaks (Jenks): the variance within each class is minimal while the variance between classes is
maximal;

• Standard Deviation: classes are built depending on the standard deviation of the values;

• Pretty Breaks: Computes a sequence of about n+1 equally spaced nice values which cover the range of the
values in x. The values are chosen so that they are 1, 2 or 5 times a power of 10. (based on pretty from the
R statistical environment http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

Lista din partea centrală a meniului Stil enumeră clasele, alături de intervalele, etichetele s, i simbolurile lor, care
vor fi randate.

Click on Classify button to create classes using the chosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_symbology_3 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Tip: Hărt,i tematice bazate pe expresii
Categorized and graduated thematic maps can be created using the result of an expression. In the properties dialog
for vector layers, the attribute chooser is extended with a Set column expression function. So you don’t need
to write the classification attribute to a new column in your attribute table if you want the classification attribute
to be a composite of multiple fields, or a formula of some sort.
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Figure 12.17: Opt,iunile de Simbolizare Gradată

Simbolul Proport,ional s, i Analiză Multivariată

Proportional Symbol and Multivariate Analysis are not rendering types available from the Style rendering drop-
down list. However with the Size Assistant options applied over any of the previous rendering options, QGIS
allows you to display your point and line data with such representation. Creating proportional symbol

Proportional rendering is done by first applying to the layer the Render cu Simbol Unic. Once you set the symbol,

at the upper level of the symbol tree, the Data-defined override button available beside Size or Width options
(for point or line layers respectively) provides tool to create proportional symbology for the layer. An assistant is

moreover accessible through the menu to help you define size expression.

Figure 12.18: Varying size assistant

The assistant lets you define:

• The attribute to represent, using the Field listbox or the Set column expression function (see Expresii)

106 Chapter 12. Lucrul cu Datele Vectoriale



QGIS User Guide, Release 2.14

• the scale method of representation which can be ‘Flannery’, ‘Surface’ or ‘Radius’

• Dimensiunile minimă s, i maximă ale simbolului

• The range of values to represent: The down pointing arrow helps you fill automatically these fields with the
minimum (or zero) and maximum values returned by the chosen attribute or the expression applied to your
data.

• O dimensiune unică, pentru a reprezenta valorile NULL.

To the right side of the dialog, you can preview the features representation within a live-update widget. This
representation is added to the layer tree in the layer legend and is also used to shape the layer representation in the
print composer legend item.

Valorile din asistentul dimensiunilor variabile de mai sus vor seta dimensiunea ‘Suprascrierii cu date definite’ la:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)

Crearea analiză multivariate

O randare a unei analize multivariată vă ajută să evaluat,i relat,ia dintre două sau mai multe variabile, astfel, una
poate fi reprezentată printr-o gamă de culoare, pe când cealaltă poate fi reprezentată printr-o mărime.

The simplest way to create multivariate analysis in QGIS is to first apply a categorized or graduated rendering on
a layer, using the same type of symbol for all the classes. Then, clicking on the symbol [Change] button above
the classification frame, you get the Selectorul de simboluri dialog from which, as seen above, you can activate
and set the size assistant option either on size (for point layer) or width (for line layer).

Like the proportional symbol, the size-related symbol is added to the layer tree, at the top of the categorized or
graduated classes symbols. And both representation are also available in the print composer legend item.

Randare bazată pe reguli

The Rule-based Renderer is used to render all the features from a layer, using rule-based symbols whose
aspect reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements.
The dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use
only the first-matched rule.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click on its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expresii). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
matches. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-click the rules in
the map legend and the Style menu of the layer properties appears showing the rule that is the background for the
symbol in the tree.

The example in figure_symbology_5 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

Deplasare Puncte

The Point Displacement renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around one center symbol or on
several concentric circles.

Note: You can still render features with other renderer like Single symbol, Graduated, Categorized or Rule-Based
renderer using the Renderer drop-down list then the Renderer Settings... button.
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Figure 12.19: Opt,iunile de Simbolizare bazată pe reguli

Figure 12.20: Dialogul de deplasare a punctelor
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Poligonul Invers

The Inverted Polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As
above you can select subrenderers, namely Single symbol, Graduated, Categorized, Rule-Based or 2.5 D renderer.

Figure 12.21: Dialogul Poligonului Invers

Harta calorică

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify
the heatmap radius in pixels, mm or map units, choose and edit a color ramp for the heatmap style and use a slider
for selecting a trade-off between render speed and quality. You can also define a maximum value limit and give a
weight to points using a field or an expression. When adding or removing a feature the heatmap renderer updates
the heatmap style automatically.

2.5 D

Using the 2.5 D renderer it’s possible to create a 2.5 D effect on your layer’s features. You start by choosing
a Height value (in map units). For that you can use a fixed value, one of your layer’s fields, or an expression. You
also need to choose an Angle (in degrees) to recreate the viewer position (0° means west, growing in counter clock
wise). Use advanced configuration options to set the Roof Color and Wall Color. If you would like to simulate

solar radiation on the features walls, make sure to check the Shade walls based on aspect option. You can also
simulate a shadow by setting a Color and Size (in map units).

Tip: Utilizează efectul 2.5 D cu alte rendere
Once you have finished setting the basic style on the 2.5 D renderer, you can convert this to another renderer
(single, categorized, graduated). The 2.5 D effects will be kept and all other renderer specific options will be
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Figure 12.22: Fereasta plugin-ului Heatmap

Figure 12.23: Dialogul 2.5 D
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available for you to fine tune them (this way you can have for example categorized symbols with a nice 2.5 D
representation or add some extra styling to your 2.5 D symbols). To make sure that the shadow and the “building”
itself do not interfere with other nearby features, you may need to enable Symbols Levels ( Advanced → Symbol
levels...). The 2.5 D height and angle values are saved in the layer’s variables, so you can edit it afterwards in the
variables tab of the layer’s properties dialog.

Randarea stratului

From the Style tab, you can also set some options that invariabily act on all features of the layer:

• Layer transparency : You can make the underlying layer in the map canvas visible with
this tool. Use the slider to adapt the visibility of your vector layer to your needs. You can also make a
precise definition of the percentage of visibility in the the menu beside the slider.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Modurile de Fuziune.

• Apply paint effects on all the layer features with the Draw Effects button.

• Control feature rendering order allows you, using features attributes, to define the z-order in which they

shall be rendered. Activate the checkbox and click on the button beside. You then get the Define
Order dialog in which you:

– choose a field or build an expression to apply to the layer features

– set in which order the fetched features should be sorted, i.e. if you choose Ascending order, the
features with lower value are rendered under those with upper value.

– define when features returning NULL value should be rendered: first or last.

You can add several rules of ordering. The first rule is applied to all the features in the layer, z-ordering
them according to the value returned. Then, for each group of features with the same value (including those
with NULL value) and thus same z-level, the next rule is applied to sort its items among them. And so on...

Once the Define Order dialog is applied, a summary of the expression(s) used to control the layer rendering

is retranscribed in the textbox beside Control feature rendering order option.

Figure 12.24: Opţiuni de randare a stratului

Alte Setări

Nivelurile simbolurilor

For renderers that allow stacked symbol layers (only heatmap doesn’t) there is an option to control the rendering
order of each symbol’s levels.

For most of the renderers, you can access the Symbols levels option by clicking the [Advanced] button below the
saved symbols list and choosing Symbol levels. For the Randare bazată pe reguli the option is directly available
through [Symbols levels] button, while for Deplasare Puncte renderer the same button is inside the Rendering
settings dialog.
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To activate symbols levels, select the Enable symbol levels. Each row will show up a small sample of the
combined symbol, its label and the individual symbols layer divided into columns with a number next to it. The
numbers represent the rendering order level in which the symbol layer will be drawn. Lower values levels are
drawn first, staying at the bottom, while higher values are drawn last, on top of the others.

Figure 12.25: Dialogul Nivelurilor simbolului

Note: If symbols levels are deactivated, the complete symbols will be drawn according to their respective features
order. Overlapping symbols will simply obfuscate to other below. Besides, similar symbols won’t “merge” with
each other.

Figure 12.26: Symbol levels activated (A) and deactivated (B) difference

Efecte de Desenare

In order to improve layer rendering and avoid (or at least reduce) the resort to other software for final rendering of

maps, QGIS provides another powerful functionality: the Draw Effects options, which adds paint effects for
customizing the visualization of vector layers.

The option is available in the Layer Properties –> Style dialog, under the Layer rendering group (applying to the
whole layer) or in symbol layer properties (applying to corresponding features). You can combine both usage.

Paint effects can be activated by checking the Draw effects option and clicking the Customize effects button,
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that will open the Effect Properties Dialog (see figure_effects_1). The following effect types, with custom options
are available:

• Source: Draws the feature’s original style according to the configuration of the layer’s properties. The
transparency of its style can be adjusted.

Figure 12.27: Efecte de Desenare: Dialogul sursă

• Blur: Adds a blur effect on the vector layer. The options that someone can change are the Blur type (Stack
or Gaussian blur), the strength and transparency of the blur effect.

Figure 12.28: Draw Effects: Blur dialog

• Colorize: This effect can be used to make a version of the style using one single hue. The base will always

be a grayscale version of the symbol and you can use the Grayscale to select how to create it (options

are: ‘lightness’, ‘luminosity’ and ‘average’). If Colorise is selected, it will be possible to mix another
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color and choose how strong it should be. You can also control the Brightness, contrast and saturation
levels of the resulting symbol.

Figure 12.29: Efecte de Desenare: Dialogul de colorizare

• Drop Shadow: Using this effect adds a shadow on the feature, which looks like adding an extra dimension.
This effect can be customized by changing the offset degrees and radius, determining where the shadow
shifts towards to and the proximity to the source object. Drop Shadow also has the option to change the blur
radius, the transparency and the color of the effect.

Figure 12.30: Draw Effects: Drop Shadow dialog

• Inner Shadow: This effect is similar to the Drop Shadow effect, but it adds the shadow effect on the inside
of the edges of the feature. The available options for customization are the same as the Drop Shadow effect.

• Inner Glow: Adds a glow effect inside the feature. This effect can be customized by adjusting the spread
(width) of the glow, or the Blur radius. The latter specifies the proximity from the edge of the feature where

114 Chapter 12. Lucrul cu Datele Vectoriale



QGIS User Guide, Release 2.14

Figure 12.31: Efecte de Desenare: Dialogul Umbrei Interioare

you want any blurring to happen. Additionally, there are options to customize the color of the glow, with a
single color or a color ramp.

Figure 12.32: Efecte de Desenare: Dialogul Strălucirii Interioare

• Outer Glow: This effect is similar to the Inner Glow effect, but it adds the glow effect on the outside of the
edges of the feature. The available options for customization are the same as the Inner Glow effect.

• Transform: Adds the possibility of transforming the shape of the symbol. The first options available
for customization are the Reflect horizontal and Reflect vertical, which actually create a reflection on the
horizontal and/or vertical axes. The 4 other options are:

– Shear: slants the feature along the x and/or y axis

– Scale: enlarges or minimizes the feature along the x and/or y axis by the given percentage

– Rotation: turns the feature around its center point

– and Translate changes the position of the item based on a distance given on the x and/or the y axis.
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Figure 12.33: Efecte de Desenare: Dialogul Strălucirii Exterioare

Figure 12.34: Efecte de Desenare: Dialogul de transformare
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There are some common options available for all draw effect types. Transparency and Blend mode options work
similar to the ones described in Randarea stratului and can be used in all draw effects except for the transform
one.

One or more draw effects can used at the same time. You activate/deactivate an effect using its checkbox in the

effects list. You can change the selected effect type by using the Effect type option. You can reorder the

effects using Move up and Move down buttons, and also add/remove effects using the Add effect and
Remove effect buttons.

There is also a Draw mode option available for every draw effect, and you can choose whether to render
and/or to modify the symbol. Effects render from top to bottom.’Render only’ mode means that the effect will be
visible while the ‘Modify only’ mode means that the effect will not be visible but the changes that it applies will
be passed to the next effect (the one immediately below). The ‘Render and Modify’ mode will make the effect
visible and pass any changes to the next effect. If the effect is in the top of the effects list or if the immediately
above effect is not in modify mode, then it will use the original source symbol from the layers properties (similar
to source).

12.3.3 Meniul Etichetelor

The Labels core application provides smart labeling for vector point, line and polygon layers, and only requires
a few parameters. This application also supports on-the-fly transformed layers. The following menus are used to
configure the labeling of vector layers:

• Text

• Formatare

• Tampon

• Fundal

• Umbră

• Pozit,ionare

• Randare

To label a layer start QGIS and load a vector layer. Activate the layer in the legend and click on the
Layer Labeling Options icon in the QGIS toolbar menu or activate the Labels tab in the layer properties dialog.

The first step is to choose the labeling method from the drop-down list. There are four options available:

• Fără etichete

• Arată etichetele pentru acest strat

• Rule-based labeling

• and Discourage other labels from covering features in this layer: allows to set a layer as just an obstacle
for other layer’s labels without rendering any labels of its own.

Select the Show labels for this layer option and then select an attribute column to use for labeling from the Label
with drop-down list. Click if you want to define labels based on expressions - See Definirea etichetelor pe
baza expresiilor.

The following steps describe simple labeling without using the Data defined override functions, which are situated
next to the drop-down menus - see Folosirea suprascrierii definit,iilor de date pentru etichetare for an use-case.

Meniul textului

You can define the text style in the Text menu (see Figure_labels_1). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the Modurile de Fuziune to create effects known from graphics programs.
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Figure 12.35: Etichetarea inteligentă a straturilor de puncte vectoriale
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Meniul de formatare

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’
function. You can format the Line Height and the alignment. For the latter typical values are available plus Follow
label placement. When set to this mode, text alignment for labels will be dependent on the final placement of the
label relative to the point. E.g., if the label is placed to the left of the point then the label will be right aligned, and
if it is placed to the right of the point then the label will be left aligned.

For line vector layers you can include line directions symbols. There are options specifying the type of symbol
and the symbol placement.

Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places may be
inserted. If you enable this option, three decimal places are initially set by default.

Meniul zonei tampon

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.

Here, you can also use blend modes. If the color buffer’s fill checkbox is activated, it will interact with partially
transparent text and give mixed color transparency results. Turning off the buffer fill fixes that issue (except where
the interior aspect of the buffer’s stroke intersects with the text’s fill) and also allows you to make outlined text.

Meniul fundalului

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see Modurile de Fuziune).

Meniul umbrei

Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode.

Meniul de pozit,ionare

Choose the Placement menu for configuring label placement and labeling priority. Note that the placement options
differ according to the type of vector layer, namely point, line or polygon.

Pozit,ionarea straturilor de tip punct

With the Cartographic placement mode, point labels are generated with best visual relationship with the point
feature, following ideal cartographic placement rules. Labels can be placed at a set Distance either from the
point feature itself or from the bounds of the symbol used to represent the feature. The latter option is especially
useful when the symbol size isn’t fixed, e.g. if it’s set by a data defined size or when using different symbols in a
categorized renderer.

În mod implicit, destinat,iile de plasare au următoarea prioritate:
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1. dreapta sus

2. stânga sus

3. dreapta jos

4. stânga jos

5. mijloc dreapta

6. mijloc stânga

7. sus, put,in spre dreapta

8. jos, put,in spre stânga.

Placement priority can however be customized or set for an individual feature using a data defined list of prioritised
positions. This also allows only certain placements to be used, so e.g. for coastal features you can prevent labels
being placed over the land.

The Around point setting places the label in an equal radius (set in Distance) circle around the feature. The
placement of the label can even be constrained using the Quadrant option.

In the Offset from point placement, labels are placed at a fixed offset from the point feature. You can select the
Quadrant in which to place your label. You are also able to set the X and Y offset distances between the points
and their labels and can alter the angle of the label placement with the Rotation setting. Thus, placement in a
selected quadrant with a defined rotation is possible.

Pozit,ionarea straturilor de tip linie

Label options for line layers include Parallel, Curved or Horizontal. For the Parallel and Curved

options, you can set the position to Above line, On line and Below line. It’s possible to select several
options at once. In that case, QGIS will look for the optimal label position. For Parallel and curved placement
you can also use the line orientation for the position of the label. Additionally, you can define a Maximum angle
between curved characters when selecting the Curved option (see Figure_labels_2 ).

For all three placement options you can set up a minimum distance for repeating labels. The distance can be in
mm or in map units.

Pozit,ionarea straturilor de tip poligon

You can choose one of the following options for placing labels in polygons: Offset from centroid, Horizontal
(slow), Around centroid, Free and Using perimeter.

In the Offset from centroid settings you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label within a specific quadrant, and define offset and rotation. The Around centroid setting places the label at
a specified distance around the centroid. Again, you can define visible polygon or whole polygon for the
centroid.

With the Using perimeter settings, you can define a position and a distance for the label. For the position,

Above line, On line, Below line and Line orientation dependent position are possible. You can specify
the distance between the label and the polygon outline, as well as the repeat interval for the label.

In the priority section you can define the priority with which labels are rendered for all three vector layer types
(point, line, polygon). This placement option interact with labels of the other vector layers in the map canvas. If
there are labels from different layers in the same location, the label with the higher priority will be displayed and
the others will be left out.
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Figure 12.36: Etichetarea inteligentă a straturilor vectoriale de tip linie
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Figure 12.37: Etichetarea inteligentă a straturilor de poligoane vectoriale

Meniul de randare

In the Rendering menu, you can tune when the labels can be rendered and their interaction with other labels and
features.

Under Label options, you find the scale-based and the Pixel size-based visibility settings.

The Label z-index determines the order in which labels are rendered, as well in relation with other feature labels in
the layer (using data-defined override expression), as with labels from other layers. Labels with a higher z-index
are rendered on top of labels (from any layer) with lower z-index.

Additionally, the logic has been tweaked so that if 2 labels have matching z-indexes, then:

• if they are from the same layer, the smaller label will be drawn above the larger label

• if they are from different layers, the labels will be drawn in the same order as their layers themselves (ie
respecting the order set in the map legend).

Note that this setting doesn’t make labels to be drawn below the features from other layers, it just controls the
order in which labels are drawn on top of all the layer’s features.

While rendering labels and in order to display readable labels, QGIS automatically evaluates the position of the

labels and can hide some of them in case of collision. You can however choose to Show all labels for this
layer (including colliding labels) in order to manually fix their placement.

With data-defined expressions in Show label and Always Show you can fine tune which labels should be rendered.

Under Feature options, you can choose to label every part of a multi-part feature and limit the number of features
to be labeled. Both line and polygon layers offer the option to set a minimum size for the features to be labeled,
using Suppress labeling of features smaller than. For polygon features, you can also filter the labels to show
according to whether they completely fit within the feature or not. For line features, you can choose to Merge
connected lines to avoid duplicate labels, rendering a quite airy map in conjunction with the Distance or Repeat
options in Placement tab.

From the Obstacles frame, you can manage the covering relation between labels and features. Activate the
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Discourage labels from covering features option to decide whether features of the layer should act as obstacles
for any label (including labels from other features in the same layer). An obstacle is a feature QGIS tries as far as
possible to not place labels over. Instead of the whole layer, you can define a subset of features to use as obstacles,

using the data-defined override control next to the option.

The priority control slider for obstacles allows you to make labels prefer to overlap features
from certain layers rather than others. A Low weight obstacle priority means that features of the layer are less
considered as obstacles and thus more likely to be covered by labels. This priority can also be data-defined, so
that within the same layer, certain features are more likely to be covered than others.

For polygon layers, you can choose the type of obstacle features could be by minimising the labels placement:

• over the feature’s interior: avoids placing labels over interior of polygon (prefers placing labels totally
outside or just slightly inside polygon)

• or over the feature’s boundary: avoids placing labels over boundary of polygon (prefers placing labels
outside or completely inside the polygon). It can be e.g. useful for regional boundary layers, where the
features cover an entire area. In this case it’s impossible to avoid placing labels within these features, and it
looks much better to avoid placing them over the boundaries between features.

Definirea etichetelor pe baza expresiilor

QGIS allows to use expressions to label features. Just click the icon in the Labels menu of the properties
dialog. In figure_labels_4 you see a sample expression to label the alaska regions with name and area size, based
on the field ‘NAME_2’, some descriptive text and the function $area in combination with format_number()
to make it look nicer.

Figure 12.38: Folosirea expresiilor pentru etichetare

Expression based labeling is easy to work with. All you have to take care of is that:

• you need to combine all elements (strings, fields and functions) with a string concatenation function such as
concat, + or ||. Be aware that in some situations (null or numeric value involved) not all of these tools
will fit your need

• s, irurile de caractere ar trebui să fie incluse între ‘ghilimele simple’

• fields are written in “double quotes” or without any quote.
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Să aruncăm o privire asupra câtorva exemple:

# label based on two fields ’name’ and ’place’ with a comma as separator
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ with other texts
’My name is ’ + "name" + ’and I live in ’ + "place"
’My name is ’ || "name" || ’and I live in ’ || "place"
concat(’My name is ’, name, ’ and I live in ’, "place")

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with other texts
# combining different concatenation functions
concat(’My name is ’, name, ’ and I live in ’ || place)

-> My name is John Smith and I live in Paris
-> My name is John Smith # if the field ’place’ is NULL

# multi-line label based on two fields ’name’ and ’place’ with a descriptive text
concat(’My name is ’, "name", ’\n’ , ’I live in ’ , "place")
-> My name is John Smith

I live in Paris

# label based on a field and the $area function
# to show the place name and its rounded area size in a converted unit.
’The area of ’ || "place" || ’ has a size of ’ || round($area/10000) || ’ ha’

-> The area of Paris has a size of 10500 ha

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
concat(’This place is a ’, CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END)

-> This place is a town

As you can see in the expression builder, you have hundreds of functions available to create simple and very
complex expressions to label your data in QGIS. See Expresii chapter for more information and examples on
expressions.

Folosirea suprascrierii definit,iilor de date pentru etichetare

With the data-defined override functions, the settings for the labeling are overridden by entries in the attribute
table. You can activate and deactivate the function with the right-mouse button. Hover over the symbol and you
see the information about the data-defined override, including the current definition field. We now describe an

example using the data-defined override function for the Move label function (see figure_labels_5 ).

1. Importă lakes.shp din setul de date es, antion al QGIS.

2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
‘xlabel’ for X and ‘ylabel’ for Y. The icons are now highlighted in yellow.

4. Transfocare către un lac.

5. Set editable the layer using the Toggle Editing button.

6. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
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(see figure_labels_6). The new position of the label is saved in the ‘xlabel’ and ‘ylabel’ columns of the
attribute table.

Figure 12.39: Labeling of vector polygon layers with data-defined override

Figure 12.40: Deplasarea etichetelor

Etichetarea bazată pe reguli

With Rule-based labeling multiple label configurations can be defined and applied selectively on the base of
expression filters, as in Rule-based rendering.

Rules can be set selecting the corresponding option at the top of the Labels panel (see figure_labels_7 ).

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. Within
the panel you can set the filter expression and the related label configurations.
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Figure 12.41: Panoul de etichetare bazată pe reguli

Figure 12.42: Setările unei reguli
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12.3.4 Meniul Câmpurilor

Within the Fields menu, the field attributes of the selected dataset can be manipulated. The buttons
New Column and Delete Column can be used when the dataset is in Editing mode.

Widget de Editare

Figure 12.43: Dialog to select an edit widget for an attribute column

Within the Fields menu, you also find an edit widget column. This column can be used to define values or a range
of values that are allowed to be added to the specific attribute table column. If you click on the [edit widget]
button, a dialog opens, where you can define different widgets. These widgets are:

• Checkbox: Displays a checkbox, and you can define what attribute is added to the column when the check-
box is activated or not.

• Classification: Displays a combo box with the values used for classification, if you have chosen ‘unique
value’ as legend type in the Style menu of the properties dialog.

• Color: Displays a color button allowing user to choose a color from the color dialog window.

• Date/Time: Displays a line field which can open a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the PostgreSQL provider.

• Nume fis, ier: Simplifică select,ia fis, ierului prin adăugarea unei ferestre de alegere a fis, ierului.

• Hidden: A hidden attribute column is invisible. The user is not able to see its contents.

• Foto: Câmpul cont,ine un nume de fis, ier pentru o imagine. Pot fi definite lăt,imea s, i înălt,imea câmpului.

• Range: Allows you to set numeric values from a specific range. The edit widget can be either a slider or a
spin box.

• Relation Reference: This widget lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Crearea relat,iilor one to many.
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• Text edit (default): This opens a text edit field that allows simple text or multiple lines to be used. If you
choose multiple lines you can also choose html content.

• Unique values: You can select one of the values already used in the attribute table. If ‘Editable’ is activated,
a line edit is shown with autocompletion support, otherwise a combo box is used.

• Generatorul UUID: Dacă acest câmp este gol, atunci va genera un câmp UUID (Identificator Unic Univer-
sal) needitabil.

• Value map: A combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviours: allow null value, order by
value, allow multiple selections and use of autocompleter. The forms will display either a drop-down list or
a line edit field when completer checkbox is enabled.

• Webview: Field contains a URL. The width and height of the field is variable.

Note: QGIS has an advanced ‘hidden’ option to define your own field widget using python and add it to this
impressive list of widgets. It is tricky but it is very well explained in following excellent blog that explains how
to create a real time validation widget that can be used like described widgets. See http://blog.vitu.ch/10142013-
1847/write-your-own-qgis-form-elements

Tip: Căile relative ale controalelor grafice
If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a qgs project with multimedia information
attached. This is enabled only for File Name, Photo and Web View at this moment.

With the Attribute editor layout, you can now define built-in forms (see figure_fields_2). This is useful for data
entry jobs or to identify objects using the option auto open form when you have objects with many attributes. You
can create an editor with several tabs and named groups to present the attribute fields.

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category to insert a tab or
a named group (see figure_fields_3). When creating a new category, QGIS will insert a new tab or named group
for the category in the built-in form. The next step will be to assign the relevant fields to a selected category with

the icon. You can create more categories and use the same fields again.

Alte opt,iuni din caseta de dialog sunt ‘Autogenerare’ s, i ‘Furnizare fis, ier-ui’.

• ‘Autogenerare’ creează editori pentru toate câmpurile s, i îi cataloghează.

• The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-Designer. Us-
ing a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. The form code can be specified in three different ways:

• încarcă din mediul de lucru (de exemplu din startup.py sau dintr-un plugin)

• load from an external file, a file chooser will appear in that case to allow you to select a Python file from
your filesystem

• load from inline code, a Python editor will appear where you can directly type your form code

În toate cazurile, trebuie să introducet,i numele funct,iei care va fi apelată ( open în exemplul de mai jos).

Un exemplu este (în modulul MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")
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Referint,a din funct,iile Init Python este: open

Figure 12.44: Dialogul de creare a categoriilor cu ajutorul Editorului de atribute

12.3.5 Meniul Îmbinărilor

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

În plus, adăugarea dialogului de îmbinare vectorială vă permite să:

• Depozitează stratul îmbinat în memoria virtuală

• Creează indexul atributului pe baza câmpului de jonct,iune

• Aleget,i câmpurile care vor fi îmbinate

• Create a Custom field name prefix
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Figure 12.45: Resulting built-in form with tabs and named groups

Figure 12.46: Alătură un tabel de atribute unui strat vectorial existent
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12.3.6 Meniul Diagramelor

The Diagrams menu allows you to add a graphic overlay to a vector layer (see figure_diagrams_1).

The current core implementation of diagrams provides support for:

• pie charts, a circular statistical graphic divided into slices to illustrate numerical proportion. The arc length
of each slice is proportional to the quantity it represents,

• text diagrams, a horizontaly divided circle showing statistics values inside

• and histograms.

For each type of diagram, the menu is divided into five tabs:

Atribute

Attributes defines which variables to display in the diagram. Use add item button to select the desired fields into
the ‘Assigned Attributes’ panel. Generated attributes with Expresii can also be used.

You can move up and down any row with click and drag, sorting how atributes are displayed. You can also change
the label in the ‘Legend’ column or the attibute color by double-clicking the item.

This label is the default text displayed in the legend of the print composer or of the layer tree.

Figure 12.47: Dialogul proprietăt,ilor vectoriale cu meniul diagramei

Aspectul

Appearance defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• the graphic transparency, its outline width and color

• the width of the bar in case of histogram

• the circle background color in case of text diagram, and the font used for texts

• the orientation of the left line of the first slice represented in pie chart. Note that slices are displayed
clockwise.

In this menu, you can also manage the diagram visibility:
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• by removing diagrams that overlap others or Show all diagrams even if they overlap each other

• by setting the scale visibility

Dimensiuni

Size is the main tab to set how the selected statistics are represented. The diagram size units can be ‘Map Units’
or ‘Millimeters’. You can use :

• Fixed size, an unique size to represent the graphic of all the features, except when displaying histogram

• or Scaled size, based on an expression using layer attributes.

Figure 12.48: Dialogul proprietăt,ilor vectoriale cu meniul diagramei, fila Dimensiunilor

Pozit,ionare

Placement helps to define diagram position. According to the layer geometry type, it offers different options for
the placement:

• ‘Over the point’ or ‘Around the point’ for point geometry. The latter variable requires a radius to follow.

• ‘Over the line’ or ‘Around the line’ for line geometry. Like point feature, the last variable requires a distance
to respect and user can specify the diagram placement relative to the feature (‘above’, ‘on’ and/or ‘below’
the line) It’s possible to select several options at once. In that case, QGIS will look for the optimal position
of the diagram. Remember that here you can also use the line orientation for the position of the diagram.

• ‘Over the centroid’, ‘Around the centroid’ (with a distance set), ‘Perimeter’ and anywhere ‘Inside polygon’
are the options for polygon features.

The diagram can also be placed using feature data by filling the X and Y fields with an attribute of the feature.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider or the z-index value.

Opţiuni

The Options tab has settings only in case of histogram. You can choose whether the bar orientation should be
‘Up’, ‘Down’, ‘Right’ and ‘Left’.
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Tip: Comutarea rapidă între diagrame
Given that almost all the settings above are common to the different types of diagram, when designing your
diagram, you can easily change the diagram type and check which one is more appropriate to your data without
any loss.

Studiu de Caz

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing tempera-
ture data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Date
es, antion).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.

2. Dublu clic pe stratul climate din legenda hărt,ii, pentru a deschide fereastra de dialog a Proprietăt,ilor
Stratului.

3. Click on the Diagrams menu, activate Show diagrams for this layer, and from the Diagram type
combo box, select ‘Text diagram’.

4. In the Appearance tab, we choose a light blue as background color, and in the Size tab, we set a fixed size
to 18 mm.

5. In the Position tab, placement could be set to ‘Around Point’.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

So, in the Attributes tab first select T_F_JAN and click the button, then repeat with T_F_JUL and
finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Activate the Scaled size and set the size of the diagrams on
the basis of the maximum value of an attribute and the Size option. If the diagrams appear too small on the

screen, you can activate the Increase size of small diagrams checkbox and define the minimum size of
the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_3 gives an idea of the result.

10. În cele din urmă, facet,i clic pe [Ok].

Remember that in the Position tab, a Data defined position of the diagrams is possible. Here, you can use
attributes to define the position of the diagram. You can also set a scale-dependent visibility in the Appearance
tab.

The size and the attributes can also be an expression. Use the button to add an expression. See Expresii
chapter for more information and example.

12.3.7 Meniul Acţiunilor

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are divided into six types and can be used like this:

• Act,iunile generice Mac, Windows s, i Unix lansează un proces extern.
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Figure 12.49: Diagrama datelor de temperatură, suprapusă pe o hartă

Figure 12.50: Dialogul de ansamblu al act,iunilor, cu unele act,iuni de probă
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• Act,iunile Python execută o expresie Python.

• Act,iunile generice s, i Python sunt vizibile oriunde.

• Mac, Windows and Unix actions are visible only on the respective platform (i.e., you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them by clicking on [Add default actions]. One
example is performing a search based on an attribute value. This concept is used in the following discussion.

Definirea Act,iunilor

Attribute actions are defined from the vector Layer Properties dialog. To define an action, open the vector Layer
Properties dialog and click on the Actions menu. Go to the Action properties. Select ‘Generic’ as type and provide
a descriptive name for the action. The action itself must contain the name of the application that will be executed
when the action is invoked. You can add one or more attribute field values as arguments to the application. When
the action is invoked, any set of characters that start with a % followed by the name of a field will be replaced by
the value of that field. The special characters %% will be replaced by the value of the field that was selected from
the identify results or attribute table (see using_actions below). Double quote marks can be used to group text into
a single argument to the program, script or command. Double quotes will be ignored if preceded by a backslash.

If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by proceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Două exemple de act,iuni sunt prezentate mai jos:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called
by the action must be in the path, or you must provide the full path. To be certain, we could rewrite the first
example as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will
ensure that the konqueror application will be executed when the action is invoked.

The second example uses the %% notation, which does not rely on a particular field for its value. When the action
is invoked, the %% will be replaced by the value of the selected field in the identify results or attribute table.

Folosirea Act,iunilor

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the pop-up menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the action. Click on the action you
wish to invoke.

Dacă invocat,i o act,iune care utilizează notat,ia %%, facet,i clic dreapta pe valoarea câmpului din dialogul de Identi-
ficare a Rezultatelor sau pe dialogul Tabelei de atribute, pe care dorit,i să le transmitet,i aplicat,iei sau script-ului.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,

12.3. Dialogul Proprietăt,ilor Vectoriale 135
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latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

După selectarea câtorva localităt,i s, i desfăs, urarea act,iunii pentru fiecare dintre ele, deschiderea fis, ierului de ies, ire
va prezenta ceva de genul:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
format is http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Asigurat,i-vă că stratul lakes este încărcat.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Clic pe meniul Actions.

4. Introducet,i un nume pentru act,iune, cum ar fi Google Search.

5. Pentru act,iune, trebuie să furnizăm numele programului extern care va rula. În acest caz, putem folosi
Firefox. În cazul în care programul nu se află în variabila Path, trebuie să-i furnizat,i calea completă.

6. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: http://google.com/search?q=

7. Textul din câmpul Act,iunii‘ar trebui să arate acum astfel: ‘‘firefox http://google.com/search?q=‘

8. Facet,i clic pe caseta derulantă ce cont,ine numele câmpurilor pentru stratul lakes. Este situat în partea
stângă a butonului [Inserare câmp].

9. From the drop-down box, select ‘NAMES’ and click [Insert Field].

10. Act,iunea textului dvs. acum arată astfel:

firefox http://google.com/search?q=%NAMES

11. Pentru a finaliza act,iunea, facet,i clic pe butonul [Add to action list].

This completes the action, and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

We can now use the action. Close the Layer Properties dialog and zoom in to an area of interest. Make sure the
lakes layer is active and identify a lake. In the result box you’ll now see that our action is visible:

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

You can define multiple actions for a layer, and each will show up in the Identify Results dialog.

You can also invoke actions from the attribute table by selecting a row and right-clicking, then choosing the action
from the pop-up menu.

There are all kinds of uses for actions. For example, if you have a point layer containing locations of images or
photos along with a file name, you could create an action to launch a viewer to display the image. You could also
use actions to launch web-based reports for an attribute field or combination of fields, specifying them in the same
way we did in our Google search example.
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Figure 12.51: Selectarea entitatăt,ii s, i alegerea act,iunii

We can also make more complex examples, for instance, using Python actions.

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like a shapefile
or SpatiaLite)? The following code will do the trick:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

We just have to remember that the action is one of type Python and the command and imagerelpath variables must
be changed to fit our needs.

But what about if the relative path needs to be relative to the (saved) project file? The code of the Python action
would be:

command="firefox"
imagerelpath="images/test_image.jpg"
projectpath=qgis.core.QgsProject.instance().fileName()
import os.path
path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None
image=os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Another Python action example is the one that allows us to add new layers to the project. For instance, the
following examples will add to the project respectively a vector and a raster. The names of the files to be added to
the project and the names to be given to the layers are data driven (filename and layername are column names of
the table of attributes of the vector where the action was created):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,
’[% "layername" %]’, ’ogr’)
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Pentru a adăuga un raster (o imagine TIF în acest exemplu), devine:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,
’[% "layername" %]’)

12.3.8 Meniul de Afis, are

This menu is specifically created for Map Tips. It includes a nice feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is also possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → Map Tips.

Figure Display 1 and 2 show an example of HTML code and how it behaves in map canvas.

Figure 12.52: HTML code for map tip

Figure 12.53: Map tip made with HTML code

138 Chapter 12. Lucrul cu Datele Vectoriale



QGIS User Guide, Release 2.14

12.3.9 Meniul de Randare

QGIS oferă suport pentru generalizarea din zbor a entităt,ilor. Acest lucru poate îmbunătăt,i timpul de randare în
momentul desenării la scări mici a unei multitudini de entităt,i complexe. Această caracteristică poate fi activată

sau dezactivată în setările stratului, folosind opt,iunea de Simplificare a geometriei. Există, de asemenea, un
nou cadru global care permite, în mod implicit, generalizarea pentru straturile nou adăugate (v. sect,iunea Opţiuni).

Figure 12.54: Dialogul de Simplificare a Stratului de Geometrie

Note: Feature generalisation may introduce artefacts into your rendered output in some cases. These may include
slivers between polygons and inaccurate rendering when using offset-based symbol layers.

While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
composer exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

Checking Force layer to render as raster forces these layers to be rasterised so that the exported files won’t
have to include all the nodes contained in these layers and the rendering is therefore sped up.

You can also do this by forcing the composer to export as a raster, but that is an all-or-nothing solution, given that
the rasterisation is applied to all layers.

12.3.10 Meniu Metadate

The Metadata menu consists of Description, Attribution, MetadataURL, LegendUrl and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and loca-
tion, number of features, feature type, and editing capabilities. The Extents table provides you with information
on the layer extent and the Layer Spatial Reference System, which is information about the CRS of the layer. This
can provide a quick way to get useful information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title
from an XML metadata file, you have to fill in a link in the DataUrl field.

Use Attribution to get attribute data from an XML metadata catalogue.

In MetadataUrl, you can define the general path to the XML metadata catalogue. This information will be saved
in the QGIS project file for subsequent sessions and will be used for QGIS server.
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QGIS User Guide, Release 2.14

In the LegendUrl section, you can provide the url of a legend image in the url field. You can use the Format
drop-down option to apply the appropriate format of the image. Currently png, jpg and jpeg image formats are
supported.

Figure 12.55: Meniul metadatelor din fereastra de proprietăt,i a stratului vectorial

12.3.11 Salvarea s, i Partajarea Proprietăt,ilor Stratului

Gestionarea Stilurilor Personalizate

When a layer is added to map canvas, QGIS uses by default a random symbol/color to render its features. You can
however set a default symbol in Project → Properties → Default styles that will be applied to each newly added
layer according to its geometry type.

But, most of the time, you’d prefer to have a custom and more complex style that can be applied automatically or
manually (with less efforts) to the layers. You can achieve this goal using the Style combobox at the bottom of the
Layer Properties dialog. This combobox provides you with functions to create, load and manage styles.

A style stores any information set in the layer properties dialog to render or interact with the features (including
symbology, labeling, action, diagram... settings).

By default, the style applied to a loaded layer is named default. Once you have got the ideal and appropriate

rendering for your layer, you can save it by clicking the Style combobox and choose:

• Rename Current: The active style gets renamed and updated with the current options

• Adăugare: Creează un nou stil, folosind opt,iunile curente.

At the bottom of the Style drop-down list, you see the styles set for the layer and the active one is checked. Once
you have more than one style defined for a layer, a Remove Current option can help you delete those you no
longer want.

Note that each time you validate the layer properties dialog, the active style is updated with the changes you’ve
done.
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Figure 12.56: Opt,iunile Casetei Stilului

You can create as many styles as you wish for a layer but only one can be active at a time. Combined to layer
visibility preset, this offers a quick and powerful way to manage complex projects with few layers (no need to
duplicate any layer in the map legend).

Tip: Manage styles from layer context menu
Right-click on the layer in Layers Panel to add, rename or remove layer style. You can also edit feature symbols.

Stocarea Stilului într-un Fis, ier sau într-o Bază de date

While these styles are saved inside the project and can be copied and pasted from layer to layer in the project,
it’s also possible to save them outside the project so that they can be loaded in another project. Clicking the

Style → Save Style saves the symbol as a QGIS layer style file (.qml) or SLD file (.sld). SLDs can be
exported from any type of renderer – single symbol, categorized, graduated or rule-based – but when importing
an SLD, either a single symbol or rule-based renderer is created. That means that categorized or graduated styles
are converted to rule-based. If you want to preserve those renderers, you have to stick to the QML format. On the
other hand, it can be very handy sometimes to have this easy way of converting styles to rule-based.

If the datasource of the layer is a database (PostGIS or Spatialite for example), you can also save your layer style
inside a table of the database. Just click on Save Style combobox and choose Save in database item then fill in the
dialog to define a style name, add a description, an ui file if applicable and check if the style is the default style.
You can add several style in the database. However each table can have only one default style.

When loading a layer in QGIS, if a default style already exists for this layer, QGIS will load the layer and its style.
After you modified the layer style, you can Save as Default, creating a new style that becomes the default one or
Restore Default style if you’re not satisfied.

Tip: Partajarea rapidă a stilului unui strat în interiorul proiectului
You can also share layer style within a project without importing a file or database style: right-click on the layer
in the Layers Panel and, from the Styles combobox , copy the style of a layer and paste it to a group or a selection
of layers: the style is applied to all the layers that are of the same type (vector vs raster) as the original layer and,
in case of vector, have the same geometry type (point, line or polygon).
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Figure 12.57: Dialogul de Salvare a Stilului în baza de date

12.4 Expresii

Funct,ionalitatea Expresiilor este disponibilă în mai multe zone ale QGIS. Aceasta poate fi accesată de către
Constructorul de Expresii, Selectarea după o Expresie..., opt,iunea stratului pentru simboluri de tipul Generator de Geome-

trie, Calculatorul de câmpuri sau instrumentul de Suprascriere a definit,iilor cu ajutorul datelor. Pe baza datelor stratului
s, i a funct,iilor precompilate sau definite de utilizator, vi se oferă o modalitate puternică de a manipula valorile
atributelor, geometria s, i variabilele, în scopul schimbării, în mod dinamic, a stilului de geometrie, a cont,inutului
sau a pozit,iei etichetei, valoarea diagramei, înălt,imea unui element de compozitor, select,ia unele entităt,i, crearea
câmpului virtual ...

Câteva exemple:

• De la câmp Calculator, se calculează câmpul “pop_density” folosind câmpurile existente “total_pop” s, i
“area_km2”:

"total_pop" / "area_km2"

• Actualizarea câmpului “density_level” cu categorii, în funct,ie de valorile “pop_density”:

CASE WHEN "pop_density" < 50 THEN ’Low population density’
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN ’Medium population density’
WHEN "pop_density" >= 150 THEN ’High population density’

END

• Aplicarea unui stil categorisit pentru toate entităt,ile, în funct,ie de pret,ul mediu al casei, dacă este mai mică
sau mai mare de 10000C pe metru pătrat:

"price_m2" > 10000

• Folosind instrumentul de “Selectare După Expresie...”, selectat,i toate entităt,ile care reprezintă zonele cu
“Densitate ridicată a populat,iei” s, i în care pret,ul mediu pentru o casă este mai mare de 10000C pe metru
pătrat:

"density_level" = ’High population density’ and "price_m2" > 10000

În acelaşi mod, expresia anterioară ar putea fi utilizată pentru a stabili ce entităt,i trebuie să fie etichetate sau afis, ate
pe hartă. Folosirea expresiilor vă oferă o mult,ime de posibilităt,i.

Expresiile oferă acces la:

• fila Expresiilor, care enumeră funct,iile ce pot fi utilizate

• fila Editorului de Funct,ii care ajută la crearea unor funct,ii personalizate, dedicate utilizării în expresii.
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12.4.1 Lista Funcţiilor

Figure 12.58: Fila Expresiilor

Fila Expresiilor cont,ine, alături de funct,ii, câmpurile s, i valorile stratului. Ea cont,ine controale grafice pentru:

• introducerea de expresii care utilizează funct,ii s, i/sau câmpuri. O previzualizare a rezultatului expresiei este
afis, ată în partea de jos a dialogului.

• selectarea funct,iei adecvate dintr-o listă. O casetă de căutare este disponibilă pentru a filtra lista s, i pentru
a găsi rapid o anumită funct,ie sau un câmp. Un dublu-clic pe numele unui element va produce adăugarea
acestuia în expresia introdusă.

• afis, area ajutorului pentru fiecare funct,ie selectată. Atunci când un câmp este selectat, acest control grafic
prezintă o mostră a valorilor sale. Un dublu-clic pe o valoare va produce adăugarea acesteia în expresia
introdusă.

Pentru a găsi rapid o funct,ie, acestea sunt organizate în grupuri. În Operatori, găsit,i operatorii matematici. Uitat,i-
vă în Matematică pentru funct,ii matematice. Grupul Conversiilor cont,ine funct,ii care transformă un tip de date
într-altul. Grupul S, irurilor oferă funct,ii pentru s, iruri de date, cum ar fi Data s, i Ora, care se ocupă de dată s, i oră.
În grupul Geometriilor, vet,i găsi funct,ii pentru obiectele geometrice. Cu ajutorul grupului de funct,ii Înregistrare,
putet,i adăuga o numerat,ie setului dvs. de date, în timp ce grupul Câmpurilor s, i Valorilor ajută la vizualizarea
tuturor atributelor tabelului de atribute. Grupul funct,iilor Personalizate cont,ine funct,iile create sau importate de
către utilizator. Există multe alte grupuri, enumerate mai jos.

Operatori

Acest grup cuprinde operatorii (ex.: +, -, *). De notat că pentru majoritatea funct,iilor matematice de mai jos, în
cazul în care una dintre intrări are valoarea NULL, atunci rezultatul este NULL.
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Funct,ia Descriere
a + b Adunarea a două valori (a plus b)
a - b Scăderea a două valori (a minus b)
a * b Înmult,irea a două valori (a înmult,it cu b)
a / b Împărt,irea a două valori (a împărt,it la b)
a % b Restul împărt,irii lui a la b (ex.: 7 % 2 = 1, sau 2 se potrives, te de trei ori în 7, având

restul 1)
a ^ b Puterea a două valori (de exemplu, 2^2=4 or 2^3=8)
a < b Compară două valori s, i le evaluează la 1, dacă valoarea din stânga este mai mică decât

cea din dreapta. (a este mai mic decât b)
a <= b Compară două valori s, i le evaluează la 1, dacă valoarea din stânga este mai mică sau

egală cu cea din dreapta
a <> b Compară două valori, s, i le evaluează la 1 dacă acestea nu sunt egale
a = b Compară două valori s, i le evaluează la 1, dacă acestea sunt egale
a != b a s, i b nu sunt egale
a > b Compară două valori s, i le evaluează la 1, dacă valoarea din stânga este mai mare decât

cea din dreapta (a este mai mare decât b)
a >= b Compară două valori s, i le evaluează la 1, dacă valoarea din stânga este mai mare sau

egală cu cea din dreapta
a ~ b a se potrives, te cu expresia regulată b
|| Îmbină două valori într-un s, ir. Dacă una dintre valori este NULL, atunci rezultatul va fi

NULL.
‘\n’ Introduce o nouă linie într-un s, ir
LIKE Returnează 1 dacă primul parametru se potrives, te cu modelul furnizat
ILIKE Returnează 1 dacă primul parametru se potrives, te, în mod insensibil la context, cu

modelul furnizat. (ILIKE poate fi folosit în loc de LIKE, pentru a realiza o identificare
insensibilă la context)

a IS b Stabiles, te dacă două valori sunt identice. Returnează 1 dacă a este similar cu b
a OR b Returnează 1 atunci când condit,iile a sau b sunt adevărate
a AND b Returnează 1 atunci când condit,iile a s, i b sunt adevărate
NOT Neagă o condit,ie
nume de coloană
“numele coloanei”

Valoarea din câmpul reprezentat de numele coloanei; a se vedea mai jos, pentru a nu
face confuzie cu ghilimelele simple

‘s, ir’ o valoare de tip s, ir; a se vedea mai sus, pentru a nu face confuzie cu ghilimelele duble
NULL valoarea NULL
a IS NULL a nu are nici o valoare
a IS NOT NULL a are o valoare
a IN
(value[,value])

a se află în lista de valori

a NOT IN
(value[,value])

a nu se află în lista de valori

Câteva exemple:

• Îmbină un s, ir cu o valoare din numele unei coloane:

’My feature’’s id is: ’ || "gid"

• Testat,i dacă atributul câmpului “description” începe cu s, irul ‘Hello’ (notat,i pozit,ia caracterului %):

"description" LIKE ’Hello%’

Condit,ionări

Acest grup cont,ine funct,ii care gestionează verificările condit,ionale din expresii.
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Funct,ia Descriere
CASE WHEN ...
THEN ... END

Evaluează o expresie s, i returnează un rezultat dacă este adevărat. Avet,i
posibilitatea să testat,i mai multe condit,ii

CASE WHEN ...
THEN ... ELSE ...
END

Evaluează o expresie s, i returnează diverse rezultate, în funct,ie de valorile
returnate, true sau false. Avet,i posibilitatea de a testa mai multe condit,ii

coalesce Returnează prima valoare non-NULL din lista de expresii
if Teste o condit,ie s, i returnează un rezultat diferit, în funct,ie de verificarea

condit,ională
regexp_match Returneaza true dacă orice parte dintr-un s, ir se potrives, te cu expresia regulată

specificată

Câteva exemple:

• Trimite înapoi o valoare în cazul în care prima condit,ie este adevărată, altfel, transmite o altă valoare:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’ END

Funct,iile Matematice

Acest grup cont,ine funct,ii matematice (ex.: rădăcina pătrată, sin s, i cos).

Funct,ia Descriere
abs Returnează valoarea absolută a unui număr
acos Returnează cosinusul invers al unei valori, în radiani
asin Returnează sinusul invers al unei valori, în radiani
atan Returnează cosinusul invers al unei valori, în radiani
atan2(y,x) Returnează tangenta inversă a y/d, folosind semnele a două argumente pentru a determina

cadranul rezultatului
az-
imuth(a,b)

Returnează azimutul, în funct,ie de nord, ca unghiul măsurat în radiani, în sens orar, pe verticală,
de la punctul a la punctul b

ceil Rotunjes, te în sus un număr
clamp Restrict,ionează într-un interval specificat o valoare de intrare
cos Returnează cosinusul unei valori, în radiani
degrees Convertes, te din radiani în grade
exp Returnează exponentul unei valori
floor Rotunjes, te în jos un număr
ln Returnează logaritmul natural al expresiei transmise
log Returnează valoarea logaritmului pentru valoarea s, i baza transmise
log10 Returnează valoarea logaritmului în baza 10 pentru expresia transmisă
max Returnează cea mai mare valoare dintr-un set de valori
min Returnează cea mai mică valoare dintr-un set de valori
pi Returnează valoarea pi, pentru calcule
radians Convertes, te din grade în radiani
rand Returnează un număr aleator întreg, în intervalul specificat de argumentele minim s, i maxim

(inclusiv).
randf Returnează un număr aleator zecimal, în intervalul specificat de argumentele minim s, i maxim

(inclusiv)
round Rotunjes, te la numărul de pozit,ii zecimale
scale_exp Transformă o valoare dată dintr-un domeniu de intrare la un interval de ies, ire, folosind o curbă

exponent,ială
scale_linear Transformă o valoare dată dintr-un domeniu de intrare la un interval de ies, ire, folosind o

interpolare liniară
sin Returnează sinusul unui unghi
sqrt Returnează rădăcina pătrată a unei valori
tan Returnează tangenta unui unghi
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Funct,iile Culorilor

Acest grup cont,ine funct,ii pentru manipularea culorilor.

Funct,ia Descriere
color_cmyk Returnează o reprezentare de tip s, ir a unei culori, în funct,ie de componentele ei cyan, magenta,

galben s, i negru
color_cmyka Returnează o reprezentare de tip s, ir a unei culori, în funct,ie de componentele ei cyan, magenta,

galben, negru s, i alpha (transparent,ă)
color_hsl Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei s, i

luminozităt,ii
color_hsla Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei, luminozităt,ii

s, i alpha (transparent,ă)
color_hsv Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei s, i valorii
color_hsva Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei, valorii s, i

alpha (transparent,ă)
color_part Returnează o componentă specifică dintr-un s, ir de culoare, de exemplu, o componentă ros, ie sau

o componentă alfa
color_rgb Returnează o reprezentare de tip s, ir a culorii, pe baza componentelor ros, ie, verde s, i albastră
color_rgba Returnează o reprezentare de tip s, ir a culorii, pe baza componentelor ros, ie, verde, albastră s, i

alpha (transparent,ă)
darker Returnează o culoare, de tip s, ir, mai închisă (sau mai deschisă)
lighter Returnează o culoare, de tip s, ir, mai deschisă (sau mai închisă)
project_colorReturnează o culoare din schema de culori a proiectului
ramp_color Returnează o reprezentare de tip s, ir a culorii, dintr-un interval de culori
set_color_partSetează o componentă de culoare specifică pentru un s, ir de culoare, cum ar fi o componentă

ros, ie sau o componentă alfa

Conversii

Acest grup cont,ine funct,ii pentru transformarea dintr-un tip de dată în altul (ex.: din s, ir în întreg, din întreg în s, ir).

Funct,ia Descriere
to_date Convertes, te un s, ir într-un obiect de tip dată
to_datetime Convertes, te un s, ir într-un obiect datetime
to_int Convertes, te un s, ir într-un număr întreg
to_interval Convertes, te un s, ir într-un interval (poate fi folosit pentru a returna zilele, orele, lunile, etc

dintr-o dată)
to_real Convertes, te un s, ir într-un număr real
to_string Convertes, te un număr într-un s, ir
to_time Convertes, te un s, ir într-un obiect time

Funct,ii personalizate

Acest grup cont,ine funct,ii create de către utilizatori. Vedet,i function_editor pentru mai multe detalii.

Funct,ii pentru Dată s, i Oră

Acest grup cont,ine funct,ii care gestionează datele calendaristice s, i ora.
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Funct,ia Descriere
age Returnează diferent,a dintre două date sau de tip datetimes, sub formă de interval
day Extrage ziua dintr-o dată sau dintr-o valoare datetime, sau numărul de zile dintr-un interval.
day_of_week Returnează un număr corespunzător zilei din săptămână, pentru data sau valoarea datetime

specificată
hour Extrage partea corespunzătoare orei dintr-o valoare datetime sau time, sau numărul de ore

dintr-un interval
minute Extrage partea corespunzătoare minutelor dintr-o valoare datetime sau time, sau numărul de

minute dintr-un interval.
month Extrage partea corespunzătoare lunii dintr-o valoare datetime sau time, sau numărul lunii

dintr-un interval.
now() Returnează data s, i ora curente
secundă Extrage partea corespunzătoare secundelor dintr-o valoare time sau datetime, sau numărul de

secunde dintr-un interval
week Extrage numărul săptămânii dintr-o valoare date sau datetime, sau numărul de săptămâni

dintr-un interval
year Extrage partea corespunzătoare anului dintr-o valoare datetime sau time, sau numărul de ani

dintr-un interval

Câteva exemple:

• Obt,ine luna s, i anul curente, în formatul “10/2014”

month(now()) || ’/’ || year(now())

Fields and Values

Cont,ine o listă de câmpuri dintr-un strat.

În general, putet,i utiliza diferite câmpuri, valori s, i funct,ii, pentru a construi expresia de calcul, sau o putet,i intro-
duce în casetă, pur s, i simplu.

Pentru a afis, a valorile unui câmp, trebuie doar să facet,i clic pe câmpul corespunzător s, i să aleget,i între Încărcarea
primelor 10 valori s, i Încărcarea tuturor valorilor unice. În partea dreaptă se află lista cu Valorile Câmpurilor,
în care sunt extrase valorile unice. În partea de sus a listei, o casetă de căutare ajută la filtrarea valorilor. Pentru a
adăuga o valoare expresiei pe care o scriet,i, facet,i dublu clic pe numele ei.

De asemenea, valorile es, antion pot fi accesate printr-un clic-dreapta. Selectat,i numele câmpului din listă, apoi
efectuat,i un clic-dreapta pentru a accesa meniul contextual cu opt,iuni, pentru a încărca valorile es, antion din câmpul
selectat.

În cadrul expresiei, numele câmpurilor ar trebui să se afle între ghilimele duble. Valorile sau s, irurile trebuie să fie
incluse între ghilimele simple.

Funct,ii pentru Potrivirea Fuzzy

Acest grup cont,ine funct,ii pentru comparat,ii fuzzy între valori.

Funct,ia Descriere
ham-
ming_distance

Returnează numărul de caractere la pozit,iile corespunzătoare acelora din s, irurilor de intrare,
ale căror caractere sunt diferite

levensheim Returnează numărul minim de modificări de caractere (inserări, s, tersături sau înlocuiri)
necesare pentru a schimba un s, ir într-altul. Măsoară similitudinea dintre două s, iruri

longest_common_substringReturnează cel mai lung subs, ir comun dintre două s, iruri
soundex Returnează reprezentarea Soundex a unui s, ir de caractere

Funct,ii Generale

Acest grup cont,ine diverse funct,ii generale.
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Funct,ia Descriere
eval Evaluează o expresie care este transmisă într-un s, ir. Foloses, te pentru a extinde parametrii

dinamici transmis, i ca variabile de context sau câmpuri
layer_propertyReturnează o proprietate a unui strat sau o valoare a metadatelor sale. Aceasta poate fi numele

stratului, crs-ul, tipul geometriei, numărul de entităt,i...
var Returnează valoarea stocată într-o variabilă specificată. A se vedea funct,iile variabile de mai jos

Funct,ii Geometrice

Acest grup cont,ine funct,ii care operează asupra geometriei obiectelor (de ex.: lungimea, suprafat,a).

Funct,ia Descriere
$area Returnează aria entităt,ii curente
$geometry Returnează geometria entităt,ii curente (se poate folosi pentru prelucrarea cu alte funct,ii)
$length Returnează lungimea entităt,ii curente de tip linie
$perimeter Returnează perimetrul entităt,ii curente de tip poligon
$x Returnează coordonata x a entităt,ii curente
$x_at(n) Returnează coordonata x al nodului n din geometria entităt,ii curente
$y Returnează coordonata y a entităt,ii curente
$y_at(n) Returnează coordonata y a nodului n din geometria entităt,ii curente
area Returnează aria unei entităt,i de geometrie poligonală. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
bounds Returnează o geomerie care reprezintă caseta de încadrare a unei geometrii de intrare. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei Geometrii
bounds_height Returnează înălt,imea unei casete de încadrare a unei geometrii. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei Geometrii
bounds_width Returnează lăt,imea casetei de încadrare a unei geometrii. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei Geometrii
buffer Returnează o geometrie care reprezintă toate punctele a căror distant,ă de la această geometrie este mai mică sau egală cu distant,a specificată. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
centroid Returnează centrul geometric al unei geometrii
closest_point Returnează cel mai apropiat punct al unei geometrii fat,ă de o alta
combine Returnează combinat,ia a două geometrii
contains(a,b) Returnează 1 (true) dacă s, i numai dacă nici un punct al geometriei b nu se află în exteriorul geometriei a, s, i cel put,in un punct din interiorul lui b se află în interiorul lui a
convex_hull Returnează anvelopa convexă a unei geometrii (aceasta reprezentând geometria convexă minimă care include toate geometriile din cadrul setului)
crosses Returnează 1 (true) dacă geometriile respective au unele puncte interioare, dar nu toate, în comun
difference(a,b) Returnează o geometrie care reprezintă port,iunea din geometria a care nu se intersectează cu geometria b
disjoint Returnează 1 (true) dacă geometriile nu partajează nici un fel de spat,iu
distance Returnează distant,a minimă (bazată pe referint,a spat,ială) dintre două geometrii în unităt,i proiectate
end_point Returnează ultimul nod dintr-o geometrie
exterior_ring Returnează o linie sub formă de s, ir, reprezentând inelul exterior al unei geometrii de tip poligon. În cazul în care geometria nu reprezintă un poligon, atunci rezultatul va fi null
extrude(geom,x,y) Returnează o versiune extrudată a intrării (Multi-)Curbă sau o geometrie (Multi-)Linie având o extensie specificată de x s, i y
geom_from_gml Returnează geometria dintr-o reprezentare GML a unei geometrii
geom_from_wkt Returnează o geometrie creată dintr-o reprezentare Well-Known Text (WKT)
geom_to_wkt Returnează reprezentarea Well-Known Text (WKT) a unei geometrii, fără metadatele SRID
geometrie Returnează geometria unei entităt,i
geometry_n Returnează geometria n dintr-o colect,ie de geometrii, sau null dacă geometria de intrare nu reprezintă o colect,ie
interior_ring_n Returnează inel interior n dintr-o geometrie poligonală, sau null dacă geometria de intrare nu reprezintă un poligon
intersection Returnează o geometrie care reprezintă port,iunea comună a două geometrii
intersects Testează dacă o geometrie intersectează o alta. Returnează 1 (true) dacă geometriile se intersectează spat,ial (partajează oricare parte din spat,iu) s, i 0 în caz contrar
intersects_bbox Testează dacă o casetă de încadrare a unei geometrii intersectează o alta. Returnează 1 (true) dacă geometriile se intersectează (partajează oricare parte din spat,iu) s, i 0 în caz contrar
is_closed Returnează true dacă o linie sub formă de s, ir este închisă (punctele de start s, i de final coincid), false dacă linia nu este închisă s, i null dacă geometria nu reprezintă o linie sub formă de s, ir
length Returnează lungimea unei entităt,i cu geometria de tip linie (sau lungimea unui s, ir de caractere)
m Returnează valoarea m dintr-o geometrie de tip punct
make_line Creează o geometrie de tip linie, dintr-o serie de geometrii de tip punct
make_point(x,y,z,m) Returnează o geometrie de tip punct din valorile x s, i y (s, i opt,ional valorile z s, i m)
make_point_m(x,y,m) Creează o geometrie de tip punct din coordonatele x, y s, i din valoarea m
make_polygon Creează o geometrie de tip poligon, dintr-un inel exterior s, i dintr-o serie de geometrii inelare interioare
nodes_to_points Returnează o geometrie multipunct constând în fiecare nod din geometria de intrare
num_geometries Returnează numărul de geometrii dintr-o colect,ie geometrică, sau null dacă geometria de intrare nu reprezintă o colect,ie
num_interior_rings Returnează numărul de inele interioare dintr-un poligon sau dintr-o colect,ie geometrică, sau null dacă geometria de intrare nu reprezintă un poligon sau o colect,ie

Continued on next page
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Table 12.1 – continued from previous page
Funct,ia Descriere
num_points Returnează numărul de vertecs, i dintr-o geometrie
num_rings Returnează numărul de inele (incluzând inelele exterioare) dintr-un poligon sau dintr-o colect,ie geometrică, sau null dacă geometria de intrare nu reprezintă un poligon sau o colect,ie
order_parts Ordonează părt,ile unei MultiGeometrii după anumite criterii
overlaps Testează dacă o geometrie se suprapune peste alta. Returnează 1 (true) dacă geometriile partajează un spat,iu, sunt de aceeas, i dimensiune, dar nu sunt complet cont,inute una în cealaltă
perimeter Returnează perimetrul unei entităt,i de geometrie poligonală. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
point_n Returnează un nod specific dintr-o geometrie
point_on_surface Returnează un punct care, garantat, se situează pe suprafat,a unei geometrii
relate Testează sau returnează Modelul Dimensional Extins cu 9 Intersect,ii (DE-9IM), de reprezentare a relat,iilor dintre două geometrii
reverse Inversează direct,ia unui s, ir de tip linie, prin inversarea ordinii vertecs, ilor săi
segments_to_lines Returnează o geometrie multi linie constând într-o linie pentru fiecare segment din geometria de intrare
shortest_line Returnează cea mai scurtă linie care unes, te două geometrii. Linia rezultată va începe la geometria 1 s, i se va încheia la geometria 2
start_point Returnează primul nod dintr-o geometrie
sym_difference Returnează o geometrie care reprezintă port,iunea comună a două geometrii care nu se intersectează
touches Testează dacă o geometrie o atinge pe alta. Returnează 1 (true) dacă geometriile respective au cel put,in un punct în comun, dar interioarele lor nu se intersectează
transform Returnează geometriea transformată dintr-un CRS sursă într-un CRS destinat,ie
translate Returnează o versiune deplasată a unei geometrii. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
union Returnează o geometrie care reprezintă setul de puncte reunit al geometriilor
within (a,b) Testează dacă o geometrie este cont,inută în alta. Returnează 1 (true) dacă geometria a este complet inclusă în geometria b
x Returnează coordonata x a unei geometrii de tip punct, sau coordonata x a centrului de greutate pentru o geometrie non-punct.
x_min Returnează coordonata x minimă a unei geometrii. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
x_max Returnează coordonata x maximă a unei geometrii. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
y Returnează coordonata y a unei geometrii de tip punct, sau coordonata y a centrului de greutate pentru o geometrie non-punct
y_min Returnează coordonata y minimă a unei geometrii. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
y_max Returnează coordonata y maximă a unei geometrii. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
z Returnează coordonata z dintr-o geometrie de tip punct

Câteva exemple:

• Returnează coordonata x a centroidului entităt,ii curente:

x($geometry)

• Trimite înapoi o valoare în funct,ie de suprafat,a entităt,ii:

CASE WHEN $area > 10 000 THEN ’Larger’ ELSE ’Smaller’ END

Funct,iile Înregistrărilor

Acest grup cont,ine funct,ii care operează asupra identificatorilor de înregistrare.

Funct,ia Descriere
$cur-
rentfea-
ture

Returnează entitatea care este evaluată în mod curent. Se poate utiliza cu funct,ia ‘atribut’ pentru a
evalua valorile atributelor din entitatea curentă.

$id Returnează id-ul entităt,ii din rândul curent
$map Returnează ID-ul elementului curent al hărt,ii, în cazul în care harta este desenată într-o

compozit,ie, sau “canvas” în cazul în care harta este în desenată în cadrul ferestrei principale QGIS
$rownum Returnează numărul rândului curent
$scale Returnează scara curentă a canevasului hărt,ii
atribut Returnează valoarea unui atribut specificat dintr-o entitate.
get_feature Returnează prima entitate a unui strat, care se potrives, te cu o valoare de atribut dată.
uuid Generează un Identificator Unic Universal (UUID) pentru fiecare rând. Fiecare UUID are o

lungime de 38 caractere

Câteva exemple:

• Returnează prima entitate din stratul “LayerA”, al cărui câmp “id” are aceeas, i valoare ca s, i câmpul “nume”
al entităt,ii curente (un fel de relat,ie):
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get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) )

• Se calculează aria entităt,ii îmbinate, din exemplul anterior:

area( geometry( get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) ) ) )

Funct,ii pentru S, iruri

Acest grup cont,ine funct,ii care operează asupra s, irurilor, (de ex: înlocuirea, conversia în majuscule).

Funct,ia Descriere
concat Concatenează mai multe s, iruri într-unul
format Formatează un s, ir folosind argumentele furnizate
for-
mat_date

Formatează un tip de dată sau un s, ir într-un format personalizat de tip text

for-
mat_number

Returnează un număr formatat, cu separatorul local pentru mii (trunchiază, de asemenea, la
numărul de cifre specificate)

left(string,
n)

Returnează un subs, ir care cont,ine n caractere din stânga s, irului

length Returnează lungimea unui s, ir (sau lungimea unei entităt,i cu geometria de tip linie)
lower Convertes, te un s, ir în litere mici
lpad Returnează un s, ir completat până la lungimea dorită, folosind un caracter de umplere
reg-
exp_replace

Returnează s, irul înlocuit cu expresia regulată furnizată

reg-
exp_substr

Returnează port,iunea dintr-un s, ir care se potrives, te cu expresia regulată specificată

replace Returnează s, irul înlocuit cu expresia regulată furnizată
right(string,
n)

Returnează un subs, ir care cont,ine n caractere din stânga s, irului

rpad Returnează un s, ir completat până la lungimea dorită, folosind un caracter de umplere
strpos Returnează s, irul înlocuit cu expresia regulată furnizată
substr Returnează o parte dintr-un s, ir
title Convertes, te, în nume proprii, toate cuvintele unui s, ir (toate cuvintele fiind scrise cu minuscule,

având o majusculă la început).
trim Elimină toate spat,iile albe de la începutul s, i de la sfârs, itul unui s, ir (spat,ii, tab-uri, etc)
upper Convertes, te un s, ir în majuscule.
wordwrap Returnează un s, ir cu un număr maxim/minim de caractere per linie

Funct,ii Recente

Acest grup cuprinde funct,iile utilizate recent. Funct,iile utilizate în dialogul Expresiilor sunt adăugate în listă, fiind
ordonate începând de la cea mai recent utilizată. Acest lucru ajută la preluarea rapidă a oricărei expresii anterioare.

Funct,ii Variabile

Acest grup cuprinde variabile dinamice referitoare la aplicat,ie, fis, ierul de proiect s, i alte setări. Aceasta înseamnă
că anumite funct,ii pot nu fie disponibile, în funct,ie de context:

• din dialogul Select by expression

• din dialogul Field calculator

• din dialogul cu proprietăt,ile stratului

• din compozitorul de hărt,i
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Pentru a utiliza aceste funct,ii într-o expresie, acestea ar trebui să fie precedate de caracterul @ (ex.:
@row_number). Sunt luate în considerare:
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Funct,ia Descriere
atlas_feature Returnează entitatea curentă a atlasului (ca obiect entitate)
atlas_featureid Returnează ID-ul entităt,ii curente a atlasului
atlas_featurenumber Returnează numărul de pagini din compozit,ie
atlas_filename Returnează numele curent al fis, ierului atlasului
atlas_geometry Returnează geometria entităt,ii curente a atlasului
atlas_pagename Returnează numele paginii curente a atlasului
atlas_totalfeatures Returnează numărul total de entităt,i din atlas
grid_axis Returnează axele actuale ale adnotării din grilă (de exemplu, ‘x’ pentru longitudine, ‘y’ pentru latitudine)
grid_number Returnează valoarea actuală a adnotării din grilă
item_id Returnează ID-ul de utilizator pentru elementul compozitorului (nu neapărat unic)
item_uuid Returnează ID-ul unic pentru elementul compozitorului
layer_id Returnează ID-ul stratului curent
layer_name Returnează numele stratului curent
layout_dpi Returnează rezolut,ia compozit,iei (DPI)
layout_numpages Returnează numărul de pagini din compozit,ie
layout_pageheight Returnează înălt,imea compozit,iei, în mm
layout_pagewidth Returnează lăt,imea compozit,iei, în mm
map_id Returnează ID-ul destinat,iei hărt,ii curente. Acesta va fi ‘canvas’ pentru rendere, s, i ID-ul elementului pentru renderele din compozitorul de hărt,i
map_extent_center Returnează entitatea de tip punct din centrul hărt,ii
map_extent_height Returnează înalt,imea curentă a hărt,ii
map_extent_width Returnează lăt,imea curentă a hărt,ii
map_rotation Returnează rotat,ia curentă a hărt,ii
map_scale Returnează scara curentă a hărt,ii
project_filename Returnează numele de fis, ier al proiectului curent
project_folder Returnează dosarul proiectului curent
project_path Returnează calea completă (inclusiv numele de fis, ier) a proiectului curent
project_title Returnează titlul proiectului curent
qgis_os_name Returnează numele Sistemului de Operare curent, ex.: ‘windows’, ‘linux’ sau ‘osx’
qgis_platform Returnează platforma QGIS, ex.: ‘desktop’ sau ‘server’
qgis_release_name Returnează numele versiunii curente de QGIS
qgis_version Returnează textul versiunii curente de QGIS
qgis_version_no Returnează numărul versiunii curente de QGIS
symbol_angle Returnează unghiul simbolului utilizat pentru randarea entităt,ii (valabil numai pentru însemnele simbolurilor)
symbol_color Returnează culoarea simbolului utilizat pentru a randa entitatea
user_account_name Returnează numele de cont al utilizatorului curent din sistemul de operare
user_full_name Returnează numele utilizatorului curent din sistemul de operare
row_number Stochează numărul rândului curent

12.4.2 Editorul de Funct,ii

Cu ajutorul Editorului de Funct,ii avet,i posibilitatea de a vă crea propriile funct,ii Python, într-un mod facil.

Editorul de funct,ii va crea noi fis, iere Python în folderul .qgis2\python\expressions s, i va încărca automat
toate funct,iile definite, la pornirea QGIS. Ret,inet,i că noile funct,ii sunt salvate numai în folderul expressions
s, i nu în fis, ierul proiectului. De asemenea, dacă avet,i un proiect care utilizează una dintre funct,iile personalizate,
va trebui să permitet,i accesul la fis, ierul .py din directorul expresiilor.

Iată un scurt exemplu cu privire la modul de creare a propriilor funct,ii:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2, feature, parent):

pass

Exemplul Scurt crează funct,ia ‘myfunc’, care vă va oferi o funct,ie cu două valori. Când se utilizează argumentul
args = ‘auto’, numărul de argumente ale funct,iei va fi calculat în funct,ie de numărul de argumente definit în Python
(minus 2 - entitatea s, i părintele).

Această funct,ie poate fi utilizată cu următoarea expresie:
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Figure 12.59: Fila Editorului de Funct,ii

myfunc(’test1’, ’test2’)

Funct,ia dvs. va fi implementată în grupul de funct,ii Personalizate ale filei Expresiilor, după utilizarea butonului
Rulare Script.

Mai multe informat,ii despre crearea de cod Python pot fi găsite în PyQGIS-Developer-Cookbook.

Editorul de funct,ii nu se limitează doar la lucrul cu calculatorul de câmpuri, el putând fi utilizat de fiecare dată în
lucrul cu expresii.

12.5 Lucrul cu Tabela de Atribute

:indexul:‘Tabelul de atribute‘ afis, ează entităt,ile unui strat selectat. Fiecare rând din tabel reprezintă o entitate a
hărt,ii, iar fiecare coloană cont,ine o anumită informat,ie despre entitate. Entităt,ile din tabel pot fi căutate, selectate,
mutate sau chiar editate.

Pentru a deschide tabelul de atribute pentru un strat vectorial, activat,i stratul, făcând clic pe el, în zona legendei

hărt,ii. Apoi, din meniul principal al Stratului, aleget,i Deschiderea Tabelei de Atribute. De asemenea, se

poate face clic dreapta pe strat, se alege Deschiderea Tabelului de Atribute din meniul derulant, apoi se apasă

butonul de Deschidere Tabelă de Atribute din bara de instrumente a Atributelor.

Se va deschide o fereastră nouă care afis, ează atributele entităt,ilor din strat (figure_attributes_1). Numărul de
funct,ii s, i numărul de entităt,i selectate sunt prezentate în titlul tabelului de atribute.

Butoanele din partea de sus a ferestrei tabelei de atribute oferă următoarele funct,ionalităt,i:

• Trecere în modul de editare, pentru editarea funct,ionalităt,ilor (de asemenea, cu Ctrl+e)

• Salvare Editări (de asemenea, cu Ctrl+s)

• Reîncărcare tabelă

• Adăugare entitate

• S, tergere entităt,i selectate (de asemenea, cu Ctrl+d)
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Figure 12.60: Tabela de Atribute pentru stratul regiunilor

• Selectare entităt,i folosind o Expresie

• Selectare generală (de asemenea, cu Ctrl+a)

• Inversare select,ie (de asemenea, cu Ctrl+r)

• Deselectare generală (de asemenea, cu Ctrl+u)

• Mutare select,ie în vârf (de asemenea, cu Ctrl+t)

• Deplasare hartă până la rândurile selectate (de asemenea, cu Ctrl+p)

• Transfocare hartă la nivelul rândului selectat (de asemenea, cu Ctrl+j)

• Copiere rânduri selectate în clipboard (de asemenea, cu Ctrl+c)

• Lipire din clipboard într-un nou rând (de asemenea, cu Ctrl+v)

• S, tergere Coloană pentru straturile PostGIS s, i OGR cu versiunea GDAL >= 1.9 (de asemenea, cu Ctrl+l)

• Coloană Nouă pentru straturile PostGIS s, i OGR cu versiunea GDAL >= 1.6 (de asemenea, cu Ctrl+w)

• Deschidere calculator de câmpuri (de asemenea, cu Ctrl+i)

Below these buttons is the Field Calculator bar (enabled only in editing mode), which allows calculations to be
quickly applied to either all or selected features attributes in the table. This bar uses the same expressions as the

Field Calculator (see Calculatorul de Câmpuri).

Tip: Se omite geometria WKT

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.
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12.5.1 Selectarea entităt,ilor din tabela de atribute

Each selected row in the attribute table displays the attributes of a selected feature in the layer. If the set of
features selected in the main window is changed, the selection is also updated in the attribute table. Likewise, if
the set of rows selected in the attribute table is changed, the set of features selected in the main window will be
updated.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort order
(downward pointing means descending values from the top row down, upward pointing means ascending values
from the top row down).

For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Calculatorul de Câmpuri). The query result can then be saved as a new vector layer. For example, if you
want to find regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields
and Values menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all
unique values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query
appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Constructorul de Interogări.

To show selected records only, use Show Selected Features from the menu at the bottom left. See next section for
more information on filter feature.

The field calculator bar allows you to make calculations on the selected rows only. For example, you can alter the
number of the ID field of the layer regions.shp with the expression

ID+5

as, a cum se arată în figure_attributes_1 .

12.5.2 Filtrare entităt,i

În partea de jos a tabelului de atribute, avet,i o listă cu derulare verticală a unui filtru diferit:

• Afişează Toate Entităt,ile;

• Afişează Entităt,ile Selectate;

• Afis, ează Entităt,ile vizibile pe hartă;

• Afis, ează Entităt,ile Noi s, i pe cele Editate;

• Filtru de Câmp;

• Filtru avansat (Expresie);
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The first four are self explanatory, the two last are expression filters. Field Filter allows user to choose a column
name in the list and add a simple form to the right of the drop-down list to filter with a like expression parameter.
This filter will create an expression filter as an Advanced filter. The last kind of filter will open an expression
window, see Expresii for more information.

12.5.3 Modul Tabel/Formular

În mod implicit fereastra de atribute are forma unui tabel. În unele cazuri, ar trebui să preferat,i să utilizarea unui
aspect de formular, care va facilita editarea unor entităt,i.

You can switch to form layout by clicking in the bottom right, on and switch back to table layout with .

12.5.4 Transfocare pe entitate

To zoom into a feature, without having to select it, right-click on the feature you want to zoom in, within the
attribute table, and select Zoom to feature.

12.5.5 Salvează entităt,ile selectate ca un nou strat

Entităt,ile selectate pot fi salvate în orice alt format vectorial acceptat de OGR s, i, de asemenea, pot fi reproiectate
într-un alt sistem de coordonate de referint,ă (CRS). Trebuie doar să deschidet,i, printr-un clic dreapta, meniul
stratului s, i să facet,i clic pe Salvare ca pentru a defini numele fis, ierului de ies, ire, formatul s, i CRS-ul său (consultat,i

sect,iunea Panoul Straturilor). Pentru a salva select,ia, asigurat,i-vă că este selectată opt,iunea de Salvare doar a
entităt,ilor selectate. De asemenea, în cadrul dialogului este posibilă specificarea opt,iunilor de creare OGR.

12.5.6 Lipire într-un nou strat

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

12.5.7 Editarea valorilor atributului

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

A virtual field is a field based on an expression calculated on the fly, meaning that its value is automatically updated
as soon as the underlying parameter changes. The expression is set once; you no longer need to recalculate the
field each time underlying values change. For example, you may want to use a virtual field if you need area to
be evaluated as you digitize features or to automatically calculate a duration between dates that may change (e.g.,
using now() function).

Note: Utilizarea Câmpurilor Virtuale
• Virtual fields are not permanent in the layer attributes, meaning that they’re only saved and available in the

project file they’ve been created.

• A field can be set virtual only at its creation and the expression used can’t be changed later: you’ll need to
delete and recreate that field.
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The field calculator is available on any layer that supports edit. When you click on the field calculator icon the
dialog opens (see figure_attributes_2). If the layer is not in edit mode, a warning is displayed and using the field
calculator will cause the layer to be put in edit mode before the calculation is made.

The quick field calculation bar on top of the attribute table is only visible if the layer is in edit mode.

In quick field calculation bar, you first select the existing field name then open the expression dialog to create your
expression or write it directly in the field then click on [Update All], [Update Selected] or [Update Filtered]
button according to your need.

Calculatorul de Câmpuri

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to define an expres-
sion and apply it to an existing or a newly created field. To use the field calculator dialog, you first must select
whether you want to only update selected features, create a new attribute field where the results of the calculation
will be added or update an existing field.

Figure 12.61: Calculatorul de Câmpuri

If you choose to add a new field, you need to enter a field name, a field type (integer, real or string), the total field
width, and the field precision (see figure_attributes_2). For example, if you choose a field width of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:

1. Încărcat,i fis, ierul shape railroads.shp în QGIS s, i efectuat,i pe Deschiderea Tabelei de Atribute.
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2. Clic pe Comutare în modul de editiare, apoi deschidet,i dialogul Calculatorului de Câmpuri.

3. Selectat,i caseta de bifare pentru Crearea unui nou câmp, în scopul salvării calculelor într-un nou câmp.

4. Add length as Output field name and real as Output field type, and define Output field width to be 10
and Precision, 3.

5. Acum, facet,i dublu clic pe funct,ia $length din grupul Geometry pentru a-l adăuga în Câmpul calcula-
torului de expresii.

6. Completat,i expresia introducând / 1000 în caseta de expresii a Calculatorului de câmpuri, s, i făcând clic
pe [Ok].

7. Acum, putet,i găsi noul câmp length în tabelul de atribute.

12.5.8 Lucrul cu tabelele de atribute non spat,iale

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Meniul Câmpurilor to find out more.

12.5.9 Formatări condit,ionale pentru Celulele Tabelelor

You can enable the conditional formatting panel clicking on at the top right of the attributes window in table
view (not available in form view).

The new panel allows user to add new rules for conditional formatting of field or full row in regard of the expression
on field. Adding new rule open a form to define:

• defini numele regulii,

• o condit,ie din fereastra de expresii,

• o formatare presetată

• cât,iva alt,i parametri pentru a îmbunătăt,i, modifica sau seta formatarea:

– culori de fundal sau pentru text,

– utilizarea pictogramei,

– îngros, area, sublinierea, înclinarea sau tăierea textului,

– câmpul textului,

– fontul.

12.5.10 Crearea relat,iilor one to many

Relations are a technique often used in databases. The concept is, that features (rows) of different layers (tables)
can belong to each other.

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).
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Figure 12.62: Formatarea condit,ională a unei tabelelor cu atribute

Chei externe

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the region layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.

Figure 12.63: Regiunile cu aeroporturi din Alaska

In addition to the already existing attributes in the airports attribute table another field fk_region which acts as a
foreign key (if you have a database, you will probably want to define a constraint on it).

This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for the editing and QGIS takes care about the setup. It works with
different providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the
relations between your tables.
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Straturi

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So can add your table as a vector layer. To demonstrate you can load the ‘region’ shapefile (with geometries) and
the ‘airport’ csv table (without geometries) and a foreign key (fk_region) to the layer region. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Definit,ie (Managerul de Relat,ii)

Primul lucru pe care îl vom face este de a indica aplicat,iei QGIS despre relat,iile din cadrul stratului. Acest lucru
se face în Proiect → Proprietăt,ile Proiectului. Deschidet,i meniul Relat,iilor s, i facet,i clic pe Adăugare.

• numele va fi folosit ca titlu. Acesta ar trebui să fie un s, ir de caractere us, or de citit, care descrie la ce foloses, te
relat,ia. Vom folosi “Airports” în acest caz.

• referencing layer is the one with the foreign key field on it. In our case this is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer is the one with the primary key, pointed to, so here it is the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms once this
is supported. If you leave it empty, one will be generated for you but you can assign one yourself to get one
that is easier to handle.

Figure 12.64: Managerul de Relat,ii

Formulare

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly
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Figure 12.65: Dialogul de identificare a regiunilor, cu relat,iile între aeroporturi

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• Btonul va s, terge definitiv aeroportul selectat.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• Cele două butoane din dreapta comută între vederea sub formă de tabelă s, i cea sun formă de formular, care,
mai târziu, vă vor permite vizualizarea tuturor aeroporturilor.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

Figure 12.66: Dialogul de identificare a aeroportului, cu relat,iile între regiuni
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12.6 Editarea

QGIS suportă diverse capabilităt,i pentru editarea straturilor vectoriale s, i a tabelelor de tip OGR, SpatiaLite, Post-
GIS, MSSQL Spatial s, i Oracle Spatial.

Note: Procedura pentru editarea straturilor GRASS este diferită - a se vedea sect,iunea Digitizarea s, i editarea
unui strat vectorial GRASS pentru detalii.

Tip: Editări Concurente
Această versiune de QGIS nu sesizează dacă altcineva editează o entitate în acelas, i timp cu dvs. Vor fi păstrate
doar editările salvate de către ultima persoană.

12.6.1 Setarea Tolerant,ei Acros, ării s, i Căutarea Razei

Pentru o editare optimă s, i exactă a geometriilor din straturile vectoriale, trebuie să setăm o valoare corespunzătoare
pentru tolerant,a acros, ării s, i pentru raza de căutare a nodurilor din entităt,i.

Toleranţa de acros, are

Tolerant,a de acros, are reprezintă distant,a până la care QGIS caută cel mai apropiat vertex s, i/sau segment la care
încearcă să se conecteze, atunci când creat,i un nou vertex sau când îl deplasat,i pe altul existent. Dacă nu vă aflat,i
în cadrul distant,ei de acros, are, QGIS va lăsa vertexul în locul în care s-a eliberat butonul mouse-ului, în locul
acros, ării la un nod sau la un segment existent. Setarea tolerant,ei de acros, are afectează toate instrumentele pentru
care se aplică tolerant,ă.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options..., Digitizing
tab. You can select between ‘To vertex’, ‘To segment’ or ‘To vertex and segment’ as default snap mode.
You can also define a default snapping tolerance and a search radius for vertex edits. The tolerance can be
set either in map units or in pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t
have to be changed after zoom operations. In our small digitizing project (working with the Alaska dataset),
we define the snapping units in feet. Your results may vary, but something on the order of 300 ft at a scale
of 1:10000 should be a reasonable setting.

2. A layer-based snapping tolerance that overrides the global snapping options can be defined by choosing
Settings → Snapping options. It enables and adjusts snapping mode and tolerance on a layer basis (see
figure_edit_1 ). This dialog offers three different modes to select the layer(s) to snap to:

• Current layer: only the active layer is used, a convenient way to ensure topology within the layer being
edited

• All layers: a quick and simple setting for all visible layers in the project so that the pointer snaps to all
vertices and/or segments. In most cases it is sufficient to use this snapping mode.

• Avansat: dacă trebuie să editat,i un strat s, i să acros, at,i nodurile sale fat,ă de un alt strat, asigurat,i-vă că at,i
selectat stratul de destinat,ie s, i cres, tet,i tolerant,a de acros, are. În plus, acros, area nu va avea loc pentru
straturile care nu sunt selectate în caseta de dialog a opt,iunilor de acros, are, indiferent de tolerant,a
globală. Prin urmare, asigurat,i-vă că at,i bifat acele straturi fat,ă de care dorit,i acros, area.

Tip: Controlat,i lista de straturi pentru acros, are
The Snapping Options dialog is by default populated with parameters (mode, tolerance, units) set in the global
Digitizing tab. To avoid layers being checked by default in the Advanced mode and hence set snappable, define
the Default Snap mode to Off.

Snapping tolerance can be set in pixels or map units (the units of the map view). While in the Advanced
layer selection mode, it is possible to use a snapping tolerance that refers to layer units, the units of the
reprojected layer when ‘on-the-fly’ CRS transformation is on.
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Figure 12.67: Editat,i opt,iunilor de acros, are în funct,ie de strat (Mod avansat)

Raza de căutare

Raza de căutare reprezintă distant,a până la care QGIS caută cel mai apropiat nod pe care încercat,i să-l selectat,i,
atunci când facet,i clic pe hartă. Dacă nu vă aflat,i în cadrul razei de căutare, QGIS nu va găsi s, i nu va selecta nici
un vertex pentru editare. Tolerant,a de acros, are s, i raza de căutare sunt exprimate în unităt,i de hartă sau în pixeli,
astfel încât va trebui să experimentat,i pentru a obt,ine setarea corectă. Dacă specificat,i o tolerant,ă prea mare, QGIS
poate realiza acros, area la vertexul gres, it, mai ales dacă vă confruntat,i cu un număr mare de noduri în imediata
apropiere. Dacă setat,i raza de căutare la o valoare prea mică, este posibil ca deplasarea să nu mai aibă loc.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project-wide snapping tolerance.

12.6.2 Editarea topologică

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, activate the Avoid Intersections option.

Editarea editării topologice

Opt,iunea de Activare a editării topologice foloses, te la îmbunătăt,irea editării s, i la ment,inerea granit,elor comune
pentru mozaicurile cu entităt,i. QGIS ‘detectează’ o granit,ă comună în funct,ie de entităt,i, as, a că este suficient doar
să mutat,i un vertex/segment, iar QGIS va asigura actualizarea celorlalte entităt,i învecinate.

Evitarea intersecţiilor pentru poligoanele noi

O a doua opt,iune topologică denumită Evitare intersect,ii vă împiedică să desenat,i noi entităt,i care se suprapun
peste altele. Serves, te la digitizarea mai rapidă a poligoanelor adiacente. Dacă avet,i deja un poligon, este posibil,
cu această opt,iune să digitizat,i un al doilea poligon adiacent, astfel încât ambele poligoane să se suprapună, apoi
QGIS va decupa al doilea poligon după limitele celui existent. Avantajul este că nu trebuie să digitizat,i toate
vertexurile limitei comune.

Note: If the new geometry is totally covered by existing ones, it gets cleared and the new feature will have no
geometry when allowed by the provider, otherwise saving modifications will make QGIS pop-up an error message.

Warning: Use cautiously the Avoid Intersections option
Because the option cuts or clears geometry of any overlaping feature from any polygon layer, do not forget to
uncheck this option once you no longer need it otherwise, you can get unexpected geometries.
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Activarea acros, ării la intersect,ii

Another option is to use Enable snapping on intersection. It allows you to snap on an intersection of back-
ground layers, even if there’s no vertex on the intersection.

Verificatorul de Geometrii

Un plugin de bază poate ajuta utilizatorul să găsească erorile de geometrie. Putet,i găsi mai multe informat,ii despre
acest plugin la Plugin-ul Verificator de Geometrie.

12.6.3 Digitizarea unui strat vectorial existent

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Digitizare avansată. You can select and unselect both under
View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Pictogramă Scop Pictogramă Scop

Editări curente Activarea/dezactivarea editării

Adăugare Entităt,i: Captura unui Punct Adăugare Entităt,i: Captura unei Linii

Adăugare Entităt,i: Captura unui Poligon Deplasarea Entităt,ii

Adăugare S, ir Circular Adaugă un S, ir Circular în funct,ie de Rază

Instrumentul Nod S, tergere Select,ie

Decupare Entităt,i Copiere Entităt,i

Lipire Entităt,i Salvează modificările stratului

Editarea Tabelei: Bara instrumentelor de editare de bază, pentru straturile vectoriale

Note that while using any of the digitizing tools, you can still zoom or pan in the map canvas without losing the
focus on the tool.

All editing sessions start by choosing the Toggle editing option found in the context menu of a given layer, from
the attribute table dialog, the digitizing toolbar or the Edit menu.

Once the layer is in edit mode, additional tool buttons on the editing toolbar will become available and markers
will appear at the vertices of all features unless Show markers only for selected features option under Settings →
Options... → Digitizing menu is checked.

Tip: Salvat,i cu Regularitate

Amintit,i-vă să Salvat,i Modificările Stratului cu regularitate. Aceasta va confirma, de asemenea, că sursa de date poate
accepta modificările.

Adăugare Entităt,i

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to add new feature (point, line
and polygon) into the current layer.

The next buttons Add circular string or Add circular string by radius allow users to add line or polygon features with a
circular geometry.
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Pentru a crea entităt,ile cu ajutorul acestor instrumente, digitizat,i în primul rând geometria, apoi introducet,i-i
atributele. Pentru a digitiza geometria, facet,i clic-stânga pe suprafat,a hărt,ii, pentru a crea primul punct al noii
entităt,i.

For linear or curved geometries, keep on left-clicking for each additional point you wish to capture or use au-
tomatic tracing capability to accelerate the digitization. You can switch back and forth between linear Add fea-
ture tool and curved Add circular string... tools to create compound curved geometry. Pressing Delete or
Backspace key reverts the last node you add. When you have finished adding points, right-click anywhere on
the map area to confirm you have finished entering the geometry of that feature.

Note: Curved geometries are stored as such only in compatible data provider
Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, GML or WFS) that supports curves to have features stored as curved, otherwise QGIS
segmentizes the circular arcs. The memory layer provider also supports curves.

Tip: Customize the digitizing rubber band
While capturing polygon, the by-default red rubber band can hide underlying features or places you’d like to
capture a point. This can be fixed by setting a lower opacity (or alpha channel) to the rubber band’s Fill Color in
Settings → Options → Digitizing menu. You can also avoid the use of the rubber band by checking Don’t update
rubber band during node editing.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. However, in the Digitizing menu under the Settings →
Options menu, you can also activate:

• După crearea unei entităt,i, se suprimă ferestrele pop-up cu atribute pentru a se evita deschiderea for-
mularelor

• or Reuse last entered attribute values to have fields automatically filled at the opening of the form and
just have to type changing values.

Figure 12.68: Completat,i Dialogul Valorilor pentru Atribute, după digitizarea unei noi entităt,i vectoriale

Folosind pictograma de Deplasare a Entit(ăt,ilor) de pe bara de instrumente, putet,i deplasa entităt,ile existente.

Instrumentul Nod

For shapefile-based or MapInfo layers as well as SpatiaLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle

Spatial tables, the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It
is possible to simply select multiple vertices at once and to move, add or delete them altogether. The node tool
also works with ‘on the fly’ projection turned on and supports the topological editing feature. This tool is, unlike
other tools in QGIS, persistent, so when some operation is done, selection stays active for this feature and tool.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero. Otherwise, QGIS will not be able to tell which vertex is being edited and will display a warning.
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Tip: Simbolurile Vertexului
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.

Operaţiuni de bază

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl when clicking to toggle the selection state of vertices (vertices
that are currently unselected will be selected as usual, but also vertices that are already selected will become
unselected).

• Adding vertices: To add a vertex, simply double click near an edge and a new vertex will appear on the
edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor position; therefore, it
should be moved if necessary.

• Deleting vertices: Select the vertices and click the Delete key. Deleting all the vertices of a feature
generates, if compatible with the datasource, a geometryless feature. Note that this doesn’t delete the

complete feature, just the geometry part; To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge and drag in the
direction you wish to move. All the selected vertices will move together. If snapping is enabled, the whole
selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Tip: Deplasarea cu precizie a entităt,ilor

The Move Feature tool doesn’t currently allow to snap features while moving. Using the Node Tool, select
ALL the vertices of the feature, click a vertex, drag and snap it to a target vertex: the whole feature is moved and
snapped to the other feature.

Editorul de Vertecs, i

With activating the Node Tool on a feature, QGIS opens the Vertex Editor panel listing all the vertices of the
feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular geometry). Simply
select a row in the table does select the corresponding vertex in the map canvas, and vice versa. Simply change
a coordinate in the table and your vertex position is updated. You can also select multiple rows and delete them
altogether.

Tăiere, Copiere s, i Lipire Entităt,i

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Tip: Transform polygon into line and vice-versa using copy/paste
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Figure 12.69: Vertex editor panel showing selected nodes

Copy a line feature and paste it in a polygon layer: QGIS pastes in the target layer a polygon whose boundary
corresponds to the closed geometry of the line feature. This is a quick way to generate different geometries of the
same data.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format. WKT features from outside QGIS
can also be pasted to a layer within QGIS.

When would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer
at a time and copy/paste features between layers. Why would we want to do this? Say we need to do some work
on a new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer
and use copy/paste to plop the needed lakes into it.

Ca un exemplu, vom copia unele lacuri într-un nou strat:

1. Încărcat,i stratul din care dorit,i să copiat,i (stratul sursă)

2. Încărcat,i sau creat,i stratul în care dorit,i să copiat,i (stratul t,intă)

3. Începet,i editarea stratului t,intă

4. Activat,i stratul sursă, făcând clic pe el în legendă

5. Folosit,i instrumentul de Selectare a Entităt,ilor după arie sau cu un singur clic pentru a selecta entit(ăt,ile) din stratul
sursă

6. Clic pe instrumentul de Copiere Entităt,i

7. Activat,i stratul destinat,ie, făcând clic pe el în legendă

8. Clic pe instrumentul de Lipire Entităt,i

9. Dezactivat,i editarea s, i salvat,i modificările.

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Note: Congruent,a Entităt,ilor Inserate
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.
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Tip: Copie un atribut de tip s, ir în altul**

If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accommodate for the length of the data to be inserted.

S, tergerea Entităt,ilor Selectate

If we want to delete an entire feature (attribute and geometry), we can do that by first selecting the geometry using

the regular Select Features by area or single click tool. Selection can also be done from the attribute table. Once you

have the selection set, press Delete or Backspace key or use the Delete Selected tool to delete the features.
Multiple selected features can be deleted at once.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Salvarea Straturilor Modificate

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Tip: Integritatea Datelor
It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.

Saving multiple layers at once

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

Aceleas, i funct,ii sunt disponibile pentru editarea tuturor straturilor proiectului.
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12.6.4 Digitizare avansată

Pictogramă Scop Pictogramă Scop

Activarea Instrumentelor de Digitizare Avansată Activarea Urmăririi

Anulare Refacere

Rotire Enti(tăt,i) Simplificare Entitate

Adăugare Inel Adăugare Parte

Umplere Inel Ştergere Inel

Ştergere Parte Remodelare Entităt,i

Curba de Compensare Divizare Entităt,i

Divizare Părt,i Unificare Entităt,i Selectate

Unificare Atribute pentru Entităt,ile Selectate Rotit,i Simbolurile Punctelor

Editarea Avansată a Tabelei: Bara instrumentelor avansate de editare a straturilor vectoriale

Anulare/Restabilire

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_4). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.

Figure 12.70: Pas, ii de Anulare/Restabilire a Digitizării

When Undo is hit or Ctrl+z (or Cmd+z) pressed, the state of all features and attributes are reverted to the
state before the reverted operation happened. Changes other than normal vector editing operations (for example,
changes done by a plugin) may or may not be reverted, depending on how the changes were performed.

To use the undo/redo history widget, simply click to select an operation in the history list. All features will be
reverted to the state they were in after the selected operation.

Rotire Enti(tăt,i)

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and
then click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user
input widget. If you want to rotate several features, they shall be selected first.

If you enable the map tool with feature(s) selected, its (their) centroid appears and will be the rotation anchor
point. If you want to move the anchor point, hold the Ctrl button and click on the map to place it.
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If you hold Shift before clicking on the map, the rotation will be done in 45 degree steps, which can be modified
afterwards in the user input widget.

To abort feature rotation, you need to click on Rotate Feature(s) icon.

Simplificare Entitate

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
remains valid. With the tool you can also simplify many features at once or multi-part features.

First, click on the feature or drag a rectangle over the features. A dialog where you can define a tolerance in map
units, layer units or pixels pops up and a colored and simplified copy of the feature(s), using the given
tolerance, appears over them. QGIS calculates the amount of vertices that can be deleted while maintaining the
geometry. The higher the tolerance is the more vertices can be deleted. When the expected geometry fits your
needs just click the [OK] button. The tolerance you used will be saved when leaving a project or when leaving an
edit session. So you can go back to the same tolerance the next time when simplifying a feature.

To abort feature simplification, you need to click on Simplify Feature icon.

Note: unlike the feature simplification option in Settings → Options → Rendering menu which simplifies the

geometry just for rendering, the Simplify Feature tool really modifies feature’s geometry in data source.

Adăugare Parte

You can Add Part to a selected feature generating a multipoint, multiline or multipolygon feature. The new part
must be digitized outside the existing one which should be selected beforehand.

The Add Part can also be used to add a geometry to a geometryless feature. First, select the feature in the
attribute table and digitize the new geometry with the Add Part tool.

Ştergere Parte

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). This tool works with all multi-part geometries: point, line and polygon. Furthermore, it can be used to
totally remove the geometric component of a feature. To delete a part, simply click within the target part.

Adăugare Inel

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Umplere Inel

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Using this tool, you simply have to digitize a polygon within an existing one. Thus you need not first use the
Add Ring icon and then the Add feature function anymore.
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Ştergere Inel

The Delete Ring tool allows you to delete rings within an existing polygon, by clicking inside the hole. This
tool only works with polygon and multi-polygon features. It doesn’t change anything when it is used on the outer
ring of the polygon.

Remodelare Entităt,i

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.

De exemplu, putet,i modifica limita unui poligon, cu ajutorul acestui instrument. În primul rând, facet,i clic în zona
interioară a poligonului, lângă punctul în care dorit,i să adăugat,i un nou nod. Apoi, adăugat,i nodurile în afara
poligonului. Pentru a termina, facet,i clic dreapta în zona interioară a poligonului. Instrumentul va adăuga automat
un nod, în cazul în care noua linie traversează marginea. De asemenea, este posibilă eliminarea unor suprafet,e
din poligon, începând o nouă linie în afara poligonului, adăugând noduri în interior, s, i terminând linia în afara
poligonului, printr-un clic dreapta.

Note: The reshape tool may alter the starting position of a polygon ring or a closed line. So, the point that is
represented ‘twice’ will not be the same any more. This may not be a problem for most applications, but it is
something to consider.

Curbe de Compensare

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the edited layer). It is thus ideally suited for the creation of distance line layers. The User Input dialog
pops-up, showing the displacement distance.

To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input

widget. Your changes may then be saved with the Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.

Divizare Entităt,i

Putet,i diviza entităt,ile folosind pictograma de Divizare a Entităt,ilor din bara de instrumente. Este suficient să traget,i
o linie peste entitatea pe care dorit,i să o divizat,i.

Divizare părt,i

In QGIS it is possible to split the parts of a multi part feature so that the number of parts is increased. Just draw a

line across the part you want to split using the Split Parts icon.
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Unificat,i entităt,ile selectate

The Merge Selected Features tool allows you to merge features. A new dialog will allow you to choose which value
to choose between each selected features or select a function (Minimum, Maximum, Median, Sum, Skip Attribute)
to use for each column. If features don’t have a common boundaries, a multipolygon will be created.

Unificat,i atributele pentru entităt,ile selectate

The Merge Attributes of Selected Features tool allows you to apply same attributes to features without merging their

boundaries. First, select several features. Then press the Merge Attributes of Selected Features button. Now QGIS asks
you which attributes are to be applied to all selected objects. As a result, all selected objects have the same attribute
entries.

Rotit,i Simbolurile Punctelor

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.

Figure 12.71: Rotit,i Simbolurile Punctelor

To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_5). When you release the left mouse button
again, the value will be updated in the attribute table.

Note: Dacă t,inet,i apăsată tasta Ctrl, rotirea se va face în pas, i de 15 grade.

Urmărirea Automată

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature.

Using the automatic tracing mode you can speed up the digitization process. Enable the Tracing tool by pushing
the icon or pressing t key and snap to a vertex or segment of a feature you want to trace along. Move the mouse
over another vertex or segment you’d like to snap and instead of an usual straight line, the digitizing rubber band
represents a path from the last point you snapped to the current position. QGIS actually uses the underlying
features topology to build the shortest path between the two points. Click and QGIS places the intermediate
vertices following the path. You no longer need to manually place all the vertices during digitization.
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Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to an existing
vertex or segment while digitizing and ensure that the two nodes are topologically connectable following existing
features, otherwise QGIS is unable to connect them and thus traces a single straight line.

Note: Adjust map scale or snapping settings for an optimal tracing
If there are too many features in map display, tracing is disabled to avoid potentially long tracing structure prepa-
ration and large memory overhead. After zooming in or disabling some layers the tracing is enabled again.

Tip: Quickly enable or disable automatic tracing by pressing t key
By pressing t key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible to
digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as usual
when tracing is disabled.

12.6.5 Panoul de Digitizare Avansată

When capturing new geometries or geometry parts you also have the possibility to use the Advanced Digitizing
panel. You can digitize lines exactly parallel or at a specific angle or lock lines to specific angles. Furthermore
you can enter coordinates directly so that you can make a precise definition for your new geometry.

Figure 12.72: Panoul de Digitizare Avansată

Note: Instrumentele nu sunt activate dacă vizualizarea hărt,ii este în coordonate geografice.

12.6.6 Crearea noillor straturi Vectoriale

QGIS allows you to create new shapefile layers, new SpatiaLite layers, new GPX layers and New Temporary
Scratch Layers. Creation of a new GRASS layer is supported within the GRASS plugin. Please refer to section
Crearea unui nou strat vectorial GRASS for more information on creating GRASS vector layers.

Crearea unui nou strat de tip fis, ier shape

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_6. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Ret,inet,i că aplicat,ia QGIS încă nu are suport pentru crearea de entităt,i 2.5D (de exemplu, entităt,ile cu coordonatele
X,Y,Z).

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
attributes are supported. Additionally and according to the attribute type, you can also define the width and
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Figure 12.73: Dialogul de Creare a unui nou strat de tip Fis, ier Shape

precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has been
created, it will be added to the map, and you can edit it in the same way as described in section Digitizarea unui
strat vectorial existent above.

Crearea unui nou strat SpatiaLite

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_edit_7.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitizarea unui strat vectorial existent above.

Managementul continuu al straturilor SpatiaLite se poate face cu DB Manager. Vedet,i Plugin-ul DB Manager.

Crearea unui nou strat GPX

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.
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Figure 12.74: Dialogul de Creare a unui Nou strat de tip SpatiaLite
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When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.

Crearea unui Strat Nou Temporar, Stocat în Memorie

Straturile de memorie editabile, goale, pot fi definite utilizând Strat → Creare Strat → Nou Strat Temporar, Stocat
în Memorie. Aici se pot crea chiar s, i Straturi de tip Multipunct, Multilinie s, i Multipoligon sub Straturi de
tip Punct, Linie s, i Poligon. Straturile temporare, stocate în memorie nu vor fi salvate s, i vor fi eliminate la
închiderea QGIS. Vedet,i s, i Lipire într-un nou strat.

12.7 Straturi virtuale

Un tip special de strat vectorial permite definirea unui strat ca rezultat al unei interogări avansate, folosind limbajul
SQL asupra oricărui număr de alte straturi vectoriale pe care QGIS este capabil să le deschidă. Aceste straturi sunt
denumite straturi virtuale: ele însele nu transportă date s, i pot fi văzute ca vederi ale altor straturi.

12.7.1 Crearea unui strat virtual

Deschide dialogul de creare a stratului virtual, făcând clic pe Adăugare Strat Virtual din meniul Strat sau din bara
de instrumente corespunzătoare.

Caseta de dialog vă permite să specificat,i o interogare SQL. Interogarea poate utiliza numele (sau ID-ul) straturilor
vectoriale existente, precum s, i numele câmpurilor din aceste straturi.

For example, if you have a layer called regions, you can create a new virtual layer with an SQL query like
SELECT * FROM regions WHERE id < 100. The SQL query will be executed, whatever the underlying
provider of the regions layer is and even if this provider does not directly support SQL queries.

Joins and complex queries can also be created simply by directly using the names of the layers that are to be
joined.

12.7.2 Limbaje acceptate

Motorul de bază foloses, te SQLite s, i Spatialite pentru a opera.

It means you can use all of the SQL your local installation of SQLite understands.

Functions from SQLite and spatial functions from Spatialite can also be used in a virtual layer query. For in-
stance, creating a point layer out of a attribute-only layer can be done with a query similar to: SELECT id,
MakePoint(x, y, 4326) as geometry FROM coordinates

Functions of QGIS expressions can also be used in a virtual layer query.

To refer the geometry column of a layer, use the name geometry.

Contrary to a pure SQL query, all the fields of a virtual layer query must be named. Don’t forget to use the as
keyword to name your columns if they are the result of a computation or function call.

12.7.3 Probleme legate de performant,ă

With default parameters set, the virtual layer engine will try its best to detect the type of the different columns of
the query, including the type of the geometry column if one is present.

This is done by introspecting the query when possible or by fetching the first row of the query (LIMIT 1) at last
resort. Fetching the first row of the result just to create the layer may be undesirable for performance reasons.

Dialogul de creare vă permite să specificat,i divers, i parametri:
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• unique identifier column: this option allows to specify which field of the query represents unique inte-
ger values that QGIS can use as row identifiers. By default, an autoincrementing integer value is used.
Specifying a unique identifier column allows to speed up selection of rows by id.

• no geometry: this option forces the virtual layer to ignore any geometry field. The resulting layer is an
attribute-only layer.

• geometry column: this option allows to specify the name of the column that is to be used as the geometry
of the layer.

• tipul geometriei: această opt,iune permite specificarea tipului de geometrie al stratului virtual.

• geometry CRS: this option allows to specify the coordinate reference system of the virtual layer.

12.7.4 Comentarii speciale

The virtual layer engine tries to determine the type of each column of the query. If it fails, the first row of the
query is fetched to determine column types.

The type of a particular column can be specified directly in the query by using some special comments.

The syntax is the following: /*:type*/. It has to be placed just after the name of a column. type can be either
int for integers, real for floating point numbers or text.

De exemplu: SELECT id+1 as nid /*:int*/ FROM table

The type and coordinate reference system of the geometry column can also be set thanks to special comments
with the following syntax /*:gtype:srid*/ where gtype is the geometry type (point, linestring,
polygon, multipoint, multilinestring or multipolygon) and srid an integer representing the
EPSG code of a coordinate reference system.

12.7.5 Folosirea indecs, ilor:

Atunci când se solicită un strat prin intermediul unui strat virtual, indecs, ii acestui strat sursă vor fi utilizat,i în
următoarele moduri:

• if an = predicate is used on the primary key column of the layer, the underlying data provider will be asked
for a particular id (FilterFid)

• for any other predicates (>, <=, !=, etc.) or on a column without primary key, a request built from an
expression will be used to request the underlying vector data provider. It means indexes may be used on
database providers if they exist.

A specific syntax exists to handle spatial predicates in requests and trigger the use of a spa-
tial index: a hidden column named _search_frame_ exists for each virtual layer. This col-
umn can be compared for equality to a bounding box. Example: select * from vtab where
_search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

Spatial binary predicates like ST_Intersects are greatly sped up when used in conjunction with this spatial
index syntax.
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CHAPTER 13

Lucrul cu Datele Raster

13.1 Lucrul cu Datele Raster

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

As of the date of this document, more than 100 raster formats are supported by the GDAL li-
brary (see GDAL-SOFTWARE-SUITE in Literatură s, i Referint,e Web). A complete list is available at
http://www.gdal.org/formats_list.html.

Note: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL installation of your OS may not have been built to support the format you want
to use. Only those formats that have been well tested will appear in the list of file types when loading a raster into
QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Lucrul cu datele raster GRASS este descris în sect,iunea Integrarea GRASS GIS.

13.1.1 Ce reprezintă datele raster?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Încărcarea Datelor Raster în QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.

Once a raster layer is loaded in the map legend, you can click on the layer name with the right mouse button to
select and activate layer-specific features or to open a dialog to set raster properties for the layer.

Meniul straturilor raster, deschis cu butonul din dreapta al mouse-ului
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• Apropiere Până la Extinderea Stratului

• Transfocare la Cea Mai Bună Scară (100%)

• Întinde, Folosind Extinderea Curentă

• Arată în Vizualizare

• Elimină

• Duplicare

• Setează CRS-ul Stratului

• Obt,ine CRS-ul Proiectului din Strat

• Salvează ca ...

• Proprietăt,i

• Redenumire

• Copiere Stiluri

• Adăugare Grup Nou

• Extinde tot

• Restrânge tot

• Actualizează Ordinea de Desenare

13.2 Dialogul Proprietăt,ilor Rasterului

Pentru a vizualiza s, i seta proprietăt,ile pentru un strat raster, facet,i dublu clic pe numele stratului din harta legendei,
sau facet,i clic dreapta pe numele stratului s, i aleget,i Properties din meniul contextual. Acest lucru va deschide
dialogul Raster Layer Properties (v. figure_raster_1).

Există câteva meniuri în dialog:

• General

• Stil

• Transparent,ă

• Piramide

• Histogramă

• Metadate

13.2.1 Meniu General

Informat,ii despre strat

Meniul General afis, ează informat,ii de bază despre rasterul selectat, incluzând calea stratului sursă, numele afis, at
în legendă (care poate fi modificat), numărul de coloane, de rânduri s, i valorile fără-date ale rasterului.

Sistemul de coordonate de referinţă

Aici, vet,i găsi informat,iile sistemului de coordonate de referint,ă (CRS), afis, ate sub formă de s, ir PROJ.4. Dacă
această setare nu este corectă, ea poate fi modificată făcând clic pe butonul [Specify].
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Figure 13.1: Dialogul Proprietăt,ilor pentru Straturile Raster

Vizibilitate în Funcţie de Scară

În plus, în această filă poate fi stabilită vizibilitatea dependentă de scară. Va trebui să bifat,i caseta s, i să stabilit,i o
scară corespunzătoare pentru afis, area datelor dvs. în canevasul hărt,ii.

În partea de jos, putet,i vedea o miniatură a stratului, simbolul legendei sale, s, i paleta.

13.2.2 Meniul Stilului

Randare bandă

QGIS oferă patru Tipuri de Render diferite. Renderul ales depinde de tipul datelor.

1. Culoare multibandă - Dacă fis, ierul vine ca o multibandă compusă din diferite benzi (de exemplu, utilizând
o imagine prin satelit cu mai multe benzi)

2. Paletă de culori - în cazul în care un singur fis, ier bandă vine cu o paletă indexată (de exemplu, utilizată cu
o hartă topografică digitală)

3. Bandă singulară gri - (o bandă a) imaginii va fi randată ca gri; QGIS va alege acest render dacă fis, ierul nu
are o multibandă, o paletă indexată sau o paletă continuă (de exemplu, este folosită cu o hartă a reliefului
umbrit)

4. Pseudoculoare simpla bandă - acest render este posibil pentru fis, ierele cu o paleta continuă, sau o harta de
culoare (ex: folosită cu o hartă de elevat,ii)

Culoare multibandă

Cu renderul de culoare multibandă, trei benzi selectate din imagine vor fi randate, fiecare bandă reprezentând
componenta de culoare ros, ie, verde sau albastră, care vor fi folosite pentru a crea o imagine color. Putet,i alege mai
multe metode de Îmbunătăt,ire a Contrastului: ‘Fără Îmbunătăt,ire’, ‘Întindere la MinMax’, ‘Întindere s, i decupare
la MinMax’ s, i ‘Decupare la min max’.

Această select,ie vă oferă o gamă largă de opt,iuni pentru modificarea aspectului stratului dumneavoastră raster. Mai
întâi de toate, trebuie să obt,inet,i intervalul de date din imaginea dvs. Acest lucru poate fi realizat prin alegerea
Extinderii s, i apoi apăsând [Load]. QGIS poate Estima (rapid) valorile Min s, i Max ale benzii sau să folosească

Actuala (mai lentă) Acuratet,e.

Acum putet,i scala culorile cu ajutorul sect,iunii de Încărcare a valorilor min/max. O mult,ime de imagini au unele
date foarte joase s, i altele foarte înalte. Aceste aberat,ii pot fi eliminate folosind setarea Cumulative count cut.
Gama standard de date este setată de la 2% până la 98% din valorile datelor s, i poate fi adaptată manual. Cu această
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Figure 13.2: Render Raster - Culoare Multibandă

182 Chapter 13. Lucrul cu Datele Raster



QGIS User Guide, Release 2.14

setare, poate fi eliminat caracterul gri al unei imagini. Cu ajutorul opt,iunii de scalare Min/max, QGIS creează
un tabel de culori având toate datele incluse în imaginea originală (de exemplu, QGIS creează un tabel de culori
cu 256 de valori, t,inând cont de faptul că avet,i benzi pe 8 bit,i). Putet,i calcula, de asemenea, tabela dvs. de culori
utilizând Media +/- deviat,ia x standard . Ulterior, doar valorile din abaterea standard sau din mai multe
deviat,ii standard sunt luate în considerare pentru tabelul de culori. Acest lucru este util atunci când avet,i una sau
două celule cu valori anormal de mari într-o grilă raster, care au un impact negativ asupra randării rasterului.

Toate calculele pot fi, de asemenea, efectuate pentru extinderea Curentă.

Tip: Vizualizarea unei singure benzi dintr-un Raster Multibandă
Dacă dorit,i să vizualizat,i o singură bandă a unei imagini multibandă (de exemplu, Ros, ie), at,i putea crede că at,i
setat benzile Verde s, i Albastră pe “nespecificat”. Dar acest lucru nu este modul corect. Pentru a afis, a banda Ros, ie,
setat,i tipul de imagine la ‘Singleband gri’, apoi selectat,i Ros, u ca bandă de utilizat pentru Gri.

Paletă

Aceasta este opt,iunea de randare standard pentru fis, ierele simplă bandă care includ deja un tabel de culori, în care
valoarea fiecărui pixel este atribuită unei anumite culori de randare. În acest caz, paleta este randată automat. Dacă
dorit,i să modificat,i culorile atribuite anumitor valori, doar facet,i dublu-clic pe culoare s, i pe dialogul de Selectare
culoare care apare. De asemenea, în QGIS este posibilă asignarea unei etichete valorilor culorilor. În acel caz,
eticheta va apărea în legenda stratului raster.

Figure 13.3: Render Raster - Paletat

Îmbunătăţirea contrastului

Note: Atunci când se adaugă rastere GRASS, opt,iunea de Îmbunătăt,ire a contrastului va fi întotdeauna setată
automat pe întindere la min max, indiferent dacă aceasta este setată la o altă valoare în opt,iunile generale ale
QGIS.
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O singură bandă gri

Acest render vă permite randarea unei singure benzi dintr-un strat, cu un Gradient de culoare: ‘De la negru la alb’
sau ‘De la alb la negru’. Putet,i defini o valoare Min sau Max, prin alegerea, mai întâi a Extinderii, urmată apoi de
[Încărcare]. QGIS poate Estima (rapid) valorile Min s, i Max ale benzilor, sau putet,i utilza Actuala (lentă)
Acuratet,e.

Figure 13.4: Render Raster - Simplă bandă gri

Cu ajutorul sect,iunii de Încărcare a valorilor min/max putet,i scala tabela de culori. Aberat,iile pot fi eliminate
folosind setarea Cumulative count cut. Gama standard de date începe de la 2% până la 98% din valorile
datelor, ea putând fi adaptată manual. Cu această setare, poate fi eliminat caracterul gri al unei imagini. Alte
modificări pot fi efectuate cu ajutorul opt,iunilor Min/max s, i Media +/- deviat,ia x standard . În
timp ce prima opt,iune creează o tabelă de culori având toate datele incluse în imaginea originală, cea de a doua
creează o tabelă de culori care ia în considerare numai valorile aflate în limitele abaterii standard, sau în cadrul
unor deviat,ii standard multiple. Acest lucru este util atunci când avet,i una sau două celule cu valori anormal de
mari într-o grilă raster, lucru care are un impact negativ asupra randării rasterului.

Pseudoculoare cu bandă unică

Aceasta este o opt,iune de randare pentru fis, ierele simplă bandă, incluzând o paletă continuă. Putet,i crea aici, de
asemenea, hărt,i individuale de culoare pentru benzile unice. Sunt disponibile trei tipuri de interpolare de
culoare:

1. Discret

2. Liniar

3. Exact

În blocul din stânga, butonul de Adăugare manuală a valorilor adaugă o valoare în tabelul de culori individ-

uale. Butonul de Eliminare rând s, terge o valoare din tabelul de culori individuale, iar butonul de
Sortare a elementelor din harta de culori sortează tabelul de culori în funct,ie de valorile pixelilor din coloana cu valori. Un
dublu-clic pe coloana valorilor permite introducerea unei anumite valori. Un dublu-clic pe coloana culorilor va
deschide dialogul de Schimbare a culorii, unde putet,i selecta o culoare pentru valoarea respectivă. În plus, putet,i
adăuga etichete pentru fiecare culoare, dar această valoare nu va fi afis, ată atunci când utilizat,i instrumentul de iden-

tificare a entităt,ii. De asemenea, putet,i face clic pe butonul de Încărcare a hărt,ii de culoare dintr-o bandă, care încearcă să

încarce tabelul dintr-o bandă (dacă are vreuna). Putet,i utiliza butoanele de Încărcare a fis, ierului hărt,ii de culori sau de
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Figure 13.5: Render Raster - Pseudoculoare cu bandă unică
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Export a hărt,ii de culoare într-un fis, ier, pentru a încărca un tabel de culori existente sau pentru a salva tabelul de culori
definite, pentru alte sesiuni.

În blocul din dreapta, Generare hartă de culori nouă vă permite să creat,i noi hărt,i de culoare organizate în clase.

Pentru Modul de clasificare cu ‘Intervale Egale’, trebuie să selectat,i numărul de clase s, i să apăsat,i

butonul de Clasificare. Putet,i inversa culorile hărt,ii, prin bifarea casetei de Inversare. În cazul Modului
‘Continuu’, QGIS creează clasele în mod automat, în funct,ie de Min s, i Max. Definirea valorilor Min/Max se poate
face cu ajutorul sect,iunii de Încărcare a valorilor min/max. O mult,ime de imagini au unele date foarte joase s, i
altele foarte înalte. Aceste aberat,ii pot fi eliminate folosind setarea Cumulative count cut. Gama standard de
date este setată de la 2% până la 98% din valorile datelor s, i poate fi adaptată manual. Cu această setare, poate
fi eliminat caracterul gri al unei imagini. Cu ajutorul opt,iunii de scalare Min/max, QGIS creează un tabel de
culori având toate datele incluse în imaginea originală (de exemplu, QGIS creează un tabel de culori cu 256 de
valori, t,inând cont de faptul că avet,i benzi pe 8 bit,i). Putet,i calcula, de asemenea, tabela dvs. de culori utilizând

Media +/- deviat,ia x standard . Ulterior, doar valorile din abaterea standard sau din mai multe deviat,ii
standard sunt luate în considerare pentru tabelul de culori.

Randarea culorii

Pentru fiecare Randare de bandă, este posibilă o Randare de culoare.

Putet,i obt,ine, de asemenea, efecte speciale de rendare pentru fis, ier(ele) raster, folosind unul din modurile de
amestecare (v. Dialogul Proprietăt,ilor Vectoriale).

Mai multe setări pot fi făcute prin modificarea Strălucirii, a Saturat,iei s, i a Contrastului. Putet,i utiliza, de aseme-
nea, o opt,iune Grayscale, în care putet,i alege între ‘By lightness’, ‘By luminosity’ s, i ‘By average’. Pentru o
nuant,ă din tabelul de culori, putet,i modifica ‘Strength’.

Reeşantionare

Opt,iunea Rees, antionare îs, i face aparit,ia atunci când mărit,i s, i mics, orat,i o imagine. Modurile de rees, antionare pot
optimiza aspectul hărt,ii. Eie calculează o nouă matrice cu valori de gri, printr-o transformare geometrică.

Figure 13.6: Randare Raster - Rees, antionare

Atunci când se aplică metoda ‘Celui mai apropiat vecin ‘, harta poate avea o structură pixelată, la efectuarea
unei transfocări. Aceasta aspect poate fi îmbunătăt,it prin utilizarea metodei ‘Biliniară’ sau ‘Cubică’, care poate
determina ca entităt,ile ascut,ite să fie neclare. Efectul constă într-o imagine mai fină. Această metodă poate fi
aplicată, de exemplu, pentru hărt,i raster, topografice, digitale.
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13.2.3 Meniul de Transparenţă

QGIS are abilitatea de a afis, a fiecare strat raster la un diferit nivel de transparent,ă. Utilizat,i cursorul de transparent,ă

pentru a indica în ce măsură straturile de bază (dacă este cazul) trebuie să fie vizibile prin
stratul raster curent. Acest lucru este foarte util dacă dorit,i să suprapunet,i mai mult de un strat raster (de exemplu, o
hartă a reliefului, suprapusă peste o hartă raster clasificată). Acest lucru va face aspectul hărt,ii mai tridimensional.

În plus, putet,i introduce o valoare raster care ar trebui să fie tratată ca FĂRĂDATE în meniul Additional no data
value.

Un mod chiar mai flexibil de a personaliza transparent,a este disponibil în sect,iunea Custom transparency options.
Transparent,a fiecărui pixel poate fi setată aici.

Ca exemplu, ne dorim să setăm stratul de apă din fis, ierul raster landcover.tif la o transparent,ă de 20%. Sunt
necesari următorii pas, i:

1. Încărcat,i fis, ierul raster landcover.tif.

2. Deschidet,i dialogul Proprietăt,ilor printr-un dublu-clic pe numele rasterului din legendă, sau printr-un clic-
dreapta urmat de selectarea Proprietăt,ilor din meniul care se deschide.

3. Selectat,i meniul Transparent,ă.

4. Pentru Banda de transparent,ă aleget,i ‘None’.

5. Clic pe butonul Add values manually. Un nou rând va apărea în lista pixelilor.

6. Introducet,i valoarea raster în coloanele ‘From’ s, i ‘To’ (vom folosi 0 aici), s, i vom ajusta transparent,a la 20.

7. Clic pe butonul [Apply], apoi aruncat,i o privire hărt,ii.

Putet,i repeta pas, ii 5 s, i 6 pentru a stabili mai multe valori cu transparent,ă personalizate.

După cum se poate vedea, des, i este destul de us, or de stabilit transparent,a după dorint,ă, trebuie parcurs, i o mult,ime

de pas, i. Prin urmare, putet,i utiliza butonul Export în fis, ier pentru a salva setările de transparent,ă într-un fis, ier.

Butonul de Import din fis, ier încarcă setările de transparent,ă s, i le aplică stratului raster curent.

13.2.4 Meniul Piramidelor

Straturile raster cu rezolut,ie mare pot încetini navigarea în QGIS. Prin crearea unor copii de rezolut,ie scăzută a
datelor (piramide), performant,a poate cres, te considerabil, întrucât QGIS utilizează cea mai potrivită rezolut,ie, în
funct,ie de nivelul de transfocare.

Trebuie să avet,i acces de scriere în directorul în care sunt stocate datele originale, pentru a construi piramide.

Mai multe metode de reproiectare pot dfi folosite pentru a calcula piramidele:

• cel mai apropiat vecin

• Medie

• Gauss

• Cubic

• Mod

• Niciuna

Dacă aleget,i ‘Intern (atunci când este posibil)’ din meniul Formatului de vizualizare, QGIS va încerca să constru-
iască piramidele în mod intern. De asemenea, putet,i alege ‘Extern’ s, i ‘Extern (Imagine Erdas)’.

Ret,inet,i că realizarea piramidelor interne poate modifica fis, ierul de date original, iar o dată create ele nu mai pot
fi eliminate! Dacă dorit,i să păstrat,i o versiune ‘fără-piramide’ a rasterului dvs., facet,i o copie de rezervă înainte
de construirea piramidelor.
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Figure 13.7: Meniul Piramidelor

13.2.5 Meniul Histogramei

Meniul Histogramei permite vizualizarea distribut,iei benzilor sau a culorilor în rasterul dvs. Histograma este
generată automat, atunci când se deschide meniul Histogramei. Vor fi afis, ate toate benzile existente. Avet,i posi-

bilitatea să salvat,i histograma sub forma unei imagini, cu ajutorul butonului . Folosind opt,iunea Vizibilitate

din meniul Prefs/Act,iuni, se pot afis, a histograme ale benzilor individuale. Va trebui să selectat,i opt,iunea
Afis, are bandă selectată. Opt,iunile min/max vă permit să ‘Afis, at,i întotdeauna marcajele min/max’, să ‘Transfocat,i
la min/max’ s, i să ‘Actualizat,i stilul la min/max’. Folosind opt,iunea Act,iunilor, putet,i ‘Reseta’ s, i ‘Recalcula his-
tograma’ după ce at,i ales Opt,iunile min/max.

Figure 13.8: Histograma Raster
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13.2.6 Meniu Metadate

Meniul Metadate afişează o multitudine de informaţii despre stratul raster, inclusiv statistici despre fiecare bandă
din stratul raster curent. Prin intermediul acestui meniu, se pot accesa Descriere, Atribuire, guilabel: ‘Meta-
dataUrl’ şi Proprietăt,i. În Proprietăt,i, statisticile sunt colectate pe tipicul ‘bine de s, tiut’, astfel încât este posibil
ca pentru un anumit strat statisticile să nu fie colectate încă.

Figure 13.9: Metadatele Raster

13.3 Analiza Raster

13.3.1 Calculatorul Raster

Calculatorul Raster din meniul Raster vă permite efectuarea calculelor pe baza valorilor raster ale pixelilor
existent,i (a se vedea figure_raster_10). Rezultatele sunt scrise într-un nou strat raster, într-un format acceptat
de GDAL.

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

În sect,iunea Stratului rezultat trebuie să definit,i un strat de ies, ire. Putet,i defini extinderea suprafet,ei calculate pe
baza unui strat de intrare raster, sau în funct,ie de coordonatele X,Y s, i de coloane s, i rânduri, pentru a seta rezolut,ia
stratului de ies, ire. În cazul în care stratul de intrare are o altă rezolut,ie, valorile vor fi rees, antionate cu algoritmul
celui mai apropiat vecin.

Sect,iunea Operatorilor cont,ine tot,i operatorii utilizabili. Pentru a adăuga un operator în caseta de expresii a
calculatorului raster, facet,i clic pe butonul corespunzător. Sunt disponibile operat,iile matematice (+, -, *, ... ) s, i
trigonometrice (sin, cos, tan, ... ). Cu timpul, vor fi disponibili mai mult,i operatori!

Cu ajutorul casetei de Adăugare a rezultatelor la proiect, stratul rezultatelor va fi automat încărcat legendă,
pentru a putea fi vizualizat.

Exemple

Conversia valorilor de elevat,ie de la metri la picioare
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Figure 13.10: Calculatorul Raster
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Pentru crearea unui raster de elevat,ie în feet dintr-un raster în metri, trebuie să utilizat,i factorul de conversie de la
metri la picioare: 3.28. Expresia este:

"elevation@1" * 3.28

Folosirea unei măs, ti

Dacă dorit,i să mascat,i unele părt,i dintr-un raster - să zicem, de exemplu, pentru că vă interesează doar altitudinile
de peste 0 metri - putet,i utiliza următoarea expresie pentru a crea o mască s, i pentru a aplica rezultatul unui raster,
într-un singur pas.

("elevation@1" >= 0) * "elevation@1"

Cu alte cuvinte, pentru fiecare celulă mai mare sau egală cu 0, valoarea sa va fi setată la 1. Altfel, va fi setată la 0.
Aceasta creează masca “din zbor”.

În cazul în care dorit,i să clasificat,i un raster - să zicem, de exemplu, în două clase de altitudine, putet,i utiliza
următoarea expresie pentru a crea un raster cu două valori, 1 s, i 2, într-un singur pas.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

Cu alte cuvinte, pentru fiecare celulă mai mică de 50, valoarea sa va fi setată la 1. Pentru fiecare celulă mai mare
sau egală cu 50 valoarea sa va fi setată la 2.

13.3.2 Alinierea Rasterelor

Acest instrument poate prelua mai multe rastere, pentru a le alinia perfect, ceea ce presupune:

• reproiectarea aceluias, i CRS,

• rees, antionarea la aceeas, i dimensiune de celulă s, i offset de grilă,

• decuparea regiunii de interes,

• redimensionarea valorilor, atunci când este necesar.

All rasters will be saved in another files.

First, open the tools from Raster → Align Raster... and click on the Add new raster button to choose one existing
raster in QGIS. Select an output file to save the raster after the alignment, the resampling method and if the tools

need to Rescale values according to the cell size. You can Edit file settings and Remove an existing file from the list.

Then in the main Align raster window, you can choose one or more options:

• Select the Reference Layer,

• Transform into a new CRS,

• Setup a different Cell size,

• Setup a different Grid Offset,

• Clip to Extent,

• Output Size,

• Add aligned raster to the map canvas.
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CHAPTER 14

Lucrul cu date OGC

14.1 QGIS ca s, i Client de Date OGC

Open Geospatial Consortium (OGC) este o organizatie internat,ională, având ca membri mai mult de 300 de
organizat,ii comerciale, guvernamentale, non-profit s, i de cercetare din întreaga lume. Membrii săi dezvoltă s, i
implementează standarde s, i servicii pentru cont,inut geospat,ial, de prelucrare s, i de schimb a datelor GIS.

Descriind un model de date de bază pentru entităt,ile geografice, un număr tot mai mare de specificat,ii sunt dez-
voltate de OGC, pentru a servi nevoilor specifice pentru tehnologii geospat,iale s, i de localizare interoperabile,
inclusiv GIS. Informat,ii suplimentare pot fi găsite la http://www.opengeospatial.org/.

Specificat,iile OGC importante, acceptate de către QGIS sunt:

• WMS — Web Map Service (Client WMS/WMTS)

• WMTS — Web Map Tile Service (Client WMS/WMTS)

• WFS — Web Feature Service (Client WFS s, i WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS s, i WFS-T)

• WCS — Web Coverage Service (Client WCS)

• SFS — Simple Features for SQL (Straturi PostGIS)

• GML — Limbaj cu Marcaje Geografice

Serviciile OGC sunt tot mai mult utilizate pentru a interschimba datele geospat,iale între diferitele implementări
GIS, sau între depozitele de date. QGIS are de-a face cu specificat,iile de mai sus din punctul de vedere al unui
client, fiind SFS (prin sprijinirea furnizorului de date PostgreSQL / PostGIS, v. sect,iunea Straturi PostGIS).

14.1.1 Client WMS/WMTS

Privire de ansamblu asupra suportului WMS

În prezent, QGIS poate act,iona ca un client WMS care înt,elege serverele WMS 1.1, 1.1.1 s, i 1.3. În special, acesta
a fost testat cu servere accesibile publicului, cum ar fi DEMIS.

Un server WMS act,ionează asupra cererilor din partea clientului (cum ar fi QGIS) pentru o hartă raster cu o
anumită extindere, set de straturi, stil de simbolizare, s, i transparent,ă. Serverul WMS îs, i consultă apoi sursele de
date locale, rasterizează harta, s, i o trimite înapoi la client, într-un format raster. Pentru QGIS, acest format va fi,
de obicei, JPEG sau PNG.

WMS este mai degrabă un serviciu generic REST (Transfer de Stare de Reprezentare), decât un serviciu Web
matur. De fapt, putet,i lua ca atare adresele URL generate de QGIS s, i să le utilizat,i într-un browser web, pentru a
obt,ine aceleas, i imagini pe care QGIS le foloses, te intern. Acest lucru poate fi util pentru depanare, deoarece există
mai multe mărci de servere WMS pe piat,ă, s, i toate au propria interpretare a standardului WMS.
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Straturile WMS pot fi adăugate pur s, i simplu, atât timp cât: s, tit,i URL-ul de acces la serverul WMS, at,i stabilit o
conexiune validă la acel server, iar serverul înt,elege ptotocolul HTTP, ca mecanism de transport al datelor.

În plus, QGIS va înmagazina pentru 24 de ore răspunsurile WMS (cum ar fi imaginile), atât timp cât nu este
declans, ată cererea GetCapabilities. GetCapabilities se declans, ează la fiecare apăsare a butonului [Connect] din
fereastra de dialog [Adăugare strat (straturi) de la un Server WMS(T)]. Aceasta este o caracteristică automată,
menită să optimizeze timpul de încărcare a proiectului. În cazul în care un proiect este salvat cu un strat WMS,
plăcut,ele WMS corespunzătoare vor fi încărcate, din memoria tampon, la următoarea deschidere a proiectului,
atâta timp cât acestea nu sunt mai vechi de 24H.

Privire de ansamblu asupra suportului WMTS

QGIS poate act,iona, de asemenea, ca un client WMTS. WMTS reprezintă un standard OGC pentru distribuirea
de seturi de plăcut,e ale datelor geospat,iale. Acesta constituie un mod mai rapid s, i mai eficient de a distribui date,
comparativ cu WMS, deoarece în cazul WMTS seturile de plăcut,e sunt pre-generate, iar clientul solicită numai
transmiterea lor, nu s, i producerea acestora. O cerere WMS implică, de regulă, atât generarea cât s, i transmiterea
datelor. Un exemplu bine-cunoscut al unui standard de bază non-OGC, pentru vizualizarea de date geospat,iale cu
ajutorul plăcut,elor, este Google Maps.

Pentru a afis, a datele la o varietate de scări, apropiate de ceea ce s, i-ar putea dori utilizatorul, seturile de plăcut,e
WMTS sunt produse la mai multe niveluri de scări diferite, s, i sunt puse la dispozit,ia clientului GIS pentru a le
apela.

Această diagramă ilustrează conceptul seturilor de plăcut,e:

Figure 14.1: Conceptul seturilor de plăcut,e WMTS:

Cele două tipuri de interfet,e WMTS, pe care QGIS le acceptă, sunt Key-Value-Pairs (KVP) s, i REST. Aceste două
interfet,e sunt diferite, s, i trebuie să le specificat,i în QGIS în mod diferit.

1. Pentru a avea acces la un serviciu WMTS KVP, un utilizator QGIS trebuie să deschidă interfat,a
WMS/WMTS s, i să adăuge următorul s, ir la adresa URL a serviciului de plăcut,e WMTS:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un exemplu al acestui tip de adresă este

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Pentru testare, stratul topo2 din acest WMTS funct,ionează bine. Adăugarea acestui s, ir indică faptul că se
va utiliza un serviciu web WMTS în locul unui serviciu WMS.

2. Serviciul RESTful WMTS are o formă diferită de adresă URL, simplă. Formatul recomandat de OGC este:
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{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

Acest format vă ajută să recunoas, tet,i o adresă RESTful. Un WMTS RESTful este accesat
în QGIS prin simpla adăugare a adresei sale în câmpul URL al formularului de setare a ser-
viciului WMS. Un exemplu de astfel de adresă, în cazul unei hărt,i de bază austriece este
http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Note: E posibil să găsit,i unele servicii vechi, denumite WMS-C. Aceste servicii sunt destul de
asemănătoare cu WMTS (adică au acelas, i scop, dar lucrează un pic diferit). Avet,i posibilitatea să le
gestionat,i similar serviciilor WMTS. Trebuie doar să adăugat,i ?tiled=true la finalul url-ului. Parcurget,i
http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification pentru mai multe informat,ii despre specificat,ia aces-
tui serviciu.

Când citit,i WMTS, vă putet,i gândi adesea s, i la WMS-C.

Selectarea serverelor WMS/WMTS

Prima dată când utilizat,i funct,iunea WMS din QGIS nu există servere definite.

Începet,i printr-un clic pe butonul Add WMS layer din bara de instrumente, sau prin selectarea elementului de
meniu Strat → Adăugare Strat WMS....

Va apărea dialogul de Adăugare Strat(uri) de la un Server. Putet,i adăuga demonstrativ unele ser-
vere, făcând clic pe butonul **[Adaugă servere implicite]**. În acest fel, adăugat,i două ser-
vere WMS demo pentru a le utiliza: serverele WMS ale DM Solutions Group s, i LizardTech. Pen-
tru a defini un nou server WMS, în fila :guilabel:‘Straturilor selectat,i butonul [Nou]. Apoi
introducet,i parametrii de conectare la serverul WMS dorit, as, a cum se arată în table_OGC_1:

Nume Un nume pentru această conexiune. Acest nume va fi folosit în lista Conexiunilor la Server,
astfel încât să o putet,i distinge de alte servere WMS.

URL URL-ul serverului care furnizează datele. Acesta trebuie să fie un nume de gazdă solubil -
acelas, i format pe care l-at,i folosi pentru a deschide o conexiune telnet, sau pentru a efectua
ping către un calculator.

Nume utilizator Numele de utilizator pentru a accesa un server WMS securizat. Acest parametru este
opt,ional.

Parolă Parola pentru autentificarea de bază la un server WMS. Acest parametru este opt,ional.

Ignorare
GetMap URI

Ignoră GetMap URI raportat în capabilităt,i. Foloses, te URI-ul dat din câmpul URL de
mai sus.

Ignorare
GetFeatureInfo
URI

Ignoră GetFeatureInfo URI raportat în capabilităt,i. Foloses, te URI-ul dat din câmpul
URL de mai sus.

Tabelul OGC 1: Parametri de conectare WMS

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

O dată ce noua conexiune de server WMS a fost creată, aceasta va fi păstrată pentru viitoarele sesiuni QGIS.

Tip: Despre URL-urile Server-ului WMS
Be sure, when entering the WMS server URL, that you have the base URL only. For example, you shouldn’t have
fragments such as request=GetCapabilities or version=1.0.0 in your URL.
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Warning: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

Încărcarea Straturilor WMS/WMTS

Once you have successfully filled in your parameters, you can use the [Connect] button to retrieve the capabilities
of the selected server. This includes the image encoding, layers, layer styles and projections. Since this is a
network operation, the speed of the response depends on the quality of your network connection to the WMS
server. While downloading data from the WMS server, the download progress is visualized in the lower left of the
WMS dialog.

Ecranul dvs. ar trebui să arate un pic ca în figure_OGR_1, care arată răspunsul oferit de serverul WMS al Portalului
Solurilor Europene.

Figure 14.2: Dialogul pentru adăugarea unui server WMS, arătând straturile sale disponibile

Codificare Imagine

The Image encoding section lists the formats that are supported by both the client and server. Choose one depend-
ing on your image accuracy requirements.

Tip: Codificare Imagine
Vet,i descoperi că, de obicei, un server WMS vă oferă posibilitatea de a alege codificarea imaginii sub formă de
JPEG sau PNG. JPEG este un format de compresie cu pierderi, în timp ce PNG reproduce fidel datele raster
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originale.

Use JPEG if you expect the WMS data to be photographic in nature and/or you don’t mind some loss in picture
quality. This trade-off typically reduces by five times the data transfer requirement compared with PNG.

Utilizat,i PNG dacă dorit,i reprezentări precise ale datelor originale, s, i nu vă deranjează cerint,ele crescute de transfer
de date.

Opt,iuni

The Options area of the dialog provides a text field where you can add a Layer name for the WMS layer. This
name will appear in the legend after loading the layer.

Mai jos de numele stratului, putet,i defini Dimensiunea plăcut,ei, în ncazul în care dorit,i să setat,i mărimea plăcut,elor
(ex.: 256x256), pentru divizarea cererii WMS.

Limitarea entităt,ilor pentru GetFeatureInfo defines, te ce entităt,i de pe server vor fi interogate.

If you select a WMS from the list, a field with the default projection provided by the mapserver appears. If the
[Change...] button is active, you can click on it and change the default projection of the WMS to another CRS
provided by the WMS server.

Finally you can activate Use contextual WMS-Legend if the WMS Server supports this feature. Then only the
relevant legend for your current map view extent will be shown and thus will not include legend items for things
you can’t see in the current map.

Ordinea straturilor

The Layer Order tab lists the selected layers available from the current connected WMS server. You may notice
that some layers are expandable; this means that the layer can be displayed in a choice of image styles.

Putet,i selecta mai multe straturi simultan, dar numai un singur stil pentru fiecare strat. Atunci când sunt selectate
mai multe straturi, acestea vor fi combinate în serverul WMS, după care vor fi transmise către QGIS toate o dată.

Tip: Ordinea straturilor WMS
WMS layers rendered by a server are overlaid in the order listed in the Layers section, from top to bottom of the
list. If you want to change the overlay order, you can use the Layer Order tab.

Transparenţă

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Tip: Transparenţa stratului WMS
Disponibilitatea transparent,ei pentru imaginile WMS depinde de codificarea folosită pentru imagini: formatele
PNG s, i GIF acceptă transparent,a, în timp ce pentru JPEG acest lucru nu este posibil.

Sistemul de Coordonate de Referint, ă

Un sistem de referint,ă de coordonate (CRS) este o terminologie OGC pentru o proiect,ie QGIS.

Fiecare strat WMS poate fi prezentat în mai multe CRS-uri, în funct,ie de capacitatea serverului WMS.

To choose a CRS, select [Change...] and a dialog similar to Figure Projection 3 in Lucrul cu Proiect,ii will appear.
The main difference with the WMS version of the dialog is that only those CRSs supported by the WMS server
will be shown.

Căutare server

Within QGIS, you can search for WMS servers. Figure_OGC_2 shows the Server Search tab with the Add Layer(s)
from a Server dialog.
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Figure 14.3: Dialogul pentru căutarea, după unele cuvinte cheie, a serverelor WMS

După cum putet,i vedea, este posibil să introducet,i un s, ir de căutare în câmpul de text, apoi apăsat,i butonul
[Search]. După o scurtă perioadă de timp, rezultatul căutării va fi înscris în lista de sub câmpul de text. Răsfoit,i
lista de rezultate s, i inspectat,i rezultatele căutării în tabel. Pentru a vizualiza rezultatele, selectat,i o intrare din
tabelă, apăsat,i butonul [Add selected row to WMS list], s, i revenit,i la fila Layers. QGIS s, i-a actualizat automat
lista dvs. de servere, iar rezultatul de căutare selectat este deja activat în lista de servere WMS salvate în fila
Layers. Trebuie doar să solicitat,i lista de straturi făcând clic pe butonul [Connect]. Această opt,iune este foarte
convenabilă atunci când dorit,i să căutat,i hărt,i folosind cuvinte cheie specifice.

Practic, această opt,iune este un front-end pentru API-ul de la http://geopole.org.

Seturi de plăcut,e

Atunci când se utilizează servicii WMTS (Cached WMS), cum ar fi

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by
selecting Settings → Panels (KDE) or View → Panels (Gnome, Windows and MacOSX), then choosing Tile Scale
Panel. This gives you the available scales from the tile server with a nice slider docked in.

Folosirea instrumentului de identificare

După ce at,i adăugat un server WMS, în cazul în care orice strat primit de la serverul WMS este interogabil, putet,i

folosi instrumentul Identificare pentru a selecta un pixel de pe canevasul hărt,ii. O interogare a serverului WMS
are loc pentru fiecare select,ie efectuată. Rezultatele interogării sunt returnate sub formă de text simplu. Formatarea
acestui text depinde de particularităt,ile serverului WMS folosit. Select,ia Formatului
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If multiple output formats are supported by the server, a combo box with supported formats is automatically added
to the identify results dialog and the selected format may be stored in the project for the layer. Suport pentru
formatul GML

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Vizualizarea Proprietăţilor

După ce at,i adăugat un server WMS, îi putet,i vizualiza proprietăt,ile printr-un clic-dreapta pe el, în legendă, s, i prin
selectarea Proprietăt,ilor. Fila Metadatelor

The tab Metadata displays a wealth of information about the WMS server, generally collected from the capabilities
statement returned from that server. Many definitions can be gleaned by reading the WMS standards (see OPEN-
GEOSPATIAL-CONSORTIUM in Literatură s, i Referint,e Web), but here are a few handy definitions:

• Proprietăţile serverului

– Versiunea WMS — Versiunea WMS acceptată de server.

– Formatele de Imagine — Lista tipurilor MIME pentru care serverul poate răspunde la momentul
desenării hărt,ii. QGIS acceptă oricare dintre formatele recunoscute de bibliotecile Qt, acestea fiind de
obicei image/png s, i image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Proprietăţile stratului

– Selectat — Indiferent dacă acest strat a fost sau nu selectat, atunci când serverul său a fost adăugat în
acest proiect.

– Vizibil — Indiferent dacă acest strat este selectat ca vizibil în legendă (nu este utilizat încă în această
versiune de QGIS).

– Poate Identifica — Dacă acest strat va returna un rezultat, sau nu, atunci când este folosit instrumentul
Identificare asupra lui.
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– Poate fi Transparent — Dacă sau nu, un strat poate fi randat cu transparent,ă. Această versiune de
QGIS va folosi întotdeauna transparent,a dacă această setare este Yes, s, i dacă codificarea imaginii
acceptă transparent,ă.

– Se Poate Mări — Dacă acest strat poate fi, sau nu, mărit de către server. Această versiune de QGIS
presupune că toate straturile WMS au această opt,iune setată pe Yes. Straturile cu deficient,e pot fi
randate în mod eronat.

– Numărare în Cascadă — Serverele WMS pot act,iona ca un proxy pentru alte servere WMS, pentru a
obt,ine datele raster ale unui strat. Această intrare arată de câte ori este transmisă cererea pentru acest
strat către alte servere WMS, pentru obt,inerea unui rezultat.

– Lăt,ime fixă, Înălt,ime Fixă — Dacă acest strat are, sau nu, dimensiuni fixe. Această versiune de
QGIS presupune că toate straturile WMS nu au această opt,iune setată. Straturile cu deficient,e pot fi
randate în mod eronat.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Disponibil în CRS — Proiect,iile în care poate fi randat acest strat de către serverul WMS. Acestea
sunt prezentate în format nativ WMS.

– Disponibil în stil — Stilurile de imagine în care poate fi randat acest strat de către serverul WMS.

Arată legenda grafică WMS în cuprins s, i în compozitor

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

If a legendGraphic is available, it is shown below the layer. It is little and you have to click on it to open it in real
dimension (due to QgsLegendInterface architectural limitation). Clicking on the layer’s legend will open a frame
with the legend at full resolution.

In the print composer, the legend will be integrated at it’s original (downloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend –> WMS LegendGraphic to match your printing
requirements

The legend will display contextual information based on your current scale. The WMS legend will be shown only
if the WMS server has GetLegendGraphic capability and the layer has getCapability url specified, so you have to
select a styling.

Limitările clientului WMS

În această versiune de QGIS, clientul WMS nu include orice funct,ionalitate posibilă. Unele dintre cele mai
notabile except,ii sunt prezentate în continuare.

Editarea Setărilor Stratului WMS

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

Cerint,ele de autentificare ale Serverelor WMS

Currently, publicly accessible and secured WMS services are supported. The secured WMS servers can be ac-
cessed by public authentication. You can add the (optional) credentials when you add a WMS server. See section
Selectarea serverelor WMS/WMTS for details.

Tip: Accesarea straturilor OGC securizate
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If you need to access secured layers with secured methods other than basic authentication, you can use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found in the
InteProxy manual at http://inteproxy.wald.intevation.org.

Tip: QGIS WMS Mapserver
Începând cu versiunea 1.7.0, QGIS include propria implementare de Mapserver WMS 1.3.0. Citit,i mai multe
despre acest lucru în capitolul QGIS ca s, i Server de Date OGC.

14.1.2 Client WCS

Un Serviciu de Acoperire Web (WCS) oferă acces la datele raster, în forme care sunt utile pentru randarea pe
partea clientului, ca date de intrare în modelele s, tiint,ifice, precum s, i pentru alt,i client,i. WCS poate fi comparat cu
WFS s, i WMS. La fel ca s, i instant,ele serviciilor WMS s, i WFS, un WCS permite client,ilor să aleagă port,iuni din
informat,iile serverelor, bazate pe constrângeri spat,iale s, i pe alte criterii de interogare.

QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

Furnizorul nativ WCS se ocupă de toate cererile de ret,ea, utilizând toate setările de ret,ea standard ale QGIS
(în special proxy). Este, de asemenea, posibil de selectat modul cache (‘întotdeauna cache’, ‘se preferă cache’,
‘se preferă ret,eaua’, ‘mereu ret,ea’), furnizorul acceptând, de asemenea, select,ia pozit,iei în timp, dacă domeniul
temporal este oferit de server.

Warning: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

14.1.3 Client WFS s, i WFS-T

În QGIS, un strat WFS se comportă destul de mult ca oricare alt strat vectorial. Putet,i identifica s, i selecta entităt,ile,
pentru a le vizualiza în tabelul de atribute. Începând cu versiunea QGIS 1.6, editarea WFS-T este, de asemenea,
acceptată.

În general, adăugarea unui strat WFS este foarte similară cu procedura utilizată pentru WMS. Diferent,a este că nu
există servere standard definite, as, a că trebuie să-l adăugăm pe al nostru.

Încărcarea unui strat WFS

Ca exemplu, vom folosi serverul WFS de la DM Solutions pentru a afis, a un strat. URL-ul este:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Clic pe instrumentul Add WFS Layer din bara de instrumente a Straturilor. Va apărea dialogul Add WFS
Layer from a Server.

2. Clic pe [Nou].

3. Introducet,i ‘DM Solutions’ ca nume.

4. Introducet,i URL-ul (a se vedea mai sus).

5. Clic pe [OK].

6. Aleget,i ‘Solut,ii DM’ din lista cu derulare verticală a Conexiunilor la Server .

7. Clic pe [Conectare].

8. As, teptat,i ca lista de straturi să fie populată.
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9. Selectat,i stratul Parks din listă.

10. Clic pe [Apply] pentru a adăuga stratul la hartă.

Ret,inet,i că orice setări proxy stabilite în preferint,e sunt, de asemenea, recunoscute.

Warning: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See ref:authentication_index for more details.

Figure 14.4: Adăugarea unui strat WFS

Ret,inet,i că progresul descărcării este vizualizat în partea din stânga jos a ferestrei principale QGIS. O dată ce
stratul este încărcat, putet,i identifica s, i selecta o provincie sau două, apoi să le vedet,i în tabelul de atribute.

Numai WFS 1.0.0 este acceptat. În acest moment, nu au existat multe teste asupra versiunilor WFS implementate
în alte servere. Dacă întâmpinat,i probleme cu oricare alt server WFS, vă rugam să nu ezitat,i să contactat,i echipa
de dezvoltare. Vă rugăm să consultat,i sect,iunea Asistent,ă s, i Ajutor pentru mai multe informat,ii despre listele de
discut,ii.

Tip: Găsirea Serverelor WFS
Putet,i găsi servere suplimentare WFS cu ajutorul Google, sau a motorului de căutare preferat. Există o serie de
liste cu URL-uri publice, unele dintre ele întret,inute, altele nu.

14.2 QGIS ca s, i Server de Date OGC

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd).
It has Python plugin support allowing for fast and efficient development and deployment of new features. The
original development of QGIS Server was funded by the EU projects Orchestra, Sany and the city of Uster in
Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.
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Atât timp cât QGIS desktop s, i QGIS Server folosesc aceleas, i biblioteci de vizualizare, hărt,ile care sunt publicate
pe web arătând la fel ca s, i în GIS desktop.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Debian/Ubuntu
Linux. For user contributed installation instructions on other platforms or distributions, we recommend reading
one of the following URLs:

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://www.itopen.it/qgis-server-python-plugins-ubuntu-setup/

14.2.1 Instalare QGIS Server pe Debian/Ubuntu

At this point, we will give a short and simple sample installation how-to for a minimal working configuration using
Apache2 on Debian Squeeze (or with negligible variations on Ubuntu 14.04). Many other OSs provide packages
for QGIS Server, too. If you have to build it all from source, please refer to the URLs above.

În primul rând, adăugat,i următorul depozit GIS pentru debian:

$ cat /etc/apt/sources.list.d/debian-gis.list
deb http://qgis.org/debian trusty main
deb-src http://qgis.org/debian trusty main

$ # Add keys
$ sudo gpg --keyserver keyserver.ubuntu.com --recv-key 3FF5FFCAD71472C4
$ sudo gpg --export --armor 3FF5FFCAD71472C4 | sudo apt-key add -

$ # Update package list
$ sudo apt-get update && sudo apt-get upgrade

Acum, instalat,i QGIS Server:

$ sudo apt-get install qgis-server python-qgis

Installation of a HelloWorld example plugin for testing the servers. You create a directory to hold server plugins.
This will be specified in the virtual host configuration and passed on to the server through an environment variable:

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
$ # In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

Instalat,i serverul Apache într-o gazdă virtuală separată, care monitorizează portul 80. Activat,i modulul de rescriere
pentru a permite autentificarea antetelor HTTP BASIC:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

Aceasta este configurat,ia gazdei virtuale, stocate în /etc/apache2/sites-available/001-qgis-server.conf
:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
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FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Acum activat,i gazda virtuală s, i repornit,i Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Testat,i serverul cu plugin-ul HelloWorld:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

Putet,i arunca o privire la comanda GetCapabilities a serverului QGIS la:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

Tip: Dacă lucrat,i cu o entitate care are multe noduri, atunci modificarea s, i adăugarea altei entităt,i va es, ua. În
acest caz, este posibilă introducerea următorului cod în fis, ierul 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

14.2.2 Crearea unui server WMS/WFS/WCS dintr-un proiect QGIS

Pentru a crea un nou Server WMS, WFS or sau WCS QGIS, trebuie să creăm un fis, ier de proiect QGIS, în care să
existe câteva date. În continuare, vom folosi fis, ierul shape ‘Alaska’, al setului de date es, antion din QGIS. În QGIS
definit,i culorile s, i stilurile straturilor, precum s, i CRS-ul proiectului, dacă nu at,i făcut deja acest lucru.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.
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Figure 14.5: Definit,iile unui proiect de Server WMS/WFS/WCS QGIS
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Warning: If you’re using the QGIS project with styling based on SVG files using relative paths then you
should know that the server considers the path relative to its qgis_mapserv.fcgi file (not to the qgs file). So, if
you deploy a project on the server and the SVG files are not placed accordingly, the output images may not
respect the Desktop styling. To ensure this doesn’t happen, you can simply copy the SVG files relative to the
qgis_mapserv.fcgi. You can also create a symbolic link in the directory where the fcgi file resides that points
to the directory containing the SVG files (on Linux/Unix).

Capabilităţi WMS

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetProjectSettings response, and
they can be used by the GetPrint request to create prints, using one of the print composer layouts as a template.
This is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries.

Putet,i primi rezultatul solicitării GetFeatureInfo sub formă de text simplu, XML s, i GML. XML este implicit,
textul sau formatul GML depinzând de formatul de ies, ire ales pentru cererea GetFeatureInfo.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown
in the GetFeatureInfo output.

QGIS acceptă următoarele cereri pentru serviciul WMS:

• GetCapabilities

• GetMap

• GetFeatureInfo

• GetLegendGraphic (profilul SLD)

• DescribeLayer (profilul SLD)

• GetStyles (profilul QGIS personalizat)

Capabilităţi WFS

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow
update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities
section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.
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QGIS acceptă următoarele cereri pentru serviciul WFS:

• GetCapabilities

• DescribeFeatureType

• GetFeature

• Transaction

Capabilităţi WCS

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Now, save the session in a project file alaska.qgs. To provide the project as a WMS/WFS, we create a new
folder /usr/lib/cgi-bin/project with admin privileges and add the project file alaska.qgs and a
copy of the qgis_mapserv.fcgi file - that’s all.

Acum vom testa proiectul nostru WMS, WFS s, i WCS. Adăugat,i în QGIS serviciile WMS, WFS s, i WCS, as, a cum
este descris în Încărcarea Straturilor WMS/WMTS, Client WFS s, i WFS-T s, i Client WCS, apoi încărcat,i datele.
URL-ul este:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

QGIS acceptă următoarele cereri pentru serviciul WCS:

• GetCapabilities

• DescribeCoverage

• GetCoverage

Stocarea cererilor GetCapabilities

In order to improve response time, QGIS Server caches the responses to the GetCapabilities requests.
When such a request comes, QGIS Server is caching the response and marking the cache valid. At the same time,
it watches if the project file changes. If the project is changed then the cache is marked as invalid and QGIS Server
waits for a new request in order to recreate the cache.

Reglarea fină a OWS-ului dvs.

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a
specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG anno-
tations to the project file. See the Annotation Tools section in Instrumente generale for instructions on creating
annotations. For annotations to be displayed as watermarks on the WMS output, the Fixed map position check
box in the Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation
while one of the annotation tools is active. For SVG annotations, you will need either to set the project to save
absolute paths (in the General menu of the Project → Project Properties dialog) or to manually modify the path
to the SVG image so that it represents a valid relative path.

14.2.3 Configurarea serverului s, i parametrii acceptat,i

QGIS Server supports some vendor parameters and requests that greatly enhance the possibilities of customising
its behavior. The following paragraphs list the vendor parameters and the environment variables supported by the
server.
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Parametri suplimentari acceptat,i de toate tipurile de cerere

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Exemplu:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Note: You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable where
to find the QGIS project file. This variable will be the location where QGIS will look for the project file. If not
defined it will use the MAP parameter in the request and finally look at the server executable directory.

Parametri suplimentari acceptat,i de cererea WMS GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OGC WMS 1.3.0 specification:

• Parametrul DPI: parametrul DPI poate fi folosit pentru a specifica rezolut,ia de ies, ire solicitată.

Exemplu:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• OPACITIES parameter: Opacity can be set on layer or group level. Allowed values range from 0 (fully
transparent) to 255 (fully opaque).

Exemplu:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

• FILTER parameter: (Available in QGIS 1.8 and above). Subsets of layers can be selected with the
FILTER parameter. Syntax is basically the same as for the QGIS subset string. However, there
are some restrictions to avoid SQL injections into databases via QGIS server:

Text strings need to be enclosed with quotes (single quotes for strings, double quotes for attributes)
A space between each word / special character is mandatory. Allowed Keywords and special char-
acters are ‘AND’,’OR’,’IN’,’=’,’<’,’>=’, ‘>’,’>=’,’!=*,’(‘,’)’. Semicolons in string expressions are not
allowed

Exemplu:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:’text’ = ’blabla’&....

Note: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS server then returns info about the matching features and generates a combined bounding box in the
xml output.

• SELECTION parameter: (Available in QGIS 1.8 and above) Vector features can be selected by passing
comma separated lists with feature ids in GetMap and GetPrint.

Exemplu:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6&...
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Parametri suplimentari acceptat,i de cererea WMS GetFeatureInfo

QGIS Server WMS GetFeatureInfo requests supports the following extra optional parameters to define the toler-
ance for point, line and polygon layers:

• FI_POINT_TOLERANCE parameter: Tolerance for point layers GetFeatureInfo request, in pixels.

• FI_LINE_TOLERANCE parameter: Tolerance for linestring layers GetFeatureInfo request, in pixels.

• FI_POLYGON_TOLERANCE parameter: Tolerance for polygon layers GetFeatureInfo request, in pixels.

Cererea GetPrint

QGIS server has the capability to create print composer output in pdf or pixel format. Print composer windows
in the published project are used as templates. In the GetPrint request, the client has the possibility to specify
parameters of the contained composer maps and labels.

Exemplu:

The published project has two composer maps. In the GetProjectSettings response, they are listed as possible print
templates:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

Clientul are acum informat,iile pentru a solicita o ies, ire la imprimantă:

http://myserver.com/cgi/qgis_mapserv.fcgi?...&REQUEST=GetPrint&TEMPLATE=Druckzusammenstellung 1&map0:EXTENT=xmin,ymin,xmax,ymax&map0:ROTATION=45&FORMAT=pdf&DPI=300

Parametrii din cererea GetPrint sunt:

• <map_id>:EXTENT gives the extent for a composer map as xmin,ymin,xmax,ymax.

• <map_id>:ROTATION map rotation in degrees

• <map_id>:GRID_INTERVAL_X, <map_id>:GRID_INTERVAL_Y Grid line density for a composer
map in x- and y-direction

• <map_id>:SCALE Sets a mapscale to a composer map. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator

• <map_id>:LAYERS, <map_id>:STYLES possibility to give layer and styles list for composer map (use-
ful in case of overview maps which should have only a subset of layers)

Cererea GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE spat,iul vertical dintre straturi (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE spat,iul vertical, dintre simbol s, i elementul următor (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH lăt,imea ferestrei de previzualizare a simbolului (mm)
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• SYMBOLHEIGHT înălt,imea ferestrei de previzualizare a simbolului (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD ‘TRUE’ to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC ‘TRUE’ to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL (from QGIS 2.4) set them to ‘FALSE’ to get only the legend graphics
without labels

Contest based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Contest based legend features are based on the UMN MapServer implementation:

Cererea GetProjectSettings

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• Vizibilitatea init,ială a straturilor

• information about vector attributes and their edit types

• information about layer order and drawing order

• lista straturilor publicate în WFS

Export DXF

It is possible to export layers in the DXF format using the GetMap Request. Only layers that have read access in
the WFS service are exported in the DXF format. Here is a valid REQUEST and a documentation of the available
parameters:

http://your.server.address/wms/liegenschaftsentwaesserung/abwasser_werkplan?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&LAYERS=Haltungen,Normschacht,Spezialbauwerke&STYLES=&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905&WIDTH=1042&HEIGHT=811&FORMAT=application/dxf&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=werkplan_abwasser.dxf

Parametri:

• FORMAT=application/dxf

• FILE_NAME=yoursuggested_file_name_for_download.dxf

• FORMAT_OPTIONS=v. opt,iunile de mai jos, key:value perechi separate prin punct s, i virgulă

Parametri FORMAT_OPTIONS:

• SCALE:scale to be used for symbology rules, filters and styles (not an actual scaling of the data - data
remains in the original scale).

• MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY corresponds
to the three export options offered in the QGIS Desktop DXF export dialog.

• LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames - if not specified,
the original QGIS layer names are used.
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• În cazul în care se activează USE_TITLE_AS_LAYERNAME, titlul stratului va servi drept nume pentru
strat.

Parametri suplimentari acceptat,i de cererea WFS GetFeature

In the WFS GetFeature request, QGIS Server accepts two extra parameters in addition to the standard parameters
according to the OGC WFS 1.0.0 specification:

• GeometryName parameter: this parameter can be used to get the extent or the centroid as the geometry or
no geometry if none if used (ie attribute only). Allowed values are extent, centroid or none.

• StartIndex parameter: STARTINDEX is standard in WFS 2.0, but it’s an extension for WFS 1.0.0 which
is the only version implemented in QGIS Server. STARTINDEX can be used to skip some features in the
result set and in combination with MAXFEATURES will provide for the ability to use WFS GetFeature to
page through results. Note that STARTINDEX=0 means start with the first feature, skipping none.

Jurnalizarea Serverului QGIS

Pentru a jurnaliza cererile transmise serverului, setat,i următoarele variabile de mediu:

• QGIS_SERVER_LOG_FILE: Specificat,i calea s, i numele fis, ierului. Asigurat,i-vă că serverul are permisi-
uni adecvate pentru a scrie în fis, ier. Fis, ierul ar trebui să fie creat automat, doar trimitet,i nis, te cereri la server.
Dacă nu se află acolo, atunci verificat,i permisiunile.

• QGIS_SERVER_LOG_LEVEL: Precizat,i nivelul de jurnalizare dorit. Valorile disponibile sunt:

– 0 INFO (se jurnalizează toate cererile),

– 1 AVERTISMENT,

– 2 CRITIC (se jurnalizează doar erorile critice, adecvat în scop de product,ie).

Exemplu:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Note:
• Când utilizat,i modulul Fcgid, folosit,i FcgidInitialEnv în loc de SetEnv!

• Jurnalizarea Serverului este activată, de asemenea, în cazul în care executabilul este compilat în modul de
lansare ca versiune nouă.

Nume scurte pentru straturi, grupuri s, i proiecte

O serie de elemente au atât un <Name> cât s, i un <Titlu>. Numele este reprezentat printr-un s, ir de caractere,
care este utilizat pentru comunicarea de-la-mas, ină-la-mas, ină, în timp ce Titlul este folosit pentru comunicarea
între utilizatori.

De exemplu, un set de date poate avea Titlul descriptiv “Temperatura Atmosferică Maximă” s, i să fie solicitat cu
ajutorul Numelui abreviat “ATMAX”. Utilizatorul poate seta deja titlul pentru straturi, grupuri s, i pentru proiect.

Numele OWS se bazează pe numele utilizat în arborele straturilor. Acest nume este mai mult o etichetă pentru
uzul utilizatorului, nicidecum un nume pentru comunicarea de-la-mas, ină-la-mas, ină.

Serverul QGIS acceptă:

• linii editabile, pentru nume scurte, în proprietăt,ile straturilor

• WMS data dialog to layer tree group (short name, title, abstract) By right clicking on a layer group and
selecting the Set Group WMS data option you will get:
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• liniile de editare a numelor scurte în proprietăt,ile proiectului- adaugă un validator regex
"^[A-Za-z][A-Za-z0-9\._-]*" pentru liniile de editare a numelor scurte, accesibil printr-o metodă
statică

• adaugă un validator regex "^[A-Za-z][A-Za-z0-9\._-]*", pentru liniile de editare a numelor
scurte, accesibil printr-o metodă statică

• adaugă un element TreeName în fullProjectSettings

În cazul în care un nume scurt a fost stabilit pentru straturi, grupuri s, i proiect, acesta va fi utilizat de QGIS Sever
pentru numele stratului.

Connection to service file

In order to make apache aware of the PostgreSQL service file (see the Service connection file section) you need to
make your *.conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None

.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/truetype/myfonts

# copy the fonts from their location
cp /fonts_location/* .
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chown root *
cd .. && fc-cache -f -v

• On Fedora based systems:

sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

Variabile de mediu

You can configure some aspects of QGIS server by setting environment variables. For example, to set QGIS
server on Apache to use /path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

or, if using fcgi:

FcgidInitialEnv QGIS_OPTIONS_PATH "/path/to/config/"

This is a list of the variables supported by QGIS server:

• QGIS_OPTIONS_PATH: Specifies the path to the directory with settings. It works the
same way as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini.

• QUERY_STRING: The query string, normally passed by the web server. This variable can be useful while
testing QGIS server binary from the command line.

• QGIS_PROJECT_FILE: the .qgs project file, normally passed as a parameter in the query string, you can
also set it as an environment variable (for example by using mod_rewrite Apache module).

• QGIS_SERVER_LOG_FILE: Specificat,i calea s, i numele fis, ierului. Asigurat,i-vă că serverul are permisi-
uni adecvate pentru a scrie în fis, ier. Fis, ierul ar trebui să fie creat automat, doar trimitet,i nis, te cereri la server.
Dacă nu se află acolo, atunci verificat,i permisiunile.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. See Jurnalizarea Serverului QGIS

• MAX_CACHE_LAYERS: Specify the maximum number of cached layers (default: 100).

• DISPLAY: This is used to pass (fake) X server display number (needed on Unix-like systems).

• QGIS_PLUGINPATH: Useful if you are using Python plugins for the server, this sets the folder that is
searched for Python plugins.
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CHAPTER 15

Lucrul cu datele GPS

15.1 Plugin-ul GPS

15.1.1 Ce este GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 Încărcarea datelor GPS dintr-un fis, ier

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• Instrumente GPS

• Crearea unui nou Strat GPX

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Date es, antion for more information
about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Răsfoit,i folderul qgis_sample_data/gps/, selectând fis, ierul GPX national_monuments.gpx
s, i făcând clic pe [Deschidere].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.

Note: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
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Figure 15.1: Fereastra de dialog a Instrumentelor GPS

file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 Importarea datelor GPS

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here, you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

15.1.5 Descărcarea datelor GPS de pe un dispozitiv

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

The device type you select in the GPS device menu determines how GPSBabel tries to communicate with your
GPS device. If none of the available types work with your GPS device, you can create a new type (see section
Definirea noilor tipuri de dispozitive).

The port may be a file name or some other name that your operating system uses as a reference to the physical port
in your computer that the GPS device is connected to. It may also be simply USB, for USB-enabled GPS units.

• Pe Linux, este ceva de genul /dev/ttyS0 sau /dev/ttyS1.

• Pe Windows, este COM1 sau COM2.

Când facet,i clic pe [OK], datele vor fi descărcate de pe dispozitiv s, i vor apărea într-un strat din QGIS.
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Figure 15.2: Instrumentul de descărcare

15.1.6 Încărcarea datelor GPS pe un dispozitiv

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Definirea noilor tipuri de dispozitive

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type will be replaced by -w if you are downloading waypoints, -r if you are downloading routes and -t if
you are downloading tracks. These are command-line options that tell GPSBabel which feature type to download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

The upload command is the command that is used to upload data to the device. The same keywords are used, but
%in is now replaced by the name of the GPX file for the layer that is being uploaded, and %out is replaced by
the port name.

Putet,i afla mai multe despre GPSBabel s, i despre opt,iunile disponibile pentru linia de comandă la
http://www.gpsbabel.org.

După ce at,i creat un nou tip de dispozitiv, acesta va apărea în listele dispozitivelor, pentru instrumentele de down-
load s, i de upload.
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15.1.8 Descărcat,i punctele/traseele de pe unităt,ile GPS

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
#6318 that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the
moment limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Instalat,i driver-ele USB Garmin de la http://www8.garmin.com/support/download_details.jsp?id=591

Connect the unit. Open GPS Tools and use type=garmin serial and port=usb: Fill the fields Layer
name and Output file. Sometimes it seems to have problems saving in a certain folder, using something like
c:\temp usually works.

Ubuntu/Mint GNU/Linux

It is first needed an issue about the permissions of the device, as described at
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. You can try to create a file
/etc/udev/rules.d/51-garmin.rules containing this rule

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

După aceea este necesar să vă asigurat,i că modulul de kernel garmin_gps nu este încărcat

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug #7182 and usually QGIS freezes
several times before the operation work fine.

BTGP-38KM datalogger (doar Bluetooth)

MS Windows

The already referred bug does not allow to download the data from within QGIS, so it is needed to use GPSBabel
from the command line or using its interface. The working command is

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Utilizat,i aceeas, i comandă (sau setări, dacă utilizat,i GPSBabel GUI) ca în Windows. În Linux, întrucâtva este
normal să obt,inet,i un mesaj de genul

skytraq: Too many read errors on serial port

este doar o chestiune de oprire s, i repornire a înregistratorului de date, apoi încercat,i din nou.

BlueMax GPS-4044 datalogger (atât BT cât s, i USB)

MS Windows

Note: Este nevoie de instalarea driver-elor sale înainte de utilizarea pe Windows 7. Vizitat,i site-ul producătorului
pentru descărcarea corectă.

La descărcarea cu GPSBabel, atât cel cu USB cât s, i cel cu BT returnează întotdeauna o eroare de genul

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1
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Ubuntu/Mint GNU/Linux

Cu USB

After having connected the cable use the dmesg command to understand what port is being used, for example
/dev/ttyACM3. Then as usual use GPSBabel from the CLI or GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Cu Bluetooth

Use Blueman Device Manager to pair the device and make it available through a system port, then run GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

15.2 Urmărirea live a GPS-ului

Pentru a activa urmărirea în direct a GPS-ului în QGIS, trebuie să selectat,i Setări → Panouri Informat,ii GPS.
Vet,i vedea o fereastră nouă, andocată în partea stângă a canevas-ului.

Există patru ecrane posibile în această fereastră de urmărire GPS:

• Coordonatele GPS s, i o interfat,ă pentru introducerea manuală a vertecs, ilor s, i a entităt,ilor

• Puterea semnalului GPS al conexiunilor prin satelit

• Ecran GPS polar, care prezintă numărul s, i pozit,ia polară a satelit,ilor

• Opt,iunile ecranului GPS (a se vedea figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Warning: If you want to record your position to the canvas, you have to create a new vector layer first and
switch it to editable status to be able to record your track.

15.2.1 Pozit,ia s, i atributele suplimentare

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 Puterea semnalului GPS

Aici se poate vedea puterea semnalului pe care îl primit,i de la satelit,i.

15.2.3 Fereastra polară GPS

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.
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Figure 15.3: Urmărirea pozit,iei GPS s, i atributele suplimentare

Figure 15.4: Puterea de urmărire a semnalului GPS
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Figure 15.5: Fereastra polară de urmărire GPS

15.2.4 Opt,iunile GPS

În cazul unor probleme de conectare, putet,i comuta între:

• Autodetectare

• Intern

• Dispozitiv serial

• gpsd (se alege Gazda, Portul s, i Dispozitivul la care este conectat GPSul dvs.)

Un nou clic pe [Connect] init,iază conectarea la receptorul GPS.

You can activate Automatically save added features when you are in editing mode. Or you can activate
Automatically add points to the map canvas with a certain width and color.

Activating Cursor, you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Finally, you can activate Log file and define a path and a file where log messages about the GPS tracking are
logged.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Conectaare la un GPS Bluetooth pentru urmărirea în direct a pozit,iei

With QGIS you can connect a Bluetooth GPS for field data collection. To perform this task you need a GPS
Bluetooth device and a Bluetooth receiver on your computer.

At first you must let your GPS device be recognized and paired to the computer. Turn on the GPS, go to the
Bluetooth icon on your notification area and search for a New Device.

On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Ret,inet,i numărul portului COM atribuit conexiunii GPS, după cum rezultă din proprietăt,ile Bluetooth.

După ce GPS-ul a fost recunoscut, creat,i asocierea pentru conexiune. De obicei, codul de autorizare este 0000.
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Figure 15.6: Fereastra opt,iunilor de urmărire GPS
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Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

If QGIS can’t receive GPS data, then you should restart your GPS device, wait 5-10 seconds then try to connect
again. Usually this solution work. If you receive again a connection error make sure you don’t have another
Bluetooth receiver near you, paired with the same GPS unit.

15.2.6 Folosirea GPSMAP 60cs

MS Windows

Cel mai simplu mod de lucru constă în utilizarea unui middleware (gratuit, dar fără sursă deschisă), denumit
GpsGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

As for Windows the easiest way is to use a server in the middle, in this case GPSD, so

sudo apt-get install gpsd

Apoi, încărcat,i nucleul garmin_gps

sudo modprobe garmin_gps

And then connect the unit. Then check with dmesg the actual device being used bu the unit, for example
/dev/ttyUSB0. Now you can launch gpsd

gpsd /dev/ttyUSB0

S, i, la final, conectat,i-va la instrumentul de urmărire în direct din QGIS.

15.2.7 Folosirea datalogger-ului BTGP-38KM (doar Bluetooth)

Folosirea GPSD (în Linux) sau GPSGate (în Windows) se face fâră efort.

15.2.8 Folosirea datalogger-ului BlueMax GPS-4044 (atât BT cât s, i USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

Pentru USB

The live tracking works both with GPSD

gpsd /dev/ttyACM3

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/ttyACM3).

Pentru Bluetooth

The live tracking works both with GPSD
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gpsd /dev/rfcomm0

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/rfcomm0).
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CHAPTER 16

Sistem de Autentificare

16.1 Prezentare Generală a Sistemului de Autentificare

Figure 16.1: Anatomia Sistemului de Autentificare

16.1.1 Baza de date de autentificare

Noul sistem de autentificare stochează configurat,iile de autentificare într-o bază de date SQLite, localizată, în mod
implicit, la:

<user home>\.qgis2\qgis-auth.db

Această bază de date de autentificare poate fi mutată între instalările QGIS, fără afectarea altor preferint,e ale
utilizatorului QGIS curent, deoarece este complet separată de setările normale ale QGIS. Atunci când stocat,i init,ial
o configurat,ie a unei baze de date, este generat un ID de configurare (un s, ir aleatoriu de 7 caractere alfanumerice).
Acesta reprezintă configurat,ia, fiind posibilă stocarea în clar a ID-ului de către componentele aplicat,iei, (cum ar fi
proiectele, plugin-urile, sau fis, ierele de setare) fără divulgarea credent,ialelor asociate.
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Note: Directorul părinte al qgis-auth.db poate fi setat folosind variabila de mediu QGIS_AUTH_DB_DIR_PATH,
sau din linia de comandă, pe durata lansării cu opt,iunea --authdbdirectory.

16.1.2 Parola master

Pentru a stoca sau pentru a accesa informat,iile sensibile din baza de date, un utilizator trebuie să definească un
parolă master. O nouă parolă master este solicitată s, i verificată, atunci când se stochează init,ial date criptate în
baza de date. Numai atunci când accesează informat,ii sensibile, utilizatorului i se solicită parola master, care
este apoi stocată în memoria tampon, pentru restul sesiunii (până la închiderea aplicat,iei), cu except,ia cazului
în care utilizatorul alege manual act,iunea de a s, terge valoarea salvată. Unele instant,e de utilizare a sistemului
de autentificare nu necesită introducerea parolei principale, cum ar fi la selectarea configurat,iei de autentificare
existentă, sau prin aplicarea unei configurat,ii pentru un serviciu (cum ar fi adăugarea unui strat WMS).

Figure 16.2: Introducerea noii parole master

Note: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Gestiunea parolei master

Odată stabilită, parola principală poate fi resetată; parola master curentă va fi necesară înainte de resetare. Pe
durata acestui proces, există opt,iunea de a genera o copie de rezervă completă a bazei de date curente.

Figure 16.3: Resetarea parolei master

În cazul în care utilizatorul uită parola principală, nu există nici o modalitate de a o recupera sau de a o suprascrie.
De asemenea, nu există nici un mijloc de recuperare a informat,iilor criptate, fără a cunoas, te parola de master.

Dacă un utilizator introduce incorect, de trei ori, parola, fereastra de dialog se va oferi să s, teargă baza de date.
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Figure 16.4: Se va cere parola după trei încercări eronate

16.1.3 Configurat,ii de Autentificare

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).

Figure 16.5: Editorul de configurat,ii

Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Metoda de Autentificare).
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Figure 16.6: Adăugarea configurărilor din cadrul Editorului de Configurat,ii

Figure 16.7: Dialogul WMS afis, ează butoanel [Add], [Edit], s, i [Remove], de configurare a autentificării
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16.1.4 Metoda de Autentificare

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings – > Option and, in the Authentication tab, click the Installed plugins button.

Figure 16.8: Available method plugins list

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Figure 16.9: Configurări de autentificare HTTP de bază

Note: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.

16.1.5 Utilitare pentru Parola Master s, i Configurările de Autentificare

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

• Input master password — Opens the master password input dialog, independent of performing any auth db
command. Clear cached master password—Unsets the master password if it has been set via input dialog.
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Figure 16.10: Configurări de autentificare ale căilor PKI

Figure 16.11: Configurări de autentificare ale căilor către fis, ierele PKI PKCS#12

Figure 16.12: Configurări de autentificare ale Identităt,ilor Stocate
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Figure 16.13: Meniul Utilitarelor

Reset master password—Opens a dialog to change the master password (the current password must be
known) and optionally back up the current database.

• Clear cached authentication configurations — Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password - Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations — Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database — Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 16.14: Meniul de verificare a s, tergerii DB

16.1.6 Folosirea configurat,iilor de autentificare

În mod tipic, o configurat,ie de autentificare este selectată într-un dialog de configurare, pentru serviciile de ret,ea
(cum ar fi WMS). Cu toate acestea, controlul grafic de selectare poate fi încorporat oriunde este necesară auten-
tificarea, sau într-o funct,ionalitate care nu este de esent,ială, cum ar fi plugin-urile tert,e PyQGIS sau C++.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.

16.1.7 Legături Python

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Avertismente de Securitate concerning Python access.
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Figure 16.15: Selectorul configurat,iilor de autentificare fără configurat,ie selectată

Figure 16.16: Selectorul configurărilor de autentificare cu configurat,ie selectată

16.2 Fluxul de Autentificare a Utilizatorului

Figure 16.17: Fluxul de lucru al utilizatorului generic

16.2.1 Autentificarea HTTP(S)

Una dintre cele mai comune conectări la resurse are loc prin prin HTTP(S), cum ar fi serverele de cartografiere
web s, i plugin-urile cu metode de autentificare, care adesea lucrează cu aceste tipuri de conexiuni. Plugin-urile
cu metode au acces la obiectul cerere HTTP s, i pot manipula atât cererea cât s, i antetele sale. Acest lucru permite
mai multe forme de autentificare prin internet. Atunci când conectarea are loc prin HTTP(S) cu ajutorul metodei
standard de autentificare nume de utilizator/ parolă, se va încerca autentificarea HTTP de bază a conexiunii.
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Figure 16.18: Configurarea unei conexiuni WMS pentru HTTP BASIC

16.2.2 Autentificarea bazei de date

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9

16.2.3 Autentificarea PKI

When configuring PKI components within the authentication system, you have the option of importing compo-
nents into the database or referencing component files stored on your filesystem. The latter may be useful if such
components change frequently, or where the components will be replaced by a system administrator. In either
instance you will need to store any passphrase needed to access private keys within the database.

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the [Manage certificates]
button.

In the Certificate manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Note: Because all authentication system edits write immediately to the authentication database, there is no need
to click the Options dialog [OK] button for any changes to be saved. This is unlike other settings in the Options
dialog.

Autorităt,i

You can manage available Certificate Authorities (CAs) from the Authorities tab in the Certificate manager from
the Authentication tab of the QGIS Options dialog.
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Figure 16.19: Configurarea unei conexiuni Postgres SSL-with-PKI

As referenced in the workflow chart above, the first step is to import or reference a file of CAs. This step is
optional, and may be unnecessary if your PKI trust chain originates from root CAs already installed in your
operating system (OS), such as a certificate from a commercial certificate vendor. If your authenticating root CA
is not in the OS’s trusted root CAs, it will need to be imported or have its file system path referenced. (Contact
your system administrator if unsure.)

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.

You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.

Warning: Schimbarea politicii de încredere implicită, poate genera probleme conexiunilor securizate.

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.
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Figure 16.20: Fluxul de lucru pentru configurarea PKI
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Figure 16.21: Deschiderea Managerului de Certificate

Figure 16.22: Editorul de autorităt,i
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Figure 16.23: Dialogul nformat,iilor despre Certificat

Figure 16.24: Salvarea modificărilor aduse politicii de încredere

Figure 16.25: Meniul opt,iunilor pentru autorităt,i
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Figure 16.26: Dialogul de importare a certificatelor

Note: If you are pasting certificate information into the PEM text field, note that encrypted certificates are not
supported.

Identităt,i

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
“bundled” file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.

16.2.4 Gestionarea straturilor eronate

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.
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Figure 16.27: Editorul de Identităt,i

Figure 16.28: Import de identitate PEM/DER
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Figure 16.29: Import de identitate PKCS#12

Figure 16.30: Gestionarea straturilor eronate s, i a autentificării
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If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

Figure 16.31: Editarea ID-ului de configurare a autentificării, în cazul straturilor eronate

16.2.5 Schimbarea ID-ului de configurare a autentificării

Occasionally, you will need to change the authenticationn configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid - This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files - If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.

Figure 16.32: Schimbarea ID-ului de configurare pentru autentificarea stratului (câmp de text galben, deblocat)
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Warning: Changing the auth config ID is considered an advanced operation and should only be done with
full knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock the
ID’s text field prior to editing the ID.

16.2.6 Suport pentru serverul QGIS

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• Baza de date pentru autentificare trebuie să fie disponibilă

• Parola master a bazei de date pentru autentificare trebuie să fie disponibilă

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Note: Variabila QGIS_AUTH_PASSWORD_FILE va fi eliminată din mediul Serverului, imediat după accesare

16.2.7 Except,ii de server SSL

Figure 16.33: Except,ie de server SSL

You can manage SSL server configurations and exceptions from the Servers tab in the Authentication section of
the QGIS Options dialog.

Sometimes, when connecting to an SSL server, there are errors with the SSL “handshake” or the server’s certifi-
cate. You can ignore those errors or create an SSL server configuration as an exception. This is similar to how
web browsers allow you to override SSL errors, but with more granular control.

Warning: You should not create an SSL server configuration unless you have complete knowledge of the
entire SSL setup between the server and client. Instead, report the issue to the server administrator.

Note: Some PKI setups use a completely different CA trust chain to validate client identities than the chain used
to validate the SSL server certificate. In such circumstances, any configuration created for the connecting server
will not necessarily fix an issue with the validation of your client identity, and only your client identity’s issuer or
server administrator can fix the issue.

You can pre-configure an SSL server configuration by clicking the button. Alternatively, you can add a
configuration when an SSL error occurs during a connection and you are presented with an SSL Error dialog
(where the error can be ignored temporarily or saved to the database and ignored):
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Figure 16.34: Adăugarea manuală a configurărilor
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Figure 16.35: Adăugarea configurărilor pe durata erorii SSL
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O dată ce o configurat,ie SSL este salvată în baza de date, aceasta poate fi editată sau s, tearsă.

Figure 16.36: Configurat,iile SSL existente

If you want to pre-configure an SSL configuration and the import dialog is not working for your server’s con-
nection, you can manually trigger a connection via the Python Console by running the following code (replace
https://bugreports.qt-project.org with the URL of your server):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl(’https://bugreports.qt-project.org’))
reply = QgsNetworkAccessManager.instance().get(req)

This will open an SSL error dialog if any errors occur, where you can choose to save the configuration to the
database.

16.3 Avertismente de Securitate

O dată ce este introdusă parola de master, API-ul este deschis pentru a vă oferi acces la baza datelor de au-
tentificare, similar modului în care funct,ionează Firefox. Cu toate acestea, la implementarea init,ială, nu sunt
definit piedici împotriva accesului PyQGIS. Acest lucru poate conduce la probleme, în cazul în care un utiliza-
tor descarcă/instalează un plugin PyQGIS rău intent,ionat, sau o aplicat,ie de sine stătătoare, care obt,ine acces la
prerogativele de autentificare.

Solut,ia rapidă pentru versiunea init,ială a caracteristicii, este de a nu include doar cele mai multe legături PyQGIS
pentru sistemul de autentificare.

O altă modalitate simplă, des, i nu robustă, este de a adăuga un ComboBox prin Setări → Opt,iuni → Autentificare
(implicit “niciodată”):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Setarea unei asemenea opt,iuni ar trebui să fie salvată într-o locat,ie de bază inaccesibilă pentru Python, cum ar fi
baza de date de autentificare, s, i să fie criptată cu parola principală.

• O altă opt,iune ar putea consta în urmărirea plugin-urilor specifice utilizatorului
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Figure 16.37: Editarea unei configurat,ii SSL existente

• allowed to access the authentication system, though it may be tricky to deduce which plugin is actually
making the call.

• Sandboxing plugins, possibly in their own virtual environments, would reduce ‘cross-plugin’ hacking of
authentication configs from another plugin that is authorized. This might mean limiting cross-plugin com-
munication as well, but maybe only between third-party plugins.

• Another good solution is to issue code-signing certificates to vetted plugin authors. Then validate the plu-
gin’s certificate upon loading. If need be the user can also directly set an untrusted policy for the certificate
associated with the plugin using existing certificate management dialogs.

• Alternatively, access to sensitive authentication system data from Python

• could never be allowed, and only the use of QGIS core widgets, or duplicating authentication system in-
tegrations, would allow the plugin to work with resources that have an authentication configuration, while
keeping master password and authentication config loading in the realm of the main app.

The same security concerns apply to C++ plugins, though it will be harder to restrict access, since there is no
function binding to simply be removed as with Python.

16.3.1 Restrict,ii

The confusing licensing and exporting issues associated with OpenSSL apply. In order for Qt to work with SSL
certificates, it needs access to the OpenSSL libraries. Depending upon how Qt was compiled, the default is to
dynamically link to the OpenSSL libs at run-time (to avoid the export limitations).

QCA follows a similar tactic, whereby linking to QCA incurs no restrictions, because the qca-ossl (OpenSSL)
plugin is loaded at run-time. The qca-ossl plugin is directly linked to the OpenSSL libs. Packagers would be the
ones needing to ensure any OpenSSL-linking restrictions are met, if they ship the plugin. Maybe. I don’t really
know. I’m not a lawyer.

The authentication system safely disables itself when qca-ossl is not found at run-time.
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CHAPTER 17

Integrarea GRASS GIS

GRASS integration provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Lit-
eratură s, i Referint,e Web). The integration consists of two parts: provider and plugin. The provider allows to
browse, manage and visualize GRASS raster and vector layers. The plugin can be used to create new GRASS
locations and mapsets, change GRASS region, create and edit vector layers and analyze GRASS 2-D and 3-D data
with more than 400 GRASS modules. In this section, we’ll introduce the provider and plugin functionalities and
give some examples of managing and working with GRASS data.

The provider supports GRASS version 6 and 7, the plugin supports GRASS 6 and 7 (starting from QGIS 2.12).
QGIS distribution may contain provider/plugin for either GRASS 6 or GRASS 7 or for both versions at the same
time (binaries have different file names). Only one version of the provider/plugin may be loaded on runtime
however.

17.1 Setul de date demonstrative

As an example, we will use the QGIS Alaska dataset (see section Date es, antion). It includes a
small sample GRASS LOCATION with three vector layers and one raster elevation map. Create a
new folder called grassdata, download the QGIS ‘Alaska’ dataset qgis_sample_data.zip from
http://download.osgeo.org/qgis/data/ and unzip the file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at
http://grass.osgeo.org/download/sample-data/.

17.2 Încărcarea straturilor raster s, i vectoriale GRASS

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

You can load GRASS raster and vector layers like any other layer from the browser either by double click on layer
item or by dragging and dropping to map canvas or legend.

Tip: Încărcarea Datelor GRASS
If you don’t see GRASS location item, verify in Help → About → Providers if GRASS vector provider is loaded.

17.3 Importing data into a GRASS LOCATION via drag and drop

This section gives an example of how to import raster and vector data into a GRASS mapset.

1. In QGIS browser navigate to the mapset you want to import data into.
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2. In QGIS browser find a layer you want to import to GRASS, note that you can open another instance of the
browser (Browser Panel (2)) if source data are too far from the mapset in the tree.

3. Drag a layer and drop it on the target mapset. The imported may take some time for larger layers, you will
see animated icon in front of new layer item until the import finishes.

Where raster data are in different CRS, they can be reprojected using an Approximate (fast) or Exact (precise)
transformation. If a link to the source raster is created (using r.external), the source data are in the same CRS and
the format is known to GDAL, the source data CRS will be used. You can set these options in the Browser tab in
Opt,iuni GRASS.

If a source raster has more bands, a new GRASS map is created for each layer with .<band number> suffix and

group of all maps with icon is created. External rasters have a different icon .

17.4 Gestiunea datelor GRASS în navigatorul QGIS

• Copying maps: GRASS maps may be copied between mapsets within the same location using drag and
drop.

• Deleting maps: Right click on a GRASS map and select Delete from context menu.

• Renaming maps: Right click on a GRASS map and select Rename from context menu.

17.5 Opt,iuni GRASS

GRASS options may be set in GRASS Options dialog, which can be opened by right clicking on the location or
mapset item in the browser and then choosing GRASS Options.

17.6 Startarea plugin-ului GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins..., select GRASS and click [OK].

The following main features are provided with the toolbar menu when you start the GRASS plugin:

• Open Mapset

• New Mapset

• Închidere set de hărt,i

• Deschidere Instrumente GRASS

• Afis,area regiunii curente GRASS

• Opt,iuni GRASS

17.7 Deschiderea Setului de hărt,i GRASS

A GRASS mapset must be opened to get access to GRASS Tools in the plugin (the tools are disabled if no mapset
is open). You can open a mapset from the browser: right click on mapset item and then choose Open mapset from
context menu.
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17.8 GRASS LOCATION s, i MAPSET

Datele GRASS sunt stocate într-un director de tip GISDBASE. Acest director, denumit adesea grassdata,
trebuie să existe înainte de a începe lucrul cu plugin-ul GRASS din QGIS. În interiorul acestui director, datele
GRASS GIS sunt organizate în proiecte stocate, la rândul lor, în subdirectoare denumite LOCATIONs. Fiecare
LOCATION este definită prin sistemul de coordonate, proiect,ia hărt,ii s, i limitele geografice. Fiecare LOCATION
poate avea mai multe MAPSETs (subdirectoare ale LOCATION) care sunt utilizate pentru a subdiviza un proiect în
diferite teme sau subregiuni, ori în spat,ii de lucru pentru membrii individuali ai unei echipe (v. Neteler & Mitasova
2008 în Literatură s, i Referint,e Web). Pentru a analiza straturile vectoriale s, i raster cu ajutorul modulelor GRASS,
trebuie să le importat,i într-o LOCATION GRASS. (Acest lucru nu este complet adevărat - cu ajutorul modulelor
GRASS r.external s, i v.external putet,i crea numai link-uri read-only către seturile de date GDAL/OGR
externe acceptate, fără să fie necesar importul lor. Însă, deoarece acesta nu este modul obis, nuit pentru începători
de a lucra cu GRASS, această opt,iune nu va fi descrisă aici.)

Figure 17.1: Datele GRASS din LOCAT, IA alaska

17.9 Importat,i datele într-o LOCAT, IE GRASS

See section Importing data into a GRASS LOCATION via drag and drop to find how data can be easily imported
by dragging and dropping in the browser.

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset in traditional way, using standard GRASS modules. Therefore, we use the
landcover raster map landcover.img and the vector GML file lakes.gml from the QGIS ‘Alaska’ dataset
(see Date es, antion).

1. Start QGIS, apoi asigurat,i-vă că plugin-ul GRASS este încărcat.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Selectat,i ca s, i bază de date GRASS dosarul grassdata, din setul de date Alaska al QGIS, ca s, i
LOCATION ‘alaska’, ca MAPSET ‘demo’, apoi facet,i clic pe [OK].

4. Acum facet,i clic pe pictograma Open GRASS tools. Va apărea bara de instrumente GRASS (v. sect,iunea
Bara de instrumente GRASS).

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows you to import GDAL-supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Răsfoit,i folderul raster din setul de date ‘Alaska’ din QGIS, apoi selectat,i fis, ierul landcover.img.
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7. As raster output name, define landcover_grass and click [Run]. In the Output tab, you
see the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. Când se spune Încheiat cu succes, facet,i clic pe [Vizualizare ies, ire]. Stratul raster landcover_grass
este acum importat în GRASS, apoi va fi vizualizat în canevasul QGIS.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows you to import OGR-supported vector files into a GRASS LOCATION. The module
dialog for v.in.ogr appears.

10. Răsfoit,i folderul gml din setul de date ‘Alaska’ din QGIS, apoi selectat,i fis, ierul lakes.gml ca fis, ier OGR.

11. As vector output name, define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. Când se spune Încheiat cu succes, facet,i clic pe [Vizualizare ies, ire]. Stratul vectorial lakes_grass este
acum importat în GRASS, apoi va fi vizualizat în canevasul QGIS.

17.9.1 Crearea unei noi LOCAT, II GRASS

Ca exemplu, este prezentat es, antionul GRASS LOCATION alaska, care este proiectat în proiect,ia Albers cu
Suprafet,e Egale s, i având feet ca unitate de măsură. Acest es, antion GRASS LOCATION alaska va fi folosit
pentru toate exemplele s, i exercit,iile din următoarele sect,iuni legate de GRASS. Este util să descărcat,i setul de date
pe computerul dvs, apoi să-l instalat,i (v. Date es, antion).

1. Start QGIS, apoi asigurat,i-vă că plugin-ul GRASS este încărcat.

2. Vizualizat,i fis, ierul shape alaska.shp (vedet,i sect,iunea vector_load_shapefile) din setul de date Alaska
din QGIS (v. Date es, antion).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Selectat,i dosarul grassdata, unei baze de date existente GRASS (GISDBASE) sau creat,i unul pentru
noua LOCATION folosind un manager de fis, iere de pe computerul dvs. Apoi facet,i clic pe [Next].

5. Putem folosi acest contro grafic pentru a crea un nou MAPSET în cadrul unei LOCATION existente (v.
sect,iunea Adăugarea unui nou MAPSET), sau pentru a crea o LOCATION complet nouă. Selectat,i
Crearea unei noi locat,ii (v. figure_grass_location_2).

6. Introducet,i un nume pentru LOCATION – vom folosi ‘alaska’ – apoi facet,i clic pe [Next].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Lucrul cu Proiect,ii)).

9. În Filtrul, inserat,i 2964 pentru a selecta proiect,ia.

10. Clic pe [Next].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current QGIS extent], to apply the extent of the
loaded layer alaska.shp as the GRASS default region extent.

12. Clic pe [Next].

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used ‘demo’. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Literatură s, i Referint,e Web).
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14. Verificat,i rezumatul pentru a vă asigura că este corect, apoi facet,i clic pe [Finish].

15. Sunt create noua LOCATION, ‘alaska’, s, i două MAPSETs, ‘demo’ s, i ‘PERMANENT’. Setul deschis în mod
curent este ‘demo’, as, a cum l-at,i definit.

16. Observat,i că unele instrumente din bara de instrumente GRASS, dezactivate anterior, sunt acum activate.

Figure 17.2: Crearea unei LOCAT, II GRASS noi, sau a unui nou SET DE HĂRT, I în QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importat,i datele într-o LOCAT, IE GRASS). You can
also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included in the
QGIS ‘Alaska’ dataset Date es, antion, and move on to section Modelul de date vectoriale GRASS.

17.9.2 Adăugarea unui nou MAPSET

A user has write access only to a GRASS MAPSET which he or she created. This means that besides access to
your own MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify
or remove only the maps in your own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (see Neteler & Mitasova 2008 in Literatură s, i Referint,e Web, and section Regiunea instrumentelor
GRASS).

1. Start QGIS, apoi asigurat,i-vă că plugin-ul GRASS este încărcat.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Selectat,i folderul grassdata al bazei de date GRASS (GISDBASE) cu locat,ia LOCATION ‘alaska’, în
care dorim să adăugăm un nou MAPSET denumit ‘test’.

4. Clic pe [Next].

5. Putem folosi acest control grafic pentru a crea un nou MAPSET în cadrul unei LOCATION existente,
sau pentru a crea o LOCATION complet nouă. Clic pe butonul radio Selectare locat,ie (v. fig-
ure_grass_location_2), apoi facet,i clic pe [Next].

6. Introducet,i denumirea text pentru noul MAPSET. În josul controlului grafic se poate vedea lista MAPSETs
existente, precum s, i proprietarii aferent,i.

7. Clic pe [Next], verificat,i rezumatul, pentru a vă asigura că este corect, apoi facet,i clic pe [Finish].

17.10 Modelul de date vectoriale GRASS

It is important to understand the GRASS vector data model prior to digitizing. In general, GRASS uses a topolog-
ical vector model. This means that areas are not represented as closed polygons, but by one or more boundaries.
A boundary between two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be
connected and closed without gaps. An area is identified (and labelled) by the centroid of the area.
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Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so-called ‘layers’ inside one GRASS vector map.
So in GRASS, a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully. (Although it is possible to mix geometry elements, it is unusual and, even in GRASS, only used in
special cases such as vector network analysis. Normally, you should prefer to store different geometry elements
in different layers.)

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. An adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is
also possible to attach attributes to boundaries. An example might be the case where the boundary between a lake
and a forest is a road, so it can have a different attribute table.

The ‘layer’ of the feature is defined by the ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there is
more than one layer inside the dataset (e.g., if the geometry is forest or lake). For now, it can be only a number. In
the future, GRASS will also support names as fields in the user interface.

Atributele pot fi stocate în interiorul LOCATION GRASS în format dBase sau SQLite3, sau în tabelele bazei de
date externe, cum ar fi PostgreSQL, MySQL, Oracle, etc.

Atributele din tabelele bazei de date sunt legate de elementele geometrice printr-o valoare de ‘categorie’.

‘Categoria’ (key, ID) este un număr întreg atas, at primitivelor geometrice, fiind folosită ca legătură către o coloană
cheie, din tabelul bazei de date.

Tip: Înt,elegerea modelului de date vectoriale GRASS
Cel mai bun mod de a învăt,a despre modelul vectorial GRASS s, i despre capabilităt,ile sale, este de a de-
scărca unul dintre multe tutoriale GRASS în care modelul vectorial este descris în profunzime. Vizitat,i
http://grass.osgeo.org/documentation/manuals/ pentru informat,ii suplimentare, cărt,i s, i tutoriale în diverse limbi.

17.11 Crearea unui nou strat vectorial GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• Strat Nou, de tip Punct

• Strat Nou, de tip Linie

• Strat Nou, de tip Poligon

and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Crearea noillor straturi Vectoriale).

17.12 Digitizarea s, i editarea unui strat vectorial GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to

• GRASS topological model versus QGIS simple feature

• complexity of GRASS model
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– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Warning: All the changes done during editing are immediately written to vector map and related attribute
tables.

Changes are written after each operation, it is however, possible to do undo/redo or discard all changes when
closing editing. If undo or discard changes is used, original state is rewritten in vector map and attribute tables.

There are two main reasons for this behaviour:

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Bara de Instrumente

The ‘Digitizing Toolbar’ has some specific tools when a GRASS layer is edited:
Pictogramă Instrument Scop

Punct Nou Digitizare punct nou

Linie nouă Digitizare linie nouă

Limită Nouă Digitize new boundary

Centroid Nou Digitizarea unui nou centroid (etichetarea zonei existente)

New Closed Boundary Digitize new closed boundary

Tabela 1 de Digitizare GRASS: Insrtrumente de Digitizare GRASS

Tip: Digitizarea poligoanelor în GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon. Then you add a centroid
(label point) into the closed boundary. The reason for this is that a topological vector model links the attribute
information of a polygon always to the centroid and not to the boundary.

Category

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute “category”. Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.

Attributes

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to ‘<not editable (layer #)>’ to warn you that such attribute is not editable. The
reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.
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If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Tip: If you want to do bulk update of attributes in table, for example using ‘Field Calculator’ (Calculatorul de
Câmpuri), and there are features without category which you don’t want to update (typically boundaries), you can
filter them out by setting ‘Advanced Filter’ to cat is not null.

Editing style

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
‘GRASS Edit’ renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties ‘Style’ tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Tip: Do not save project file when the layer is edited, the layer would be stored with ‘Edit Style’ which has no
meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field ‘topo_symbol’.
The field is automatically removed when editing is closed.

Tip: Do not remove ‘topo_symbol’ field from attribute table, that would make features invisible because the
renderer is based on that column.

Acros, area

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.

Tip: Canvasul foloses, te CRS-ul stratului s, i la momentul editării.

Limitări

Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and Mac OSX only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Tip: Permisiuni de Editare GRASS
Trebuie să fit,i proprietarul MAPSET GRASS, pentru a-l putea edita. Este imposibilă editarea datelor din straturile
MAPSET care nu vă apart,ine, chiar dacă avet,i permisiunea de scriere.

17.13 Regiunea instrumentelor GRASS

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.
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The region can be modified in ‘Region’ tab in ‘GRASS Tolls’ dock widget. Type in the new region bounds and
resolution, and click [Apply]. If you click on [Select the extent by dragging on canvas] you can select a new
region interactively with your mouse on the QGIS canvas dragging a rectangle.

The GRASS module g.region provides a lot more parameters to define an appropriate region extent and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in section Bara
de instrumente GRASS.

17.14 Bara de instrumente GRASS

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

Figure 17.3: GRASS Toolbox and Module Tree

17.14.1 Lucrul cu modulele GRASS

The GRASS shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user-friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.14 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

De asemenea, este posibilă personalizarea cont,inutul Instrumentarului GRASS. Această procedură este descrisă
în sect,iunea Personalizarea Barei de Instrumente GRASS.

As shown in figure_grass_toolbox_1, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

By clicking on a graphical module icon, a new tab will be added to the Toolbox dialog, providing three new
sub-tabs: Options, Output and Manual.
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Opt,iuni

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

Figure 17.4: GRASS Toolbox Module Options

The provided module parameters are often not complete to keep the dialog simple. If you want to use further
module parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Rezultat

Fila Rezultatelor oferă informat,ii despre starea de ies, ire a modulului. Când facet,i clic pe butonul [Run], modulul
comută la fila Rezultatelor tab, apoi vet,i vedea informat,ii despre procesul de analiză. Dacă totul funct,ionează
bine, vet,i vedea în cele din urmă un mesaj de Definitivare cu succes.

Manual

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page, you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as the module g.manual.

Tip: Afis, ează imediat rezultatele
Dacă dorit,i să afis, at,i imediat rezultatele calculelor dvs în canevasul hărt,ii, putet,i folosi butonul ‘Vizualizare Out-
put’, din partea de jos a filei modulului.

17.14.2 Exemple de module GRASS

Următoarele exemple vor demonstra puterea unora dintre modulele GRASS.
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Figure 17.5: GRASS Toolbox Module Output

Figure 17.6: GRASS Toolbox Module Manual
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Crearea curbelor de nivel

The first example creates a vector contour map from an elevation raster (DEM). Here, it is assumed that you have
the Alaska LOCATION set up as explained in section Importat,i datele într-o LOCAT, IE GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now open the Toolbox with the Open GRASS tools button.

• În lista de de unelte pentru categorii, facet,i dublu-clic pe Raster → Surface Management → Generate vector
contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Lucrul cu modulele
GRASS).

• In the Name of input raster map enter gtopo30.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Introducet,i în Name for output vector map ‘numele ‘‘ctour_100‘.

• Facet,i clic pe [Run] pentru a începe procesul. As, teptat,i câteva momente până când mesajul Finalizare
cu succes apare în fereastra de ies, ire. Apoi facet,i clic pe [View Output] s, i [Close].

Deoarece aceasta este o regiune mare, va dura ceva timp până la afis, are. După ce se termină randarea, putet,i
deschide fereastra cu proprietăt,ile stratului, pentru a schimba culoarea liniei astfel încât conturul să apară clar pe
rasterul de elevat,ie, la fel ca în Dialogul Proprietăt,ilor Vectoriale.

Next, zoom in to a small, mountainous area in the center of Alaska. Zooming in close, you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping
their overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms
(i.e., Douglas Peuker and Vertex Reduction) simplify the line by removing some of the vertices. The resulting
vector will load faster. This process is useful when you have a highly detailed vector, but you are creating a very
small-scale map, so the detail is unnecessary.

Tip: Instrumentul de simplificare
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms, there is Chaiken’s, which does just that (also
Hermite splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even
more slowly.

• Open the GRASS Toolbox and double-click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Verificat,i dacă ‘ctour_100’ apare ca Nume pentru vectorul de intrare.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [Close].

• Putet,i schimba culoarea vectorului pentru a-l afis, a în mod clar pe fundalul raster, s, i pentru a contrasta fat,ă
de curbele de nivel originale. Vet,i observa că noile curbe de nivel au colt,uri mai fine decât originalul, în
timp ce urmează fidel forma originală.

Tip: Alte utilizări pentru r.contour
The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.
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Figure 17.7: GRASS module v.generalize to smooth a vector map

Crearea unui efect 3-D de umbrire

Several methods are used to display elevation layers and give a 3-D effect to maps. The use of contour lines, as
shown above, is one popular method often chosen to produce topographic maps. Another way to display a 3-D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus, you get sun-facing slopes lighted; the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS Toolbox, and under the
Raster category, double-click to open Spatial analysis → Terrain analysis.

• Apoi facet,i clic pe r.shaded.relief pentru a deschide modulul.

• Change the azimuth angle 270 to 315.

• Introducet,i gtopo30_shade pentru noul raster reliefat, apoi facet,i clic pe [Run].

• Când procesul se încheie, adăugat,i hărt,ii rasterul reliefat. Ar trebui să-l vedet,i afis, at în tonuri de gri.

• To view both the hillshading and the colors of the gtopo30 together, move the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
Transparency tab and set its transparency level to about 25%.

Ar trebui să avet,i acum elevat,ia gtopo30 cu harta de cuori s, i transparent,a setate deasupra hărt,ii reliefu-
lui, în tonuri de gri. Pentru a observa mai bine efectele vizuale ale reliefării, desetat,i vizualizarea hărt,ii
gtopo30_shade, apoi resetat,i-o.

Folosirea consolei GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

The module r.shaded.relief can take a parameter zmult, which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].
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Figure 17.8: The GRASS shell, r.shaded.relief module
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• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• As explained above, move the shaded relief raster below the gtopo30 raster in the table of contents, then
check the transparency of the colored gtopo30 layer. You should see that the 3-D effect stands out more
strongly compared with the first shaded relief map.

Figure 17.9: Displaying shaded relief created with the GRASS module r.shaded.relief

Statistici raster pentru o hartă vectorială

Următorul exemplu arată modul în care un modul din GRASS poate agrega datele rastere, apoi să adauge coloanele
de statistici pentru fiecare poligon din harta vectorială.

• Din nou, folosind datele pentru Alaska, referit,i-vă la Importat,i datele într-o LOCAT, IE GRASS pentru a
importa arborii fis, ierelor shape din directorul shapefiles din GRASS.

• Now an intermediate step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• Din Bara de instrumente aleget,i Vector → Manage features, apoi deschidet,i modulul v.centroids.

• Introducet,i ‘forest_areas’ pentru output vector map, apoi rulat,i modulul.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Meniul Stilului of the vector section.)

• Mai departe, redeschidet,i Bara de instrumente GRASS, apoi deschidet,i Vector → Vector update din alte
hărt,i.

• Clic pe modulul v.rast.stats. Introducet,i gtopo30 s, i forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [Run]. This is a computa-
tionally heavy operation, which will run for a long time (probably up to two hours).

• Finally, open the forest_areas attribute table, and verify that several new columns have been added,
including elev_min, elev_max, elev_mean, etc., for each forest polygon.

17.14.3 Personalizarea Barei de Instrumente GRASS

Nearly all GRASS modules can be added to the GRASS Toolbox. An XML interface is provided to parse the
pretty simple XML files that configure the modules’ appearance and parameters inside the Toolbox.
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Un fis, ier XML es, antion, pentru generarea modulului v.buffer (v.buffer.qgm) arată în felul următor:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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CHAPTER 18

Cadrul de procesare al QGIS

18.1 Introducere

Acest capitol introduce cadrul de prelucrare al QGIS, un mediu de geoprocesare care poate fi folosit pentru a apela
algoritmi nativi sau ai unei tert,e părt,i din QGIS, făcând sarcinile de analiză spat,ială mai productive s, i mai us, or de
realizat.

În următoarele sect,iuni, vom examina modul de a folosi elementele grafice ale acestui cadru s, i de a obt,ine mai
mult de la fiecare.

Există patru elemente de bază în cadrul GUI, care sunt utilizate pentru a rula algoritmi cu scopuri diferite. Alegerea
un instrument sau a altuia va depinde de tipul de analiză care urmează a fi efectuată, s, i de caracteristicile specifice
ale fiecărui utilizator s, i proiect. Toate acestea (cu except,ia interfet,ei de prelucrare în serie, care se apelează din
bara de instrumente, sau a ferestrei de execut,ie a algoritmului, as, a cum vom vedea) pot fi accesate din meniul
Processing. (Vet,i vedea mai mult de patru intrări. Cele rămase nu sunt folosite pentru a executa algoritmi s, i vor fi
explicate mai târziu, în acest capitol.)

• Setul de instrumente. Elementul principal al GUI, acesta este utilizat pentru a executa un singur algoritm
sau o serie de procese bazate pe acel algoritm.

• Modelatorul grafic. Mai mult,i algoritmi pot fi combinat,i grafic folosind modelatorul, pentru a defini un flux
de lucru, s, i pentru a crea un singur proces care implică mai multe subprocese.

• Gestionarul istoricului. Toate act,iunile realizate, folosind oricare dintre elementele ment,ionate anterior, sunt
stocate într-un fis, ier care poate fi, mai târziu, reprodus cu us, urint,ă, cu ajutorul managerului de istoric.

• Interfat,a de procesare în serie. Această interfat,ă vă permite să executat,i procese în serie s, i să automatizat,i
execut,ia unui singur algoritm pe seturi de date multiple.

În următoarele sect,iuni, vom examina în detaliu fiecare dintre aceste elemente.

18.2 Instrumentarul

Bara de instrumente este elementul principal al GUI-ului de prelucrare, fiind cel cu care avet,i cele mai multe
s, anse de a vă întâlni în munca de zi cu zi. Acesta prezintă lista, grupată în diferite blocuri, a tuturor algoritmilor
disponibilii, fiind punctul de acces pentru rularea lor, fie ca proces individual, fie ca proces apart,inând unei serii,
care implică mai multe execut,ii ale aceluias, i algoritm utilizând diferite seturi de intrare.

Setul de instrumente cont,ine tot,i algoritmii disponibili, împărt,it,i în as, a-numit,ii “Furnizori”.

Providers can be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you
of that whenever there are inactive providers. Use the link in the label to open the settings window and set up
providers. We will discuss the settings dialog later in this manual.

By default only, providers that do not rely on third-party applications (that is, those that only require QGIS el-
ements to be run) are active. ALgorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.
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Figure 18.1: Bara Instrumentelor Processing
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Figure 18.2: Modelatorul Processing

Figure 18.3: Istoricul Processing
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Figure 18.4: Interfat,a de Procesare în Serie

În partea de sus a setului de instrumente, vet,i găsi o casetă de text. Pentru a reduce numărul de algoritmi prezentat,i
în caseta de instrumente s, i pentru a găsi mai us, or unul de care avet,i nevoie, putet,i introduce orice cuvânt sau o
expresie în caseta de text. Observat,i că, pe măsură ce tastat,i, numărul de algoritmi din setul de instrumente se
reduce doar la acei algoritmi care cont,in în numele lor textul pe care l-at,i introdus.

Dacă există algoritmi care se potrivesc căutării dvs., dar apart,in unui furnizor care nu este activ, o etichetă supli-
mentară va fi afis, ată în partea de jos a bării de instrumente.

If you click on the link in that label, the list of algorithms will also include those from inactive providers, which
will be shown in light gray. A link to active each inactive provider is also shown.

Pentru a executa un algoritm, este suficient să facet,i dublu-clic pe numele său, în bara de instrumente.

18.2.1 Dialogul algoritmului

După ce facet,i dublu-clic pe numele algoritmului pe care dorit,i să îl executat,i, este afis, at un dialog similar cu cel
din figura de mai jos (în acest caz, dialogul corespunde algoritmului ‘Centroizii poligonului’).

Acest dialog este utilizat pentru a seta valorile de intrare pe care algoritmul trebuie să le execute. Vi se prezintă
un tabel în care trebuie setate valorile de intrare s, i parametrii de configurare. Cont,inutul va fi diferit, desigur, în
funct,ie de cerint,ele algoritmului care urmează să fie executat, creându-se automat pe baza acestor cerint,e.

Des, i numărul s, i tipul de parametri depind de caracteristicile algoritmului, structura este similară pentru toate.
Parametrii din tabel pot avea unul din tipurile de mai jos.

• Un strat raster, selectabil dintr-o listă a tuturor straturilor disponibile (deschise în mod curent), în QGIS.
Selectorul cont,ine s, i un buton în partea sa dreaptă, permit,ând selectarea numelor corespunzătoare straturilor
neîncărcate, în mod curent, în QGIS.

• Un strat vectorial, selectabil dintr-o listă a tuturor straturilor vectoriale disponibile în QGIS. Straturile care
nu sunt încărcate în QGIS pot fi selectate, similar straturilor raster, dar numai în cazul în care algoritmul nu
necesită selectarea unui câmp din tabelul de atribute al stratului. În acest caz, numai straturile deschise pot
fi selectate, astfel încât să se poată prelua lista de nume a câmpurilor disponibile.

Vet,i vedea un buton pentru fiecare selector de strat vectorial, as, a cum se arată în figura de mai jos.

În cazul în care algoritmul cont,ine mai mult,i, se va putea alege doar unul. Dacă este apăsat butonul corespunzător
unei intrări vectoriale, algoritmul va fi executat iterativ pentru fiecare dintre entităt,ile sale, în loc de o singură dată

266 Chapter 18. Cadrul de procesare al QGIS



QGIS User Guide, Release 2.14

Figure 18.5: Bara instrumentelor de procesare
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Figure 18.6: Processing Toolbox showing search results
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Figure 18.7: Processing Toolbox showing search results

18.2. Instrumentarul 269



QGIS User Guide, Release 2.14

Figure 18.8: Dialogul Parametrilor

Figure 18.9: Butonul de iterare vectorială
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pentru întregul strat, generându-se un număr de rezultate identic cu numărul de execut,ii ale algoritmului. Acest
lucru permite automatizarea procesului, atunci când toate entităt,ile dintr-un strat trebuie să fie procesate separat.

• O tabelă, selectabilă dintr-o listă a tuturor tabelelor disponibile în QGIS. Tabelele non-spat,iale sunt încărcate
în QGIS sub formă de straturi vectoriale, fiind tratate ca atare de către program. În mod curent, lista tabelelor
disponibile, pe care o vedet,i atunci când execută un algoritm, este limitată la tabele care provin din fis, iere
având formatul dBase (.dbf) sau Valori Separate prin Virgulă (.csv).

• Opt,iunea de a alege dintr-o listă de select,ie a variantelor posibile.

• O valoare numerică, care urmează să fie introdusă într-o casetă de text. Vet,i găsi un buton alături de
casetă. Efectuând clic pe el se va deschide un dialog care permite introducerea unei expresii matematice,
transformându-se într-un calculator foarte util. În expresie pot fi adăugate anumite variabile utile, legate de
datele încărcate în QGIS, astfel încât să putet,i selecta o valoare derivată din oricare dintre aceste variabile,
cum ar fi dimensiunea celulei dintr-un strat sau coordonata nordică a altuia.

Figure 18.10: Selectorul de Numere

• Un interval, cu valori min s, i max care vor fi introduse în două casete de text.

• Un s, ir, care urmează să fie introdus într-o casetă de text.

• Un câmp, de ales din tabelul atribute al unui strat vectorial, sau un singur tabel selectat dintr-un alt
parametru.

• Un sistem de coordonate de referint,ă. Avet,i posibilitatea să tastat,i codul EPSG direct în caseta de text, sau
să-l selectat,i din dialogul de select,ie a CRS-ului, care apare atunci când facet,i clic pe butonul din partea
dreaptă.

• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you two options:
to select the value from a layer or the current canvas extent, or to define it by dragging directly onto the map
canvas.

Figure 18.11: Selectorul Extinderii

Dacă selectat,i prima opt,iune, vet,i vedea o fereastră similară cu cea următoare.
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Figure 18.12: Lista Extinderilor

Dacă o selectat,i pe a doua, fereastra parametrilor se va ascunde, astfel încât să putet,i facet,i clic pe ea s, i să o
traget,i pe pânză. După ce at,i definit dreptunghiul selectat, dialogul va reapărea, având valorile în caseta de
text a extinderii.

Figure 18.13: Glisare Extindere

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

Figure 18.14: Select,ie Multiplă

• Un mic tabel care va fi editat de către utilizator. Acesta este folosit pentru a defini parametri, cum ar fi tabele
de căutare sau nucleele de convolut,ie, printre altele.

Facet,i clic pe butonul din partea dreapta pentru a vedea tabelul s, i pentru a-i edita valorile.
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Figure 18.15: Tabelă Reparată

În funct,ie de algoritm, numărul de rânduri poate fi modificat sau nu, cu ajutorul butoanelor din pe partea
dreaptă a ferestrei.

Along with the parameters tab, you will find another tab named ‘Log’. Information provided by the algorithm
during its execution is written in this tab, and allow you to track the execution and be aware and have more details
about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many of them might
run silently without producing any output other than the final files.

On the right hand side of the dialog you wil find a short description of the algorithm, which will help you un-
derstand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

Some algorithms might have a more detailed help file, which might include description of every parameter it uses,
or examples. In that case, you will find a Help tab in the parameters dialog.

O notă privind proiect,iile

Algorithms that are run from the processing framework — this is also true of most of the external applications
whose algorithms are exposed through it— do not perform any reprojection on input layers and assume that all
of them are already in a common coordinate system and ready to be analyzed. Whenever you use more than one
layer as input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same
coordinate system.

Note that, due to QGIS’s on-the-fly reprojecting capabilities, although two layers might seem to overlap and match,
that might not be true if their original coordinates are used without reprojecting them onto a common coordinate
system. That reprojection should be done manually, and then the resulting files should be used as input to the
algorithm. Also, note that the reprojection process can be performed with the algorithms that are available in the
processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show CRS option.

Dacă încercat,i să executat,i un algoritm folosind ca intrare două sau mai multe straturi, cu CRS-uri nepotrivite, va
fi afis, at un dialog de avertizare.

Putet,i încă să executat,i algoritmul, dar fit,i cons, tient,i de faptul că, în cele mai multe cazuri se vor produce rezultate
gres, ite, cum ar fi straturile goale datorate straturilor de intrare care nu se suprapun.
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18.2.2 Obiecte de date generate de algoritmi

Obiectele de date generate de un algoritm pot fi oricare din următoarele tipuri:

• Un strat raster

• Un strat vectorial

• O tabelă

• Un fis, ier HTML (folosit pentru ies, iri de text s, i grafice)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS or Spatialite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .shp
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

You can set a default folder for output data objects. Go to the settings dialog (you can open it from the Processing
menu), and in the General group, you will find a parameter named Output folder. This output folder is used as the
default path in case you type just a filename with no path (i.e., myfile.shp) when executing an algorithm.

When running an algorithm that uses a vector layer in iterative mode, the entered file path is used as the base path
for all generated files, which are named using the base name and appending a number representing the index of
the iteration. The file extension (and format) is used for all such generated files.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Pentru toate celelalte tipuri de rezultate, vet,i găsi o casetă de selectare, pe care o putet,i folosi pentru a indica
algoritmului dacă să încarce fis, ierul după ce este generat de către algoritm, sau nu. În mod implicit, toate fis, ierele
vor fi deschise.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).
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18.2.3 Configurarea cadrului de procesare

După cum s-a ment,ionat, meniul de configurare oferă acces la un nou dialog în care putet,i configura modul în care
funct,ionează algoritmii. Parametrii de configurare sunt structurat,i în blocuri separate pe care le putet,i selecta în
partea stângă a dialogului.

Împreună cu intrarea Output folder, mai sus ment,ionată, blocul General cont,ine parametri pentru stabilirea stilului
de randare prestabilit pentru straturile de ies, ire (care sunt straturi generate prin utilizarea algoritmilor oricăruia din-
tre componentele GUI). Doar creat,i stilul pe care dorit,i să-l folosit,i în QGIS, salvat,i-l într-un fis, ier, apoi introducet,i
calea către acest fis, ier în setări, astfel încât algoritmii să-l poată folosi. Ori de câte ori un strat va fi încărcat prin
SEXTANTE, iar apoi va fi adăugat la canevasul QGIS, el va fi randat cu acest stil.

Stilurile de randare pot fi configurate în mod individual pentru fiecare algoritm s, i pentru fiecare dintre rezultatele
sale. Doar facet,i clic dreapta pe numele algoritmului din caseta de instrumente s, i selectat,i Edit rendering styles.
Vet,i vedea un dialog similar cu cel care urmează.

Figure 18.16: Stiluri de Randare

Selectat,i fis, ierul de stil (.qml), pe care îl dorit,i pentru fiecare ies, ire, apoi apăsat,i [OK].

Alt,i parametri de configurare din grupul General sunt listat,i mai jos:

• Use filename as layer name. The name of each resulting layer created by an algorithm is defined by the
algorithm itself. In some cases, a fixed name might be used, meaning that the same output name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice that, if the output is saved to a temporary file, the filename
of this temporary file is usually a long and meaningless one intended to avoid collision with other already
existing filenames.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an al-
gorithm, only its selected features will be used. If the layer has no selected features, all features will be
used.

• Pre-execution script file and Post-execution script file. These parameters refer to scripts written using the
processing scripting functionality, and are explained in the section covering scripting and the console.

Apart from the General block in the settings dialog, you will also find a block for algorithm providers. Each
entry in this block contains an Activate item that you can use to make algorithms appear or not in the toolbox.
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Also, some algorithm providers have their own configuration items, which we will explain later when covering
particular algorithm providers.

18.3 Modelatorul grafic

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, but rather part of a chain of operations instead. Us-
ing the graphical modeler, that chain of processes can be wrapped into a single process, so it is as more convenient
to execute as a single process later on a different set of inputs. No matter how many steps and different algorithms
it involves, a model is executed as a single algorithm, thus saving time and effort, especially for larger models.

Modelatorul poate fi deschis din meniul de prelucrare.

Modelatorul are un canevas de lucru în care sunt prezentate structura modelului s, i fluxul de lucru pe acesta care
îl reprezintă. În partea stângă a ferestrei, poate fi folosit un panou cu două file, pentru a adăuga noi elemente
modelului.

Figure 18.17: Modelatorul

Crearea unui model de implică două etape:

1. Definirea intrărilor necesare. Aceste intrări vor fi adăugate la fereastra parametrilor, astfel încât utilizatorul
să le poată seta valorile la momentul execut,iei modelului. Modelul în sine reprezintă un algoritm, astfel
încât fereastra parametrilor este generată automat, as, a cum se întâmplă cu tot,i algoritmii disponibili în
cadrul procesării.

2. Definition of the workflow. Using the input data of the model, the workflow is defined by adding algorithms
and selecting how they use those inputs or the outputs generated by other algorithms already in the model.
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18.3.1 Definit,ia intrărilor

The first step to create a model is to define the inputs it needs. The following elements are found in the Inputs tab
on the left side of the modeler window:

• Stratul raster

• Stratul vectorial

• S, irul

• Câmpul tabelei

• Tabela

• Extinderea

• Numărul

• Boolean

• Fis, ierul

Double-clicking on any of these elements, a dialog is shown to define its characteristics. Depending on the
parameter itself, the dialog may contain just one basic element (the description, which is what the user will see
when executing the model) or more of them. For instance, when adding a numerical value, as can be seen in the
next figure, apart from the description of the parameter, you have to set a default value and a range of valid values.

Figure 18.18: Parametrii Modelului

Pentru fiecare intrare adăugată, un element nou este adăugat pe canevasul modelatorului.

Putet,i adăuga intrări, de asemenea, prin glisarea tipului de intrare din listă, s, i fixarea lui în canevasul modelatorului,
în pozit,ia în care dorit,i să-l plasat,i.

18.3.2 Definit,ia fluxului de lucru

Once the inputs have been defined, it is time to define the algorithms to apply on them. Algorithms can be found
in the Algorithms tab, grouped much in the same way as they are in the toolbox.
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Figure 18.19: Parametrii Modelului

Figure 18.20: Parametrii Modelului
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To add an algorithm to a model, double-click on its name or drag and drop it, just like it was done when adding
inputs. An execution dialog will appear, with a content similar to the one found in the execution panel that is shown
when executing the algorithm from the toolbox. The one shown next corresponds to the SAGA ‘Convergence
index’ algorithm.

Figure 18.21: Parametrii Modelului

As you can see, some differences exist. Instead of the file output box that was used to set the file path for output
layers and tables, a simple text box is used here. If the layer generated by the algorithm is just a temporary result
that will be used as the input of another algorithm and should not be kept as a final result, just do not edit that text
box. Typing anything in it means that the result is final and the text that you supply will be the description for the
output, which will be the output the user will see when executing the model.

Selecting the value of each parameter is also a bit different, since there are important differences between the
context of the modeler and that of the toolbox. Let’s see how to introduce the values for each type of parameter.

• Layers (raster and vector) and tables. These are selected from a list, but in this case, the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Numerical values. Literal values can be introduced directly in the text box. But this text box is also a list
that can be used to select any of the numerical value inputs of the model. In this case, the parameter will
take the value introduced by the user when executing the model.

• Şir. Ca s, i în cazul valorilor numerice, s, irurile de caractere literale pot fi tastate, sau se poate selecta un s, ir
de intrare.

• Table field. The fields of the parent table or layer cannot be known at design time, since they depend on the
selection of the user each time the model is executed. To set the value for this parameter, type the name of
a field directly in the text box, or use the list to select a table field input already added to the model. The
validity of the selected field will be checked at run time.

In all cases, you will find an additional parameter named Parent algorithms that is not available when calling
the algorithm from the toolbox. This parameter allows you to define the order in which algorithms are executed
by explicitly defining one algorithm as a parent of the current one, which will force the parent algorithm to be
executed before the current one.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
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in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes a SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
the two steps will be executed in the correct order.

Once all the parameters have been assigned valid values, click on [OK] and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, that provide objects
that are used as inputs for that algorithm.

Elementele pot fi deplasate într-o pozit,ie diferită pe canevas, pentru a schimba modul în care este afis, ată structura
modulului, făcându-l mai clar s, i mai intuitiv. Legăturile dintre elemente sunt automat actualizate. Îl putet,i mări s, i
mics, ora cu ajutorul rotit,ei mouse-ului.

You can run your algorithm any time by clicking on the [Run] button. However, in order to use the algorithm
from the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

18.3.3 Salvarea s, i încărcarea modelelor

Use the [Save] button to save the current model and the [Open] button to open any model previously saved.
Models are saved with the .model extension. If the model has been previously saved from the modeler window,
you will not be prompted for a filename. Since there is already a file associated with that model, the same file will
be used for any subsequent saves.

Înainte de a salva un model, trebuie să introducet,i un nume s, i un grup pentru el, folosind casetele de text din partea
de sus a ferestrei.

Models saved on the models folder (the default folder when you are prompted for a filename to save the model)
will appear in the toolbox in the corresponding branch. When the toolbox is invoked, it searches the models
folder for files with the .model extension and loads the models they contain. Since a model is itself an algorithm,
it can be added to the toolbox just like any other algorithm.

Dosarul modelelor poate fi setat din dialogul de configurare pentru Processing, conform grupului Modeler.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the
Algorithms tab of the modeler window. That means that you can incorporate a model as a part of a bigger model,
just as you add any other algorithm.

18.3.4 Editarea unui model

Putet,i edita modelul pe care îl creat,i în mod curent, să redefinit,i fluxul de lucru s, i relat,iile dintre algoritmi s, i
intrările care definesc modelul în sine.

Dacă facet,i clic-dreapta pe un algoritm din canevas reprezentând modelul, vet,i vedea un meniu contextual ca cel
prezentat în continuare:

Figure 18.22: Clic-Dreapta pe Modelator

Selecting the Remove option will cause the selected algorithm to be removed. An algorithm can be removed only
if there are no other algorithms depending on it. That is, if no output from the algorithm is used in a different one
as input. If you try to remove an algorithm that has others depending on it, a warning message like the one you
can see below will be shown:
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Figure 18.23: Nu se Poate S, terge Algoritmul

Selecting the Edit option will show the parameters dialog of the algorithm, so you can change the inputs and
parameter values. Not all input elements available in the model will appear in this case as available inputs. Layers
or values generated at a more advanced step in the workflow defined by the model will not be available if they
cause circular dependencies.

Select the new values and then click on the [OK] button as usual. The connections between the model elements
will change accordingly in the modeler canvas.

A model can be run partially, by deactivating some of its algorithms. To do it, select the Deactivate option in the
context menu that appears when right-clicking on an algorithm element. The selected algorithm, and all the ones
in the model that depend on it will be displayed in grey and will not be executed as part of the model.

Figure 18.24: Modelul cu Algoritmi Deactivat,i

When right-clicking on an algorithm that is not active, you will instead see a Activate menu option that you can
use to activate it back.

18.3.5 Editarea fis, ierelor de ajutor s, i a meta-informat,iilor modelului

You can document your models from the modeler itself. Just click on the [Edit model help] button and a dialog
like the one shown next will appear.

On the right-hand side, you will see a simple HTML page, created using the description of the input parameters
and outputs of the algorithm, along with some additional items like a general description of the model or its author.
The first time you open the help editor, all these descriptions are empty, but you can edit them using the elements
on the left-hand side of the dialog. Select an element on the upper part and then write its description in the text
box below.

Modelul ajutorului este salvat ca parte a modelului în sine.

18.3.6 Exportarea unui model sub formă de script Python

As we will see in a later chapter, Processing algorithms can be called from the QGIS Python console, and new
Processing algorithms can be created as well using Python. A quick way of creating such a Python script is to
create a model and then to export is as a Python file.

To do so, click on the Export as Python script button. Select the output file in the file chooser dialog, and
Processing will write in it the Python commands that perform the same operations defined in the current model.

18.3.7 Despre algoritmii disponibili

You might notice that some algorithms that can be be executed from the toolbox do not appear in the list of
available algorithms when you are designing a model. To be included in a model, an algorithm must have a
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Figure 18.25: Edit,ia Ajutorului

correct semantic, so as to be properly linked to others in the workflow. If an algorithm does not have such a
well-defined semantic (for instance, if the number of output layers cannot be known in advance), then it is not
possible to use it within a model, and thus, it does not appear in the list of algorithms that you can find in the
modeler dialog.

Additionally, you will see some algorithms in the modeler that are not found in the toolbox. These algorithms are
meant to be used exclusively as part of a model, and they are of no interest in a different context. The ‘Calculator’
algorithm is an example of that. It is just a simple arithmetic calculator that you can use to modify numerical
values (entered by the user or generated by some other algorithm). This tool is really useful within a model, but
outside of that context, it doesn’t make too much sense.

18.4 Interfat,a de prelucrare în serie

18.4.1 Introducere

Tot,i algoritmii (inclusiv modelele) se pot executa ca un proces în serie. Astfel, aces, tia pot fi executat,i folosindu-se
nu doar un singur set de intrări, ci mai multe, care rulează algoritmii la nevoie. Acest lucru este util când se
procesează cantităt,i mari de date, nefiind necesară lansarea repetată a unui algoritm din caseta de instrumente.

Pentru a executa un algoritm sub formă de procedeu în serie, facet,i clic-dreapta pe numele său din caseta de
instrumente, apoi selectat,i opt,iunea Execute as batch process din meniul pop-up care va apărea.

Figure 18.26: Clic Dreapta pe Interfat,a de Procesare în Serie

Dacă avet,i deschis dialogul de execut,ie a algoritmului, tot de acolo putet,i lansa interfat,a de prelucrare în serie,
făcând clic pe butonul de Executare ca proces în serie....
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Figure 18.27: Procesarea în Serie din Dialogul Algoritmului

18.4.2 Tabela parametrilor

Executarea unui proces în serie este similară execut,iei unui singur algoritm. Des, i valorile parametrilor trebuie să
fie definite, în acest caz nu este de ajuns o singură valoare pentru fiecare parametru, ci un set, câte unul pentru
fiecare execut,ie a algoritmului. Valorile sunt introduse cu ajutorul unui tabel asemănător cu cel prezentat în
continuare.

Fiecare linie a tabelului reprezintă o singură execut,ie a algoritmului, iar fiecare celulă cont,ine valoarea unuia dintre
parametri. Acesta este similar cu dialogul parametrilor pe care îl vedet,i la execut,ia unui algoritm din caseta de
instrumente, însă cu un alt aranjament.

În mod implicit, tabelul cont,ine doar două rânduri. Putet,i adăuga sau elimina rânduri folosind butoanele din partea
de jos a ferestrei.

O dată ce dimensiunea tabelei a fost stabilită, acesta trebuie să fie umplută cu valorile dorite.

18.4.3 Completarea tabelei cu parametri

Pentru majoritatea parametrilor, setarea valorii este trivială. Trebuie doar să tastat,i valoarea sau să o selectat,i din
lista de opt,iuni disponibile, în funct,ie de tipul parametrului.

Numele fis, ierelor de intrare ale obiectelor de tip dată sunt introduse în mod direct sau, mai convenabil, făcând

clic pe butonul din partea dreaptă a celulei, care prezintă un meniu contextual cu două opt,iuni: una pentru
selectarea din straturile curent deschise s, i alta pentru a selecta din sistemul de fis, iere. A doua opt,iune, atunci când
este folosită, prezintă un dialog tipic de selectare a unui fis, ier. În cazul în care parametrul de intrare reprezintă
un singur obiect de date, iar mai multe fis, iere sunt selectate, fiecare dintre ele va fi introdusă într-un rând separat,
adăugându-se altele noi, dacă este necesar. Dacă parametrul reprezintă o intrare multiplă, atunci fis, ierele selectate
vor fi adăugate toate într-o singură celulă, separarea efectuându-se cu ajutorul caracterului punct s, i virgulă (;).

Identificatorii stratului pot fi introdus, i direct în caseta de text a parametrilor. Putet,i introduce calea completă către
un fis, ier sau numele unui strat care este încărcat în proiectul QGIS curent. Numele stratului va fi atas, at în mod
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Figure 18.28: Procesarea în Serie

automat căii sursă. Ret,inet,i că, în cazul în care mai multe straturi au acelas, i nume, acest lucru ar putea duce la
rezultate neas, teptate, din cauza ambiguităt,ii.

Obiectele datelor de ies, ire sunt întotdeauna salvate într-un fis, ier s, i, spre deosebire de executarea unui algoritm din
caseta de instrumente, salvarea într-un fis, ier temporar sau într-o bază de date nu este permisă. Putet,i introduce
numele în mod direct sau de a folosi dialogul selectorului de fis, iere, care apare când facet,i clic pe butonul însot,itor.

După ce at,i selectat fis, ierul, este prezentat un nou dialog, care permite autocompletarea altor celule din aceeas, i
coloană (acelas, i parametru).

Figure 18.29: Salvarea Procesării în Serie

În cazul în care este selectată valoarea implicită (‘Autocompletarea nu are loc’), numele fis, ierului selectat va fi
introdus în celula selectată din tabelul de parametri. Dacă oricare dintre celelalte opt,iuni este selectată, atunci
toate celulele aflate sub cea selectată vor fi automat completate, pe baza unor criterii definite. În acest fel, este
mult mai us, oară completarea tabelei, procesul în serie putându-se defini cu efort redus.

Completarea automată se poate face prin simpla adăugare de numere corelative la calea fis, ierului selectat, sau prin
adăugarea valorii unui alt câmp în acelas, i rând. Acest lucru este deosebit de util pentru a denumi obiectele datelor
de ies, ire în funct,ie de cele de intrare.
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Figure 18.30: Calea către Fis, ierul de Procesare în Serie

18.4.4 Executare ca proces în serie

Pentru a executa procesul în serie după ce at,i introdus toate valorile necesare, facet,i clic pe [OK]. Progresul
activităt,ii de procesare globală va fi afis, at în bara de progres din partea de jos a dialogului.

18.5 Utilizarea algoritmilor de procesare din consolă

The console allows advanced users to increase their productivity and perform complex operations that cannot be
performed using any of the other GUI elements of the processing framework. Models involving several algorithms
can be defined using the command-line interface, and additional operations such as loops and conditional sentences
can be added to create more flexible and powerful workflows.

There is not a processing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

Codul pe care îl putet,i executa din consola Python, chiar dacă nu apelează nici o metodă de procesare specifică,
poate fi transformat într-un nou algoritm pe care să îl putet,i apela mai târziu din caseta de instrumente, din mode-
latorul grafic sau dintr-o componentă, similar oricărui alt algoritm. De fapt, unii algoritmi pe care îi putet,i găsi în
caseta de instrumente sunt simple script-uri.

În această sect,iune, vom vedea cum se utilizează algoritmii de procesare din Consola Python a QGIS, s, i, de
asemenea, cum să scriet,i algoritmi folosind Python.

18.5.1 Apelarea algoritmilor din consola Python

Primul lucru pe care trebuie să-l facet,i, este de a importa funct,iile de prelucrare cu ajutorul următoarei linii:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the runalg() method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the first
thing you need to know is the name of the algorithm to execute. That is not the name you see in the toolbox, but
rather a unique command–line name. To find the right name for your algorithm, you can use the alglist()
method. Type the following line in your console:

>>> processing.alglist()

Vet,i vedea ceva de genul asta.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
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QGIS User Guide, Release 2.14

Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Aceasta e o listă a tuturor algoritmilor disponibili, ordonată alfabetic, împreună cu numele corespunzătoare pentru
linia de comandă.

You can use a string as a parameter for this method. Instead of returning the full list of algorithms, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Acest rezultat s-ar putea schimba în funct,ie de algoritmii pe care îi avet,i la dispozit,ie.

De acum, găsirea algoritmului s, i a numelui pentru linia de comandă care vă interesează devine mai us, oară, în
acest caz, saga:slopeaspectcurvature.

Once you know the command-line name of the algorithm, the next thing to do is to determine the right syntax to
execute it. That means knowing which parameters are needed and the order in which they have to be passed when
calling the runalg() method. There is a method to describe an algorithm in detail, which can be used to get a
list of the parameters that an algorithm requires and the outputs that it will generate. To get this information, you
can use the alghelp(name_of_the_algorithm) method. Use the command-line name of the algorithm,
not the full descriptive name.

Calling the method with saga:slopeaspectcurvature as parameter, you get the following description:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Acum avet,i tot ceea ce vă trebiue pentru a rula orice algoritm. As, a cum am ment,ionat deja, există o singură
comandă unică pentru a executa algoritmi : runalg(). Sintaxa este următoarea:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

The list of parameters and outputs to add depends on the algorithm you want to run, and is exactly the list that the
alghelp() method gives you, in the same order as shown.

Depending on the type of parameter, values are introduced differently. The next list gives a quick review of how
to introduce values for each type of input parameter:

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.
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• Selection. If an algorithm has a selection parameter, the value of that parameter should be entered using an
integer value. To know the available options, you can use the algoptions() command, as shown in the
following example:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

În acest caz, algoritmul are un astfel de parametru, cu s, apte opt,iuni. Ret,inet,i că ordonarea începe de la zero.

• Multiple input. The value is a string with input descriptors separated by semicolons (;). As in the case of
single layers or tables, each input descriptor can be the data object name, or its file path.

• Table Field from XXX. Use a string with the name of the field to use. This parameter is case-sensitive.

• Tabel fix. Tastat,i lista tuturor valorilor din tabel, separate prin virgulă (,) s, i incluse între ghilimele (").
Introducerea valorilor începe cu rândul de sus s, i se desfăs, oară de la stânga la dreapta. De asemenea, putet,i
utiliza o matrice 2-D cu valori care reprezintă tabelul.

• CRS. Introducet,i numărul de cod EPSG pentr CRS-ul dorit.

• Extindere. Trebuie să utilizat,i un s, ir cu valorile xmin, xmax, ymin s, i ymax separate prin virgule (,).

Parametrii boolean, fis, ier, s, ir s, i numeric nu au nevoie de explicat,ii suplimentare.

Input parameters such as strings, booleans, or numerical values have default values. To use them, specify None
in the corresponding parameter entry.

For output data objects, type the file path to be used to save it, just as it is done from the toolbox. If you want to
save the result to a temporary file, use None. The extension of the file determines the file format. If you enter
a file extension not supported by the algorithm, the default file format for that output type will be used, and its
corresponding extension appended to the given file path.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

The runalg method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the file paths of those outputs as values. You can load those layers by passing the corresponding file
paths to the load() method.

18.5.2 Funct,ii suplimentare pentru prelucrarea datelor

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Layers List

• values(layer, fields): Returns the values in the attributes table of a vector layer, for the passed
fields. Fields can be passed as field names or as zero-based field indices. Returns a dict of lists, with the
passed field identifiers as keys. It considers the existing selection.
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• features(layer): Returns an iterator over the features of a vector layer, considering the existing
selection.

• uniqueValues(layer, field): Returns a list of unique values for a given attribute. Attributes can
be passed as a field name or a zero-based field index. It considers the existing selection.

18.5.3 Crearea script-urilor s, i execut,ia lor din caseta de instrumente

Putet,i crea proprii algoritmi, prin scrierea codului Python corespunzător s, i prin adăugarea câtorva linii supli-
mentare, pentru a furniza informat,iile suplimentare, necesare pentru a defini semantica algoritmului. Putet,i găsi
meniul Create new script în grupul Tools din blocul algoritmilor, al barei de instrumente. Facet,i dublu-clic pe el,
pentru a deschide dialogul de editare a script-ului. Acolo ar trebui să tastat,i codul. Salvând script-ul de acolo în
folderul scripts (implicit, atunci când deschidet,i dialogul de salvare a fis, ierului), cu extensia .py, se va crea
automat algoritmul corespunzător.

Numele algoritmului (cel pe care îl vet,i vedea în caseta de instrumente) este generat din numele fis, ierului,
eliminându-i extensia s, i înlocuind cratimele cu spat,ii albe.

Haidet,i să aruncăm o privire la următorul cod, care calculează Indicele de Umiditate Topografic (TWI) direct
dintr-un DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

După cum se poate vedea, calculele implică trei algoritmi, tot,i provenind din SAGA. Ultimul din ei calculează
TWI, dar necesită prezent,a unui strat al pantei s, i un strat de acumulare a fluxului. Nu avem aceste straturi, dar din
moment ce avem DEM-ul, le putem calcula, prin apelarea la algoritmii corespunzători, din SAGA.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
sections in this chapter. The first lines, however, need some additional explanation. They provide the information
that is needed to turn your code into an algorithm that can be run from any of the GUI components, like the toolbox
or the graphical modeler.

Aceste linii încep cu un dublu simbol de comentariu Python (##) s, i are următoarea structură:

[parameter_name]=[parameter_type] [optional_values]

Aici se află o listă a tuturor tipurilor de parametri care sunt acceptat,i în script-urile de procesare, sintaxa acestora
s, i câteva exemple.

• raster. Un strat raster.

• vector. Un strat vectorial.

• table. O tabelă.

• number. O valoare numerică. Trebuie să existe o valoare implicită. De exemplu, depth=number 2.4.

• string. Un s, ir de text. Ca s, i în cazul valorilor numerice, trebuie să fie adăugată o valoare implicită. De
exemplu, name=string Victor.

• boolean. O valoare booleană. Se adaugă True sau False pentru a seta valoarea implicită. De exemplu,
verbose=boolean True.

• multiple raster. Un set de straturi raster, de intrare.

• multiple vector. Un set de straturi vectoriale de intrare.
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• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. Un folder.

• file. Un nume de fis, ier.

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Ies, irile sunt definite într-un mod similar, folosind următoarele etichete:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

The value assigned to the output variables is always a string with a file path. It will correspond to a temporary file
path in case the user has not entered any output filename.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

Do not use the load() method in your script algorithms, just when working with the console line. If a layer is
created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly use
the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, you have to assign a value to them. To do so,
just set the value of a variable with the name you used to declare that output. For instance, if you have used this
declaration,

##average=output number

următoarea linie va seta valoarea de ies, ire la 5:

average = 5

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two possible methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

Several examples are provided. Please check them to see real examples of how to create algorithms using the
processing framework classes. You can right-click on any script algorithm and select Edit script to edit its code or
just to see it.
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18.5.4 Documentarea script-urilor

As in the case of models, you can create additional documentation for your scripts, to explain what they do and
how to use them. In the script editing dialog, you will find an [Edit script help] button. Click on it and it will
take you to the help editing dialog. Check the section about the graphical modeler to know more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving the script for the first time. If you later close the script editing dialog
without saving the script (i.e., you discard it), the help content you wrote will be lost. If your script was already
saved and is associated to a filename, saving the help content is done automatically.

18.5.5 Script de interceptare a pre- s, i post-execut,iei

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing configuration dialog, you will find two entries named Pre-execution script
file and Post-execution script file where the filename of the scripts to be run in each case can be entered.

18.6 Managerul istoricului

18.6.1 Procesarea istoricului

De fiecare dată când executat,i un algoritm, informat,iile despre proces sunt stocate în managerul istoricului. Îm-
preună cu parametrii utilizat,i, sunt salvate, de asemenea, data s, i ora executării.

În acest fel, sunt us, or de urmărit, de controlat s, i de reprodus toate lucrările care au fost dezvoltate cu ajutorul
cadrului de lucru Processing.

Managerul de istoric reprezintă un set de intrări de registru, grupate în funct,ie de data de executare, ceea ce
us, urează informat,iile despre un algoritm executat în orice moment anume.

Informat,iile procesului sunt păstrate ca o expresie pentru linia de comandă, chiar dacă algoritmul a fost lansat din
caseta de instrumente. Acest lucru îl face, de asemenea, util pentru cei care învat,ă cum să utilizeze interfat,a liniei
de comandă, deoarece aces, tia pot apela un algoritm folosind bara de instrumente s, i apoi să verifice managerul
istoricului, pentru a vedea cum ar putea acelas, i algoritm să fie apelat din linia de comandă.

În afară de navigarea intrărilor în registru, putet,i, de asemenea re-executa procesele, printr-un simplu dublu-clic
pe intrarea corespunzătoare.

18.6.2 Jurnalul de Procesare

Fereastra de dialog a istoricului cont,ine doar apelurile de execut,ie, dar nu s, i informat,iile produse de către algoritm
pe durata execut,iei sale. Aceste date sunt prezentate în scris în jurnalul QGIS, din fila Processing.

Algoritmii tert,i sunt, de obicei, executat,i prin apelarea interfet,elor lor, de tip linie de comandă, care comunică
cu utilizatorul prin intermediul consolei. Des, i această consolă nu este afis, ată, un jurnal complet al ei este sto-
cat în grupul Informat,iilor, la fiecare execut,ie a fiecărui algoritm. Putet,i evita aglomerarea jurnalului cu aceste
informat,ii, prin dezactivarea lor, cu ajutorul opt,iunii corespunzătoare din dialogul cu setări al fiecărui furnizor.

Unii algoritmi, chiar dacă pot genera un rezultat pornind de la datele de intrare, pot insera în jurnal comentarii
sau informat,ii suplimentare, pentru a vă avertiza în cazul în care detectează eventuale probleme referitoare la date.
Asigurat,i-vă că at,i citit aceste mesaje atunci când obt,inet,i rezultate neas, teptate.
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Figure 18.31: Istoricul
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18.7 Scrierea noilor Algoritmi de Procesare sub formă de script-uri
Python

Putet,i crea proprii algoritmi, prin scrierea codului Python corespunzător s, i prin adăugarea câtorva linii supli-
mentare, pentru a furniza informat,iile suplimentare, necesare pentru a defini semantica algoritmului. Putet,i găsi
meniul Create new script în grupul Tools din blocul algoritmilor, al barei de instrumente. Facet,i dublu-clic pe el,
pentru a deschide dialogul de editare a script-ului. Acolo ar trebui să tastat,i codul. Salvând script-ul de acolo în
folderul scripts (implicit, atunci când deschidet,i dialogul de salvare a fis, ierului), cu extensia .py, se va crea
automat algoritmul corespunzător.

Numele algoritmului (cel pe care îl vet,i vedea în caseta de instrumente) este generat din numele fis, ierului,
eliminându-i extensia s, i înlocuind cratimele cu spat,ii albe.

Haidet,i să folosim următorul cod, care calculează Indicele de Umiditate Topografic (TWI) direct dintr-un DEM

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

După cum se poate vedea, acesta implică 3 algoritmi, tot,i provenind din SAGA. Ultimul din ei calculează TWI,
dar necesită prezent,a unui strat al pantei s, i un strat de acumulare a fluxului. Nu avem aceste straturi, dar din
moment ce avem DEM-ul, le putem calcula, prin apelarea la algoritmii corespunzători, din SAGA.

Partea de cod în care are loc această prelucrare nu este greu de înt,eles dacă at,i citit capitolul anterior. Totus, i,
primele linii au nevoie de unele explicat,ii suplimentare. Ele furnizează informat,iile necesare pentru a transforma
codul într-un algoritm care poate fi rulat de oricare dintre componentele GUI, cum ar fi setul de instrumente sau
modelatorul grafic.

Aceste linii încep cu un dublu simbol de comentariu Python (##) s, i are următoarea structură

[parameter_name]=[parameter_type] [optional_values]

Aici se află o listă a tuturor tipurilor de parametri care sunt acceptat,i în script-urile de procesare, sintaxa acestora
s, i câteva exemple.

• raster. Un strat raster

• vector. Un strat vectorial

• table. O tabelă

• number. O valoare numerică. Trebuie să fie specificată o valoare implicită. De exemplu, depth=number
2.4

• string. Un s, ir care cuprinde text. Ca s, i în cazul valorilor numerice, trebuie să existe o valoare implicită.
De exemplu, name=string Victor

• longstring. Este similar s, irului de caractere, dar se va afis, a o casetă de text mai mare, mai potrivită
pentru s, irurile lungi, cum ar fi un script care as, teaptă un mic fragment de cod.

• boolean. O valoare booleană. Se adaugă True sau False pentru a seta valoarea implicită. De exemplu,
verbose=boolean True.

• multiple raster. Un set de straturi raster de intrare.

• multiple vector. Un set de straturi vectoriale de intrare.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.
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• extent. O extindere spat,ială definită de xmin, xmax, ymin, ymax

• folder. Un folder

• file. Un nume de fis, ier

• crs. Un Sistem de Coordonate de Referint,ă

• selection. A dropdown menu that allows the user to select from a pre-populated list. For example
units=selection sq_km;sq_miles;sq_degrees

• name. Name of the script. This will be displayed as the algorithm name in the processing toolbox. For
example My Algorithm Name=name

• group. Folder name where the script will appear in the Processing Toolbox. For Example, adding
Utils=groups will put the script within a Utils folder within Scripts.

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
underscores with spaces. So, for instance, if you want the user to see a parameter named A numerical value,
you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Ies, irile sunt definite într-un mod similar, folosind următoarele etichete:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

• output extent

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the user has not entered any output filename.

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

The last tag that you can use in your script header is ##nomodeler. Use that when you do not want your
algorithm to be shown in the modeler window. This should be used for algorithms that do not have a clear syntax
(for instance, if the number of layers to be created is not known in advance, at design time), which make them
unsuitable for the graphical modeler

18.8 Manipularea datelor produse de algoritm

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
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use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,

##average=output number

următoarea linie va seta valoarea de ies, ire la 5:

average = 5

18.9 Comunicarea cu utilizatorul

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

If you have to provide some information to the user, not related to the progress of the algorithm, you can use the
setInfo(text) method, also from the progress object.

If your script has some problem, the correct way of propagating it is to raise an exception of type
GeoAlgorithmExecutionException(). You can pass a message as argument to the constructor of the
exception. Processing will take care of handling it and communicating with the user, depending on where the
algorithm is being executed from (toolbox, modeler, Python console...)

18.10 Documentarea script-urilor

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to find out more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Note that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated with a filename, saving is done automatically.

18.11 Exemple de script-uri

Several examples are available in the on-line collection of scripts, which you can access by selecting the Get script
from on-line script collection tool under the Scripts/tools entry in the toolbox.

Please, check them to see real examples of how to create algorithms using the processing framework classes. You
can right-click on any script algorithm and select Edit script to edit its code or just to see it.
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18.12 Cele mai bune practici pentru scrierea algoritmilor pentru
script

Here’s a quick summary of ideas to consider when creating your script algorithms and, especially, if you want to
share with other QGIS users. Following these simple rules will ensure consistency across the different Processing
elements such as the toolbox, the modeler or the batch processing interface.

• Do not load resulting layers. Let Processing handle your results and load your layers if needed.

• Always declare the outputs your algorithm creates. Avoid things such as declaring one output and then
using the destination filename set for that output to create a collection of them. That will break the correct
semantics of the algorithm and make it impossible to use it safely in the modeler. If you have to write an
algorithm like that, make sure you add the ##nomodeler tag.

• Do not show message boxes or use any GUI element from the script. If you want to communicate with the
user, use the setInfo() method or throw an GeoAlgorithmExecutionException

• As a rule of thumb, do not forget that your algorithm might be executed in a context other than the Processing
toolbox.

18.13 Script de interceptare a pre- s, i post-execut,iei

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing config dialog you will find two entries named Pre-execution script file and
Post-execution script file where the filename of the scripts to be run in each case can be entered.

18.14 Configurarea Aplicat,iilor Externe

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external applications are managed by their own algorithm provider.

This section will show you how to configure the processing framework to include these additional applications,
and it will explain some particular features of the algorithms based on them. Once you have correctly configured
the system, you will be able to execute external algorithms from any component like the toolbox or the graphical
modeler, just like you do with any other geoalgorithm.

By default, all algorithms that rely on an external application not shipped with QGIS are not enabled. You can
enable them in the settings dialog. Make sure that the corresponding application is already installed in your
system.

18.14.1 O notă pentru utilizatorii de Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms from these providers will be ready to be run without needing any further configuration. If
installing through OSGeo4W application, make sure you select for installation SAGA, GRASS and OTB as well.

If you want to know more about how these providers work, or if you want to use some algorithms not included in
the simplified toolbox (such as R scripts), keep on reading.
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18.14.2 O notă privind formatele de fis, iere

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Utilizarea straturilor GRASS raster reprezintă, de exemplu, un caz în care at,i putea avea probleme, nefiind în
măsură să finalizat,i activitatea dacă apelat,i un algoritm extern asupra unui astfel de strat de intrare. Din acest
motiv, aceste straturi nu vor apărea ca fiind disponibile pentru algoritmi.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common formats that can later be transformed
by QGIS automatically. As in the case of input layers, if this conversion is needed, that might increase the
processing time.

18.14.3 O notă privind select,iile stratului vectorial

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

În alte cazuri, este necesară exportarea doar a entităt,ilor selectate, care provoacă timpi de execut,ie mai lungi.

18.14.4 SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself and your QGIS installer did not include it, the path to the SAGA executable
must be configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named
SAGA Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you
are ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with Processing, so you have to download and install
the software yourself. Please check the SAGA website for more information.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folder entries.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

Despre limitările sistemului grilă SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
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calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

Definirea acestui sistem grilă comun este controlată de către utilizator, acest lucru putând făcut din zona grupului
SAGA al ferestrei de setare. Există două modalităt,i de stabilire a sistemului grilă t,intă:

• Setare manuală. Putet,i defini extinderea, prin stabilirea valorilor următorilor parametri:

– Rees, antionare min X

– Rees, antionare max X

– Rees, antionare min Y

– Rees, antionare max Y

– Rees, antionare dimensiune celulă

Ret,inet,i că aplicat,ia QGIS va rees, antiona straturile de intrare la această extindere, chiar dacă acestea nu se
suprapun cu ea.

• Setare automată din straturile de intrare. Pentru a selecta această opt,iune, doar să verificat,i opt,iunea Use
min covering grid system for resampling. Toate celelalte setări vor fi ignorate, iar extinderea minimă care
acoperă toate straturile de intrare va fi utilizată. Dimensiunea celulei din stratul t,intă reprezintă maximul
dimensiunilor tuturor celulelor din straturile de intrare.

For algorithms that do not use multiple raster layers, or for those that do not need a unique input grid system, no
resampling is performed before calling SAGA, and those parameters are not used.

Limitări pentru straturile multi-bandă

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

Limitări de mărime a celulelor

SAGA assumes that raster layers have the same cell size in the X and Y axis. If you are working with a layer with
different values for horizontal and vertical cell size, you might get unexpected results. In this case, a warning will
be added to the processing log, indicating that an input layer might not be suitable to be processed by SAGA.

Jurnalizare

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

Most other providers that use an external application and call it through the command-line have similar options,
so you will find them as well in other places in the processing settings list.
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18.14.5 R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Note: for Windows user, usually the R executable file is in the C:Program FilesRR-3.2 folder. Add just
the folder and NOT the binary!

Once again, this is different in Linux, and you just have to make sure that the R folder is included in the PATH
environment variable. If you can start R just typing R in a console, then you are ready to go.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

R script files have the extension .rsx, and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings group
(available from the processing settings dialog), just like you do with the folder for regular processing scripts.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the Processing
scripts that we have already seen, so they will not be described here again.

Please have a look at the R Intro and the R Syntax Training Manual Chapters to have more information on how to
write your own R scripts-

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of
a parameter is also the name of the variable that we can use in R for accessing the value of that parameter (thus,
you should avoid using reserved R words as parameter names).

Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tabelele sunt deschise folosind comanda read.csv(). În cazul în care un tabel introdus de către utilizator nu
este în format CSV, acesta va fi convertit înainte de importul în R.

În plus, fis, ierele raster pot fi citite prin utilizarea comenzii readGDAL() în loc de brick()‘‘atuni când
se foloses,te ‘‘##usereadgdal.
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If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilenames tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Cu ajutorul informat,iilor de mai sus, putem înt,elege acum prima linie de primul nostru exemplu de script (prima
linie care nu începe cu un comentariu Python).

pts=spsample(polyg,numpoints,type="random")

The variable polygon already contains a SpatialPolygonsDataFrame object, so it can be used to call the
spsample method, just like the numpoints one, which indicates the number of points to add to the created
sample grid.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and that it contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the ##passfilenames option, outputs are generated using the raster package (with
writeRaster()), even though it is not used for the inputs.

If your algorithm does not generate any layer, but rather a text result in the console instead, you have to indicate
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithm that performs a normality test on a given field (column) of
the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Dacă algoritmul dvs. creează orice gen de grafic (folosind metoda plot()), adăugat,i următoarea linie:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Ambele rezultate grafice cât s, i cele din consolă vor fi afis, ate în managerul rezultatelor procesării.

For more information, please check the script files provided with Processing. Most of them are rather simple and
will greatly help you understand how to create your own scripts.

Note: rgdal and raster libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing,
library(ggplot2). If the package is not already installed on your machine, Processing will download and
install it. In this way the package will be also available in R Standalone. Be aware that if the package has to be
downloaded, the first time you run the script it might take a long time.
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18.14.6 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionally, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Dacă lucrat,i pe Linux, trebuie doar să vă asigurat,i că GRASS este instalat corect s, i că poate fi rulat fără probleme
de la o consolă.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behavior you prefer, just check the Use
min covering region option in the GRASS configuration parameters.

18.14.7 GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

18.14.8 Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are running Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Then, configure the path to the folder where OTB command-line tools and libraries are installed:

• Usually OTB applications folder points to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin.

• If you use any of the installers that include OTB, such as OSGeo4W, there is no need for further con-
figuration. Processing will detect the path automatically and will not show the corresponding configuration
entries. Otherwise, fill the OTB applications folder and OTB command line tools folder parameters with the
to the corresponding values for your installation.

18.14.9 TauDEM

TauDEM (Terrain Analysis Using Digital Elevation Models) is a tools for the extraction and analysis of hydrolog-
ical information from Digital Elevation Models (DEM). TauDEM can be used from QGIS if you have it installed
in your system and configured QGIS properly, so it can find all necessary files.

There are two versions of TauDEM tools: singlefile (TauDEM 5.0.6 or 5.1.2) and multifile (TauDEM 5.2.0). The
difference between these versions in the supported inputs/outputs. Single files version accepts only single raster
file and write single file as output. Multifile version accepts a directory with rasters and writes directory with
rasters as output. Such directory should contain rasters that will be treated as a single DEM grid.
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TauDEM Processing provider supports both single- and multifile versions of TauDEM and even allows to use them
simultaneously.

Note: While TauDEM Processing provider supports TauDEM 5.0.6, 5.1.2 and 5.2.0 we recommend to use 5.1.2
and/or 5.2.0 as this versions have some new tools available, like Gage Watershed and TWI.

Instalarea TauDEM sub Windows

Please visit the TauDEM homepage and download desired version of the precompiled binaries for your platform
(32-bit or 64-bit), usually this is “Command Line Executables”. Also you need to download Microsoft HPC Pack
2012 MS-MPI. First install Microsoft HPC Pack 2012 MS-MPI by runing mpi_x64.Msi for 64-bit platforms
and mpi_x86.Msi for 32-bit platforms.

Note: În cazul în care dorit,i să utilizat,i TauDEM 5.0.6

Instalarea TauDEM sub Linux

Unfortunately there are no packages for most Linux distributions, so you should compile TauDEM by yourself.
As TauDEM uses MPI it is necessary to install first any MPI implementation e.g MPICH or OpenMPI. Use your
favorite package manager to install MPICH or OpenMPI.

Download TauDEM 5.2.0 source code package from GitHub repository and extract archive contents. Open termi-
nal and cd into src directory inside extracted folder. Create build directory and cd into it

mkdir build
cd build

Configure your build (change install prefix if necessary) and compile

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..
make

When compilation finished install TauDEM tools by running

sudo make install

Note: Executable files will be installed into bin subdirectory inside prefix you specified at the con-
figure stage. For example if you specified prefix /opt/taudem5.2 than binaries will be installed into
/opt/taudem5.2/bin.

To use singlefile version — download source package here and perform above mentioned steps to compile and
install it.

Old TauDEM 5.0.6 also available. But before compiling this version it is necessary to edit some source files.

Deschidet,i fis, ierul linearpart.h, apoi după linia

#include "mpi.h"

adăugat,i o nouă linie cu

#include <stdint.h>

astfel, vet,i obt,ine

#include "mpi.h"
#include <stdint.h>

Salvat,i modificările s, i închidet,i fis, ierul. Acum deschidet,i tiffIO.h, găsit,i linia #include "stdint.h" s, i
înlocuit,i ghilimelele ("") cu <>, apoi vet,i obt,ine
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#include <stdint.h>

Salvat,i modificările s, i închidet,i fis, ierul.

Acum, configurat,i, compilat,i s, i instalat,i TauDEM 5.0.6 folosind aceleas, i comenzi, similar descrierii de mai sus.

Configurarea furnizorului TauDEM

Once TauDEM is installed, start QGIS, open the Processing options dialog from Processing → Options... and
configure the TauDEM algorithm provider. In the Providers group find TauDEM (hydrologic analysis) block, and
expand it. Here you will see all settings related to TauDEM.

First, ensure that algorithms are enabled, and activate provider if necessary.

Next step is to configure MPI. The MPICH/OpenMPI bin directory setting used to define location of the mpiexec
program. In most Linux distributions you can safely leave this empty, as mpiexec available in your PATH.

The Number of MPI parallel processes to use is a second setting related to MPI. It defines number of processes
that will be used to execute TauDEM commands. If you don’t know which value to use, it is better to leave this
value unchanged.

Now we need to configure the path to the folder(s) where TauDEM command-line tools are installed. As we
already mention TauDEM provider supports both single- and multifile TauDEM, so there are two settings for
TauDEM folders:

• TauDEM command line tools folder used to set location of the singlefile tools

• TauDEM multifile command line tools folder used to set location of the multifile tools

If you have both TauDEM versions installed in different directories it is possible to specify both options.

Ultimul pas este de a defini versiunea de TauDEM care se va folosi:

• with Enable multifile TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM multifile command line tools folder. Multifile tools have same name as singlefile
with “(multifile)” suffix added

• with Enable single TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM command line tools folder.

It is possible to enable both tools simultaneously. In this case you will have two instances of each tool in toolbox
and can use them in your analysis.

Note: Be careful with developing Processing models using TauDEM!
As single- and multifile versions have different inputs, model created with singlefile algorithms will not work if
only multifile algorithms are available. If you plan to share your model please specify which TauDEM version
should be used or, better, provide two versions of your model: for single- and multifile TauDEM.

18.15 QGIS Commander

Processing include un instrument practic care vă permite să rulat,i algoritmi, fără a fi nevoie să utilizat,i bara de
instrumente, doar prin tastarea numelui algoritmului pe care dorit,i să îl rulat,i.

Instrumentul este cunoscut ca s, i QGIS commander, s, i constă doar într-o simplă casetă de text cu autocompletare,
unde vet,i tasta comanda pe care dorit,i să o rulat,i.

The Commander is started from the Processing menu or, more practically, by pressing Shift + Ctrl + M
(you can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). To close
it, just press ESC. Apart from executing Processing algorithms, the Commander gives you access to most of the
functionality in QGIS, which means that it gives you a practical and efficient way of running QGIS tasks and
allows you to control QGIS with reduced usage of buttons and menus.
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Figure 18.32: QGIS Commander

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

18.15.1 Comenzi disponibile

Comenzile disponibile în Commander se încadrează în următoarele categorii:

• Algoritmi de procesare. Aces, tia sunt afis, at,i ca Algoritmi de procesare: <name of the
algorithm>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Funct,ii Python. Putet,i crea funct,ii scurte Python care vor fi incluse în lista de comenzi disponibile. Acestea
sunt afis, ate ca Funct,ia: <function name>.

Pentru a rula oricare dintre categorii, este suficient să începet,i să tastat,i, apoi să selectat,i elementul corespunzător
din lista de comenzi disponibile, care apare după filtrarea întregii liste de comenzi, generată de textul introdus.

In the case of calling a Python function, you can select the entry in the list, which is prefixed by Function:
(for instance, Function: removeall), or just directly type the function name (removeall in the previous
example). There is no need to add brackets after the function name.

18.15.2 Crearea funct,iilor personalizate

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis2/processing/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.

The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favourite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

De exemplu, putet,i adăuga următoarea funct,ie, care elimină toate straturile:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

După ce at,i adăugat funct,ia, ea va fi disponibilă în Commander, putând-o invoca prin tastarea removeall. Nu
este nevoie să facet,i nimic în afară de scrierea funct,iei în sine.
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Functions can receive parameters. Add *args to your function definition to receive arguments. When calling the
function from the Commander, parameters have to be passed separated by spaces.

Aici este un exemplu al unei funct,ii care încarcă un strat, s, i care primes, te ca parametru numele de fis, ier a stratului
care se va încărca.

import processing

def load(*args):
processing.load(args[0])

Dacă dorit,i să încărcat,i stratul din /home/myuser/points.shp, introducet,i în caseta de text a Commander-
ului:

‘‘load /home/myuser/points.shp‘‘
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CHAPTER 19

Compozitorul de Hărt,i

Cu ajutorul Compozitorului de Hărt,i putet,i crea hărt,i s, i atlase frumoase, care pot fi imprimate sau salvate ca fis, iere
PDF, ca imagine sau ca fis, ier SVG. Aceasta este o modalitate puternică de a face schimb de informat,ii geografice
generate de QGIS, care pot fi incluse în rapoarte sau publicat,ii.

19.1 Generalităt,i despre Compozitorul de Hărt,i

Compozitorul de Hărt,i oferă capabilităt,i în cres, tere de aspect s, i de imprimare. Acesta permite adăugarea el-
ementelor, cum ar fi canevasul hărt,ilor QGIS, etichete de text, imagini, legende, scări grafice, forme de bază,
săget,i, tabele de atribute s, i cadre HTML. Există posibilitatea de dimensionare, grupare, aliniere, pozit,ionare s, i
rotire a fiecărui element s, i de reglare a proprietăt,ilor, în scopul punerii în pagină. Hărt,ile pot fi tipărite sau ex-
portate ca formate de imagine, PostScript, PDF sau SVG (exportul către SVG nu funct,ionează corect cu unele
versiuni recente de Qt4; ar trebui să încercat,i s, i să verificat,i în mod individual pe sistemul dumneavoastră). Avet,i
posibilitatea să salvat,i un s, ablon, pe care să-l încărcat,i din nou într-o altă sesiune. În cele din urmă, generarea mai
multor hărt,i pe baza unui s, ablon poate fi realizată prin intermediul generatorului atlasului.

19.1.1 Sesiune de Probă

Before you start to work with the Print Composer, you need to load some raster or vector layers in the QGIS map
canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized to

your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will be
prompted to choose a title for the new Composer.

Pentru a demonstra cum se poate crea o hartă folosit,i următoarele instruct,iuni.

1. On the left side, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and click with the left mouse button on the Print Composer
canvas. A scalebar will be added to the canvas.

3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Selectat,i pictograma Select/Move item pentru a selecta harta de pe canevas s, i pentru a o muta un pic.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change it’s size.

6. Click the Item Properties tab on the left lower panel and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.
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7. Now, you can print or export your print composition to image formats, PDF or to SVG with the export tools
in Composer menu.

8. În cele din urmă, putet,i salva compozit,ia cu ajutorul butonului Salvare Proiect.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

19.1.2 Managerul Compozit,iilor

The Composer Manager is the main window to manage print composers in the project. It helps you add new print

composer, duplicate an existing one, rename or delete it. To open the composer manager dialog, click on the
Composer Manager button in the toolbar or choose Composer → Composer Manager. It can also be reached from the
main window of QGIS with Project → Composer Manager.

Figure 19.1: Managerul Compozitorului de Hărt,i

The composer manager lists in its upper part all the available print composers in the project. The bottom part
shows tools that help to:

• a arăta compozito(arele) selectate: putet,i deschide mai multe compozitoare de hărt,i printr-un singur clic

• duplicate the selected composer (available only if one print composer is selected): it creates a new composer
using the selected composer as template. You’ll be prompted to choose a new title for the new composer

• rename the composer (also available only if one print composer is selected): You’ll be prompted to choose
a new title for the composer. Note that you can also rename the composer by double-clicking on its title in
the upper part

• remove the composer: the selected print composer(s) will be deleted from the project.

With the Composer Manager, it’s also possible to create new print composers as an
empty composer or from a saved template. By default, QGIS will look for tem-
plates in user directory (~/.qgis2/composer_templates) or application’s one
(ApplicationFolder/composer_templates). QGIS will retrieve all the available templates and
propose them in the combobox. The selected template will be used to create a new composer when clicking Add
button. You can also save composer templates in another folder. Choosing specific in the template list offers the
ability to select such template and use it to create a new print composer.
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QGIS User Guide, Release 2.14

19.1.3 Meniuri, instrumente s, i panouri ale compozitorului de hărt,i

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items: the current QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview prezintă o vedere init,ială a Compozitorului de Hărt,i, înainte de adăugarea oricăror
elemente.

Figure 19.2: Compozitorul de Hărt,i

On the right beside the canvas you find two panels. The upper panel holds the tabs Items and Command History
and the lower panel holds the tabs Composition, Item properties and Atlas generation.

• Fila Elementelor oferă o listă a tuturor elementelor adăugate în canevasul hărt,ii din compozitor.

• The Command history tab displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this tab,
you can also customize settings for grid and smart guides.
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• The Item Properties tab displays the properties for the selected item. Click the Select/Move item icon to
select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab and
customize the settings for the selected item.

• Fila de Generare a atlasului vă permite să activat,i generarea unui atlas pentru Compozitorul curent,
oferindu-vă acces la parametrii săi.

În partea de jos a ferestrei Compozitorului de Hărt,i, putet,i găsi o bară de stare cu pozit,ia mouse-ului, numărul
curent al paginii, o casetă combinată pentru a seta nivelul de mărire, numărul de elemente selectate, dacă este
cazul s, i, atunci când are loc generarea atlasului, numărul de entităt,i.

In the upper part of the Print composer window, you can find menus and other toolbars. All Print Composer tools
are available in menus and as icons in a toolbar. See a list of tools in table_composer_1.

The toolbars and the tabs can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars or View → Panels.
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Instrumente

Pic-
togramă

Scop Pic-
togramă

Scop

Salvare Proiect Compozitor Nou

Duplicare Compozitor Managerul Compozit,iilor

Încărcare din s, ablon Salvare ca s, ablon

Imprimă sau exportă ca PostScript Exportare într-un format de imagine

Exportă compozit,ia în format SVG Exportare ca PDF

Revenire la ultima modificare Restaurare conform ultimei modificări

Transfocare pe ansamblu Transfocare la &100%

Mărire Mics, orare

Actualizează Vizualizarea

Deplasare Transfocare la o regiune specifică

Selectează/Mută elementul din
compozit,ie

Mută cont,inutul în interiorul unui element

Adaugă noua hartă din canevasul
hărt,ii QGIS

Adaugă imaginea în compozit,ie

Adaugă eticheta în compozit,ie Adaugă noua legendă în compozit,ie

Adaugă scara grafică în compozit,ie Adaugă formele de bază în compozit,ie

Adaugă săgeata în compozit,ie Adaugă tabela de atribute în compozit,ie

Adaugă un cadru HTML

Grupează elementele în compozit,ie Degrupează elementele din compozit,ie

Blochează Elementele Selectate Deblochează Toate Elementele

Ridică elementele selectate Coboară elementele selectate

Mută în capătul de sus elementele
selectate

Mută în capătul de jos elementele selectate

Aliniere la stânga a elementelor
selectate

Aliniere la dreapta a elementelor selectate

Aliniere în centru a elementelor
selectate

Aliniere în centru, pe verticală, a
elementelor selectate

Aliniere în sus a elementelor
selectate

Aliniere în jos a elementelor selectate

Previzualizare atlas Prima Entitate

Entitatea Anterioară Entitatea Următoare

Ultima entitate Imprimare Atlas

Exportare Atlas sub formă de
Imagine

Setări Atlas

Tabelul Compozit,iilor 1: Instrumentele Compozitorului de Hărt,i
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Meniul Compozitorului

With the Composer → Save Project action, you can save the project file directly from the print composer window.
The Composer menu also provides actions to:

• Create a new and blank print composer with New Composer...

• Duplicate Composer... : Create a new print composer by duplicating the current one

• Deschidet,i Managerul de Compozit,ii...

• Print Composers... : Deschidet,i un compozitor de hărt,i existent

Once the layout is designed, with Save as template and Add items from template icons, you can save the current state
of a Print Composer session as a .qpt template and load its item again in another session.

In the Composer menu, there are also powerful ways to share geographical information produced with QGIS that

can be included in reports or published. These tools are Export as Image..., Export as PDF..., Export as SVG... and
Print....

Meniul Setărilor

Din Setări → Opt,iunile Compozitorului putet,i seta unele opt,iuni care vor fi selectate ca implicite, pe durata
lucrului.

• Compozit,iile implicite vă permit să specificat,i fontul de folosit, implicit.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grila s, i liniile deghidare implicite definesc spat,ierea, decalajul s, i tolerant,a grilei.

Meniul de Editare

Copierea/Decuparea s, i Lipirea elementelor

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position. Using the Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current
page, at the same position they were in their initial page. It ensures to copy/paste items at the same place, from
page to page.

Note: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties tab.

Meniul de Vizualizare

Instrumentele de Navigare

Pentru a naviga în structura canevasului, Compozitorul de Hărt,i oferă o serie de instrumente generale:

• Mărire

• Mics,orare
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• Transfocare la nivelul Hărt,ii

• Transfocare la 100%

• Actualizarea vizualizării (dacă vizualizarea se află într-o stare inconsistentă)

• Afis, area Grilei în spatele elementelor.

• Grila de Acros, are pentru fixarea elementelor pe grilă.

• Show Guides to help user to align items. These are red line that you can click in the rule (above or at the
left side of the layout) and drag and drop to the desired location.

• Snap Guides: allows user to snap items to the guides,

• Smart Guides: uses other composer items as guides to dynamically snap to as user moves or reshapes an
item.

• Clear Guides to remove all current guides.

• Afis, area Casetei de Încadrare în jurul elementelor.

• Afis, area Riglelor în jurul compozit,iei.

• Show Pages or set up pages to transparent. Often composer is used to create non-print layouts, e.g. for
inclusion in presentations or other documents, and it’s desirable to export the composition using a totally
transparent background. It’s sometimes referred to as “infinite canvas” in other editing packages.

• Toggle Full Screen makes the composer window to full screen.

• Hide Panels hides/shows the right panel

• Panels lists all panels available to hide/show them.

• Toolbars same as above for toolbars.

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need
to switch to pan mode while working in the Composer area, you can hold the Spacebar or the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to Zoom In mode, and with Ctrl+Shift+Spacebar, to
Zoom Out mode.

Ascunderea s, i Afis, area Panourilor

Pentru a maximiza spat,iul disponibil la interact,iunea cu o compozit,ie, putet,i folosi View –> Ascunderea
panourilor sau putet,i apăsa F10.

Note: It’s also possible to switch to a full screen mode to have more space to interact by pressing F11 or using
View → Toggle full screen.

Fila Compozit,iei

Dimensiunea paginii s, i alte setări

În fila Compozit,iilor, putet,i defini setările globale ale compozit,iei dvs. curente

Putet,i alege unul dintre formatele de Presetare pentru pagina dvs, sau să introducet,i propriile valori pentru lăt,ime,
înălt,ime s, i unităt,i. Putet,i folosi, de asemenea, pagina Orientare.

Composition can be divided into several pages. For instance, a first page can show a map canvas, and a second
page can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
organization website. Set the Number of pages to the desired value. you can also custom the Page Background
with the color or the symbol you want.
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Figure 19.3: Setările Compozitorului de Hărt,i

The Page size options apply to all the pages in the composition. However, you can modify the values using the
data defined override options (see Butoane de Suprascriere Definită de Date).

A custom page size can also be set, using the Resize page tool. This creates an unique page composition, resizes
the page to fit the current contents of the composition (with optional margins).

Setări de export

You can define a resolution to use for all exported maps in Export resolution. This setting can however be overrid-

den each time you are exporting a map. When checked, print as raster means all elements will be rasterized
before printing or saving as PostScript or PDF.

While exporting to an image file format, you can choose to generate a world file by checking World file on and
select a map item. The world file is created beside the exported map, has same name and contains information to
easily georeference it.

Figure 19.4: Setările de Export din Compozitorul de Hărt,i
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Grilă s, i de ghidaje

Se pot pune unele marcaje de referint,ă pe foaia de hârtie a compozit,iei dvs., care vor ajuta la plasarea unor
elemente. Aceste marcaje pot fi:

• simple lines (called Guides) put at the position you want. To do that, ensure that Show Rulers and Show
Guides in View menu are checked. Then, click and drag from within the ruler to the paper sheet. A vertical
or horizontal line is added to the paper and you can set its position following the coordinates displayed at
the left bottom of the composer dialog.

• sau Grila obis, nuită.

Whether grids or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap composer items. The Grid and guides section lets you customize grid settings like Grid spacing, Grid offset
and Snap tolerance to your need. The tolerance is the maximum distance below which an item is snapped to a
grid or a guide.

Figure 19.5: Setările grilei din Compozitorul de Hărt,i

In the Options → Composer menu in QGIS main canvas, you can also set the spacing, offset and snap tolerance
of the grid as much as its style and color. These options are applied by default to any new print composer.

Fila Istoricului de Comenzi: Act,iuni de Revenire s, i Restaurare

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Anulează ultima modificare

• Restaurează ultima modificare

This can also be done by mouse click within the Command history tab (see figure_composer_1). The History tab
lists the last actions done within the composer. Just select the point you want to revert to and once you do new
action all the actions done after the selected one will be removed.

Figure 19.6: Istoricul Comenzilor din Compozitorul de Hărt,i

Fila Elementelor

The Items tab offers some options to manage selection and visibility of items. All the items added to the print
composer canvas are shown in a list and selecting an item makes the corresponding row selected in the list as well
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as selecting a row does select the corresponding item in the print composer canvas. This is thus a handy way to
select an item placed behind another one. Note that a selected row is shown as bold.

Oricărui element selectat, îi putet,i:

• seta sau nu vizibilitatea,

• bloca sau debloca pozit,ia,

• order its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print composer canvas. By default, a newly created item
is placed in the foreground.

• schimba numele, făcând dublu-clic pe text.

Once you have found the correct position for an item, you can lock it by ticking the box in column. Locked
items are not selectable on the canvas. Locked items can be unlocked by selecting the item in the Items tab and
unchecking the tickbox or you can use the icons on the toolbar.

19.2 Elementele Compozitorului

19.2.1 Opt,iuni Comune ale Elementelor din Compozitor

Elementele compozitorului au un set de proprietăt,i comune, pe care le vet,i găsi în partea de jos a filei cu
Proprietăt,ile Articolului: Pozit,ia s, i dimensiunea, Rotirea, Cadrul, Fundalul, ID-ul elementului s, i Randarea (v.
figure_composer_common_1).

• Dialogul Ppozit,iei s, i dimensiunilor permite definirea dimensiunii s, i a pozit,iei cadrului care cont,ine elemen-
tul. Putet,i alege, de asemenea, care Punct de Referint,ă va fi setat la coordonatele X s, i Y, definite anterior.

• Rotirea stabiles, te rotat,ia elementului (în grade).

• The Frame shows or hides the frame around the item. Click on the [Color] and [Thickness] buttons to
adjust those properties.

• Use the Background color menu for setting a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can be adjusted through
atlering the alpha field settings.

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
other potential web clients. You can set an ID on an item (for example, a map or a label), and then the
web client can send data to set a property (e.g., label text) for that specific item. The GetProjectSettings
command will list the items and IDs which are available in a layout.

• Modul de Randare vă ajută să setat,i vizibilitatea s, i modul de afis, are a elementului.

Note:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map
item or use expressions. These are particularly helpful with atlas generation (See Butoane de Suprascriere
Definită de Date).
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Figure 19.7: Dialogul proprietăt,ilor comune ale elementelor
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Modul de randare

QGIS permite, de acum, randarea avansată pentru elementele de Compozitor, la fel ca s, i pentru straturile vectoriale
s, i raster.

Figure 19.8: Modul de randare

• Blending mode: With this tool you can achieve effects which would otherwise only be achieved using
graphic rendering software. The pixels of your overlaying and underlaying items can be mixed according
to the mode set (see Modurile de Fuziune for description of each effect).

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.

• Exclude item from exports: You can decide to make an item invisible in all exports. After activating this
checkbox, the item will not be included in export to PDF, print etc..

Dimensiunea s, i pozit,ia

Each item inside the Composer can be moved and resized to create a perfect layout. For both operations the

first step is to activate the Select/Move item tool and to click on the item; you can then move it using the mouse
while holding the left button. If you need to constrain the movements to the horizontal or the vertical axis, just
hold the Shift button on the keyboard while moving the mouse. If you need better precision, you can move
a selected item using the Arrow keys on the keyboard; if the movement is too slow, you can speed up it by
holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using the grid snapping or smart guides. Guides are set by clicking
and dragging within the ruler area. To move a guide, click on the ruler, level with the guide and drag it to a new
position. To delete a guide move it off the canvas. If you need to disable the snap on the fly, hold Ctrl while
moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items tab. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items tab and unchecking the tickbox or you can use
the icons on the toolbar.

Pentru a deselecta un element, este suficient să t,inet,i apăsat butonul Shift.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.
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QGIS User Guide, Release 2.14

Alinierea

Raising or lowering the visual hierarchy for elements are inside the Raise selected items pull-down menu. Choose
an element on the Print Composer canvas and select the matching functionality to raise or lower the selected
element compared to the other elements. This order is shown in the Items tab. You can also raise or lower objects
in the Items tab by clicking and dragging an object’s label in this list.

Figure 19.9: Liniile de ghidare din Compozitorul de Hărt,i

There are several alignment options available within the Align selected items pull-down menu (see fig-
ure_composer_common_3). To use an alignment function, you first select the elements then click on the matching
alignment icon. All selected elements will then be aligned to their common bounding box. When moving items
on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

19.2.2 Elementul Hartă

Efectuat,i clic pe butonul de Adăugare a unei noi hărt,i, din bara de instrumente a Compozitorului, pentru a adăuga
canevasul hărt,ii QGIS. Apoi, t,inând apăsat butonul stâng al mouse-ului, trasat,i un dreptunghi pe canevas, pentru a
adăuga harta. Pentru afis, area hărt,ii curente, putet,i alege între trei moduri diferite, în fila Proprietăt,ilor Elementului.

• Rectangle reprezintă setarea implicită. Se afis, ează doar o casetă goală, alături de mesajul ‘Harta va fi
imprimată aici’.

• Cache randează harta la rezolut,ia ecranului curent. Dacă at,i mări sau at,i mics, ora fereastra Compozitorului,
harta nu va mai fi randată, însă imaginea va fi scalată.

19.2. Elementele Compozitorului 317



QGIS User Guide, Release 2.14

• Randarea se referă la faptul că, atunci când transfocat,i fereastra Compozitorului, harta va fi randată din
nou, însă, din motive de spat,iu, numai până la o rezolut,ie maximă.

Cache reprezintă modul de previzualizare implicit pentru hărt,ile nou adăugate în Compozitorul de Hărt,i.

You can resize the map item by clicking on the Select/Move item button, selecting the element, and dragging one
of the blue handles in the corner of the map. This button also helps to move the map to another place. Select the
item and while holding the left mouse button, move to the new place and release the mouse button. After you have
found the right place for an item, you can lock the item position within the Print Composer canvas. Select the map

item and use the toolbar Lock Selected Items or the Items tab to Lock the item. A locked item can only be selected

using the Items tab. Once selected you can use the Items tab to unlock individual items. The Unlock All Items icon
will unlock all locked composer items. With the map selected, you can now adapt more properties in the map Item
Properties tab.

Pentru a deplasa straturile în cadrul elementului hartă, mai întăi selectat,i harta, facet,i clic pe pictograma de
Mutare a cont,inutului elementului, apoi deplasat,i straturile, utilizând butonul din stânga al mouse-ului.

Proprietăt,i principale

Dialogul Proprietăt,ilor principale de pe fila Proprietăt,ilor Elementului hărt,ii, oferă următoarele functionalităt,i (v.
figure_composer_map_1):

Figure 19.10: Fila Proprietăt,ilor Elementului de pe Hartă

• The Preview area allows you to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. If you change the view on the QGIS map canvas by changing vector or raster properties, you can
update the Print Composer view by selecting the map element in the Print Composer and clicking the
[Update preview] button.

• Câmpul Scării setează o scară manuală.

• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map view can be imitated here. Note that a correct coordinate frame can only be added with
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the default value 0 and that once you defined a Map rotation it currently cannot be changed.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this
is checked, any layer that would be displayed or hidden in the main QGIS window will not appear or be
hidden in the map item of the Composer. But style and labels of a locked layer are still refreshed according
to the main QGIS interface. You can prevent this by using Lock layer styles for map item.

• The button allows you to add quickly all the presets views you have prepared in QGIS. Clicking on the
button you will see the list of all the preset views: just select the preset you want to display. The map

canvas will automatically lock the preset layers by enabling the Lock layers for map item: if you want

to unselect the preset, just uncheck the and press the button. See Panoul Straturilor to find out how
to create presets views.

Locked layers in the map can also be data-defined, using the icon beside the option. When used, this
overrides the selection set in the drop-down list. You need to pass a list of layers separated by | character.
The following example locks the map item to use only layers layer 1 and layer 2:

concat (’layer 1’, ’|’, ’layer 2’)

Extinderi

Dialogul Extinderilor de pe fila elementului hărt,ii oferă următoarele functionalităt,i (v. figure_composer_map_2):

Figure 19.11: Dialogul Extinderilor Hărt,ii

• The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking
the [Set to map canvas extent] button. This button sets the map extent of the composer map item to the
extent of the current map view in the main QGIS application. The button [View extent in map canvas]
does exactly the opposite, it updates the extent of the map view in the QGIS application to the extent of the
composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_map_1).

Grile

The Grids dialog of the map Item Properties tab provides the possibility to add several grids to a map item.

• Cu butoanele plus s, i minus putet,i adăuga sau elimina o grilă selectată.

• Cu ajutorul butoanelor în sus s, i în jos putet,i muta o grilă în listă, pentru a seta prioritatea de desenare.
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Dacă facet,i dublu clic pe grila adăugată îi putet,i da un alt nume.

Figure 19.12: Dialogul Grilelor Hărt,ii

After you have added a grid, you can activate the checkbox Draw grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_4.

Figure 19.13: Dialogul de Desenare a Grilei

As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the divisions section
of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid and its
rendering mode can be chosen. See Modul de randare. Furthermore, you can define an interval in the X and Y
directions, an X and Y offset, and the width used for the cross or line grid type.

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• With ‘Latitude/Y only’ and ‘Longitude/X only’ setting in the divisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• De asemenea, modul de randare avansat este disponibil pentru ret,ele.

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose the
annotation numeric format, the options range from decimal to degrees, minute and seconds, with or without
suffix, aligned or not and a custom format using the expression dialog. You can choose which annotation
to show. The options are: show all, latitude only, longitude only, or disable(none). This is useful when the
map is rotated. The annotation can be drawn inside or outside the map frame. The annotation direction can
be defined as horizontal, vertical ascending or vertical descending. Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.
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Figure 19.14: Dialogul Cadrului Grilei

Figure 19.15: Dialogul de Desenare a Coordonatelor Grilei
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Prezentare generală

Dialogul Vizualizărilor de pe fila hărt,ii cu Proprietăt,ile Elementului oferă următoarele functionalităt,i:

Figure 19.16: Dialogul Vederilor Hărt,ii

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map and the map you want to
use as the overview map, just like a normal map.

Then expand Overviews option and press the green plus icon-button to add an overview. Initially this overview
is named ‘Overview 1’ (see Figure_composer_map_7). You can change the name when you double-click on the
overview item in the list named ‘Overview 1’ and change it to another name.

• Cu butoanele plus s, i minus putet,i adăuga sau elimina o vizualizare.

• Cu ajutorul butoanelor în sus s, i în jos putet,i muta o vizualizare în listă, pentru a seta prioritatea de desenare.

Când selectat,i elementul imaginii de ansamblu în lista, îl putet,i personaliza.

• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• Stilul Cadrului vă permite să schimbat,i stilul cadrului pentru imaginea de ansamblu.

• The Blending mode allows you to set different transparency blend modes.

• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.

19.2.3 Elementul Etichetă

Pentru a adăuga o etichetă, facet,i clic-stânga pe pictograma de Adăugare etichetă, plasat,i elementul pe canevasul
Compozitorului de Hărt,i, apoi personalizat,i-i pozit,ia s, i aspectul în fila Proprietăt,ilor Elementului.

Fila Proprietăt,ilor elementului pentru un element de tip etichetă oferă următoarele funct,ionalităt,i (v. Fig-
ure_composer_label):
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Figure 19.17: Fila Proprietăt,ilor Elementului Etichetă

Proprietăt,i principale

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
useful, particularly associated with the atlas functionality: geometry functions and records functions. At the
bottom, a preview of the expression is shown.

Aspectul

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

• Se pot specifica diferite margini orizontale s, i verticale în mm. Aceasta este distant,a fat,ă de marginea el-
ementului din compozitor. Eticheta poate fi pozit,ionată în afara limitelor etichetei, de exemplu, pentru a
alinia etichetele fat,ă de alte elemente. În acest caz, trebuie să utilizat,i valori negative pentru margine.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.

19.2.4 Elementul Legendă

Pentru a adăuga o legendă, facet,i clic-stânga pe pictograma de Adăugare legendă nouă, plasat,i elementul pe caneva-
sul Compozitorului de Hărt,i, apoi personalizat,i-i pozit,ia s, i aspectul în fila Proprietăt,ilor Elementului.

Proprietăt,ile elementului de pe fila elementului de tip legendă oferă următoarele funct,ionalităt,i (v. fig-
ure_composer_legend_1):
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Figure 19.18: Fila Proprietăt,ilor Elementului Legendă

Proprietăt,i principale

Dialogul Proprietăt,ilor principale de pe fila Proprietăt,ilor Elementului hărt,ii oferă următoarele functionalităt,i (v.
figure_composer_legend_2):

Figure 19.19: Dialogul Proprietăt,ilor Principale ale Legendei

În proprietăt,ile principale putet,i:

• Modifica titlul legendei.

• Seta alinierea titlului la Stânga, Centru sau Dreapta.

• Putet,i alege la care dintre elementele Hărt,ii se va referi legenda curentă din lista de selectare.

• Putet,i încadra titlului legendei pentru un anumit caracter.

Elementele legendei

Dialogul Elementelor Legendei de pe fila Proprietăt,ilor Elementului hărt,ii oferă următoarele functionalităt,i (v.
figure_composer_legend_3):

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.
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Figure 19.20: Dialogul Elementelor Legendei

– The item order can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ function-
ality. The order can not be changed for WMS legend graphics.

– Folosit,i butonul [Adăugare grup] pentru a adăuga un grup de legendă.

– Folosit,i butoanele [plus] s, i [minus] pentru a adăuga sau a elimina straturi.

– Butonul [Editare] este folosit pentru a modifica stratul, numele grupului sau titlul. Mai întâi trebuie
să selectat,i elementul legendă.

– Butonul [Sigma] adaugă numărul de entităt,i pentru fiecare strat vectorial.

– Use the [filter] button to filter the legend by map content, only the legend items visible in the map will
be listed in the legend.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.

Fonturi, Coloane, Simboluri

The Fonts, Columns and Symbol dialogs of the legend Item Properties tab provide the following functionalities
(see figure_composer_legend_4):

• Putet,i schimba fontul pentru titlul legendei, pentru grup, subgrup s, i element (stratul) din elementul legendă.
Facet,i clic pe un buton de categorie pentru a deschide dialogul Select font.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths stabiles, te modul în care ar trebui să fie ajustate coloanele legendei.

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.

• You can also change the width and height of the legend symbol,set a color and a thickness in case of raster
layer symbol.

WMS LegendGraphic s, i Spat,ierea

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties tab provide the following function-
alities (see figure_composer_legend_5):

When you have added a WMS layer and you insert a legend composer item, a request will be sent to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.

WMS LegendGraphic is used to be able to adjust the Legend width and the Legend height of the WMS legend
raster image.
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Figure 19.21: Dialogul Fonturilor, Coloanelor s, i Simbolurilor Legendei

Figure 19.22: Dialogurile pentru WMS LegendGraphic s, i Spat,iere
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Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.

19.2.5 Elementul Scării Grafice

Pentru a adăuga o scară grafică, facet,i clic-stânga pe pictograma de Adăugare scară nouă, plasat,i elementul pe
canevasul Compozitorului de Hărt,i, apoi personalizat,i-i pozit,ia s, i aspectul în fila Proprietăt,ilor Elementului.

Proprietăt,ile elementului de pe fila elementului de tip scală oferă următoarele funct,ionalităt,i (v. fig-
ure_composer_scalebar_1):

Figure 19.23: Fila de proprietăt,i a Elementului Scării Grafice

Proprietăt,i principale

Dialogul Proprietăt,ilor principale de pe fila Proprietăt,ilor Elementului de tip scară grafică, oferă următoarele
functionalităt,i (v. figure_composer_scalebar_2):

Figure 19.24: Dialogul Proprietăt,ilor Principale ale Scării Grafice

• În primul rând, aleget,i scara grafică, pentru a o atas, a hărt,ii.

• Apoi, aleget,i stilul scării grafice. Sunt disponibile s, ase stiluri :

– Stilurile O singură casetă s, i Casetă dublă, care cont,in una sau două linii de casete cu culori con-
trastante.

– Opt,iunile Mijloc, Sus sau Jos pentru linie.

– Numeric, în care este imprimat raportul scării (ex.: 1:50000).
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Unităt,i s, i Segmente

Dialogul Unităt,ilor s, i Segmentelor scării grafice de pe fila Proprietăt,ilor Elementului, oferă următoarele
funct,ionalităt,i (v. figure_composer_scalebar_3):

Figure 19.25: Dialogurile Unităt,ilor s, i Segmentelor Scării Grafice

În aceste două dialoguri, putet,i seta modul în care va fi reprezentată scara grafică.

• Select the units you want to use with Scalebar units. There are four possible choices: Map Units, the
default one and Meters, Feet or Nautical Miles which may force unit conversions.

• The Label unit multiplier specifies how many scalebar units per labeled unit. Eg, if your scalebar units are
set to “meters”, a multiplier of 1000 will result in the scale bar labels in “kilometers”.

• The Label for units field defines the text used to describe the units of the scale bar, eg “m” or “km”. This
should be matched to reflect the multiplier above.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar.

• You can set how long each segment will be (fixed width), or limit the scale bar size in mm with Fit segment
width option. In the latter case, each time the map scale changes, the scale bar is resized (and its label
updated) to fit the range set.

• Height is used to define the height of the bar.

Afis, area

The Display dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_4):

Putet,i defini modul în care va fi afis, ată scara grafică în cadrul său.

• Box margin : spat,iul dintre bordurile textului s, i ale cadrului

• Labels margin : spat,iul dintre textului s, i desenul scării grafice

• Lăt,imea Liniei : lăt,imea liniei de desenare a scării grafice

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)
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Figure 19.26: Afis, area Scării Grafice

Fonturi s, i culori

The Fonts and colors dialog of the scale bar Item Properties tab provide the following functionalities (see fig-
ure_composer_scalebar_5):

Figure 19.27: Dialogurile Fonturilor s, i Culorilor Scării Grafice

Putet,i defini fonturile s, i culorile folosite pentru scara grafică.

• Use the [Font] button to set the font of scale bar label

• Font color: setează culoarea fontului

• Fill color: setează prima culoare de umplere

• Secondary fill color: setează a doua culoare de umplere

• Stroke color: setează culoarea liniilor Scării grafice

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

19.2.6 Elementul de tip Tabelă de Atribute

Este posibilă adăugarea părt,ilor unui tabel cu atribute vectoriale în canevasul Compozitorului de Hărt,i: Facet,i clic

pe pictograma de Adăugare tabelă de atribute, iar apoi, t,inând apăsat butonul stâng al mouse-ului, glisat,i pe canevas,
pentru a plasa s, i dimensiona elementul. Putet,i să-i pozit,ionat,i s, i să-i personalizat,i mai bine aspectul, în fila cu
Proprietăt,ile Articolului.

Fila Proprietăt,ilor elementului pentru o tabelă de atribute oferă următoarele funct,ionalităt,i (v. fig-
ure_composer_legend_1):
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Figure 19.28: Fila Proprietăt,ilor pentru Elementul de tip Tabelă de Atribute

Proprietăt,i principale

Fila Proprietăt,ilor elementului pentru o tabelă de atribute oferă următoarele funct,ionalităt,i (v. fig-
ure_composer_table_2):

Figure 19.29: Fila Proprietăt,ilor Principale ale Tabelei de Atribute

• Ca Sursă putet,i selecta, în mod normal, doar ‘Entităt,ile stratului’.

• Cu Layer putet,i alege dintre straturile ectoriale încărcate în proiect.

• In case you activated the Generate an atlas option in the Atlas generation tab, there are two additional
Source possible: ‘Current atlas feature’ (see figure_composer_table_2b) and ‘Relation children’ (see fig-
ure_composer_table_2c). Choosing the ‘Current atlas feature’ you won’t see any option to choose the layer,
and the table item will only show a row with the attributes from the current feature of the atlas coverage
layer. Choosing ‘Relation children’, an option with the relation names will show up. The ‘Relation children’
option can only be used if you have defined a relation using your atlas coverage layer as parent, and the table
will show the children rows of the atlas coverage layer’s current feature (for further information about the
atlas generation, see Generarea unui Atlas).

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_3, that can be used
to change the visible contents of the table. After making changes use the [OK] button to apply changes to
the table. The upper part of the window shows the list of the attributes to display and the lower part helps to
set the way the data is sorted.

În sect,iunea Coloanelor putet,i:
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Figure 19.30: Proprietăt,ile Principale ale Tabelei de Atribute pentru ‘Entitatea atlas curentă’

Figure 19.31: Proprietăt,ile Principale ale Tabelei de Atribute pentru ‘Relat,ia copil’

Figure 19.32: Dialogul de Selectare a atributelor din Tabela de atribute
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– Remove an attribute, just select an attribute row by clicking anywhere in the row and press the minus
button to remove the selected attribute.

– Adăugat,i un nou atribut folosind butonul plus. La final, va apărea un nou rând gol, apoi vet,i putea
selecta celula goală a coloanei Atribut. Putet,i selecta câmpul unui atribut din listă sau putet,i alege con-
struirea unui nou atribut, folosind o expresie regulată (butonul |expresie|). Desigur, avet,i posibilitatea
de a modifica fiecare atribut existent deja prin intermediul unei expresii regulate.

– Utiliza săget,ile îndreptate în sus s, i în jos, pentru a schimba ordinea atributelor din tabelă.

– Selecta o celulă în coloana Anteturilor pentru a-i schimba pozit,ia, doar tastând un nume nou.

– set a precise Alignment (mixing vertical and horizontal alignment options) for each column.

– Select a cell in the Width column and change it from Automatic to a width in mm, just type a number.
When you want to change it back to Automatic, use the cross.

– The [Reset] button can always be used to restore it to the original attribute settings.

În sect,iunea de Sortare putet,i:

– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– utiliza butonul minus pentru a elimina un atribut din lista ordinii de sortare.

Filtrarea entităt,ilor

The Feature filtering dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_4):

Figure 19.33: Dialogul de Filtrare a Entităt,ii din Tabela de Atribute

Putet,i:

• Defini Numărul maxim de rânduri care vor fi afis, ate.

• Activate Remove duplicate rows from table to show unique records only.

• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features shown on the map of that particular
page of the atlas.

• Activate Filter with and provide a filter by typing in the input line or insert a regular expression using

the given expression button. A few examples of filtering statements you can use when you have loaded
the airports layer from the Sample dataset:
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– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%’

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the airports that have a letter ‘i’ in the attribute field ‘USE’.

Aspectul

The Appearance dialog of the attribute table provides the following functionalities (see figure_composer_table_5):

Figure 19.34: Fereastra de Dialog a Aspectului Tabelei de Atribute

• Click Show empty rows to fill the attribute table with empty cells. This option can also be used to provide
additional empty cells when you have a result to show!

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have chosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display

• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table. The Advanced customization option
helps you define different background colors for each cell (see figure_composer_table_6)

• With the Wrap text on option, you can define a character on which the cell content will be wraped each time
it is met

• With Oversized text you define the behaviour when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.

19.2. Elementele Compozitorului 333



QGIS User Guide, Release 2.14

Figure 19.35: Fereastra de Dialog Avansată a Fundalului Tabelei de Atribute

Afis, area grilei

The Show grid dialog of the attribute table provides the following functionalities (see figure_composer_table_7):

Figure 19.36: Dialogul de Afis, are a Grilei din Tabela de Atribute

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• With Line width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.

Stilizarea fonturilor s, i a textelor

Dialogul de Stilizare a fonturilor s, i textelor din tabela de atribute oferă următoarele funct,ionalităt,i (v. fig-
ure_composer_table_8):

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment to Follow column alignment or override this
setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes dialog
(see Figure_composer_table_3 ).

334 Chapter 19. Compozitorul de Hărt,i
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Figure 19.37: Dialogul de Stilizare a Fontului s, i a Textului din Tabela de Atribute

Cadrele

The Frames dialog of the attribute table provides the following functionalities (see figure_composer_table_9):

Figure 19.38: Fereastra de Dialog a Cadrului Tabelei de Atribute

• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.

• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

19.2.7 Elementul Imagine

Pentru a adăuga o imagine, facet,i clic pe pictograma de Adăugare Imagine, apoi trasat,i un dreptunghi pe canevasul
hărt,ii, t,inând apăsat butonul stâng al mouse-ului. Îi putet,i configura ulterior pozit,ia s, i aspectul, în fila Proprietăt,ilor
Elementului.
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Fila Proprietăt,ilor elementului pentru o imagine oferă următoarele funct,ionalităt,i (v. figure_composer_image_1):

Figure 19.39: Fila Proprietăt,ilor pentru Elementul Imagine

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

Putet,i selecta unul din următoarele moduri:

• Zoom: Măres, te imaginea la dimensiunea cadrului, ment,inând în acelas, i timp raportul aspectului imaginii.

• Stretch: Întinde imaginea pentru a se potrivi în interiorul cadrului, ignorând raportul aspectului.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.

• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Redimensionează cadrul la dimensiunea imaginii: Setează dimensiunea cadrului pentru a se potrivi dimen-
siunii originale a imaginii, fără scalare.
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Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside it’s frame. The Search directories area allows
you to add and remove directories with images in SVG format to the picture database. A preview of the pictures
found in the selected directories is shown in a pane and can be used to select and set the image source.

It is possible to change SVG fill/outline color and outline width when using parameterized SVG files such as
those included with QGIS. If you add a SVG file you should add the following tags in order to add support for
transparency:

• fill-opacity=”param(fill-opacity)”

• stroke-opacity=”param(outline-opacity)”

Putet,i citi această postare de blog pentru a vedea un exemplu.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image (i.e., a rotated north arrow) with the rotation applied to the selected map item.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_2.

Note: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for languages
that do not use an ‘N’ for North, so they can use another letter.

Figure 19.40: Săget,ile Nordului disponibile pentru select,ie în Biblioteca SVG

19.2.8 Elementul HTML de tip cadru

Este posibilă adăugarea unui cadru care afis, ează cont,inutul unui site web, sau chiar crearea, stilizarea s, i afis, area
propriei pagini HTML!
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Facet,i clic pe pictograma de Adăugare cadru HTML, plasat,i elementul prin trasarea unui dreptunghi pe canevasul
Compozitorului de Hărt,i, t,inând apăsat butonul stâng al mouse-ului, apoi personalizat,i-i pozit,ia s, i aspectul în fila
Proprietăt,ilor Elementului (v. figure_composer_html_1).

Figure 19.41: Cadrul HTML, fila proprietăt,ilor

Sursa HTML

Ca sursă HTML, putet,i seta fie o adresă URL, căreia să-i activat,i butonul radio URL, fie să introducet,i sursa
HTML direct în caseta de text furnizată, urmată de activarea butonului radio Sursă.

Dialogul Sursei HTML de pe fila Proprietăt,ilor Elementului oferă următoarele functionalităt,i (v. fig-
ure_composer_html_2):

Figure 19.42: Cadrul HTML, Proprietăt,ile Sursei HTML

• In URL you can enter the URL of a webpage you copied from your internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• În cadrul casetei de text Sursă se poate introduce un text , însot,it de etichete HTML, sau să furnizat,i o pagină
HTML completă.

• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.
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• Activat,i Evaluarea expresiilor QGIS din codul HTML pentru a vedea rezultatul expresiei pe care at,i
inclus-o, în caz contrar, vet,i vedea expresia originală.

• Folosit,i butonul [Actualizare HTML] pentru a reactualiza cadr(ele) HTML s, i pentru a vedea rezultatul
schimbărilor.

Cadrele

Dialogul Cadrelor de pe fila cu Propert,ile elementului de tip cadru oferă următoarele functionalităt,i (v. fig-
ure_composer_html_3):

Figure 19.43: Cadrul HTML, Proprietăt,ile cadrelor

• Cu ajutorul Modului de redimensionare putet,i selecta randarea cont,inutului HTML:

– Utilizează cadrele existente afis, ează rezultatul doar în primul cadru s, i în cele adit,ionale.

– Extend to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repetare pe fiecare pagină va repeta partea din stânga-sus a paginii web, folosind cadre de aceeas, i
dimensiune.

– Se repetă până la definitivare va crea, de asemenea, numărul de cadre corespunzător opt,iunii de Ex-
tindere la următoarea pagină, toate cadrele având aceeas, i dimensiune.

• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activarea opt,iunii de Nedesenare a fundalului în cazul unui cadru vid previne desenarea cadrului HTML
atunci când cadrul nu cont,ine nimic.

Folosirea salturilor de pagină inteligente s, i a paginii de stil a Utilizatorului

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties tab provides the
following functionalities (see figure_composer_html_4):

• Activat,i Folosirea întreruperilor de pagină inteligente pentru a preveni ruperea liniilor de text la jumătate
din cadrele cu cont,inut html, astfel încât ele să continue frumos s, i neted în cadrul următor.

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.
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Figure 19.44: Cadrul HTML, Folosirea salturilor de pagină inteligente s, i a paginii de stil a Utilizatorului

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Folosit,i butonul de [Actualizare HTML] pentru a vedea rezultatul setărilor de stil.

19.2.9 Elementele Formelor de Bază

Pentru a adăuga o formă de bază (elipsă, dreptunghi, triunghi), facet,i clic-stânga pe pictograma de
Adăugare formă de bază, plasat,i elementul pe canevasul Compozitorului de Hărt,i, apoi personalizat,i-i pozit,ia s, i aspectul
în fila Proprietăt,ilor Elementului.

De asemenea, atunci când t,inet,i apăsată tasta Shift pe durata pozit,ionării formei, putet,i crea un pătrat perfect,
un cerc sau un triunghi.

Figure 19.45: Fila Proprietăt,ilor Elementului Shape

The Shape item properties tab allows you to select if you want to draw an ellipse, rectangle or triangle inside the
given frame.

Putet,i seta stilul formei folosind dialogul avansat de stilizare a simbolului, cu ajutorul căruia putet,i defini conturul
s, i culoarea de umplere, modelul de umplere, utilizarea figurilor etcetera.

Pentru forma dreptunghiulară, putet,i seta valoarea razei de rotunjire a colt,urilor.
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Note: Spre deosebire de alte elemente, nu putet,i stiliza cadrul sau culoarea de fundal a acestuia.

19.2.10 Elementul Săgeată

Pentru a adăuga o săgeată, facet,i clic pe pictograma Adăugare Săgeată, plasat,i elementul t,inând apăsat bu-
tonul stâng al mouse-ului s, i traget,i o linie pentru a desena săgeata pe canevasului Compozitorului de Hărt,i,
personalizându-i apoi pozit,ia s, i aspectul în fila Proprietăt,ilor Articolului.

De asemenea, atunci când t,inet,i apăsată tasta Shift pe durata pozit,ionării săget,ii, acesta este plasată într-un
unghi de exact 45° .

Elementul săget,ii poate fi folosit pentru a adăuga o linie sau o săgeată simplă, care pot fi folosite, de exemplu,
pentru a arăta relat,ia dintre celelalte elemente ale compozitorului de hărt,i. Pentru a crea o săgeată a nordului,
ar trebui să fie luat în considerare, în primul rând, elementul de imagine. QGIS dispune de un set de săget,i ale
nordului, în format SVG. Mai mult, putet,i conecta un element de imagine cu o hartă astfel încât să se poată roti,
în mod automat, o dată cu harta (v. Elementul Imagine).

Figure 19.46: Fila Proprietăt,ilor Elementului Săgeată

Proprietăţile elementului

Fila proprietăt,ilor elementului Arrow vă permite să configurat,i un element săgeată.

Butonul corespunzător [Stilului liniei ...] poate fi folosit pentru a seta stilul liniei, cu ajutorul simbolului editorului
de stil.

În Simbolurile Săget,ii putet,i selecta unul dintre cele trei butoane radio.

• Implicit: Pentru a desena o săgeată normală, vă oferă opt,iuni de stilizare a vârfului săget,ii
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• Nici unul: Pentru a desena o linie fără săgeată în vârf

• Marcaj SVG: Pentru a desena o linie cu un Simbol de start s, i/sau un Simbol de final în format SVG

Pentru simbolul de săgeată Implicit putet,i utiliza următoarele opt,iuni de stilizare a vârfului săget,ii.

• Culoarea de contur a săget,ii: Setează culoarea de contur a vârfului săget,ii

• Culoarea de umplere a săget,ii: Stabiles, te culoarea de umplere a vârfului săget,ii

• Lăt,imea conturului săget,ii: Stabiles, te lăt,imea conturului pentru vârful săget,ii

• Lăt,imea vârfului săget,ii: Stabiles, te lăt,imea vârfului săget,ii

Pentru Simbolul SVG putet,i utiliza următoarele opt,iuni.

• Simbolul de start: Aleget,i o imagine SVG pentru a o desena la începutul liniei

• Simbolul de final: Aleget,i o imagine SVG pentru a o desena la sfârs, itul liniei

• Lăt,imea vârfului săget,ii: Setează lăt,imea simbolurilor de Start s, i/sau de Final

Imaginile SVG sunt rotite automat, simultan cu linia. Culoarea imaginii SVG nu poate fi schimbată.

19.3 Generarea unui Rezultat

Figure_composer_output_1 prezintă un exemplu de as, ezare în pagină în Compozitorul de Hărt,i, inclusiv fiecare
tip de element de hartă descris în sect,iunea anterioară.

Figure 19.47: Compozitorul de Hărt,i, căruia i s-au adăugat vizualizarea hărt,ii, legenda, o imagine, o scară, coor-
donate, un text s, i un cadru HTML

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View –> Show bounding boxes or pressing the shortcut Ctrl+Shift+B.
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Compozitorul de Hărt,i vă permite să creat,i mai multe formate de ies, ire, fiind posibilă definirea rezolut,iei (calitatea
imprimării) s, i a dimensiunilor hârtiei:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

• The Export as PDF icon saves the defined Print Composer canvas directly as a PDF.

19.3.1 Exportare ca imagine

Clicking the Export as image icon will ask you to enter the filename to use to export composition: in case of
multi-page composition, each page will be exported to a file with the given name appended with the page number.

You can then override the print resolution (set in Composition tab) and resize exported image dimensions. Prin

bifarea opt,iunii Decupare în funct,ie de cont,inut, imaginea generată de compozitor va include doar suprafat,a
compozit,iei care are un cont,inut. Există, de asemenea, o opt,iune de adăugare a unor margini în jurul limitelor
elementelor, dacă este necesar.

În cazul în care compozit,ia include o singură pagină, atunci ies, irea va fi dimensionată pentru a include TOTUL în
compozit,ie. Dacă este o compozit,ie pe mai multe pagini, atunci fiecare pagină va fi decupată pentru a include din
acea pagină numai zona cu elemente.

Figure 19.48: Opt,iuni de Export ale Imaginii

If you need to export your layout as a georeferenced image (e.g., to share with other projects), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will create a world file along the exported image.

Note: Exportul rasterelor mari poate es, ua uneori, chiar dacă pare a exista suficientă memorie. Aceasta este, de
asemenea, o problemă de management a rasterelor, care t,ine de Qt.
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19.3.2 Exportare ca SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi_page

composition) and then can apply Crop to content option.

În plus, dialogul opt,iunilor de export vă permit :

• exportarea straturilor hărt,ii ca grupuri svg:

• randarea etichetelor hărt,ii ca s, i contururi

Figure 19.49: Opt,iuni de Export SVG

Note: În prezent, producerea SVG-ului este foarte simplă. Aceasta nu t,ine de QGIS, ci de biblioteca Qt de la
bază. Acest lucru se va schimba, sperăm, în versiunile viitoare.

19.3.3 Exportare ca PDF

Exportare ca PDF exportă toată compozit,ia într-un singur fis, ier PDF.

If you applied to your composition or any shown layer an advanced effect such as blend modes, transparency
or symbol effects, these cannot be printed as vectors and your effects may be lost. Checking Print as a raster
in Composition tab helps to keep the effects but rasterize the composition. Note that the Force layer to render
as raster in the Rendering tab of Layer Properties is a layer-level alternative that avoids global composition
rasterization.

19.3.4 Generarea unui Atlas

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation param-
eters, refer to the Atlas generation tab. This tab contains the following widgets (see figure_composer_atlas_1):

• Generare atlas, care activează sau dezactivează generarea atlasului.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the features on
which to iterate over.
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Figure 19.50: Fila de generare a atlasului

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select an attribute of the coverage layer or set an expression. If this option is empty, QGIS
will use an internal ID, according to the filter and/or the sort order applied to the layer.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

De asemenea, avet,i opt,iuni de setare a ies, irii atlasului:

• An Output filename expression textbox that is used to generate a filename for each geometry if needed. It is
based on expressions. This field is meaningful only for rendering to multiple files.

• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A Margin around feature that allows you to select the amount of space added around each geometry
within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• O Scară predefinită (cea mai bună încadrare). Aceasta va utiliza cea mai bună opt,iune de încadrare, din
lista de scări predefinite în proprietăt,ile proiectului dvs. (a se vedea Proiect –> Proprietăt,ile Proiectului –>
General –> Scările Proiectului pentru a configura aceste scări predefinite).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.
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Etichete

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. What you should
take care of is to place expression part (including functions, fields or variables) between [% and %]. For example,
for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] km2

sau, o altă combinat,ie:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] is an expression used inside the label. both expressions
would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2

Butoane de Suprascriere Definită de Date

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly useful with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition tab for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than its width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. Press the button of field Orientation,
select Edit... so the Expression string builder dialog opens. Enter the following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically. For each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) - 20

Folosit,i butonul al câmpului Înălt,ime pentru a obt,ine următoarea expresie:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 210 ELSE 297 END) - 20

When you want to give a title above the map in the center of the page, insert a label item above the map. First use
the item properties of the label item to set the horizontal alignment to Center. Next activate from Reference
point the upper middle checkbox. You can provide the following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when the
page is automatically rotated in portrait or landscape.
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Information provided is derived from the excellent blog (in English and Portuguese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

Acesta este doar un exemplu despre cum se pot utiliza opt,iunile de Înlocuire Definită de Date.

Previzualizare s, i generare

Figure 19.51: Bara instrumentelor de previzualizare a atlasului

Once the atlas settings have been configured and composer items (map, table, image...) linked to it, you can create

a preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows
in the same toolbar to navigate through all the features:

• Prima entitate

• Entitatea anterioară

• Următoarea entitate

• Ultima entitate

You can also use the combo box to directly select and preview a specific feature. The combo box shows atlas
features name according to the expression set in the atlas Page name option.

As for simple compositions, an atlas can be generated in different ways (see Generarea unui Rezultat for more
information). Instead of Composer menu, rather use tools from Atlas menu or Atlas toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF...: The user will be asked for a directory to save all the generated PDF files,

except if the Single file export when possible has been selected. In that case, you’ll be prompted to give a
filename.

With Atlas → Export Atlas as Images... or Atlas → Export Atlas as SVG... tool, you’re also prompted to select a
folder. Each page of each atlas feature composition is exported to an image or SVG file.

Tip: Imprimă o entitate specifică a atlasului
If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Composer → Print (or export... to any supported file format).
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CHAPTER 20

Plugin-uri

20.1 Plugin-uri QGIS

QGIS a fost conceput cu o arhitectură de plugin. Acest lucru permite adăugarea us, oară a multor caracteristici s, i
funct,ii noi. Multe dintre caracteristicile din QGIS sunt de fapt implementate ca plugin-uri.

20.1.1 Plugin-uri de bază s, i externe

Plugin-urile QGIS sunt implementate fie ca Plugin-uri de Bază, fie ca Plugin-uri Externe.

Core Plugins are maintained by the QGIS Development Team and are automatically part of every QGIS distribu-
tion. They are written in one of two languages: C++ or Python.

Cele mai multe dintre Plugin-urile Externe sunt în prezent scrise în Python. Acestea sunt stocate fie în Depozit
QGIS ‘Oficial’ de la adresa http://plugins.qgis.org/plugins/ fie în arhive externe care sunt întret,inute de către autorii
individuali. Documentat,ia detaliată despre utilizare, versiunea minimă de QGIS, pagina de start, autorii, precum s, i
alte informat,ii importante sunt disponibile pentru plugin-urile din Depozitul Oficial. Pentru alte depozite externe,
documentat,ia este încorporată chiar în plugin-urile externe. În general, ea nu este inclusă în acest manual.

Installed external python plugins are placed under ~/.qgis2/python/plugins folder. Home directory (de-
noted by above ~) on Windows is usually something like C:\Documents and Settings\(user) (on
Windows XP or earlier) or C:\Users\(user).

Paths to Custom C++ plugins libraries can also be added under Settings → Options → System.

Putet,i gestiona plugin-urile dumneavoastră în fereastra de dialog, care poate fi deschisă cu Plugins > Manage and
install plugins ....

Când un plugin trebuie să fie actualizat, în cazul în care setările plugin-urilor au fost setate în consecint,ă, interfat,a
QGIS principală ar putea afis, a un link albastru în bara de stare, pentru a vă sugera că există câteva actualizări care
as, teaptă să fie aplicate.

20.1.2 Dialogul Plugin-urilor

Meniurile din dialogul Plugin-urilor permit utilizatorului să instaleze, să dezinstaleze s, i să actualizeze plugin-urile
în diverse moduri. Fiecare plugin are unele metadate afis, ate în panoul din dreapta:

• informat,ii despre caracterul experimental al plugin-ului

• descriere

• vot(urile) de evaluare (se poate vota pentru plugin-ul preferat!)

• etichete

• unele link-uri utile, ca pagina de start, cea a actualizărilor s, i a depozitului de cod

• autor(i)
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• versiunea disponibilă

Se poate utiliza filtrul pentru a găsi un anumit plugin.

Toate

Aici sunt listate toate plugin-urile disponibile, incluzând atât plugin-urile de bază cât s, i pe cele externe. Utilizat,i
[Actualizează tot] pentru a căuta noi versiuni ale plugin-urilor. În plus, putet,i utiliza [Instalare plugin], dacă un
plugin este listat dar nu este instalat, s, i [Dezinstalare plugin], precum s, i [Reinstalare plugin], în cazul în care
este instalat un plugin. Dacă este instalat un plugin, acesta poate fi dez/activat folosind caseta de bifare.

Figure 20.1: Meniul Toate

Instalat

În acest meniu, putet,i găsi doar plugin-urile instalate. Plugin-urile externe pot fi dezinstalate s, i reinstalate folosind
butoanele [Dezinstalare plugin] s, i [Reinstalare plugin]. Putet,i [Actualiza tot], la fel de bine.

Neinstalat

Acest meniu listează toate plugin-uri disponibile care nu sunt instalate. Avet,i posibilitatea să utilizat,i butonul de
[Instalare plugin] pentru a implementa un plugin în QGIS.

Actualizabile

Dacă activat,i Afis, area plugin-urilor experimentale din meniul Setărilor, putet,i utiliza acest meniu pen-
tru a căuta versiuni recente ale plugin-urilor. Acest lucru se poate face cu butoanele [Actualizare plugin] sau

[Actualizează tot]. Setări

În acest meniu, vet,i vedea următoarele opt,iuni:

• Verificare actualizare la start. Ori de câte ori un nou plugin sau o actualizare de plugin este disponibilă,
QGIS vă va informa ‘de fiecare dată când se lansează QGIS’, ‘o dată pe zi’, ‘o dată la 3 zile’, ‘în fiecare
săptămână’, ‘la fiecare 2 săptămâni’ sau ‘în fiecare lună’.

• Arată, de asemenea, plugin-urile experimentale. QGIS vă va arăta plugin-urile aflate în stadii incipiente
de dezvoltare, care sunt, în general, improprii pentru utilizarea în product,ie.
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Figure 20.2: Meniul Instalate

Figure 20.3: Meniul Neinstalate
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Figure 20.4: Meniul Actualizabile

• Arată, de asemenea, plugin-uri depreciate. Aceste plugin-uri sunt depreciate s, i, în general, sunt impro-
prii pentru utilizarea în product,ie.

Pentru a adăuga depozitele autorilor externi, facet,i clic pe [Add...] din sect,iunea Plugin repositories. Dacă nu
dorit,i adăugarea unia sau a mai multora dinte depozitele adăugate, le putet,i dezactiva prin intermediul butonului
[Edit...], sau eliminat,i-le complet cu butonul [Delete].

Note that you can use an authentication (basic authentication, PKI) to access to a plugin repository. The default
QGIS repository is an open repository and you don’t need any authentication. You should deploy your own plugin
repository. You can get more information on QGIS authentication support in Autentificarea chapter.

Funct,ia de Căutare este disponibilă în aproape fiecare meniu (cu except,ia Setărilor). Aici, putet,i căuta plugin-
uri specifice.
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Figure 20.5: Meniul Setărilor
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20.2 Folosirea Plugin-urilor de Bază QGIS

Pic-
togramă

Plugin Descriere Manual de Referint,ă

Captură coordonate Capturează coordonatele mouse-ului
într-un CRS diferit

Plugin-ul de Captură a
Coordonatelor

DB Manager Gestionarea bazelor de date din QGIS Plugin-ul DB Manager

Convertor
DXF2Shape

Converteşte fişierul din format DXF în
format SHP

Plugin-ul Convertor
Dxf2Shp

eVis Instrumentul de Vizualizare a
Evenimentelor

Plugin-ul eVis

fTools O suită de instrumente vectoriale Plugin-ul fTools

Instrumente GDAL Funct,ionalitatea rasterelor GDAL Plugin-ul Instrumentelor
GDAL

Geometry Checker Verificarea s, i repararea erorilor din
geometriile vectoriale

Plugin-ul Verificator de
Geometrie

Acros, area
Geometriei

Acros, area geometriilor la un strat de
referint,ă

Plugin-ul de Acros, are a
Geometriei

Georeferenţiator
GDAL

Georeferenţiere rastere folosind GDAL Plugin-ul de georeferent,iere

Instrumente GPS Instrumente pentru încărcarea s, i importul
datelor GPS

Plugin-ul GPS

GRASS Funct,ionalitatea GRASS Integrarea GRASS GIS

Hartă calorică Creează hărt,i calorice raster din vectorii de
intrare de tip punct.

Plugin-ul Heatmap

Plugin-ul de
interpolare

Interpolarea bazată pe vertecs, ii unui strat
vectorial

Plugin-ul de Interpolare

Metasearch
Catalogue Client

Interact,ionează cu serviciile catalogului de
metadate (CSW)

MetaSearch Catalogue
Client

Editarea Offline Editarea offline şi sincronizarea cu baza de
date

Plugin-ul de Editare Offline

Oracle Spatial
GeoRaster

Accesare Oracle Spatial GeoRasters Plugin-ul GeoRaster Oracle
Spatial

Managerul de
Plugin-uri

Gestionează plugin-uri de bază s, i externe Dialogul Plugin-urilor

Processing Cadrului de procesare al datelor spat,iale Cadrul de procesare al
QGIS

Analiza Terenurilor
Raster

Calculează entităt,ile geomorfologice din
DEM-uri

Plugin-ul de Analiză a
Terenurilor Raster

Plugin pentru
Grafuri Rutiere

Analiza celei mai scurte căi Plugin pentru Grafuri
Rutiere

Interogare spaţială Interogări spat,iale asupra vectorilor Pluginul de Interogare
spaţială

Verificatorul de
Topologie

Identificarea erorilor topologice în
straturile vectoriale

Plugin-ul de Verificare a
Topologiei

Statistici Zonale Calculează statistici raster pentru vectorii
poligonali

Plugin-ul de statistici
zonale354 Chapter 20. Plugin-uri
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20.3 Plugin-ul de Captură a Coordonatelor

Plugin-ul de captură a coordonatelor este us, or de utilizat s, i oferă capacitatea de afis, are a coordonatelor pe caneva-
sul hărt,ii, pentru cele două sisteme de coordonate de referint,ă selectate (CRS-uri).

Figure 20.6: Plugin-ul de Captură a Coordonatelor

1. Startat,i QGIS, selectat,i Project Properties din meniul Setări (KDE, Windows) sau Fis, ier (Gnome, OSX),

apoi facet,i clic pe fila Proiect,iei. De asemenea, ca alternativă, putet,i face clic pe pictograma CRS status

din colt,ul din dreapta-jos o bării de stare.

2. Clic pe caseta de bifare Activare proiect,ie din zbor s, i selectat,i sistemul de proiect,ie a coordonatelor dorit
(v. Lucrul cu Proiect,ii).

3. Activat,i plugin-ul de captură a coordonatelor din Managerul de Plugin-uri (v. Dialogul Plugin-urilor) s, i

asigurat,i-vă ca dialogul este vizibil, mergând la View → Panels s, i bifând Coordinate Capture. Dialogul
de captură a coordonatelor va aparea, as, a cum se vede în Imaginea figure_coordinate_capture_1. Ca al-

ternativă, putet,i merge la Vector → Coordinate Capture s, i să vedet,i dacă este bifată caseta Coordinate
Capture.

4. Clic pe pictograma Click to the select the CRS to use for coordinate display s, i selectat,i un CRS diferit de cel selectat
mai sus.

5. Pentru a începe înregistrarea coordonatelor, facet,i clic pe [Start capture]. Acum avet,i posibilitatea să facet,i
clic oriunde pe canevas, iar plugin-ul va afis, a coordonatele pentru ambele CRS-uri selectate.

6. Pentru a activa urmărirea coordonatelor mouse-ului, efectuat,i clic pe pictograma mouse tracking.

7. De asemenea, se pot copia în clipboard coordonatele selectate.

20.4 Plugin-ul DB Manager

Managerul DB Plugin este oficial parte a nucleului QGIS, fiind destinat să fie principalul instrument pentru inte-
grarea s, i gestionarea formatelor de baze de date spat,iale acceptate de QGIS (PostGIS, SpatiaLite, Geopackage,

Oracle Spatial, Straturi virtuale) într-o interfat,ă unică. Pluginul DB Manager oferă mai multe funct,ionalităt,i.
Avet,i posibilitatea de a glisa straturile din browser-ul QGIS în Managerul DB, s, i de a importa stratul în baza de
date spat,ială. Este suficient să glisat,i tabele între bazele de date spat,iale, iar acestea vor fi importate.

Meniul Bazei de Date vă permite să vă conectat,i la o bază de date existentă, pentru a lansa fereastra SQL s, i pentru
a ies, i din Plugin-ul DB Manager. O dată ce vă conectat,i la o bază de date existentă, apar meniurile adit,ionale
Schemă s, i Tabelă.

Meniul Schema include instrumente pentru a crea s, i a s, terge scheme (vide) s, i, în cazul în care topologia este
disponibilă, (de exemplu, PostGIS 2), pentru a începe o TopoVizualizare.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
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Figure 20.7: Dialogul DB Manager

for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry, as well as about existing fields, constraints and indexes. It also allows you
to run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows
all attributes, and the Preview tab renders the geometries as preview.

20.4.1 Lucrul cu fereastra SQL

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

20.5 Plugin-ul Convertor Dxf2Shp

Plugin-ul convertor dxf2shape poate fi folosit pentru a converti date vectoriale dintr-un DXF în format shapefile.
Este nevoie de următorii parametri care trebuie să fie specificat,i înainte de rulare:

• Fis, ierul de intrare DXF: Introducet,i calea către fis, ierul DXF care trebuie convertit.

• Fis, ierul de ies, ire Shp: Introducet,i numele dorit pentru fis, ierul shape care trebuie creat.

• Tipul fis, ierului de ies, ire: Specificat,i tipul de geometrie dorit pentru fis, ierul shape de ies, ire. Tipuri de
acceptate în prezent sunt polilinie, poligon, s, i punct.
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Figure 20.8: Executarea interogărilor SQL în fereastra SQL DB Manager

Figure 20.9: Plugin-ul Convertor Dxf2Shape
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• Exportare etichete cu text: Când opt,iunea este selectată, un strat suplimentar de tip shapefile va fi creat,
iar tabela DBF asociată va cont,ine informat,ii despre câmpul ‘text’ din fis, ierul DXF, s, i s, irurile de caractere
în sine.

20.5.1 Utilizarea plugin-ului

1. Startat,i QGIS, încărcat,i plugin-ul Dxf2Shape din Managerul de Plugin-uri (v. Dialogul Plugin-urilor), apoi

facet,i clic pe pictograma convertorului Dxf2Shape Converter, care apare în meniul barei de instrumente din
QGIS. Va apărea dialogul plugin-ului Dxf2Shape, as, a cum se vede în Figure_dxf2shape_1.

2. Introducet,i fis, ierul DXF de intrare, numele s, i tipul pentru fis, ierul shape de ies, ire.

3. Activat,i caseta de bifare Exportă etichetele cu text dacă dorit,i să creat,i un strat suplimentar, de tip punct,
cu etichete.

4. Clic pe [OK].

20.6 Plugin-ul eVis

(Această sect,iune este derivată din Ghidul utilizatorului eVis (v1.1.0), Horning, N., K. Koy, P. Ersts.
2009. Muzeul American de Istorie Naturală, Centrul pentru conservarea biodiversităt,ii” Disponibil la
http://biodiversityinformatics.amnh.org/, s, i distribuit sub licent,ă GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis este instalat s, i activat automat în noile versiuni de QGIS s, i, similar tuturor plugin-urilor, poate fi dezactivat
s, i activat cu ajutorul Managerului de Plugin-uri (v. Dialogul Plugin-urilor).

Plugin-ul eVis este compus din trei module: ‘Database Connection tool’, ‘Event ID tool’, s, i ‘Event Browser’.
Acestea lucrează împreună pentru a permite vizualizarea fotografiilor geocodate s, i a altor documente care sunt
legate de entităt,i stocate în fis, iere vectoriale, baze de date sau foi de calcul.

20.6.1 Browser-ul de Evenimente

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Lansarea modulului Event Browser

To launch the Event Browser module, click on Database → eVis → eVis Event Browser. This will open the
Generic Event Browser window.

The Event Browser window has three tabs displayed at the top of the window. The Display tab is used to view the
photograph and its associated attribute data. The Options tab provides a number of settings that can be adjusted to
control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to maintain a table
of file extensions and their associated application to allow eVis to display documents other than images.
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Înt,elegerea ferestrei de Afis, are

To see the Display window, click on the Display tab in the Event Browser window. The Display window is used
to view geocoded photographs and their associated attribute data.

Figure 20.10: Fereastra de afis, are eVis

1. Fereastra de afis, are: O fereastră în care va apărea fotografia.

2. Zoom in button: Apropiat,i pentru a vedea mai multe detalii. Dacă nu se poate afis, a întreaga imagine vor
apărea bare de derulare în stânga s, i în josul ferestrei pentru a putea permite derularea imaginii.

3. Zoom out button: Depărtat,i pentru a vedea o zonă mai mare.

4. Butonul Zoom to full extent: Afis, ează întreaga fotografie.

5. Fereastra de informat,ii despre Atribute: Toate informat,iile atributelor punctului asociate cu fotografia
vizualizată sunt afis, ate aici. Dacă tipul de fis, ier ment,ionat în înregistrarea afis, ată nu este o imagine, dar este
un tip de fis, ier definit în fila de Configurare a Aplicat,iilor Externe, atunci când facet,i dublu-clic pe valoarea
câmpului care cont,ine calea către fis, ier, aplicat,ia îl va lansa, vizualizându-i sau ascultându-i cont,inutul.
Dacă extensia fis, ierului este recunoscută, datele atributului vor fi afis, ate în verde.

6. Navigation buttons: Folosit,i butoanele Anterior s, i Următor pentru a încărca entitatea precedentă sau urmă-
toare atunci când este selectată mai mult de o entitate.

Înt,elegerea ferestrei Opt,iuni

1. File path: A drop-down list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path, then the checkbox must
be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
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Figure 20.11: Fereastra de opt,iuni eVis
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about the different options for specifying the file location are noted in the section Specificat,i locat,ia s, i
numele unei fotografii below.

2. Compass bearing: A drop-down list to specify the attribute field that contains the compass bearing asso-
ciated with the photograph being displayed. If compass bearing information is available, it is necessary to
click the checkbox below the drop-down menu title.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Calea directorului de bază: Calea la care se va adăuga calea relativă definită în Figure_eVis_2 (A).

5. Replace path: If this checkbox is checked, only the file name from A will be appended to the base path.

6. Regula se aplică tuturor documentelor: Dacă se bifează, aceleas, i căi către reguli, care sunt definite pentru
imagini, vor fi utilizate pentru documentele non-imagine, cum ar fi filmele, documentele de tip text s, i
fis, ierele de sunet. Dacă nu se bifează, căile către reguli se vor aplica numai pentru imagini, iar restul
documentelor vor ignora parametrul Path Base.

7. Remember settings: If the checkbox is checked, the values for the associated parameters will be saved for
the next session when the window is closed or when the [Save] button below is pressed.

8. Resetare valori: Resetează valorile de pe această linie la setarea implicită.

9. Restabilire valori implicite: va reseta valorile tuturor câmpurilor la valorile implicite. Are acelas, i efect ca
s, i un clic pe fiecare dintre butoanele [Reset].

10. Salvare: Acest lucru va salva setările fără a închide panoul Opt,iunilor.

Înt,elegera ferestrei de Configurare a Aplicat,iilor Externe

Figure 20.12: Fereastra Aplicat,iilor Externe eVis

1. Tabela de referint, ă a fis, ierelor: Un tabel care cont,ine tipurile de fis, iere care pot fi deschise cu eVis. Fiecare
tip de fis, ier are nevoie de o extensie s, i de o cale către o aplicat,ie care poate deschide acel tip de fis, ier. Astfel,
în plus fat,ă de imagini, este posibilă deschiderea unui număr mare fis, iere, cum ar fi filme, înregistrări sonore
s, i documente text.

2. Add new file type: Adaugă un nou tip de fis, ier cu o extensie unică s, i calea către aplicat,ia care poate
deschide acel fis, ier.

3. Delete current row: S, terge tipul de fis, ier evident,iat în tabel s, i definit de o extensie de fis, ier s, i o cale către
o aplicat,ie asociată.

20.6. Plugin-ul eVis 361



QGIS User Guide, Release 2.14

20.6.2 Specificat,i locat,ia s, i numele unei fotografii

The location and name of the photograph can be stored using an absolute or relative path, or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

20.6.3 Specificat,i locat,ia s, i numele altor documente justificative

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis. To
do this, it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon; this is particularly useful for accessing documents from wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

20.6.4 Lansarea modulului de Răsfoire a Evenimentelor

When the Event Browser window opens, a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear, it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table, the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document, double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green, then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked, it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window, a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided, then an arrow will
appear pointing in the direction indicated by the value in the compass bearing display field in the Event Browser
window. The arrow will be centered over the point that is associated with the photograph or other document.

Pentru a închide Vizualizarea Evenimentelor, facet,i clic pe butonul [Închidere] din fereastra de Vizualizare.

20.6.5 Instrumentul Event ID

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.
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Lansarea modulului Event ID

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the Browser-ul de Evenimente section of this guide.

20.6.6 Conexiune la Baza de Date

Modulul ‘Database Connection’ pune la dispozit,ie unelte pentru conectarea s, i interogarea unei baze de date sau a
unei alte resurse ODBC, cum ar fi o foaie de calcul.

eVis can directly connect to the following types of databases: PostgreSQL, MySQL, and SQLite; it can also
read from ODBC connections (e.g., MS Access). When reading from an ODBC database (such as an Excel
spreadsheet), it is necessary to configure your ODBC driver for the operating system you are using.

Lansarea modulului de Conectare la Baza de Date

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Conectarea la baza de date

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Introducet,i numele bazei de date în câmpul text Numele Bazei de Date. Opt,iunea nu este disponibilă dacă aleget,i
‘MS Access’ ca tip de bază de date. În cazul în care baza de date se află pe calculatorul dvs., va trebui să introducet,i
denumirea “localhost”.

Introducet,i numele bazei de date în câmpul text Database Name. Dacă selectat,i ‘ODBC’ ca tip de bază de date,
va trebui să introducet,i numele sursei de date.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established, you will need to check that the correct parameters were entered above.

1. Tipul Bazei de Date: O listă derulantă în care se va specifica tipul bazei de date care va fi utilizată.

2. Database Host: Numele gazdei pentru baza de date.

3. Port: Numărul portului, atunci când tipul bazei de date este MySQL sau PostgreSQL.

4. Nume Bază de Date.: Numele bazei de date.

5. Conectare: Un buton pentru conectarea la baza de date, folosind parametrii definit,i mai sus.

6. Consola de Ies, ire: Fereastra consolei, în care sunt afis, ate mesajele referitoare la procesare.

7. Username: Nume utilizator care va fi utilizat atunci când o bază de date este protejată prin parolă.

8. Password: Parola care va fi utilizată atunci când o bază de date este protejată prin parolă.

9. Predefined Queries: Fila care va deschide fereastra “Interogărilor Predefinite”
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Figure 20.13: Fereastra de conectare la Baza de Date eVis

10. Conectare la Baza de Date: Închide fereastra principală a Conexiunii la Baza de Date.

11. SQL Query: Fila care va deschide fereastra “SQL Query”.

12. Ajutor: Deschide fereastra de asistent,ă online.

13. OK: Închide fereastra principală a “Conexiunii la Baza de Date”.

Rularea interogărilor SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful, a Database File Selection
window will be displayed. If the query is not successful, an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

1. Fereastra Textului SQL de Interogare: O fereastră de introducere a interogărilor SQL.

2. Execut,ie Interogare: Butonul care va executa interogarea introdusă în Fereastra de Interogare SQL.

3. Fereastra Consolei: Fereastra consolei în care sunt afis, ate mesajele referitoare la procesare.

4. Ajutor: Deschide fereastra de asistent,ă online.

5. OK: Închide fereastra principală a Conexiunii la Baza de Date.
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Figure 20.14: Fila de interogare eVis SQL

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Tip: Crearea unui strat vectorial dintr-o foaie de calcul Excel
When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.

Rularea interogărilor predefinite

With predefined queries, you can select previously written queries stored in XML format in a file. This is par-
ticularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Select the query you want to run from the drop-down menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
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switching databases, you need to be sure to connect to the database.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful, a
Database File Selection window will be displayed. If the query is not successful, an error message will appear in
the Output Console window.

Figure 20.15: Fila Interogărilor eVis Predefinite

1. Deschidere Fis, ier: Lansează navigatorul de fis, iere “Deschidere Fis, ier”, pentru a căuta fis, ierul XML care
cont,ine interogări predefinite.

2. Interogări Predefinite: O casetă cu derulare verticală, care cont,ine interogările predefinite, dintr-un fis, ier
XML.

3. Descrierea interogării: O scurtă descriere a interogării. Această descriere face parte din fis, ierul XML de
interogări predefinite.

4. Fereastra Consolei: Fereastra consolei în care sunt afis, ate mesajele referitoare la procesare.

5. Ajutor: Deschide fereastra de asistent,ă online.

6. OK: Închide fereastra principală a “Conexiunii la Baza de Date”.

Formatul XML pentru interogări predefinite eVis

Etichetele XML citite de eVis
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Etichetă Descriere
interogare Defines, te începutul s, i sfârs, itul unei expresii de interogare.
scurtă
descriere

A short description of the query that appears in the eVis drop-down menu.

descriere O descriere mai detaliată a interogării afis, ată în Fereastra Textului de Interogare Predefinită .
database-
type

The database type, defined in the Database Type drop-down menu in the Database Connection
tab.

database-
port

The port as defined in the Port text box in the Database Connection tab.

database-
name

Numele bazei de date, as, a cum este definit în caseta de text Numele Bazei de Date din fila
Conexiunilor la Baza de Date.

databaseuser-
name

The database username as defined in the Username text box in the Database Connection tab.

databasep-
assword

The database password as defined in the Password text box in the Database Connection tab.

sqlstate-
ment

Comanda SQL.

autocon-
nect

A flag (“true”” or “false”) to specify if the above tags should be used to automatically connect to
the database without running the database connection routine in the Database Connection tab.

Modelul complet de fis, ier XML, cu trei interogări, este afis, at mai jos:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
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<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

20.7 Plugin-ul fTools

Scopul plugin-ului conceput în Python, fTools, este acela de a oferi o resursă pentru mai multe operat,iuni cu vectori
GIS, fără a mai fi nevoie de software adit,ional, biblioteci, sau alte improvizat,ii complexe. Oferă o suită, în cres, tere,
de funct,ii pentru managementul si analiza datelor spatiale, ale căror însus, iri predominante sunt funct,ionalitatea s, i
rapiditatea în execut,ie.

fTools este de acum instalat s, i activat, în mod automat, în noile versiuni de QGIS s, i, asemenea tuturor plugin-
urilor, poate fi dezactivat s, i activat folosind Managerul de Plugin-uri (v. Dialogul Plugin-urilor). Atunci când este
activat, plugin-ul fTools adaugă un meniu Vector în QGIS, oferind funct,ii începând de la Instrumentele de Analiză
sau Cercetare, până la cele de Geoprocesare, precum s, i câteva Unelte de Management al Datelor.

20.7.1 Unelte de analiza

IconitaUnealta Scop

Matricea
distantelor

Masoara distantele dintre doua straturi de puncte si ofera rezultatul sub forma de:
a) Matrice patratica a distantelor, b) Matrice liniara a distantelor sau c) Rezumat al
distantelor. Calculul poate fi limitat la cele mai apropiate mii puncte.

Suma
lungimilor
liniilor

Calculeaza suma totala a lungimilor liniilor aflate in interiorul fiecarui poligon de
pe un strat vectorial de poligoane.

Puncte in
poligon

Numara punctele aflate in interiorul fiecarui poligon al unui strat vectorial de
poligoane.

Lista valorilor
unice

Afis, ează lista cu valorile unice dintr-un câmp al unui strat vectorial de intrare.

Statistici
esentiale

Calculeaza statistici esentiale (media, deviatia statistica standard, suma,
coeficientul de variatie CV) pentru un camp dat.

Analiza celui
mai apropiat
vecin

Afis, ează rezultatele analizei celui mai apropiat vecin pentru a evalua nivelul de
grupare într-un strat vectorial de tip punct .

Coordonatele
medii

Calculeaza coordonatele fie ale centrului normal, fie ale centrului de greutate,
pentru obiecte vectoriale - individual sau grupate dupa anumite campuri ale bazei
de date.

Intersectii de
linii

Indentifica intersectiile dintre linii si genereaza un fisier shape cu punctele
corespunzatoare. Util pentru localizarea intersectiilor de drumuri, ape curgatoare.
Ignora intersectiile cu lungime mai mare de 0.

Tabela Ftools 1: fTools Unelte de Analiza
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20.7.2 Unelte de cercetare

IconitaUnealta Scop

Select,ie aleatorie Selectat,i aleatoriu un număr sau un procentaj de n entităt,i.

Select,ie aleatorie
în cadrul
subseturilor

Selecteaza aleatoriu elemente din subseturi create pe baza unor identificatori
unici.

Puncte aleatorii Genereaza puncte pseudo-aleatoare intre limitele unui strat indicat.

Puncte regulate Genereaza o retea regulata de puncte intre limitele unui strat indicat si exporta
respectivele puncte ca fisier shape.

Grilă vectorială Generează grilă de tip linie sau poligon, în funct,ie de spat,ierea specificată de
utilizator.

Selectie in functie
de localizare

Selecteaza elemente pe baza pozitiei relative fata de un alt strat. Rezultatul poate
fi o selectie noua, un subset dintr-o selectie curenta, sau o completare a selectiei
curente cu noi elemente.

Poligon din
extinderea
stratului

Creaza un poligon dreptunghiular care incadreaza limitele unui strat vectorial
sau raster.

Tabela Ftools 2: fTools Unelte de Cercetare

20.7.3 Unelte de geoprocesare

IconitaUnealta Scop

Structuri
convexe

Creaza o structura convexa minima (Convex hull) pentru un strat indicat, sau pe
baza unor identificatori din baza de date.

Zona(-e)
tampon

Creaza zone tampon in jurul elementelor la o distanta specificata sau preluata
dintr-un camp al bazei de date.

Intersectare Rezultatul va contine elementele din stratul initial care se suprapun (se
intersecteaza) peste elementele din stratul indicat drept de intersectie.

Uniune Rezultatul va combina elementele din cele 2 straturi indicate, fie ca se interesteaza
fie ca nu.

Diferenta
simetrica

Rezultatul va contine elementele din straturile indicate mai putin elementele care
se suprapun (se intersecteaza).

Taiere Rezultatul va contine elementele din stratul initial care se suprapun cu elementele
stratului indicat drept de taiere. Elementele initiale vor fi taiate la intersectia cu
elementele din stratul de taiere.

Diferenta Rezultatul va contine elementele din stratul initial care nu se suprapun cu
elementele stratului indicat drept de taiere. Elementele initiale vor fi taiate la
intersectia cu elementele din stratul de taiere.

Dizolvare Imbina elementele pe baza unui identificator indicat. Toate elementele cu valori
identice se vor combina astfel incat sa formeze un singur element.

Eliminarea
poligoanelor tip
sliver

Unifică entităt,ile selectate, cu poligonul învecinat cu cea mai mare arie sau cu cea
mai mare frontieră comună.

Tabela Ftools 3: fTools Unelte de geoprocesare

20.7. Plugin-ul fTools 369



QGIS User Guide, Release 2.14

20.7.4 Unelte de geometrie

IconitaUnealta Scop

Verificare validitate
geometrie

Identifică intersect,iile, găurile închise s, i reface ordinea nodurilor în
poligoane. Putet,i alege în dialogul opt,iunilor motorul care va fi folosit, prin
modificarea valorii de Validare a Geometriei. Există două motoare: QGIS s, i
GEOS care au un comportament destul de diferit. Există alte instrumente
care prezintă rezultatele în mod diferit: pluginul de Verificare Topologie s, i
regula ‘nu trebuie să existe geometrii incorecte’.

Exporta/Adauga
coloane cu informatie
geometrica.

Adauga informatie geometrica la straturi de puncte (XCOORD, YCOORD),
de linii (LUNGIMEA) sau respectiv de poligoane (ARIA, PERIMETRUL).

Centroizii
poligoanelor

Calculeaza centroidul fiecarui poligon pentru un strat indicat de poligoane.

Triangulatia Delaunay Calculează s, i de salvează (ca poligoane) triangularea Delaunay a stratului
vectorial de tip punct.

Poligoane Voronoi Calculează poligoanele Voronoi ale stratului vectorial de tip punct.

Simplifica geometria Generalizeaza liniile sau poligoanele pe baza unui algoritm
Douglas-Peucker modificat.

Densificare geometria Densifică liniile sau poligoanele prin adăugarea de noduri.

Degrupare elemente Converteste grupurile de elemente in elemente simple. Creaza poligoane si
linii.

Grupare elemente Grupeaza elemente intr-un singur element pe baza unui identificator unic.

Din poligoane in linii Converteste poligoanele in linii, grupurile de poligoane in grupuri de linii.

Din linii in poligoane Converteste liniile in poligoane, grupurile de linii in grupuri de poligoane.

Extrage noduri Extrage nodurile din straturile indicate de linii sau poligoane si creaza un
strat de puncte.

Tabela Ftools 4: fTools Unelte de geometrie

Note: Instrumentul Simplificare geometrie poate fi folosit pentru a elimina nodurile duplicate, din geometriile de
tip linie s, i poligon. E suficient să setat,i parametrul Simplificare tolerant,ă la 0 iar acest lucru va rezolva problema.

20.7.5 Instrumente de management de date

IconitaUnealta Scop

Definire proiectie
actuala

Specifica CRS pentru fisiere shape care nu au definit sistemul de coordonate.

Imbinare atribute
in functie de
localizare

Adauga atribute aditionale la un strat vectorial pe baza unei relatii spatiale.
Atributele unui strat sunt adaugate la tabela de atribute a celuilalt strat -
rezultatul salvandu-se in format shape.

Separa stratul
vectorial

Separa stratul vectorial indicat in straturi multiple pe baza atributelor.

Imbinare fisiere
shape intr-unul
singur

Imbina informatia din multiple fisiere shape intr-un unic fisier pe baza tipului de
strat vectorial (punct, linie, poligon).

Creare index
spatial

Creaza un index spatial pentru formatele OGR- suportate.

Tabela Ftools 5: fTools Unelte de managementul datelor
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20.8 Plugin-ul Instrumentelor GDAL

20.8.1 Ce reprezintă Instrumentele GDAL?

The GDAL Tools plugin offers a GUI to the collection of tools in the Geospatial Data Abstraction Library,
http://gdal.osgeo.org . These are raster management tools to query, re-project, warp and merge a wide variety
of raster formats. Also included are tools to create a contour (vector) layer, or a shaded relief from a raster DEM,
and to make a VRT (Virtual Raster Tile in XML format) from a collection of one or more raster files. These tools
are available when the plugin is installed and activated.

Biblioteca GDAL

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDAL Tools plugin offers an easy interface to the tools, exposing only the most popular options.

20.8.2 Lista Instrumentelor GDAL

Figure 20.16: Meniul Instrumentelor GDAL

Proiect,ii

Warp
(Re-
proiectare)

This utility is an image mosaicing, reprojection and warping utility. The program can
reproject to any supported projection, and can also apply GCPs stored with the image if the
image is “raw” with control information. For more information, you can read on the GDAL
website http://www.gdal.org/gdalwarp.html.

Asignare
proiect,ie

This tool allows you to assign projection to rasters that are already georeferenced but miss
projection information. Also with its help, it is possible to alter existing projection
definitions. Both single file and batch mode are supported. For more information, please visit
the utility page at the GDAL site, http://www.gdal.org/gdalwarp.html.

Extragere
proiect,ie

This utility helps you to extract projection information from an input file. If you want to
extract projection information from a whole directory, you can use the batch mode. It creates
both .prj and .wld files.
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Conversion

Rasterizare
This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR-supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided.
For more information see http://www.gdal.org/gdal_rasterize.html.

Poligo-
nizare

Acest utilitar creează poligoanele vectoriale pentru toate regiunile pixelilor din raster, care
partajează valoarea unui pixel comun. Fiecare poligon este creat cu un atribut care indică
valoarea de pixel a acelui poligon. Utilitarul va crea sursa de date a vectorului de ies, ire în
cazul în care nu există deja, în mod implicit în formatul ESRI shapefile. Vedet,i s, i
http://www.gdal.org/gdal_polygonize.html.

Translat,ie
This utility can be used to convert raster data between different formats, potentially performing
some operations like subsetting, resampling, and rescaling pixels in the process. For more
information you can read on http://www.gdal.org/gdal_translate.html.

Din
RGB în
PCT

Acest utilitar va calcula un tabel optim cu pseudo-culori pentru o imagine RGB dată, folosind
un algoritm de decupare mediană pe o histogramă RGB sub-es, antionată. Apoi, transformă
imaginea într-una pseudo-colorată, folosind tabelul de culori. Această conversie utilizează
oscilat,iile Floyd-Steinberg (difuzia erorilor) pentru a maximiza calitatea vizuală a imaginii de
ies, ire. Utilitarul este descris, de asemenea, în http://www.gdal.org/rgb2pct.html.

Din
PCT în
RGB

Acest utilitar va converti o bandă de pseudoculori, din fis, ierul de intrare, într-un fis, ier RGB de
ies, ire, în formatul dorit. Pentru mai multe informat,ii, consultat,i
http://www.gdal.org/pct2rgb.html.

Extragere

Curbe
de nivel

This program generates a vector contour file from the input raster elevation model (DEM). On
http://www.gdal.org/gdal_contour.html, you can find more information.

Decupare
This utility allows you to clip (extract subset) rasters using selected extent or based on mask
layer bounds. More information can be found at http://www.gdal.org/gdal_translate.html.
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Analiză

Sită This utility removes raster polygons smaller than a provided threshold size (in pixels) and
replaces them with the pixel value of the largest neighbor polygon. The result can be
written back to the existing raster band, or copied into a new file. For more information,
see http://www.gdal.org/gdal_sieve.html.

Aproape
Negru

Acest utilitar va scana o imagine s, i va încerca să seteze tot,i pixelii, din jurul marginii,
care sunt aproape negri (sau aproape albi) exact la culoarea neagră (sau albă). Acest lucru
este adesea folosit pentru a “repara” aerofotogramele comprimate cu pierderi, astfel că
pixelii colorat,i pot fi tratat,i ca fiind transparent,i atunci când are loc mozaicarea.
Consultat,i, de asemenea, http://www.gdal.org/nearblack.html.

Umplere cu
fărădate

This utility fills selected raster regions (usually nodata areas) by interpolation from valid
pixels around the edges of the areas. On http://www.gdal.org/gdal_fillnodata.html, you
can find more information.

Proximitatea Acest utilitar generează o hartă raster de proximitate, care indică distant,a de la centrul
fiecărui pixel până la centrul celui mai apropiat pixel, identificat ca pixel t,intă. Pixelii
t,intă sunt aceia din rasterul sursă, pentru care valoarea pixelilor se află în setul de valori al
pixelilor t,intă. Pentru mai multe informat,ii, consultat,i
http://www.gdal.org/gdal_proximity.html.

Grilă
(Interpolare)

This utility creates a regular grid (raster) from the scattered data read from the OGR
datasource. Input data will be interpolated to fill grid nodes with values, and you can
choose from various interpolation methods. The utility is also described on the GDAL
website, http://www.gdal.org/gdal_grid.html.

DEM
(Modele ale
terenului)

Tools to analyze and visualize DEMs. It can create a shaded relief, a slope, an aspect, a
color relief, a Terrain Ruggedness Index, a Topographic Position Index and a roughness
map from any GDAL-supported elevation raster. For more information, see
http://www.gdal.org/gdaldem.html.

Diverse

Construire
Raster Virtual
(Catalog)

Acest program construies, te un VRT (Set de Date Virtual), care reprezintă un mozaic
de pe lista rasterelor de intrare acceptate de GDAL. Consultat,i, de asemenea,
http://www.gdal.org/gdalbuildvrt.html.

Îmbinare This utility will automatically mosaic a set of images. All the images must be in the
same coordinate system and have a matching number of bands, but they may be
overlapping, and at different resolutions. In areas of overlap, the last image will be
copied over earlier ones. The utility is also described at
http://www.gdal.org/gdal_merge.html.

Informat,ii This utility lists various information about a GDAL-supported raster dataset. On
http://www.gdal.org/gdalinfo.html, you can find more information.

Construire
Vederi de Ansamblu

The gdaladdo utility can be used to build or rebuild overview images for most
supported file formats with one of several downsampling algorithms. For more
information, see http://www.gdal.org/gdaladdo.html.

Index Plăcut,e Acest utilitar construies, te un fis, ier shape cu o înregistrare pentru fiecare fis, ier raster de
intrare, un atribut care cont,ine numele fis, ierului, s, i o geometrie poligonală care
conturează rasterul. Consultat,i s, i http://www.gdal.org/gdaltindex.html.

Setările Instrumentelor GDAL

Utilizat,i acest dialog pentru a încorpora variabilele GDAL.
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20.9 Plugin-ul Verificator de Geometrie

Verificatorul de geometrie reprezintă un plugin de bază puternic, dedicat verificării s, i remedierii validităt,ii geome-
triei unui strat. Dialogul Verificatorul de geometrie prezintă, în prima filă, diverse grupuri de setări (Settings):

• Stratul vectorial de intrare: pentru a selecta layer-ul de verificat. O casetă de bifare dedicată Doar
entităt,ilor selectate poate restrânge geometriile la cele select,ionate.

• Validitatea geometriei: oferă utilizatorului posibilitatea de a alege între Auto intersect,ii, Noduri duplicate,
Poligon cu mai put,in de 3 noduri.

• Tipuri de geometrii permise: sunt acceptate doar anumite tipuri de geometrie, cum ar fi punctul, multipunc-
tul, linia, multilinia, poligonul s, i multipoligonul.

• Geometry properties displays Polygons and multipolygons may not contain any holes and Multipart
objects must consist of more than one part.

• Geometry conditions: user can add some condition to validate the geometries with a minimal segment
length, a minimum angle between segment, a minimal polygon area and sliver polygons detection.

• Topology checks: checks for duplicates, for features within other features, overlaps smaller than a number,
for gaps smaller than a number.

• Tolerant,a: putet,i defini aici tolerant,a pentru verificare.

• Output vector layer gives the choice to the user how get the result between modifiy the current layer and
create a new layer.

După ce vă mult,umes, te configurat,ia, putet,i face clic pe butonul [Run].

The results appear in the second tab and as an overview layer of the errors in the canvas (its name is checker). A
table list the geometry check result with one error by row: the first row is an ID, the second the reason of the error,
then the coordinates of the error, a value (depending on the type of the error) and finally the resolution column
which indicates the resolution of the error. At the bottom of this table, you can export the error into a shapefile.
At the left, you have the number of the errors and the fixed errors.

Plugin-ul Verificator de Geometrie poate găsi următoarele erori:

• Autointersect,ii: un poligon se intersectează cu el însus, i,

• Noduri duplicate: două noduri duplicate dintr-un segment

• Găuri: găurile dintr-un poligon

• Lungimea segmentului: o lungime de segment mai mică decât un prag,

• Unghiul minim: două segmente cu un unghi mai mic decât un prag,

• Aria minimă: suprafat,a poligonală mai mică decât un prag,

• Poligoanele de tip “as, chie”: această eroare provine de la poligoanele foarte mici (cu suprafat,a mică) dar cu
un perimetru mare,

• Entităt,i duplicate,

• Entităt,ile incluse în alte entităt,i,

• Suprapuneri: poligoanele suprapuse,

• Bres, e: fantele dintre poligoane

Figura următoare prezintă diferitele verificări efectuate de către plugin.

You can select a row to see the localisation of the error. You can change this behaviour by selecting another action

between error (default), Feature, Don’t move, and Highlight contour of selected features.

Below the zoom action when clicking on the table row, you can Show the selected features in attribute table, Fix
selected errors using default resolution and Fix selected errors, prompt for resolution method. In the latter, you
will see a window to choose the resolution’s method among which:
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Figure 20.17: Plugin-ul Verificator de Geometrie
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Figure 20.18: The Differents checks supported by the plugin
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• Unes, te cu poligonul învecinat care are cea mai lungă margine comună

• Unes, te cu poligonul învecinat care are cea mai mare suprafat,ă

• Unes, te cu poligonul învecinat care are valori identice ale atributelor, dacă este cazul, sau rămâne as, a cum
este

• Ştergere entitate

• Nici o act,iune

Tip: Remediere erori multiple
You can fix multiple errors by selecting more than one row in the table with the CTRL + click action.

The default action could be changed with the last icon Error resolution settings. For some type of errors, you can
change the default action between some specific action or No action.

În cele din urmă, putet,i alege atributul care va fi utilizat, atunci când fuzionează entităt,ile după valoarea atribu-
tului.

20.10 Plugin-ul de Acros, are a Geometriei

Cu ajutorul instrumentului de Acros, are Geometrie, putet,i alinia în mod automat marginile s, i vertecs, ii unui strat
vectorial fat,ă de marginile s, i vertecs, ii unui al doilea strat, folosind o tolerant,ă definită de utilizator.

Interfat,a de mai jos arată setările acestui plug-in. Utilizatorul trebuie să aleagă stratul de schimbat (a se vedea
stratul vectorial de intrare) s, i straturile de referint,ă la care va avea loc acros, area. O distant,ă maximă de acros, are
(în unităt,i de hartă) permite schimbarea tolerant,ei de acros, are.

Se pot acros, a numai entit(ăt,ile) selectate, prin bifarea opt,iunii Numai entităt,ile selectate.

Output vector layer allows you to choose between Modifying input layer or Create a new layer.

Figure 20.19: Plugin-ul de Acros, are a Geometriei

20.11 Plugin-ul de georeferent,iere

Plugin-ul de Georeferent,iere este un instrument pentru generarea de fis, iere world pentru raster. Acesta vă permite
să referint,iat,i rastere în sisteme geografice sau proiectate de coordonate, prin crearea unui nou GeoTiff sau prin
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adăugarea unui fis, ier world imaginii existente. Abordarea de bază pentru georeferent,ierea unui raster, este de a
localiza punctele de pe raster pentru care putet,i determina cu exactitate coordonatele.

Funct,ionalităt,i

Pictogramă Scop Pictogramă Scop

Deschidere raster Start georeferent,iere

Generare script GDAL Încărcare puncte GCP

Salvare puncte GCP ca Setări de transformare

Adăugare punct S, tergere punct

Mutare punct GCP Panoramare

Mărire Mics, orare

Mărire la nivelul stratului Nivelul de mărire anterior

Următorul nivel de mărire Legarea Georeferent,iatorului de QGIS

Legarea aplicat,iei QGIS de Georeferent,iator Întinderea completă a histogramei

Întinderea locală a histogramei

Tabela Georeferent,iator 1: Instrumente Georeferent,iator

20.11.1 Procedura uzuală

Pentru introducerea coordonatelor X s, i Y (DMS (dd mm ss.ss), DD (dd.dd) sau a coordonatelor proiectate
(mmmm.mm)), ce corespund cu punctul selectat din imagine, pot fi folosite două proceduri alternative:

• Uneori, rasterul are pe margine cruciulit,e cu coordonatele “scrise” pe imagine. În acest caz, putet,i introduce
manual coordonatele.

• Folosirea straturilor deja georeferent,iate. Acestea pot fi date raster sau vectoriale care cont,in aceleas, i
obiecte/entităt,i pe care le are s, i imaginea pe care dorit,i să o georeferent,iat,i, având s, i proiect,ia pe care o
dorit,i pentru imaginea dvs. În acest caz, putet,i introduce coordonatele, făcând clic pe setul de date de
referint,ă încărcat în canevasul hărt,ii QGIS.

Procedura standard de georeferent,iere a unei imagini implică selectarea mai multor puncte de pe raster,
specificându-le coordonatele s, i alegând o modalitate relevantă de transformare a tipului lor. Bazându-se pe
parametrii s, i datele introduse, plugin-ul va calcula parametrii fis, ierului hart,ii lumii. Cu cât oferit,i mai multe
coordonate, cu atât va fi mai bun rezultatul.

Primul pas este de a lansa QGIS, de a încărca Plugin-ul de Georeferent,iere (parcurget,i Dialogul Plugin-urilor),
apoi facet,i clic pe Raster → Georeferencer, care apare în bara de meniuri QGIS. Dialogul Plugin-ului de
Georeferent,iere apare as, a cum se arată în figure_georeferencer_1.

Pentru acest exemplu, utilizăm o plans, ă topografică a Dakotei de Sud din SDGS. Va putea fi vizualizată mai târziu
împreună cu datele din locat,ia fis, ierului GRASS spearfish60. Putet,i descărca plans, a topografică de aici:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Introducet,i punctele de control din teren (GCPs)

1. Pentru a începe o georeferent,iere, trebuie să încărcat,i un raster fără referint,ă cu ajutorul butonului .
Rasterul va apărea în zona principală de lucru a dialogului. O dată ce rasterul este încărcat, putem începe să
introducem punctele de referint,ă.

2. Utilizând butonul Add Point, adaugat,i puncte la suprafat,a principală de lucru s, i introducet,i coordonatele
acestora (v. figure_georeferencer_2 ). Pentru această procedură avet,i trei opt,iuni:
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Figure 20.20: Fereastra a plugin-ului de georeferent,iere

• Facet,i clic pe un punct din imaginea raster s, i introducet,i coordonatele X s, i Y manual.

• Facet,i clic pe un punct din imaginea raster, apoi aleget,i butonul From map canvas pentru a adăuga
coordonatele X s, i Y, cu ajutorul unei hărt,i georeferent,iate, deja încărcate în canevasul hărt,ii QGIS.

• Cu ajutorul butonului , putet,i muta GCP-urile în ambele ferestre, dacă sunt pozit,ionate eronat.

3. Continuat,i să introducet,i puncte. Ar trebui să aibă cel put,in patru puncte, iar cu cât mai mult coordonate
introducet,i, cu atât mai bun va fi rezultatul. Există instrumente adit,ionale în dialogul pluginului, pentru
transfocarea s, i deplasarea zonei de lucru, în scopul localizării unui set relevant de puncte GCP.

Figure 20.21: Adăugare puncte la imaginea raster

Punctele care sunt adăugate la hartă vor fi stocate într-un fis, ier text separat ([filename].points), de obicei,
alăturat imaginii raster. Acest lucru ne permite să redeschidem plugin-ul Georeferent,iator la o dată ulterioară s, i să
adăugăm noi puncte, sau să le s, tergem pe cele existente, pentru a optimiza rezultatul. Fis, ierul de puncte cont,ine

valori de forma: mapX, mapY, pixelX, pixelY. Putet,i utiliza butoanele de Încărcare puncte GCP s, i
Salvare puncte GCP ca... pentru a gestiona fis, ierele.
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Definirea setărilor de transformare

După ce at,i adăugat GCP / Ground Control Point = Puncte de Control pe Teren, la imaginea raster, va trebui să
definit,i parametrii transformării pentru procesul de georeferent,iere.

Figure 20.22: Definirea setărilor de transformare ale georeferent,iatorului

Algoritmi de transformare disponibili

În funct,ie de cât de multe puncte de control at,i capturat din teren, poate că dorit,i să utilizat,i divers, i algoritmi de
transformare. Alegerea algoritmului de transformare depinde, de asemenea, de tipul s, i calitatea datelor de intrare,
s, i de valoarea distorsiunilor geometrice pe care dorit,i să le introducet,i în rezultatul final.

În mod curent, sunt disponibile următoarele tipuri de transformări:

• Algoritmul Liniar este utilizat la crearea unui fis, ier world, fiind diferit de alt,i algoritmi prin faptul că nu
transformă, de fapt, rasterul. Acest algoritm probabil că nu va fi suficient, atunci când vă confruntat,i cu un
material scanat.

• The Helmert transformation performs simple scaling and rotation transformations.

• Algoritmii Polinomiali 1-3 sunt printre cele mai utilizat,i algoritmi pe scară largă, pentru a se potrivi
punctelor de control sursă s, i destinat,ie, din teren. Cel mai folosit algoritm este transformarea polinomi-
ală de gradul doi, ceea ce permite o anumită curbură. Transformarea polinomială de gradul întâi (afină)
păstrează coliniaritatea, s, i permite numai scalarea, translat,ia s, i rotat,ia.

• Algoritmul Thin Plate Spline (TPS) este o metodă de georeferent,iere mai modernă, care este capabil de
a introduce deformări locale în date. Acest algoritm este util atunci când sunt georeferent,iate originale de
calitate foarte mică.

• Transformarea Projective efectuează translat,ia s, i rotat,ia liniară a coordonatelor.
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Definire metodă de reeşantionare

Tipul de rees, antionarea pe care o aleget,i va depinde în funct,ie de datele de intrare s, i de obiectivul final al
exercit,iului . Dacă nu dorit,i să modificat,i statistica imaginii , este posibil să dorit,i să aleget,i ” Cel mai apropiat
vecin ” , în timp ce un ” rees, antionare Cubică ” va oferi probabil un rezultat mai finisat .

Dacă este posibil, se va alege între cinci metode diferite de rees, antionare:

1. Cel mai apropiat vecin

2. Liniar

3. Cubic

4. Curbă Cubică

5. Lanczos

Definit,i setările de transformare

Există mai multe opt,iuni care trebuie definite pentru grila de ies, ire georeferentiată.

• Caseta de text Create world file este disponibilă numai dacă vă decidet,i să utilizat,i tipul de transformare
liniar, pentru că acest lucru înseamnă că imaginea raster nu va fi transformată, în realitate. În acest caz,
câmpul Output raster nu este activat, deoarece se va crea numai un nou fis, ier world.

• Pentru toate celelalte tipuri de transformare, trebuie să definit,i o Ies, ire raster. Implicit, un nou fis, ier ([file-
name]_modified) va fi creat în acelas, i dosar, împreună cu imaginea raster originală.

• Ca un pas următor, trebuie să definit,i Target SRS (Sistemul de Referint,ă Spat,ială) pentru rasterul
georeferent,iat (v. Lucrul cu Proiect,ii).

• Dacă dorit,i, putet,i genera o hartă PDF s, i, de asemenea, **un raport pdf **. Raportul include informat,ii cu
privire la parametrii utilizat,i de transformare, o imagine a reziduurilor s, i o listă cu toate GCP-urile s, i erorile
lor RMS.

• În plus, putet,i bifa caseta Setare Rezolut,ie T, intă, pentru a defini rezolut,ia pixelilor din rasterul de ies, ire.
Rezolut,iile orizontală s, i verticală implicite sunt 1.

• Opt,iunea Use 0 for transparency when needed poate fi activată, dacă pixelii cu valoarea 0 ar trebui să
fie transparent,i. În exemplul nostru toposheet, toate zonele albe ar trebui să fie transparente.

• În cele din urmă, Load in QGIS when done încarcă automat rasterul rezultat în canevasul hărt,ii QGIS,
atunci când are loc transformarea.

Afis, area s, i adaptarea proprietăt,ilor rasterului

Executând click pe eticheta ”Proprietăt,i raster” din meniul ”Setări” se deschide meniul proprietăt,i raster al stratului
pe care dorit,i să îl georeferent,iat,i.

Configurarea georeferent,iatorului

• Putet,i defini dacă să arătat,i coordonatele s, i/sau ID-urile GCP.

• Ca unităt,i reziduale, se pot alege pixelii s, i unităt,ile de hartă.

• Pentru raportul PDF, pot fi definite o margine stângă s, i una dreaptă s, i, de asemenea, dimensiunea hârtiei
pentru harta PDF.

• În final, putet,i bifa caseta Arată fereastra Georeferent,iatorului andocată.
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Execut,ie transformare

După ce au fost colectate toate GCP-urile s, i au fost definite toate setările de transformare, trebuie doar să apăsat,i

butonul Start georeferent,iere, pentru a crea noul raster georeferent,iat.

20.12 Plugin-ul Heatmap

Plugin-ul Heatmap foloses, te Evaluarea Densităt,ii Nucleului pentru a crea un raster al densităt,ii (o hartă calorică)
dintr-un strat de puncte vectoriale de intrare. Densitatea se calculează pe baza numărului de puncte dintr-o locat,ie,
un număr mai mare de puncte într-o aglomerare determinând valori mai mari. Hărt,ile calorice permit identificarea
cu us, urint,ă a “punctelor fierbint,i” s, i a aglomerărilor de puncte.

20.12.1 Activarea plugin-ului Heatmap

First this core plugin needs to be activated using the Plugin Manager (see Dialogul Plugin-urilor). After activation,

the heatmap icon can be found in the Raster Toolbar, and under the Raster → Heatmap menu.

Selectat,i meniul View → Toolbars → Raster pentru a arăta Bara de Instrumente, dacă aceasta nu este vizibilă.

20.12.2 Folosirea plugin-ului Heatmap

Apăsând pe butonul instrumentului Hartă calorică, se va deschide dialogul plugin-ului Heatmap (v. Fig-
ure_Heatmap_2).

Dialogul are următoarele opt,iuni:

• Stratul punctelor de intrare: Listează toate straturile vectoriale de tip punct din proiectul curent, fiind
utilizat la selectarea stratului care urmează să fie analizat.

• Rasterul de ies, ire: Permite folosirea butonului pentru a selecta directorul s, i numele de fis, ier pe care
le generează plugin-ul Heatmap pentru imaginea rasterului de ies, ire. O extensie de fis, ier nu este necesară.

• Output format: Selects the output format. Although all formats supported by GDAL can be chosen, in
most cases GeoTIFF is the best format to choose.

• Radius: Is used to specify the heatmap search radius (or kernel bandwidth) in meters or map units. The
radius specifies the distance around a point at which the influence of the point will be felt. Larger values
result in greater smoothing, but smaller values may show finer details and variation in point density.

Atunci când este bifată caseta Advanced, vor fi disponibile opt,iuni adit,ionale:

• Rows and Columns: Used to change the dimensions of the output raster. These values are also linked to
the Cell size X and Cell size Y values. Increasing the number of rows or columns will decrease the cell size
and increase the file size of the output file. The values in Rows and Columns are also linked, so doubling
the number of rows will automatically double the number of columns and the cell sizes will also be halved.
The geographical area of the output raster will remain the same!

• Cell size X and Cell size Y: Control the geographic size of each pixel in the output raster. Changing these
values will also change the number of Rows and Columns in the output raster.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Decay ratio: Can be used with Triangular kernels to further control how heat from a feature decreases with
distance from the feature.
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– O valoare de 0 (=minimum) indică o căldură concentrată în centrul razei date, s, i complet stinsă la
margine.

– O valoare de 0.5 indică faptul că pixelii de la marginea razei vor primi jumătate din “căldura” pe care
o primesc pixelii aflat,i în centrul razei de căutare.

– O valoare de 1 semnifică distribuirea uniformă a căldurii pe întreaga rază a cercului de căutare. (Acest
lucru este echivalent cu kernel-ul ‘Uniform’.)

– O valoare mai mare decât 1 indică o căldură mai mare înspre marginea razei de căutare, decât în centru.

Stratul punctelor de intrare poate avea, de asemenea, câmpuri atribut, care pot afecta modul de influent,are a hărt,ii
calorice:

• Use radius from field: Sets the search radius for each feature from an attribute field in the input layer.

• Use weight from field: Allows input features to be weighted by an attribute field. This can be used to
increase the influence certain features have on the resultant heatmap.

Când este specificat ca ies, ire un nume de fis, ier raster, butonul [OK] poate fi utilizat pentru a crea harta calorică.

20.12.3 Tutorial: Crearea unei Hărt,i Calorice

For the following example, we will use the airports vector point layer from the QGIS sample dataset (see Date
es, antion). Another excellent QGIS tutorial on making heatmaps can be found at http://www.qgistutorials.com.

În Figure_Heatmap_1, sunt afis, ate aeroporturile din Alaska.

Figure 20.23: Aeroporturile din Alaska

1. Selectat,i butonul instrumentului Heatmap, pentru a deschide dialogul Hărt,ilor Calorice (v. Fig-
ure_Heatmap_2).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.
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3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).

4. Lăsat,i GeoTIFF ca Format de ies, ire implicit.

5. Schimbat,i valoarea Razei la 1000000 metri.

6. Clic pe [OK] pentru a crea s, i încărca harta calorică Aeroporturi (a se vedea Figure_Heatmap_3).

Figure 20.24: Dialogul Hărt,ii Calorice

QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.

1. Open the properties dialog of the heatmap_airports layer (select the layer heatmap_airports,
open the context menu with the right mouse button and select Properties).

2. Selectat,i fila Stil.

3. Schimbat,i Tipul randării pe ‘Singleband pseudocolor’.

4. Selectat,i o Hartă de culoare , cum ar fi YlOrRed.

5. Clic p butonul [Load] pentru a obt,ine valorile minime s, i maxime din raster, apoi facet,i clic pe butonul
[Classify].

6. Apăsat,i [OK] pentru a actualiza stratul.

Rezultatul final este prezentat în Figure_Heatmap_4.

20.13 Plugin-ul de Interpolare

Plugin-ul de Interpolare poate fi folosit pentru a genera o interpolare TIN sau IDW, a unui strat vectorial de tip
punct. Este foarte simplu de manevrat s, i oferă o interfat,ă cu utilizatorul grafică, intuitivă, pentru crearea de straturi
raster interpolate (v. Figure_interpolation_1). Plugin-ul necesită specificarea următorilor parametri, înainte de a
rula:

• Straturile vectoriale de intrare: Specificat,i strat(urile) vectoriale de intrare, de tip punct, dintr-o listă de
straturi încărcate. În cazul în care sunt specificate mai multe straturi, atunci vor fi folosite pentru interpolare
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Figure 20.25: După încărcare, harta calorică arată ca o suprafat,ă gri

Figure 20.26: Harta calorică, stilizată, a aeroporturilor din Alaska
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datele din toate straturile. Notă: Este posibilă introducerea liniilor sau poligoanelor ca s, i constrângeri pentru
triangulare, prin specificarea “punctelor”, a “liniilor de structură” sau a “liniilor de întrerupere” în caseta

Tip .

• Atributul de interpolare: Selectat,i coloana atributului care se va utiliza pentru interpolare, sau activat,i

caseta de Utilizare a Coordonatei Z, pentru a folosi valorile Z stocate în strat.

• Metoda de Interpolare: Selectat,i metoda de interpolare. Aceasta poate fi ori ‘Ret,ea Neregulată Triangulată
(TIN)’, ori ‘Distant,a Inversă Ponderată (IDW)’. Cu ajutorul metodei TIN putet,i crea o suprafat,ă alcătuită
din triunghiuri, cu ajutorul celor mai apropiate puncte învecinate. Pentru a face acest lucru, sunt create
cercuri în jurul punctelor selectate, iar intersect,iile lor sunt conectate la o ret,ea de triunghiuri, pe cât posibil,
nesuprapuse s, i compacte. Suprafet,ele rezultate nu sunt netede. Atunci când se utilizează metoda IDW,
punctele sunt ponderate pe durata interpolării, în as, a fel încât influent,a unui punct în raport cu altul, scade
o dată cu distant,a fat,ă de punctul necunoscut, pe care dorit,i să-l creat,i. Metoda de interpolare IDW are s, i
unele dezavantaje: calitatea rezultatului interpolării poate scădea în cazul în care distribut,ia punctelor este
inegală. Mai mult, valorile maxime s, i minime ale suprafet,ei interpolate pot apărea numai pentru datele de
tip punct. Rezultatul constă în mici vârfuri s, i gropi, în jurul punctelor din es, antion.

• Configurarea Metodei de Interpolare: Asigură configurarea metodei de interpolare pe care at,i ales-o.
Pentru metoda TIN putet,i alege între metodele de interpolare Liniară s, i Clough Toucher (cubică). De aseme-
nea, putet,i salva triangulat,ia în format de fis, ier shape. Pentru interpolarea IDW se poate seta coeficientul de
distant,ă.

• Numărul de coloane/rânduri: Specificat,i numărul de rânduri s, i coloane pentru fis, ierul de ies, ire raster.

• Fis, ierul de ies, ire: Specificat,i un nume pentru fis, ierul raster generat.

• Adăugat,i rezultatul în proiect pentru a-l vedea pe canevasul hărt,ii.

Ret,inet,i că dacă utilizat,i liniile ca s, i constrângeri pentru interpolarea triangulării (metoda TIN), putet,i folosi fie
‘linii de structură’ fie ‘linii de întrerupere’. Atunci când folosit,i ‘linii de întrerupere’ vet,i produce treceri brus, te
pe suprafat,ă, în timp ce ‘liniile de structură’ vor produce treceri continue. Triangularea este modificată de către
ambele metode, astfel încât nici o muchie nu traversează o linie de întrerupere sau de structură.

Figure 20.27: Plugin-ul de Interpolare

20.13.1 Modul de utilizare a plugin-ului

1. Lansat,i QGIS s, i încărcat,i un strat vectorial de tip punct (cum ar fi elevp.csv).

2. Încărcat,i plugin-ul de Interpolare din Managerul de Plugin-uri (a se vedea Dialogul Plugin-urilor), apoi

facet,i clic pe meniul Raster → Interpolare → Interpolare, care apare în bara de meniu a QGIS. Dialogul
Plugin-ului de Interpolare apare as, a cum se arată în Figure_interpolation_1.

386 Chapter 20. Plugin-uri



QGIS User Guide, Release 2.14

3. Selectat,i un strat de intrare (cum ar fi elevp ) s, i o coloană (de ex.: ELEV) pentru interpolare.

4. Selectat,i o metodă de interpolare (de exemplu, ‘Ret,ea Neregulată Triangulată (TIN)’), s, i specificat,i o di-
mensiune a celulelor de 5000, precum s, i numele fis, ierului de ies, ire raster (de exemplu, elevation_tin).

5. Clic pe [OK].

20.14 MetaSearch Catalogue Client

20.14.1 Introducere

Metasearch este un plug-in QGIS dedicat interact,iunii cu serviciile de catalogare a metadatelor, s, i care acceptă
standardul Serviciului de Catalogare OGC pentru Web (CSW).

MetaCăutarea oferă o abordare simplă, intuitivă, s, i o interfat,ă prietenoasă, pentru căutarea în cataloagele cu meta-
date din QGIS.

20.14.2 Instalare

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.

Instalat,i Metacăutarea din managerul de pluginuri QGIS, sau manual de la
http://plugins.qgis.org/plugins/MetaSearch.
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20.14.3 Lucrul cu Catalogul Metadatelor în QGIS

CSW (Serviciu Catalog pentru Web)

CSW (Catalogue Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines com-
mon interfaces to discover, browse and query metadata about data, services, and other potential resources.

Iniţializare

To start MetaSearch, click icon or select Web → MetaSearch → MetaSearch via the QGIS main menu. The
MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.

Gestiunea Serviciului Catalog

Figure 20.28: Gestiunea Serviciului Catalog

The Services tab allows the user to manage all available catalogue services. MetaSearch provides a default list of
Catalogue Services, which can be added by pressing [Add default services] button.

Pentru toate intrările Catalogului de Servicii listate, facet,i clic pe caseta de selectare.

To add a Catalogue Service entry, click the [New] button, and enter a Name for the service, as well as the URL
(endpoint). Note that only the base URL is required (not a full GetCapabilities URL). Clicking [OK] will add the
service to the list of entries.

To edit an existing Catalogue Service entry, select the entry you would like to edit and click the [Edit] button, and
modify the Name or URL values, then click [OK].

To delete a Catalogue Service entry, select the entry you would like to delete and click the [Delete] button. You
will be asked to confirm deleting the entry.
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MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="http://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the [Load] button. A new window will appear; click the [Browse] button and
navigate to the XML file of entries you wish to load and click [Open]. The list of entries will be displayed. Select
the entries you wish to add from the list and click [Load].

Click the [Service info] button to displays information about the selected Catalogue Service such as service
identification, service provider and contact information. If you would like to view the raw XML response, click
the [GetCapabilities response] button. A separate window will open displaying Capabilities XML.

Serviciul de Căutare în Catalog

Figure 20.29: Serviciul de căutare în catalog

The Search tab allows the user to query Catalogue Services for data and services, set various search parameters
and view results.

Următorii parametri de căutare sunt disponibili:
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• Keywords: cuvinte cheie, de căutare într-un text liber

• From: Serviciul Catalog, în care se vor efectua căutările

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, guilabel:Ymax, and guil-
abel:Ymin. Click [Set global] to do a global search, click [Map extent] to do a search on the visible area
only or manually enter custom values as desired

Clicking the [Search] button will search the selected Metadata Catalogue. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the [View search results as XML] button opens a window with the service
response in raw XML format.

Efectuarea unui clic pe un rezultat va pferi următoarele informat,ii:

• if the metadata record has an associated bounding box, a footprint of the bounding box will be displayed on
the map

• double-clicking the record displays the record metadata with any associated access links. Clicking the links
opens the link in the user’s web browser

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate [Add to
WMS/WMTS|WFS|WCS] buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialogue will then appear

Figure 20.30: Afis, area metadatelor unei înregistrări

Setări

Putet,i rafina MetaCăutatea cu ajutorul următoarelor setări:
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Figure 20.31: Setările metacăutării

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is stored
with the various QGIS layer provider. Use this setting to set whether to use the name provided from
MetaSearch, whether to overwrite or to use a temporary name

• Results paging: when searching metadata catalogues, the number of results to show per page. Default value
is 10

• Timeout: when searching metadata catalogues, the number of seconds for blocking connection attempt.
Default value is 10

20.15 Plugin-ul de Editare Offline

Pentru colectarea datelor, lucrul în teren cu un laptop sau un telefon mobil, neconectate la ret,ea, reprezintă o
situat,ie comună. La revenirea ret,elei, modificările trebuie să fie sincronizate cu sursa de date de master (cum
ar fi o bază de date PostGIS). Dacă mai multe persoane lucrează simultan la aceleas, i seturi de date, este dificilă
fuzionarea editărilor individuale, chiar dacă nimeni nu modifică aceleas, i entităt,i.

Pluginul de Editare Offline automatizează sincronizarea, prin copierea cont,inutului unei surse de date (de obicei
PostGIS sau WFS-T) într-o bază de date SpatiaLite, s, i prin stocarea offline a modificărilor, într-o tabelă dedicată.
După re-conectarea la ret,ea, este posibilă aplicarea modificărilor efectuate asupra setului de date de master, în
perioada lipsei conexiunii la ret,ea.

20.15.1 Utilizarea plugin-ului

• Deschidet,i unele straturi vectoriale (cum ar fi din PostGIS sau dintr-o sursă de date WFS-T).

• Salvat,i-l ca proiect.

• Merget,i la Baza de date → Editare Offline → Conversie în proiect offline s, i selectat,i straturile de salvat.
Cont,inutul straturilor este salvat în tabele SpatiaLite.

• Editarea offline a straturilor.
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• După restabilirea conexiunii, actualizat,i modificările folosind Baza de date → Editare Offline → Sin-
cronizare.

Figure 20.32: Creare proiect offline din PostGIS sau din straturile WFS.

20.16 Plugin-ul GeoRaster Oracle Spatial

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Acesta va încărca rasterul în tabela GDAL_IMPORT, sub forma unei coloane denumite RASTER.

20.16.1 Gestionare conexiuni

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Dialogul Plugin-urilor). The
first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains the

data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Nume: Introducet,i un nume pentru conexiunea la baza de date.

• Instant,a bazei de date: Introducet,i numele bazei de date la care vă vet,i conecta.

392 Chapter 20. Plugin-uri



QGIS User Guide, Release 2.14

• Numele de utilizator: Numele utilizatorului care va fi utilizat pentru accesarea bazei de date.

• Parola: Parola asociată numelui de utilizator care este cerut la accesarea bazei de date.

Figure 20.33: Dialogul de Creare a conexiunilor Oracle

Acum, înapoi în principala fereastră de dialog a GeoRaster-ului Oracle Spatial (a se vedea Fig-
ure_oracle_raster_2), utilizat,i lista derulantă pentru a alege o conexiune, apoi folosit,i butonul de [Conectare]
pentru a stabili o conexiune. De asemenea, at,i putea [Edita] conexiunea, prin deschiderea dialogului anterior s, i să
aducet,i modificări informat,iilor de conectare, sau să utilizat,i butonul de [S, tergere] pentru a elimina conexiunea
din lista derulantă.

20.16.2 Selectarea unui GeoRaster

O dată ce o conexiune a fost stabilită, fereastra subseturilor de date va arata numele tuturor tabelelor care cont,in
coloanele GeoRaster din această bază de date, în formatul unui nume de subset de date GDAL.

Facet,i clic pe unul dintre subseturile de date enumerate s, i apoi pe [Select], pentru a alege numele tabelei. În
acest moment, se va deschide o altă listă de subseturi de date, împreună cu numele coloanelor GeoRaster din acea
tabelă. Aceasta este, de obicei, o listă scurtă, din moment ce majoritatea utilizatorilor nu vor avea mai mult de una
sau două coloane GeoRaster într-o singură tabelă.

Facet,i clic pe unul dintre subseturile de date enumerate s, i apoi pe [Select], pentru a alege una dintre combinat,iile
tabelă/coloană. Caseta de dialog va arăta acum toate rândurile care cont,in obiecte GeoRaster. Ment,ionăm că lista
subseturilor de date va prezenta acum perechile alcătuite din Tabelele cu Date Raster s, i Id-urile Rasterelor.

În orice moment, intrarea select,iei poate fi editată pentru a merge direct la un GeoRaster cunoscut, sau pentru a
reveni la început s, i pentru a selecta un alt nume de tabelă.

Datele de intrare selectate pot fi folosite, de asemenea, pentru a introduce o clauză WHERE la sfârs, itul
s, irului de identificare (ex.: geor:scott/tiger@orcl,gdal_import,raster,geoid=). Parcurget,i
http://www.gdal.org/frmt_georaster.html pentru mai multe informat,ii.

20.16.3 Afis, area GeoRaster-ului

În cele din urmă, prin selectarea unui GeoRaster din lista Tabelelor de Date Raster s, i Id-urile Raster, imaginea
raster va fi încărcată în QGIS.

The Select Oracle Spatial GeoRaster dialog can be closed now and the next time it opens, it will keep the same
connection and will show the same previous list of subdatasets, making it very easy to open up another image
from the same context.

Note: GeoRasterele care cont,in piramide se vor afis, a mult mai rapid, dar piramidele trebuie să fie generate în
afara QGIS., folosind Oracle PL/SQL sau gdaladdo.

Următorul exemplu foloses, te gdaladdo:
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Figure 20.34: Selectarea Dalogului Oracle GeoRaster

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Acesta este un exemplu care foloses, te PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

20.17 Plugin-ul de Analiză a Terenurilor Raster

|dem_analysis| Plugin-ul de Analiză a Terenului Raster poate fi folosit pentru a calcula panta, aspectul, umbrirea,
indicele de rugozitate s, i relieful pentru modelele digitale de elevat,ie (DEM). Este foarte simplu de manevrat s, i
oferă o interfat,ă cu utilizatorul grafică, intuitivă, pentru crearea de noi straturi raster (v. Figure_raster_terrain_1).

Descrierea analizei:

• Pante: Calculează unghiul de înclinare, în grade, pentru fiecare celulă (pe baza primei comenzi de estimare
derivativă).

• Aspectul: Expozit,ia (începe cu 0 pentru direct,ia nordului, în grade, în sens invers acelor de ceasornic).

• Umbrirea reliefului: Creează o hartă umbrită folosind lumina s, i umbra, pentru a oferi un aspect pronunt,at
tridimensional unei hărt,i cu relief umbrit. Harta de ies, ire are o singură bandă, care reflectă valoarea de gri a
pixelilor.

• Indicele de Robustet,e: O măsurare cantitativă a eterogenităt,ii terenului, as, a cum este descris de către Riley
s, i colab. (1999). Se calculează pentru fiecare locat,ie, prin rezumarea schimbărilor de altitudine, în grila 3x3
pixeli.
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• Relieful: Creează o hartă a reliefului umbrit, din datele digitale ale elevat,iei. Este implementată o metodă de
alegere a culorilor de elevat,ie, prin analizarea distribut,iei de frecvent,ă. Harta de ies, ire este de tip multibandă,
cu trei benzi care reflectă valorile RGB ale reliefului umbrit.

Figure 20.35: Plugin-ul de Modelare a Terenurilor Raster (calculul pantei)

20.17.1 Utilizarea plugin-ului

1. Pornit,i QGIS s, i încărcat,i stratul raster, gtopo30, din locat,ia es, antionului GRASS.

2. Încarcă plugin-ul de Analiză a Terenului Raster din Managerul de Plugin-uri (v. Dialogul Plugin-urilor).

3. Selectat,i o metodă de analiză din meniu (cum ar fi, Raster → Analiza Terenului → Pantă). Dialogul Pantei
apare as, a cum se prezintă în Figure_raster_terrain_1.

4. Specificat,i o cale s, i un tip pentru fis, ierul de ies, ire.

5. Clic pe [OK].

20.18 Plugin pentru Grafuri Rutiere

Road Graph este un plugin C++ pentru QGIS, care calculează calea cea mai scurtă dintre două puncte de pe orice
strat de tip polilinie, trasând apoi această cale pe ret,eaua de drumuri.

Caracteristici principale:

• Calculează calea, precum s, i lungimea s, i durata călătoriei.

• Optimizarea se face în funct,ie de lungimea sau de timpul călătoriei.

• Exportă calea într-un strat vectorial.

• Evident,iază direct,iile drumurilor (aceasta e desfăs, oară lent, utilizându-se, în principal, pentru scopuri de
depanare s, i pentru testarea setărilor).

Ca s, i strat al drumurilor, putet,i utiliza orice strat vectorial de tip polilinie, în orice format acceptat de QGIS. Două
linii cu un punct comun sunt considerate conectate. Ret,inet,i că trebuie să utilizat,i CRS-ul stratului ca CRS pentru
proiect, în timpul editării stratului de drumuri. Acest lucru se datorează faptului că recalcularea coordonatelor între
diferite CRS-uri introduce unele erori care pot duce la discontinuităt,i, chiar s, i atunci când se foloses, te ‘acros, area’.

În tabela de atribute a stratului, pot fi folosite următoarele câmpuri:

• Viteza din sect,iunea drumurilor (câmp numeric).

• Direct,ia (orice tip care pot fi exprimat înr-un s, ir). Direct,iile înainte s, i înapoi corespund unui drum cu sens
unic, ambele direct,ii indicând un drum cu două sensuri.

Dacă unele câmpuri nu au nici o valoare sau nu există, se folosesc valorile implicite. Putet,i modifica valorile
implicite s, i unele setări de plugin, din caseta de dialog a setărilor.
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Figure 20.36: Plugin pentru Grafuri Rutiere

20.18.1 Utilizarea plugin-ului

După activarea plugin-ului, vet,i vedea un panou suplimentar în partea stângă a ferestrei principale QGIS. Acum,
introducet,i cât,iva parametri în dialogul Road graph plugin settings, din meniul Vector → Road Graph (parcurget,i
figure_road_graph_2).

După setarea Unităt,ilor de timp, a Unităt,ilor de distant,ă s, i a Tolerant,ei topologiei, putet,i alege stratul vectorial
din fila Stratului de transport. Aici putet,i alege, de asemenea, Câmpul direct,iei s, i Câmpul vitezei. În fila Setărilor
implicite, putet,i seta Direct,ia pentru calcule.

În cele din urmă, în panoul Shortest Path, selectat,i un punct de Start s, i unul de Stop în stratul ret,elei de drumuri,
apoi facet,i clic pe [Calculate].

20.19 Pluginul de Interogare spaţială

Plugin-ul de Interogare Spat,ială vă permite să efectuat,i o interogare spat,ială (cum ar fi, selectarea entităt,ilor) într-un
strat t,intă, cu referire la un alt strat. Funct,ionalitatea sa se bazează pe biblioteca GEOS s, i depinde de stratul cu
entităt,i selectat.

Posibilii operatori sunt:

• Cont,ine

• Este egal

• Se suprapune

• Se încrucis, ează

• Se intersectează

• Este separat
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Figure 20.37: Setările plugin-ului Road graph

• Atinge

• Este în interior

20.19.1 Utilizarea plugin-ului

Ca exemplu, ne dorim să găsim regiunile care cont,in aeroporturi, din setul de date Alaska.Sunt necesari următorii
pas, i:

1. Lansat,i QGIS s, i încărcat,i straturile vectoriale regions.shp s, i airports.shp.

2. Încărcat,i plugin-ul de Interogare Spat,ială din Managerul de Plugin-uri (v. Dialogul Plugin-urilor) s, i

efectuat,i clic pe pictograma Interogare Spat,ială, care apare în bara de meniuri QGIS. Se va afis, a dialogul
plugin-urilor.

3. Selectează stratul regiuni ca sursă, s, i stratul airporturi ca referint,ă pentru entităt,i.

4. Selectat,i ‘Cont,ine’ ca oprator, apoi facet,i clic pe operatorul [Apply].

Din interogare, vet,i obt,ine o listă de ID-uri ale entităt,ilor, cu mai multe opt,iuni, as, a cum se arată în fig-
ure_spatial_query_1.

• Clic pe Creează stratul cu lista elementelor.

• Selectat,i un ID din listă s, i efectuat,i clic pe Creează stratul cu select,ia.

• Selectat,i ‘Eliminarea din select,ia curentă’ din câmpul S, i foloses, te rezultatul la .

• Putet,i bifa Transfocare pe item sau guilabel:Jurnalizează mesajele.

• În plus, în ID-urile Entităt,ilor Rezultate cu opt,iunile ‘Sursă nevalidă’ s, i ‘Referint,e nevalide’ activate, putet,i
arunca o privire la entităt,ile cu erori geometrice. Aceste entităt,i nu sunt utilizate în interogare.
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Figure 20.38: Analiza de Interogare Spat,ială - regiunile care cont,in aeroporturi

Figure 20.39: Plugin-ul de Verificare a Topologiei
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20.20 Plugin-ul de Verificare a Topologiei

Topologia descrie relat,iile dintre puncte, linii s, i poligoane, care reprezintă entităt,ile unei regiuni geografice. Cu
ajutorul plugin-ului Topology Checker, putet,i trece prinntre fis, ierele vectoriale s, i le putet,i verifica topologia, în
funct,ie de diverse reguli. Aceste reguli determină dacă între entităt,ile dvs. se află relat,ii spat,iale de tipurile ‘Equal’,
‘Contain’, ‘Cover’, ‘CoveredBy’, ‘Cross’, ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’ sau ‘Within’. Depinde de
întrebările dvs. individuale care dintre regulile topologice se vor aplica datelor vectoriale (de exemplu, în mod
normal, nu vet,i accepta depăs, iri în straturile de tip linie, dar în cazul unor străzi înfundate, nu dorit,i ca acestea să
fie eliminate din stratul vectorial).

QGIS are o caracteristică de editare topologică încorporată, care este foarte bună pentru crearea fără erori a noilor
entităt,i. Dar erorile datelor existente s, i erorile introduse de utilizator sunt greu de găsit. Acest plugin vă ajută să
găsit,i astfel de erori, folosind o listă de reguli.

Este foarte simplă crearea regulilor de topologie cu plugin-ul Topology Checker.

În straturile de tip punct sunt disponibile următoarele reguli:

• Trebuie să fie acoperit de: Aici putet,i alege un strat vectorial din proiectul dvs. Punctele care nu sunt
acoperite de stratul vectorial dat, apar în câmpul ‘Eroare’.

• Trebuie să fie acoperit de punctele finale din: Aici putet,i alege un strat de tip linie din proiectul dvs.

• Trebuie să se afle în interior: Aici putet,i alege un strat poligonal din proiect. Punctele trebuie să fie în
interiorul unui poligon. Altfel, QGIS va înregistra o ‘Eroare’ pentru punct.

• Nu trebuie să aibă duplicate: Ori de câte ori un punct este reprezentat de două sau de mai multe ori, el va
apărea în câmpul ‘Eroare’.

• Nu trebuie să aibă geometrii nevalide: Verifică dacă geometriile sunt valabile.

• Nu trebuie să aibă geometrii-multi-parte: Toate punctele multi-parte sunt înscrise în câmpul ‘Eroare’.

În straturile de tip linie, sunt disponibile următoarele reguli:

• Punctele de capăt trebuie să fie acoperite de: Aici putet,i selecta un strat de tip punct din proiectul dvs.

• Nu trebuie să aibă răsuciri: Aceasta va arăta depăs, irile din stratul de tip linie.

• Nu trebuie să aibă duplicate: Ori de câte ori o linie este reprezentată de două sau de mai multe ori, ea va
apărea în câmpul ‘Eroare’.

• Nu trebuie să aibă geometrii nevalide: Verifică dacă geometriile sunt valabile.

• Nu trebuie să aibă geometrii multi-parte: Uneori, o geometrie poate fi de fapt o colect,ie de simple
geometrii (simple-părt,i). O astfel de geometrie poartă denumirea de geometrie multi-parte. În cazul în
care cont,ine doar un singur tip de geometrie simplă, o denumim multi-punct, multi-linie sau multi-poligon.
Toate liniile multi-parte sunt scrise în câmpul ‘Error’.

• Nu trebuie să aibă pseudo noduri: Punct final al unei geometrii de tip linie ar trebui să fie conectat la
capetele celorlalte două geometrii. În cazul în care capătul este conectat la punct final al unei singure
geometrii, acesta este denumit pseudo nod.

În straturile de tip poligon, sunt disponibile următoarele reguli:

• Trebuie să cont,ină: Strat poligonal trebuie să cont,ină cel put,in geometria unui punct din al doilea strat.

• Ar trebui să nu aibă duplicate: Poligoanele din acelas, i strat nu trebuie să aibă geometrii identice. Ori de
câte ori un poligon este reprezentat de două sau de mai multe ori, el va apărea în câmpul ‘Eroare’.

• Nu trebuie să aibă lacune: Poligoane adiacente nu trebuie să formeze goluri între ele. Granit,ele adminis-
trative ar putea fi ment,ionate ca un exemplu (poligoanele statelor din SUA nu au nici un fel de spat,ii între
ele...).

• Nu trebuie să aibă geometrii nevalide: Verifică dacă geometriile sunt valabile. Unele dintre regulile care
definesc o geometrie validă sunt:

– Inelele poligonale trebuie să fie închise.
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– Inelele care definesc găurile ar trebui să fie situate în interiorul inelelor care definesc limitele exte-
rioare.

– Inelele pot să nu de auto-intersecteze (pot să nu se atingă sau să nu se suprapună).

– Inelele pot să nu se atingă cu alte inele, cu except,ia unui punct.

• Nu trebuie să aibă geometrii multi-parte: Uneori, o geometrie poate fi de fapt o colect,ie de simple
geometrii (simple-părt,i). O astfel de geometrie poartă denumirea de geometrie multi-parte. În cazul în care
cont,ine doar un singur tip de geometrie simplă, o denumim multi-punct, multi-linie sau multi-poligon. De
exemplu, o t,ară formată din mai multe insule poate fi reprezentată ca un multi-poligon.

• Nu trebuie să se suprapună: Poligoanele adiacente nu ar trebui să partajeze nici un spat,iu comun.

• Nu trebuie să se suprapună cu: Poligoanele adiacente dintr-un strat nu ar trebui să partajeze nici un spat,iu
comun cu alt strat.

20.21 Plugin-ul de statistici zonale

Cu ajutorul plugin-ului Statistici zonale, putet,i analiza rezultatele unei clasificări tematice. Acesta vă per-
mite calcularea mai multor valori ale pixelilor dintr-un strat raster cu ajutorul unui strat vectorial poligonal (v.
figure_zonal_statistics). Alegând o bandă de culoare, plugin-ul generează coloane de ies, ire în stratul vectorial,
utilizând un prefix definit de utilizator, s, i calculează pentru fiecare poligon statistici cu privire la pixelii pe care îi
cont,ine. Statisticile disponibile sunt:

• Numărul: pentru a returna numărul de pixeli

• Suma: pentru a însuma valorile pixelilor

• Media: pentru a obt,ine valorile medii ale pixelilor

• Mediana: pentru a obt,ine valorile mediane ale pixelilor

• StDev: pentru a obt,ine deviat,ia standard a valorilor pixelilor

• Min: pentru a obt,ine valorile minime ale pixelilor

• Max: pentru a obt,ine valorile maxime ale pixelilor

• Intervalul: pentru a obt,ine intervalul de valori (max - min) ale pixelilor

• Minoritatea: pentru a obt,ine valorile pixelilor cel mai put,in reprezentat,i

• Majoritatea: pentru a obt,ine valorile pixelilor cel mai des reprezentat,i

• Varietatea: pentru a returna numărul de pixeli cu valori distincte
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Figure 20.40: Dialogul statisticilor zonale
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CHAPTER 21

Asistent,ă s, i Ajutor

21.1 Liste de discut,ii

QGIS este în curs de dezvoltare activă s, i, ca atare, nu va funct,iona întotdeauna as, a cum vă as, teptat,i. Modul
preferat de a obt,ine ajutor este prin folosirea listei de discut,ii a utilizatorilor QGIS. Întrebările dvs. vor ajunge la
un public mai larg, iar răspunsurile să fie în beneficiul altor persoane.

21.1.1 qgis-users

This mailing list is used for discussion of QGIS in general, as well as specific questions regarding its
installation and use. You can subscribe to the qgis-users mailing list by visiting the following URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

21.1.2 fossgis-talk-liste

For the German-speaking audience, the German FOSSGIS e.V. provides the fossgis-talk-liste mailing list. This
mailing list is used for discussion of open-source GIS in general, including QGIS. You can subscribe to the fossgis-
talk-liste mailing list by visiting the following URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

21.1.3 qgis-developer

Dacă suntet,i un dezvoltator care se confruntă cu probleme de natură tehnică, putet,i adera la lista de discut,ii QGIS-
developer: http://lists.osgeo.org/mailman/listinfo/qgis-developer

21.1.4 qgis-ux

O listă dedicată, unde oricine poate interveni în discut,ie s, i poate expune subiecte referitoare la QGIS, legate de
UX (experient,a personală) / probleme de uzabilitate.

http://lists.osgeo.org/mailman/listinfo/qgis-ux

21.1.5 qgis-commit

Each time a commit is made to the QGIS code repository, an email is posted to this list. If you
want to be up-to-date with every change to the current code base, you can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-commit
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21.1.6 qgis-trac

Această listă oferă notificări prin e-mail referitoare la managementul de proiect, inclusiv rapoarte de erori, sarcini,
s, i cereri de funct,ionalităt,i. Vă putet,i abona la această listă, accesând: http://lists.osgeo.org/mailman/listinfo/qgis-
trac

21.1.7 qgis-community-team

Această listă tratează teme precum documentat,ia, ajutorul contextual, ghidul de utilizare, site-urile web, blogul,
listele de discut,ii, forumurile s, i eforturile de traducere. De asemenea, în cazul în care dorit,i să lucrat,i la ghidul
utilizatorului, această listă este potrivită pentru a adresa întrebări. Vă putet,i abona la această listă, accesând:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

21.1.8 qgis-release-team

Această listă tratează teme precum procesul de compilare, de împachetare a fis, ierelor binare pentru diferite sisteme
de operare, s, i de comunicare a noilor versiuni către întreg mapamondul. Vă putet,i abona la această listă, accesând:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

21.1.9 qgis-tr

Această listă este dedicată eforturilor de traducere. Dacă v-ar plăcea să lucrat,i la traducerea manualelor sau a
interfet,ei grafice cu utilizatorul (GUI), această listă este un bun punct de plecare pentru întrebările dumneavoastră.
Vă putet,i abona la această listă, accesând: http://lists.osgeo.org/mailman/listinfo/qgis-tr

21.1.10 qgis-edu

Această listă este dedicată eforturilor de educare. Dacă v-ar plăcea să lucrat,i la traducerea manualelor QGIS,
această listă reprezintă un bun punct de plecare pentru întrebările dumneavoastră. Vă putet,i abona la această listă,
accesând: http://lists.osgeo.org/mailman/listinfo/qgis-edu

21.1.11 qgis-psc

Această listă este utilizată pentru discut,ii ale Comitetului de Coordonare legate de gestionarea s, i conducerea
generală a QGIS. Vă putet,i abona la această listă, accesând: http://lists.osgeo.org/mailman/listinfo/qgis-psc

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences. Note that the qgis-commit and qgis-trac lists are designed for notification only and
are not meant for user postings.

21.2 IRC

We also maintain a presence on IRC - visit us by joining the #qgis channel on irc.freenode.net. Please wait for a
response to your question, as many folks on the channel are doing other things and it may take a while for them to
notice your question. If you missed a discussion on IRC, not a problem! We log all discussion, so you can easily
catch up. Just go to http://qgis.org/irclogs and read the IRC-logs.

Commercial support for QGIS is also available. Check the website http://qgis.org/en/commercial-support.html for
more information.
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21.3 BugTracker

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.

Please bear in mind that your bug may not always enjoy the priority you might hope for (depending on its severity).
Some bugs may require significant developer effort to remedy, and the manpower is not always available for this.

Cererile de funct,ionalităt,i pot fi depuse, de asemenea, folosind acelas, i sistem de tichete ca s, i pentru erori.
Asigurat,i-vă că at,i selectat tipul Feature.

If you have found a bug and fixed it yourself, you can submit either a Pull Request on the Github QGIS Project
(prefered) or a patch also. The lovely redmine ticketsystem at http://hub.qgis.org/projects/quantum-gis/issues has
this type as well. Check the Patch supplied checkbox and attach your patch before submitting your bug.
One of the developers will review it and apply it to QGIS. Please don’t be alarmed if your patch is not applied
straight away – developers may be tied up with other commitments.

Note that if you supply a Pull Request, your change would be more likely be merged into the source code!

21.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

21.5 Plugin-uri

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

21.6 Wiki

Lastly, we maintain a WIKI web site at http://hub.qgis.org/projects/quantum-gis/wiki where you can find a variety
of useful information relating to QGIS development, release plans, links to download sites, message-translation
hints and more. Check it out, there are some goodies inside!
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CHAPTER 22

Anexă

22.1 Licent,a Publică Generală GNU

Versiunea 2, Iunie 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Oricui îi este permisă copierea şi distribuirea de copii identice ale acestui document de licent,iere, dar fără modifi-
carea lui.

Preambul

Licent,ele majorităt,ii programelor sunt concepute pentru a vă priva de libertatea de a le partaja s, i de a le modifica.
Prin contrast, intent,ia Licent,ei Publice Generale GNU este de a vă garanta libertatea de a distribui s, i modifica
programele gratuite - pentru a se asigura că programele sunt gratuite pentru tot,i utilizatorii. Această Licent,ă Pub-
lică Generală se aplică majorităt,ii programelor apart,inând Free Software Foundation precum s, i tuturor celorlalte
programe ai căror autori decid să o folosească. (În schimb, alte programe apart,inând Free Software Foundation
se află sub Licent,a Publică Generală GNU pentru Biblioteci.) De asemenea, ea poate fi aplicată s, i programelor
dumneavoastră.

Când vorbim de software gratuit, ne referim la libertate, s, i nu la pret,. Licent,ele noastre sunt concepute să vă
garanteze libertatea de a distribui copii ale programelor gratuite (s, i de a oferi acest serviciu contra cost, dacă
dorit,i), de a primi sau de a obt,ine codul sursă, dacă dorit,i, de a schimba programul sau a folosi port,iuni din el în
noi programe libere, s, i de a s, ti că putet,i face toate aceste lucruri.

Pentru a vă proteja drepturile, trebuie să impunem restrict,ii împotriva oricui ar încerca să vă conteste aceste
drepturi sau să vă ceară să renunt,at,i la ele. Aceste restrict,ii implică anumite responsabilităt,i pentru dumneavoastră
dacă distribuit,i copii ale programelor, sau dacă le modificat,i.

De exemplu, dacă distribuit,i copii ale unui astfel de program, indiferent dacă o facet,i gratuit sau contra unei sume
de bani, trebuie să cedat,i beneficiarilor toate drepturile pe care le avet,i dumneavoastră. Trebuie să vă asigurat,i că
ei primesc, sau pot primi, codul sursă. În plus, trebuie să le arătat,i care sunt termenii în care primesc programul,
pentru a s, ti care le sunt drepturile.

Vă protejăm drepturile în două rânduri: (1) prin stabilirea drepturilor de autor pentru program, s, i (2) prin această
Licent,ă care vă conferă dreptul legal de a copia, distribui s, i/sau modifica programul.

De asemenea, pentru propria noastră protect,ie cât s, i pentru cea a autorilor, vrem să ne asigurăm că toată lumea
înt,elege că nu există niciun fel de garant,ie pentru acest program gratuit. Dacă programul este modificat de altcineva
s, i distribuit mai departe, vrem ca beneficiarii programului să s, tie că ceea ce au nu este originalul, în as, a fel încât
nicio problemă introdusă de altcineva nu va avea un efect negativ asupra reputat,iei autorilor init,iali.

În final, orice program liber este în mod constant amenint,at de patentele software. Vrem să evităm pericolul ca cei
ce redistribuie programele libere să obt,ină patente, practic transformând programul într-unul proprietar. Pentru a
preveni aceasta, facem clară pozit,ia noastră conform căreia orice patent trebuie acordat fie în as, a fel, încât să poată
fi licent,iat s, i fără restrict,ii pentru uzul gratuit al oricui, fie să nu necesite licent,ă.
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Termenii s, i condit,iile exacte de copiere, distribuire s, i modificare sunt specificate în următoarele paragrafe. TER-
MENI S, I CONDIT, II PENTRU COPIERE, DISTRIBUIRE S, I MODIFICARE

0. Această Licent,ă se aplică oricărui program sau proiect ce cont,ine o ment,iune a det,inătorului drepturilor de
autor spunând că poate fi distribuit în termenii acestei Licent,e Publice Generale. Prin “Program”, în contin-
uare, vom înt,elege orice asemenea program sau proiect, iar prin “lucru bazat pe Program” vom înt,elege fie
programul fie orice alt proiect derivat din Program, conform cu legea drepturilor de autor: adică, un proiect
ce cont,ine Programul sau port,iuni din el, fie în forma originală fie modificată s, i/sau tradusă în altă limbă. (În
restul acestui document traducerile vor fi incluse fără restrict,ii în termenul “modificare”.) Fiecare persoană
autorizată de această Licent,ă va fi desemnată prin termenul “dumneavoastră”.

Activităt,ile care nu sunt de copiere, distribuire s, i modificare nu sunt acoperite de această Licent,ă; ele sunt
în afara scopului ei. Activitatea de executare a Programului nu este restrict,ionată, iar rezultatul Programului
este acoperit de licent,ă doar în cazul în care cont,inutul său constituie un proiect bazat pe Program (indepen-
dent de faptul că a fost obt,inut prin rularea Programului). Măsura în care acest lucru este adevărat depinde
de natura Programului.

1. Puteţi copia şi distribui copii nemodificate ale codului sursă al Programului în forma în care îl primit,i, prin
orice mediu, cu condit,ia să specificaţi vizibil pe fiecare copie autorul şi lipsa oricărei garant,ii, să păstrat,i
intacte toate notele referitoare la această Licenţă şi la absenţa oricărei garant,ii şi să distribuiţi o copie a
acestei Licenţe cu fiecare copie a Programului.

Puteţi pretinde o retribut,ie financiară pentru actul fizic de transfer al unei copii, şi putet,i oferi garant,ie contra
cost.

2. Putet,i efectua modificări asupra copiilor Programului, sau asupra oricăror port,iuni ale sale, creând astfel
un proiect bazat pe Program, iar copierea s, i distribuirea unor asemenea modificări sau proiecte se pot face
conform termenilor Sect,iunii 1 de mai sus, doar dacă toate condit,iile următoarele sunt îndeplinite:

(a) Trebuie ca fis, ierele modificate să cont,ină notit,e proeminent vizibile, care să ment,ioneze faptul că
dumneavoastră le-at,i modificat, precum s, i data fiecărei modificări.

(b) Trebuie ca orice proiect pe care îl distribuit,i sau publicat,i, care în întregime sau în parte cont,ine sau
este derivat din Program, sau din oricare parte a acestuia, să poată fi licent,iat gratuit s, i în întregime
tuturor părt,ilor tert,e, în termenii acestei Licent,e.

(c) Dacă programul modificat cites, te comenzi în mod interactiv, trebuie să îl modificat,i în as, a fel încât,
atunci când este pornit în mod interactiv, să afis, eze un mesaj referitor la drepturile de autor, precum s, i o
notă în care se ment,ionează lipsa oricărei garant,ii (sau faptul că dumneavoastră oferit,i o garant,ie). De
asemenea, trebuie specificat faptul că utilizatorii pot redistribui programul în aceste condit,ii, precum
s, i o explicat,ie a modalităt,ii în care poate fi obt,inut textul acestei Licent,e. (Except,ie: dacă Programul
este interactiv, dar nu afis, ează în mod normal un asemenea mesaj, nu este necesar ca proiectul bazat
pe Program să afis, eze un mesaj.)

Aceste cerint,e se aplică Programului modificat în întregime. Dacă pot fi identificate sect,iuni ale proiectului
care nu sunt derivate din Program, s, i pot fi considerate de sine stătătoare, atunci această Licent,ă s, i termenii
săi nu se aplică acelor sect,iuni când sunt distribuite ca proiecte separate. Când distribuit,i aceleas, i sect,iuni ca
parte a unui întreg care este un proiect bazat pe Program, distribuirea întregului proiect trebuie să fie făcută
în acord cu termenii acestei Licent,e, ale cărei permisiuni pentru alte licent,e se extind asupra întregului, s, i
deci asupra fiecărei sect,iuni în parte, indiferent de autor.

Astfel, nu este în intent,ia acestei sect,iuni să pretindă drepturi sau să conteste drepturile dumneavoastră
asupra unui proiect efectuat în întregime de dumneavoastră. Intent,ia este de a exercita dreptul de a controla
distribut,ia proiectelor derivate sau colective bazate pe Program.

În plus, pura agregare pe un mediu de stocare sau distribut,ie cu Programul (sau cu un proiect bazat pe
Program) a unui alt proiect, care nu este bazat pe Program, nu aduce acel proiect sub incident,a acestei
Licent,e.

3. Putet,i copia s, i distribui Programul (sau un proiect bazat pe el, conform Sect,iunii 2) în format obiect sau
executabil conform termenilor Sect,iunilor 1 s, i 2 de mai sus, cu condit,ia să îndeplinit,i una dintre condit,iile
de mai jos:

(a) Să îl oferit,i însot,it de codul sursă corespunzător, în format citibil de către mas, ină, care trebuie să fie
distribuit în termenii Sect,iunilor 1 s, i 2 de mai sus, pe un mediu de distribut,ie uzual transportului de
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software; sau

(b) Să îl oferit,i însot,it de o ofertă scrisă, validă pentru cel put,in trei ani, pentru o taxă care să nu depăs, ească
costul fizic al efectuării distribut,iei sursei, de a oferi o copie completă, în format citibil de către mas, ină,
a codului sursă, distribuit în termenii Sect,iunilor 1 s, i 2 de mai sus, pe un mediu de distribut,ie uzual
transportului de software; sau

(c) Să îl oferit,i însot,it de informat,ia pe care at,i primit-o referitoare la oferta de a distribui codul sursa
corespunzător. (Această alternativă este permisă numai pentru distribuiri necomerciale s, i doar dacă
at,i primit programul în format obiect sau executabil împreună cu această ofertă, în conformitate cu
Subsect,iunea b de mai sus.)

Codul sursă al unui proiect este forma preferată în care se fac modificări asupra proiectului. Pentru un proiect
executabil, codul sursă complet înseamnă codul sursă al tuturor modulelor pe care le cont,ine, împreună cu
toate fis, ierele asociate cont,inând definit,ii ale interfet,elor s, i scripturile folosite pentru a controla compilarea s, i
instalarea executabilului. Cu toate acestea, ca o except,ie, nu este obligatorie distribuirea împreună cu codul
sursă a acelor componente care sunt în mod normal distribuite (în format sursă sau binar) cu componentele
majore (compilator, nucleu, etc.) ale sistemului de operare sub care rulează executabilul, exceptând situat,ia
în care acea componentă acompaniază executabilul.

Dacă distribut,ia executabilului sau codului obiect este făcută prin oferirea permisiunii de copiere dintr-un
loc dedicat, atunci oferirea permisiunii de copiere a codului sursă din acelas, i loc este considerată distribuire
a codului sursă, chiar dacă beneficiarul nu este obligat să copieze codul sursă împreuna cu codul obiect.

4. Nu putet,i copia, modifica, sub-autoriza sau distribui Programul decât as, a cum este prevăzut în această
Licent,ă. Orice încercare de a copia, modifica, sub-autoriza sau distribui Programul în alt,i termeni va duce
la anularea drepturilor ce vă revin conform acestei Licent,e. Cu toate acestea, nu vor fi anulate drepturile
celor ce au primit copii sau drepturi de la dumneavoastră conform cu această Licent,ă, atâta timp cât rămân
în conformitate cu ea.

5. Nu suntet,i obligat,i să acceptat,i această Licent,ă, deoarece nu at,i semnat-o. Cu toate acestea, numai această
Licent,ă vă permite să modificat,i Programul sau proiectele derivate din el. Aceste act,iuni sunt interzise prin
lege dacă nu acceptat,i această Licent,ă. În consecint,ă, prin modificarea sau distribuirea Programului (sau a
oricărui proiect bazat pe Program), indicat,i în mod implicit acceptarea acestei Licent,e s, i a tuturor termenilor
s, i condit,iilor de copiere, distribuire sau modificare a Programului sau proiectelor bazate pe el.

6. De fiecare dată când redistribuit,i Programul (sau orice proiect bazat pe Program), beneficiarul primes, te o
licent,ă de la licent,iatorul original care îi permite să copieze, distribuie sau modifice Programul în aceias, i
termeni s, i condit,ii. Nu putet,i impune nici o restrict,ie adit,ională asupra exercitării drepturilor pe care desti-
natarul le primes, te prin această Licent,ă. Nu suntet,i responsabil cu impunerea respectării acestei Licent,e de
către o tert,ă parte.

7. În cazul în care, ca o consecint,ă a unei decizii judecătores, ti, sau pretinsă încălcare a unui patent, sau pentru
orice altă cauză (nu neapărat limitată la chestiuni legate de patente), vi se impun condit,ii (prin hotărâre
judecătorească, înt,elegere sau alte mijloace) care contravin condit,iilor acestei Licent,e, acest lucru nu vă
permite nerespectarea condit,iilor acestei Licent,e. Dacă nu putet,i face în as, a fel încât să satisfacet,i simultan
obligat,iile din această Licent,ă s, i alte obligat,ii pertinente, atunci, ca o consecint,ă, vă este interzisă distribuirea
Programului. De exemplu, dacă o autorizat,ie de folosire a unui patent nu vă permite redistribuirea gratuită
a Programului de către oricine îl primes, te de la dumneavoastră, direct sau indirect, atunci singurul mod în
care putet,i satisface simultan aceste condit,ii s, i Licent,a de fat,ă este să nu distribuit,i Programul în niciun fel.

Dacă vreo port,iune a acestei sect,iuni este invalidată sau de neaplicat în anumite circumstant,e, restul sect,iunii
continuă să se aplice, iar sect,iunea în întregime se aplică în toate celelalte circumstant,e.

Nu este în intent,ia acestei sect,iuni să vă determine să încălcat,i vreun patent sau alte pretent,ii de drepturi
de proprietate, sau să contestat,i valabilitatea oricăror asemenea pretent,ii; această sect,iune are ca scop unic
protejarea integrităt,ii sistemului de distribuire de programe libere, care este implementat prin licent,e publice.
Multe persoane au contribuit generos la spectrul larg de programe distribuite prin acest sistem, bazându-se
pe aplicarea sa consistentă; este la latitudinea autorului/donatorului să decidă dacă este dispus să distribuie
programe prin orice alt sistem, s, i o persoană autorizată să folosească acele programe nu poate impune acea
decizie.

Această sect,iune este dedicată clarificării a ceea ce este considerat a fi o consecint,ă a restului acestei Licent,e.
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8. Dacă distribut,ia s, i/sau folosirea Programului este restrict,ionată în anumite t,ări, din cauza patentelor, sau din
cauza unor interfet,e aflate sub incident,a unor drepturi de autor restrictive, det,inătorul drepturilor de autor
ce plasează Programul sub această Licent,ă poate adăuga o limitare geografica a distribuirii ce exclude acele
t,ări, în as, a fel încât distribuirea să fie permisă doar în, sau între, t,ările care nu sunt excluse. Într-un asemenea
caz, Licent,a încorporează această limitare ca s, i cum ar fi scrisă în corpul acestei Licent,e.

9. Free Software Foundation poate publica din când în când noi versiuni s, i/sau versiuni revăzute, ale Licent,ei
Publice Generale. Asemenea versiuni noi vor fi similare în spirit versiunii prezente, dar pot diferi în anumite
detalii, pentru a adresa noi probleme sau situat,ii.

Fiecărei versiuni îi este asociat un număr unic. Dacă programul specifică faptul că i se aplică o versiune
a acestei Licent,e s, i “orice altă versiune ulterioară”, avet,i opt,iunea de a urma termenii s, i condit,iile acelei
versiuni, sau ai oricărei versiuni ulterioare publicate de Free Software Foundation. Dacă Programul nu
specifică un număr de versiune, putet,i alege orice versiune publicată vreodată de Free Software Foundation.

10. Dacă dorit,i să incorporat,i părt,i ale Programului în alte programe libere ale căror condit,ii de distribut,ie sunt
diferite, ceret,i permisiunea autorului. Pentru programe ale căror drepturi de autor apart,in Free Software
Foundation, ceret,i permisiunea de la Free Software Foundation; uneori facem except,ii pentru aceasta. De-
cizia noastră va fi ghidată de cele două scopuri de a prezerva statutul liber al tuturor proiectelor derivate din
programele noastre libere s, i de a promova distribuirea s, i refolosirea programelor în general.

NICIO GARANT, IE

11. DEOARECE PROGRAMUL ESTE OFERIT SUB O LICENT, Ă CE NU IMPLICĂ NICI UN COST,
NU EXISTĂ NICIO GARANT, IE PENTRU PROGRAM, ÎN MĂSURA PERMISĂ DE LEGILE CE SE
APLICĂ. EXCEPTÂND SITUAT, IILE UNDE ESTE SPECIFICAT ALTFEL ÎN SCRIS, DET, INĂTORII
DREPTURILOR DE AUTOR S, I/SAU ALTE PĂRT, I IMPLICATE OFERĂ PROGRAMUL “ÎN FORMA
EXISTENTĂ” FĂRĂ NICIO GARANT, IE DE NICIUN FEL, EXPLICITĂ SAU IMPLICITĂ, IN-
CLUZÂND, DAR FĂRĂ A FI LIMITATĂ LA, GARANT, II IMPLICITE DE VANDABILITATE S, I CON-
FORMITATE UNUI ANUMIT SCOP. VĂ ASUMAT, I ÎN ÎNTREGIME RISCUL ÎN CEEA CE PRIVES, TE
CALITATEA S, I PERFORMANT, A ACESTUI PROGRAM. ÎN CAZUL ÎN CARE PROGRAMUL SE
DOVEDES, TE A FI DEFECT, VĂ ASUMAT, I ÎN ÎNTREGIME COSTUL TUTUROR SERVICIILOR,
REPARAT, IILOR S, I CORECT, IILOR NECESARE.

12. ÎN NICIO SITUAT, IE, EXCEPTÂND CAZURILE ÎN CARE ESTE CERUT DE LEGEA APLICABILĂ
SAU CA REZULTAT AL UNEI ÎNT, ELEGERI SCRISE, UN DET, INĂTOR AL DREPTURILOR DE
AUTOR, SAU ORICE ALTĂ PARTE CARE POATE MODIFICA S, I/SAU REDISTRIBUI PROGRA-
MUL CONFORM PERMISIUNILOR DE MAI SUS NU VA FI FĂCUT RĂSPUNZĂTOR PENTRU
PAGUBELE DUMNEAVOASTRĂ, INCLUSIV CELE GENERALE, SPECIALE, ÎNTÂMPLĂTOARE
SAU REZULTANTE, APĂRUTE DIN FOLOSIREA SAU INABILITATEA DE A FOLOSI PROGRAMUL
(INCLUZÂND, DAR FĂRĂ A FI LIMITAT LA PIERDEREA SAU DETERIORAREA DATELOR, SAU
PIERDERILE SUFERITE DE DUMNEAVOASTRĂ SAU TERT, E PERSOANE, SAU O INCAPACITATE
A PROGRAMULUI DE A INTEROPERA CU ALTE PROGRAME), CHIAR DACĂ DET, INĂTORUL
SAU TERT, A PARTE A FOST PREVENITĂ ASUPRA POSIBILITĂT, II UNOR ASEMENEA PAGUBE.

Except,ia QGIS Qt de la GPL

În plus, ca o except,ie specială, echipa de dezvoltare QGIS oferă permisiunea de a lega codul acestui program cu
biblioteca Qt, inclusiv, dar fără a se limita la următoarele versiuni (atât gratuite s, i comerciale): Qt/Non-commerical
Windows, Qt/Windows, Qt/X11, Qt/Mac, s, i Qt/Embedded (sau cu versiuni modificate ale Qt care folosesc aceeas, i
licent,ă ca s, i Qt), s, i de a distribui combinat,ii ale celor două legate. Trebuie să vă supunet,i Licent,ei Generale
Publice GNU în toate privint,ele pentru toate codul utilizat, altul decât Qt. Dacă modificat,i acest fis, ier, putet,i
prelungi această except,ie de la versiunea de fis, ier, dar nu avet,i obligat,ia să facet,i acest lucru. Dacă nu dorit,i acest
lucru, s, terget,i această declarat,ie de except,ie din versiunea dumneavoastră.

22.2 Licent,a GNU pentru Documentat,ia liberă

Versiunea 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc
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http://fsf.org/

Oricui îi este permisă copierea şi distribuirea de copii identice ale acestui document, dar fără modificarea lui.

Preambul

Scopul acestei Licenţe este de a conferi “gratuitate” unui manual, colect,ii de texte, sau altui document funct,ional
s, i folositor, în sensul libertăt,ii: de a asigura tuturor permisiunea de copiere şi redistribuire, cu sau fără modificări,
în scopuri comerciale şi necomerciale. Ca scop secundar, această Licenţă rezervă autorului şi editorului dreptul
de a fi creditaţi pentru munca lor, atât timp cât nu sunt responsabili pentru modificările efectuate de către alţii.

Acestă Licent,ă conferă un fel de “obligat,ii”, ceea ce înseamnă că lucrările derivate dintr-un document trebuie să
fie s, i ele libere, la rândul lor. Această Licent,ă este inspirată de Licent,a Publică Generală GNU, care este o licent,ă
similară, concepută pentru a acoperi softul liber.

Am creat această Licenţă pentru a fi de folos manualelor pentru softul liber, deoarece un soft liber necesită o
documentaţie liberă: un program trebuie însoţit de manuale care oferă aceeaşi libertate de folosire ca şi softul.
Acestă Licenţă nu este limitată, însă, la manualele pentru soft; ea poate fi folosită pentru textul oricărei lucrări,
indiferent de subiect sau de modul de publicare. Această Licenţă este recomandată în principal pentru lucrări care
servesc drept referinţă sau au fost scrise în scop de instruire.

1. APLICABILITATE ŞI DEFINIŢII

Această Licenţă se aplică oricărei lucrări sau manual, în orice mediu, care conţine o notă, inclusă de către deţină-
torul dreptului de autor, care permite distribuţia în termenii acestei Licenţe. Această notă conferă dreptul universal,
fără indemnizaţie şi nelimitat ca durată de a folosi lucrarea în condiţiile de fat,ă. Termenul Document, de mai jos,
se referă la un astfel de manual sau lucrare. Orice membru din public este un beneficiar al acestei Licenţe şi va
fi desemnat prin termenul Dvs.. Se consideră, în mod automat, că aţi acceptat termenii acestei Licenţe, în urma
copierii, modificării sau distribuirii unei lucrări într-un mod care necesită permisiunea autorului, în condit,iile legii
drepturilor de autor.

O “Versiune Modificată” a Documentului este orice lucrare conţinând Documentul sau o porţiune de-a lui, copiată
identic sau cu modificări şi/sau tradusă într-o altă limbă.

O “Secţiune Secundară” este o anexă cu titlu, sau o secţiune menţionată în cuprins care are ca scop exclusiv
descrierea relaţiei editorilor sau a autorilor Documentului cu subiectul Documentului (sau cu aspecte conexe)
şi care nu conţine referiri directe la subiectul Documentului. (Astfel, dacă Documentul este în parte manual de
matematică, o Secţiune Secundară nu poate conţine deloc explicaţii matematice.) Poate exista doar o conexiune is-
torică cu subiectul s, i cu problemele înrudite cu subiectul, ori pot fi prezentate puncte de vedere legale, comerciale,
filozofice, etice sau politice legate de acesta.

“Secţiunile Neschimbabile” sunt anumite Secţiuni Secundare ale căror titluri sunt specificate ca fiind acele titluri
de Secţiuni Neschimbabile din nota ce permite distribuţia Documentului sub acoperirea acestei Licenţe. Dacă o
secţiune nu este conformă cu definiţia de mai sus a unei Secţiuni Secundare atunci ea nu poate fi desemnată ca
fiind Neschimbabilă. Documentul poate să nu conţină Secţiuni Neschimbabile. Dacă Documentul nu specifică
vreo Secţiune Neschimbabilă atunci se consideră că nu există nici una.

“Textele De Copertă” sunt anumite pasaje scurte de text care sunt listate ca Texte Pentru Coperta I sau ca Texte
Pentru Coperta IV în nota care specifică distribuirea Documentului sub acoperirea acestei Licenţe. Un Text Pentru
Coperta I poate avea cel mult 5 cuvinte, iar un Text Pentru Coperta IV poate avea cel mult 25 de cuvinte.

O copie “Transparentă” a Documentului este o copie în format electronic, reprezentată într-un format ale cărui
specificaţii sunt disponibile publicului, fiind uşor de modificat cu ajutorul unui editor de text generic sau (pentru
imagini compuse din pixeli) cu un editor grafic generic ori (pentru desene) cu un editor larg răspândit de grafică
vectorială, şi care poate fi folosit ca intrare în procesoarele de text sau de transformare automată în diverse formate
adecvate ca intrare pentru procesoarele de text. O copie făcută într-un format de fişier Transparent dar care, prin
prezenţa sau absenţa anumitor elemente specifice formatului, descurajează sau împiedică modificările ulterioare,
nu reprezintă o copie Transparentă. Un format de imagine nu este Transparent dacă este folosit pentru a reprezenta
o cantitate substanţială de text. O copie care nu este “Transparentă” se numes, te “Opacă”

Exemple de formate compatibile cu copiile Transparente: textul ASCII fără marcaje, formatul de intrare Tex-
info, formatele de intrare LaTeX, SGML şi XML folosind un DTD public, HTML simplu şi standard, fişierele
PostScript şi PDF modificabile. Exemple de formate Transparente pentru imagine: PNG, XCF şi JPG. Formatele
Opace includ formate de text ce pot fi citite şi editate doar de procesoare de text proprietare, SGML şi XML pentru
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care DTD-ul şi/sau uneltele de procesare nu sunt disponibile, HTML generat automat, documentele PostScript şi
PDF produse de diverse procesoare de text doar în scopul printării/afişării.

“Pagina de Titlu” înseamnă, pentru o carte tipărită, pagina cu titlul şi paginile următoare, necesare pentru a
prezenta, lizibil, materialul care trebuie tipărit, conform acestei Licenţe, pe Pagina de Titlu. Pentru lucrări care
nu au o pagină cu titlu propriu-zisă, “Pagina de Titlu” este textul aflat lângă principala apariţie a titlului lucrării,
precedând începutul corpului Documentului.

“Editorul” reprezintă orice persoană sau entitate care distribuie copii ale documentului pentru public.

O secţiune “Numită XYZ” este o subunitate a Documentului, al cărei titlu este, fie XYZ, fie conţine XYZ în
paranteze, după textul care traduce XYZ în altă limbă. (Aici XYZ înlocuieşte nume specifice ce vor fi menţionate
mai jos, ca de exemplu “Mulţumiri”, “Dedicaţii”, “Giruri” sau “Istorie”.) Pentru a “Păstra Titlul” unei astfel de
secţiuni atunci când modificaţi Documentul înseamnă că va rămânea o sect,iune “Numită XYZ”, conform acestei
definiţii.

Documentul poate include Limitări de Responsabilitate ataşate notificării care afirmă că această Licenţă se aplică
Documentului. Aceste se consideră a fi incluse prin referinţă în această Licenţă, dar numai cu privire la limitările
de responsabilitate: orice alte implicaţii pe care aceste Limitări de Responsabilitate le-ar putea avea sunt nule şi
nu au nici un efect asupra înţelesului acestei Licenţe.

2. COPII IDENTICE

Puteţi copia şi distribui Documentul pe orice mediu, fie comercial sau necomercial, atâta timp cât această Licenţă,
notificările de drepturi de autor şi notificarea de licenţă care spune că această Licenţă se aplică acestui Document,
sunt reproduse în toate copiile, şi atâta timp cât nu adăugaţi nici un fel de altă condiţie în afară de cele prezente
în această Licenţă. Nu aveţi dreptul să luaţi măsuri tehnice de a obstrucţiona sau controla citirea sau recopierea
copiilor pe care le faceţi sau le distribuiţi. Aveţi totuşi dreptul să acceptaţi compensaţii în schimbul copiilor. Dacă
distribuiţi un număr suficient de mare de copii, atunci trebuie să respectaţi şi condiţiile din secţiunea 3.

Avet,i, de asemenea, dreptul să împrumutat,i copii în aceleas, i condit,ii ca cele de mai sus, s, i avet,i dreptul să afis, at,i
copii.

3. COPIEREA ÎN CANTITĂT, I MARI

Dacă publicat,i copii tipărite (sau copii în medii care folosesc de obicei copert,i tipărite) ale Documentului, în număr
mai mare de 100 s, i dacă notificarea de licent,ă a Documentului cere Texte de Copertă, trebuie să includet,i copiile
pe copert,i care să cont,ină, clar s, i lizibil, toate aceste Texte de Copertă: Textele Pentru Coperta I pe coperta I s, i
Texte Pentru Coperta IV pe coperta IV. Ambele copert,i trebuie de asemenea să vă identifice în mod clar s, i lizibil
ca editor al respectivelor copii. Coperta I trebuie să prezinte titlul în întregime, cu toate cuvintele din titlu la fel
de vizibile s, i proeminente. Putet,i adăuga alte materiale pe copertă în plus. Copierea cu modificările limitate la
copert,i, atâta timp cât satisfac aceste condit,ii, pot fi tratate în toate celelalte aspecte ca s, i copii identice.

Dacă textele necesare pentru oricare dintre copert,i sunt prea voluminoase pentru a încăpea în mod lizibil, trebuie
să punet,i primele rânduri (atâtea cât încap în mod rezonabil) pe coperta efectivă s, i să continuat,i cu restul pe pagini
adiacente.

Dacă publicat,i sau distribuit,i copii Opace ale Documentului în număr mai mare de 100, trebuie ori să includet,i
câte o copie Transparentă în format electronic împreună cu fiecare copie Opacă, ori să specificat,i în sau împreună
cu fiecare copie Opacă o locat,ie din ret,eaua electronică la care publicul general care foloses, te ret,eaua să aibă
acces pentru a descărca, folosind un protocol standard public, copii complete, Transparente ale documentului,
fără adăugarea oricărui material adit,ional. Dacă folosit,i a doua opt,iune trebuie să facet,i demersuri rezonabil
de prudente ca atunci când începet,i distribuirea copiilor Opace să vă asigurat,i că această copie Transparentă va
rămâne accesibilă, în acest fel, la locat,ia respectivă timp de cel put,in un an după distribut,ia ultimei copii Opace
(în mod direct sau prin agent,i ori distribuitori) a respectivei edit,ii pentru public.

Se cere, dar nu în mod necesar, să contactat,i autorii Documentului cu o perioadă bună înainte de a distribui orice
cantitate mare de copii, pentru a le da ocazia să vă pună la dispozit,ie o versiune actualizată a Documentului.

4. MODIFICĂRI

Putet,i copia s, i distribui o Versiune Modificată a Documentului în condit,iile sect,iunilor 2 s, i 3 de mai sus, cu condit,ia
de a acoperi Versiunea Modificată sub exact această Licent,ă, cu Versiunea Modificată t,inând locul Documentului,
astfel licent,iind distribuirea s, i modificările Versiunii Modificate oricui intră în posesia unei copii ale acesteia. În
plus, trebuie să facet,i următoarele lucruri în Versiunea Modificată:
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QGIS User Guide, Release 2.14

1. Folosit,i în Pagina de Titlu (s, i pe copert,i, dacă există) un titlu diferit de cel al Documentului, s, i de versiunile
sale anterioare (care trebuie, dacă există, să fie listate în sect,iunea de Istorie a Documentului). Putet,i folosi
acelas, i titlu ca o versiune anterioară dacă editorul original al acelei copii vă dă permisiunea.

2. Listat,i pe Pagina de Titlu, ca autori, una sau mai multe dintre persoanele sau entităt,ile responsabile în calitate
de autori pentru modificările Versiunii Modificate, împreună cu cel put,in cinci dintre autorii principali ai
Documentului (tot,i autorii principali, dacă are mai put,in de cinci), în afară de cazul că aces, tia vă eliberează
de această obligat,ie.

3. Includet,i pe Pagina de Titlu numele editorului Versiunii Modificate în calitate de editor.

4. Păstrat,i toate notificările de drepturi de autor ale Documentului.

5. Adăugat,i o notificare de drepturi de autori relevantă pentru modificările Dvs. adiacent celorlalte notificări
de drepturi de autor.

6. Includet,i, imediat după notificările de drepturi de autor, o notificare de licent,ă dând permisiune publică de a
folosi Versiunea Modificată în condit,iile acestei Licent,e, sub forma prezentată în Apendicele de mai jos.

7. Păstrat,i în acea notificare de licent,ă lista integrală a Sect,iunilor Neschimbabile s, i Textele de Copertă nece-
sare, date în notificarea de licent,ă a Documentului.

8. Includet,i o copie nealterată a acestei Licent,e.

9. Păstrat,i sect,iunea Numită “Istorie”, Păstrat,i-i Titlul s, i adăugat,i-i un element care să indice măcar titlul, anul,
noii autori s, i editorul Versiunii Modificate as, a cum este dat pe Pagina de Titlu. Dacă nu există o sect,iune
Numită “Istorie” în Document, creat,i una în care indicat,i titlul, anul, autorii s, i editorul Documentului as, a
cum este dat pe Pagina de Titlu al acestuia s, i apoi adăugat,i un element care să descrie Versiunea Modificată
as, a cum a fost cerut în fraza precedentă.

10. Păstrat,i locat,ia de ret,ea, dacă există, dată în Document pentru acces public la o copie Transparentă a Doc-
umentului, cât s, i locat,iile de ret,ea date în Document pentru versiunile mai vechi pe care s-a bazat acesta.
Acestea pot fi incluse în sect,iunea Numită “Istorie”. Putet,i omite locat,ia de ret,ea a unei lucrări care a fost
publicată cu cel put,in patru ani înainte de Documentul în sine, sau dacă editorul original al versiunii la care
se referă vă dă permisiunea.

11. Pentru orice sect,iune Numită “Mult,umiri” sau “Dedicat,ii” Păstrat,i Titlul sect,iunii s, i păstrat,i în sect,iunile
respective toată substant,a s, i tonul mult,umirilor s, i/sau dedicat,iilor fiecărui contribuitor.

12. Păstrat,i toate Sect,iunile Neschimbabile ale Documentului, nealterate ca text s, i ca titluri. Numerotarea
sect,iunilor sau echivalentul numerotării nu sunt considerate ca făcând parte din titlurile sect,iunilor.

13. S, terget,i orice sect,iune Numită “Giruri”. O astfel de sect,iune nu poate fi inclusă în Versiunea Modificată.

14. Nu modificat,i titlul nici unei sect,iuni existente pentru a fi Numită “Giruri” sau pentru a intra în conflict cu
vreo Sect,iune Neschimbabilă.

15. Păstrat,i toate Limitările de Responsabilitate.

Dacă Versiunea Modificată include sect,iuni noi incluse în titlu sau anexe care se califică drept Sect,iuni Secundare
s, i nu cont,in material copiat din Document, avet,i dreptul la alegerea Dvs. să numit,i unele sau toate acestea ca
fiind Neschimbabile. Pentru a face aceasta, adăugat,i-le titlurile la lista de Sect,iuni Neschimbabile în notificarea
de licent,ă a Versiunii Modificate. Aceste titluri trebuie să fie distincte fat,ă de toate celelalte titlurile de sect,iune.

Putet,i adăuga o sect,iune Numită “Giruri” doar dacă aceasta cont,ine numai girurile a diverse entităt,i asupra Ver-
siunii Modificate—de exemplu recenzii sau faptul că textul a fost aprobat de o organizat,ie ca fiind o definit,ie
autoritară a unui standard.

Putet,i adăuga un pasaj de cel mult cinci cuvinte ca Text Pentru Coperta I s, i un pasaj de cel mult 25 de cuvinte
ca Text Pentru Coperta IV la sfârs, itul Textelor De Copertă în Versiunea Modificată. Numai un singur pasaj poate
fi adăugat la Textul Pentru Coperta I s, i unul la Textul Pentru Coperta IV de către (sau prin aranjament cu) orice
entitate. Dacă Documentul cont,ine deja texte de copertă pentru coperta respectivă, adăugat în prealabil de Dvs.
sau prin aranjament cu aceeas, i entitate în numele căreia act,ionat,i, atunci nu putet,i adăuga un altul, însă putet,i să-l
înlocuit,i pe cel vechi numai cu permisiunea explicită a editorului anterior care l-a adăugat pe cel vechi.

Autorul (autorii) s, i editorul (editorii) Documentului nu vă dau prin această Licent,ă permisiunea de a le folosi
numele pentru publicitate sau pentru a pretinde sau implica vreo girare a oricărei Versiuni Modificate.
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5. COMBINAREA DOCUMENTELOR

Putet,i combina Documentul cu alte documente acoperite de această Licent,ă sub termenii definit,i în sect,iunea 4 de
mai sus pentru versiuni modificate, cu condit,ia să includet,i în versiunea combinată toate Sect,iunile Neschimbabile
ale tuturor documentelor originale, nemodificate, s, i să le listat,i pe toate ca Sect,iuni Neschimbabile ale versiunii
combinate în notificarea de licent,ă, cât s, i să păstrat,i toate Limitările de Responsabilitate.

Versiunea modificată nu trebuie să cont,ină decât o singură copie a acestei Licent,e, iar duplicatele identice ale
Sect,iunilor Neschimbabile pot fi înlocuite cu o singură copie. Dacă există Sect,iuni Neschimbabile cu nume
identice s, i cont,inut diferit, schimbat,i-le numele adăugând la sfârs, itul titlului, în paranteză, ori numele autorului
sau al editorului original al acelei sect,iuni dacă acesta este cunoscut, ori un număr unic. Facet,i aceleas, i modificări
respective titlurilor sect,iunilor în lista de Sect,iuni Neschimbabile din notificarea de licent,ă a versiunii combinate.

În versiunea combinată trebuie să combinat,i s, i toate sect,iunile Numite “Istorie” din diversele documente originale,
creând o sect,iune unică Numită “Istorie”; la fel trebuie să combinat,i s, i toate sect,iunile Numite “Mult,umiri” cât s, i
cele Numite “Dedicat,ii”. Trebuie să s, terget,i toate sect,iunile Numite “Giruri”.

6. COLECT, II DE DOCUMENTE

Putet,i crea o colect,ie formată din Document s, i alte documente acoperite de această Licent,ă s, i să înlocuit,i copiile
individuale ale acestei Licent,e din diversele documente cu o singură copie care să fie inclusă în colect,ie cu condit,ia
să urmat,i regulile acestei Licent,e pentru copii identice pentru fiecare document în toate celelalte privint,e.

Putet,i să extraget,i un document dintr-o astfel de colect,ie s, i să-l distribuit,i individual sub această Licent,ă cu condit,ia
de a include o copie a acestei Licent,e în documentul extras s, i să urmat,i condit,iile acestei Licent,e în toate celelalte
privint,e în legătură cu copiile identice ale acelui document.

7. AGREGAREA CU LUCRĂRI INDEPENDENTE

O compilat,ie a Documentului sau a unui derivat al său cu orice document sau lucrare separată independentă,
în sau pe un volum de stocare sau distribuire se numes, te “agregat” dacă drepturile de autor rezultate în urma
compilării nu sunt folosite pentru a limita drepturile legale ale utilizatorilor compilat,iei mai mult decât permit
lucrările individuale. Când Documentul este inclus într-un agregat, această Licent,ă nu se aplică celorlalte lucrări
din agregat care nu sunt ele însele rezultate derivate ale Documentului.

Dacă cerint,ele legate de Textele de Copertă din sect,iunea 3 se aplică acestor copii ale Documentului, atunci dacă
Documentul este mai put,in de jumătate din întregul agregat atunci Textele de Copertă ale Documentului pot fi
puse pe copert,i care să separe Documentul în cadrul agregatului, sau pe un echivalent electronic al acestora, dacă
Documentul se prezintă în format electronic. Altfel ele trebuie să apară pe copert,ile tipărite care îmbracă întreg
agregatul.

8. TRADUCERE

Traducerea este considerată o formă de modificare, drept care putet,i distribui traduceri ale Documentului sub
cerint,ele sect,iunii 4. Înlocuirea Sect,iunilor Neschimbabile cu traduceri ale acestora necesită permisiune specială
din partea celor care det,in drepturile de autor, însă putet,i include traduceri ale unora dintre sau tuturor Sect,iunilor
Neschimbabile împreună cu variantele originale ale acestora. Putet,i include o traducere a acestei Licent,e cât s, i
toate notificările de licent,ă din Document, cât s, i Limitările de Responsabilitate atâta timp cât includet,i s, i versiunea
originală în engleză a acestei Licent,e, plus versiunile originale ale respectivelor notificări de licent,ă s, i limitări de
responsabilitate. În cazul aparit,iei oricăror discrepant,e între versiunea tradusă s, i versiunea originală a acestei
Licent,e, a vreunei notificări de licent,ă sau a vreunei limitări de responsabilitate, versiunea originală are prioritate.

Dacă vreo sect,iune din Document este Numită “Mult,umiri”, “Dedicat,ii” sau “Istorie” cerint,a (din sect,iunea 4) de
a-i Păstra Titlul (sect,iunea 1) va necesita în mod normal schimbarea titlului în sine.

9. REZILIERE

Nu putet,i copia, modifica, sublicent,ia sau distribui Documentul decât în condit,iile specificate explicit în această
Licent,ă. Orice copiere, modificare sau redistribuire a Documentului în vreo altă condit,ie este nulă s, i vă va anula
în mod automat drepturile conferite de această Licent,ă.

Cu toate acestea, dacă încetat,i orice încălcare a acestei Licent,e, licent,a din partea titularului dreptului de autor este
reinstaurată (a) cu titlu provizoriu, cu except,ia cazului când titularul dreptului de autor încetează în mod explicit
s, i în cele din urmă licent,a, s, i (b) permanent, în cazul în care titularul dreptului de autor nu vă anunt,ă încălcarea,
prin mijloace reonabile, în termen de 60 de zile de la încetare.
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În plus, licent,a de la titularul particular al dreptului de autor este repusă permanent în cazul în care titularul
dreptului de autor vă anunt,ă de încălcare prin mijloace rezonabile, s, i este prima dată când at,i primit o notificare de
încălcare a acestei Licent,e (pentru orice lucrare), din partea titularului dreptului de autor, s, i at,i încetat încălcarea
cu 30 de zile înainte de primirea notificării.

Încetarea drepturilor dumneavoastră, în conformitate cu această sect,iune, nu încetează licent,ele părt,ilor care au
primit copii sau drepturi de la dumneavoastră sub această Licent,ă. Dacă drepturile dumneavoastră au fost terminate
s, i nu s-au repus permanent, primirea unei copii ale aceluias, i material nu vă dă nici un drept să-l folosit,i.

10. VERSIUNI VIITOARE ALE ACESTEI LICENT, E

Fundat,ia Free Software Foundation poate publica, din când în când, versiuni noi, revizuite ale acestei Licent,e
GNU pentru Documentat,ia liberă. Aceste noi versiuni vor păstra spiritul acestei versiuni dar pot diferi în privint,a
detaliilor, cu scopul de a se adresa unor noi probleme reale sau potent,iale. A se vedea http://www.gnu.org/copyleft/

Fiecărei versiuni ale acestei Licent,e îi este asociat un număr de versiune distinct. Dacă Documentul specifică
un anumit număr de versiune “sau orice versiune ulterioară” al acestei Licent,e, avet,i de ales între a vă conforma
termenilor s, i condit,iilor ori ale versiunii specificate explicit sau ale oricărei variante ulterioare publicate (nu ca
variantă preliminară) de către Free Software Foundation. Dacă Documentul nu specifică un număr de versiune
al acestei Licent,e atunci putet,i alege orice versiune publicată (nu ca variantă preliminară) de către Free Software
Foundation.

11. RELICENŢIEREA

“Site-ul de Colaborare Masivă a Multiautorilor” (sau „MMC Site”) înseamnă orice server www care publică
lucrări posibil de a fi supuse drepturilor de autor şi, de asemenea, oferă facilităţi proeminente pentru oricine
editează aceste lucrări. Un server pubic wiki este un exemplu în care oricine poate edita lucrări scrise. Un
“Site de Colaborare Masivă a Multiautorilor” (sau „MMC Site”) în conţinutul său înseamnă o mulţime de lucrări
susceptibile de a fi supuse licenţelor supsue site-ului MMC.

“CC-BZ-SA” înseamnă licenţă a Creative Commons Attribution-Share Alike 3.0 publicată de Corporaţia Cre-
ative Commons, o corporaţie nonprofit cu sediul principal la San Francisco, California, şi deasemenea viitoarele
variante de “obligat,ii” a acestei licenţe publicată de aceeaşi organizaţie.

„Încorporarea” înseamnă publicarea ori republicarea unui Document, în întregime sau în parte, ca parte a unui alt
document.

Un MMC este “eligibil pentru reautorizare” dacă este licent,iat sub această Licent,ă, s, i în cazul în care toate lucrările
care au fost publicate mai întâi în această Licent,ă în altă parte decât acest MMC, s, i, ulterior, au fost încorporate
în totalitate sau în parte în MMC, (1) nu a avut texte de copertă sau sect,iuni invariante, s, i (2) au fost astfel incluse
până la 1 noiembrie 2008.

Operatorul unui site MMC poate republica un MMC cont,inut în site sub CC-BY-SA în acelas, i loc, în orice moment
înainte de 1 august 2009, cu condit,ia ca MMC să fie eligibil pentru reautorizare.

ADDENDUM: Cum să utilizaţi această licenţă pentru documentele dvs.

Pentru a utiliza această licenţă într-un document pe care l-aţi scris, includet,i o copie a Licenţei în document şi
introducet,i următoarele notificări referitoare la dreptul de autor s, i la licenţă, imediat după pagina de titlu:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

Dacă avet,i Sect,iuni Neschimbabile, Texte pentru Coperta I s, i Texte pentru Coperta IV, înlocuit,i linia “cu ... Texte.”
cu:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

Dacă avet,i Sect,iuni Neschimbabile, fără Texte de Copertă, sau o altă combinat,ie a celor trei, fuzionat,i ambele
alternative pentru a se potrivi situat,iei.
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Dacă documentul cont,ine exemple netriviale de cod de programare, vă recomandăm publicarea acestor exemple,
în paralel, sub o licent,ă pentru softul liber, cum ar fi Licent,a Publică Generală GNU, pentru a permite utilizarea
lor în software-ul liber.
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Act,iunile, 45
Acţiuni, 135
Acros, are, 162, 377
Acros, area La Intersect,ii, 163
Add Part, 170
adnotare, 46
Ajutor contextual, 37
Analiză multivariată, 105
apache, 203
apache2, 203
Arc/Info_ASCII_Grid, 179
Arc/Info_Binary_Grid, 179
ArcInfo Binary Coverage, 81
Asistent dimensiune, 105
Atlas_Generation, 344
Attribute_Table, 329
Attribute_Table_Selection, 154

Banda elastică, 165
bară de instrumente, 30
Bara de instrumente GRASS, 255

personalizare, 261
Biroul de Recensământ a Statelor Unite, 81
Blending modes, 41
Browse_Maps, 76
built-in forms, 128

calculation bar, 157
Calculator Field, 156
Calculatorul de Câmpuri, 156
calculatorul scării, 36
calitatea randării, 39
CAT, 193
Categorized, 104
CGI, 202
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color, 39
color_Ramp, 95

colorBrewer, 95
Combinat,ii de taste, 37
Common_Gateway_Interface, 202
Compose_Maps, 305, 314
Composer_Items, 314
Composer_Manager, 306
composer_map, 317
Composer_Template, 305
conditional formatting, 158
conditional_formatting, 158
Coordinate_Reference_System, 69, 197
crea entităt,ile, 165
create a rule, 107
Create_Maps, 305, 314
Creează_Noi_Straturi, 173
crossing the 180 degrees longitude line, 90
CRS, 69, 197
CSV, 82, 167
Cuantile, 104
Custom_color_Ramp, 95
Custom_CRS, 72
customization, 66

data-defined override, 44, 124
Datum_transformation, 73
DB_Manager, 91
Debian_Squeeze, 203
default_CRS, 69
define an action, 135
delete parts, 170
Deplasare, 42
deplasarea cu săget,ile, 35
Derived Fields, 156
diagram, 131
Digitizare, 373
Digitizarea, 164

Îmbinare Atribute, 172
Ştergere Inel, 170
Ştergere Parte, 170
Acros, are, 162
Adăugare Inel, 170
Adăugare Parte, 170
Anulare, 169
Curbe de Compensare, 171
Divizare Entităt,i, 171
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Divizare Părt,i, 171
Panoul avansat, 173
Refacere, 169
Remodelare Entitate, 171
Rotit,i Simbolurile Punctelor, 172
Rotire Entitate, 169
Simplificare Entitate, 170
Umplere Inel, 170
Unificare Entităt,i Selectate, 171
Urmărirea automată, 172

digitizing tools, 164
Discret, 184
displacement circle, 107
document de licent,iere, 407
documentat,ie, 5

Editările_Curente, 168
editarea, 162
Editarea Topologică, 163
editing, 164
Efecte de desenare, 112
EPSG, 69
Erori, 373
ESRI, 82
European_Petroleom_Search_Group, 69
Evitarea Intersecţiilor, 163
exemple de act,iuni, 135
Export_as_image, 342
Export_as_PDF, 342
Export_as_SVG, 342
Expresii, 141
expresii, 53
Expresiilor, 142
Expression based labeling, 123

FastCGI, 202
fereastra principală, 21
Fis, ier shape, 79, 82
fis, ier vectorial, 79
field calculator, 157
Field_Calculator_Functions, 143
Format de Transfer UK_National, 81
Formatul Tiger, 81

GDAL, 179
generalizarea, 139
Geometria, 377
geometryless feature, 166, 170
GeoTIFF, 179
GeoTiff, 179
GiST (Generalized Search Tree) index, 89
GML, 193
Gradient_color_Ramp, 95
Graduated Renderer, 105
GRASS, 247, see Crearea noilor vectori; editarea;

crearea unui nou strat
afis, are rezultate, 256, 258
afis, area regiunii, 254
bară de instrumente, 258

editarea regiunii, 255
instrumente de digitizare, 252
legare atribut, 252
regiune, 254
stil, 254
stocare atribut, 252

GRASS vector data model, 251
Grilă

Grids
Map_Grid, 319

Harta Culorilor, 184
heatmap, 109
Histogram, 105
Histogramă, 188
HTML_Frame, 337

Identificare entităt,i, 45
IGNF, 69
Imagine Erdas, 179
imbricarea proiectelor, 48
Import_Maps, 76
Imprimare

Export_Map, 342
imprimare rapidă din compozitorul de hărt,i, 19
Institut_Geographique_National_de_France, 69
instrumentarul aspectului, 30
Instrumentul_Nod, 165
InteProxy, 200
Interpolare_culoare, 184
Intervale egale, 104
Intervale Naturale (Jenks), 104
Items_Alignment, 316

join, 129
join layer, 129
jurnalizare

QGIS Server, 211

keyword lists, 139

label placement, 119
labeling, 117
layer rendering, 111
Layout_Maps, 305, 314
legend_composer

Map_Legend, 323
legendă, 31
Licent,ei Publice Generale GNU, 407
loading_raster, 179
Log messages, 35

Mărire Mics, orare, 42
mărirea cu rotit,a mouse-ului, 35
măsurare, 42

lungimea liniei, 43
suprafeţe, 43
unghiuri, 43

Map overview, 35
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Map Tips, 138
Map_Template, 305
MapInfo, 79
mediu

QGIS Server, 211
meniuri, 22
Metadate, 139, 188
MSSQL Spatial, 91
multiline, 170
multipoint, 170
multipolygon, 170

Navigarea_pe_Hartă, 42
Nivelurile simbolurilor, 111
Noduri, 166
Non_Spatial_Attribute_Tables, 158
Nou_Strat_GPX, 173, 174
Nou_Strat_Shapefile, 173
Nou_Strat_SpatiaLite, 173
Nou_Strat_Spatialite, 174
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OGR, 82
OGR Simple Feature Library, 82
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Oracle Spatial, 91
OSM, 84

Partajarea Muchiilor Poligonului, 163
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Piramide, 187
Plugin, 377
Plugin-ul de Acros, are a Geometriei, 377
Plugin-ul de deplasare, 107
plugin-uri, 349
polygon_to_line

line_to_polygon, 166
PostGIS, 85
PostGIS spatial index, 89
PostgreSQL, 85
print_composer

instrumente, 308
Proiect,ii, 69
Proj.4, 72
Proj4, 71
Proj4_text, 71
Proxy, 195
proxy-server, 195

QGIS Server
jurnalizare, 211
mediu, 211

QGIS_mapserver, 201

QGIS_Server, 202
QML, 140
QSpatiaLite, 91
Query Builder, 100

Randare, 38
Randare 2.5 D, 109
Randare bazată pe Reguli, 107
Randarea în funcţie de scară, 38
Raster, 179
Raster_Calculator, 189
Raster_Cu_Trei_Benzi_Colorate, 181
Raster_Multi_Bandă, 181
Raster_Simplă_Bandă, 181
Raza de Căutare, 162
Raza de căutare, 163
Redo, 35
Relat,ii, 158
Render cu Simbol Unic, 103
rendering effects, 41
Rendering_Mode, 314
Renderul Categorisit, 104
Renderul de Deplasare a Punctelor, 107
Renderul Gradat, 104
Renderul Hărt,ii Calorice, 109
Renderul Poligonului Invers, 109
Revert_Layout_Actions, 313
rezultatul se salvează ca imagine, 19
ring polygons, 170
Rotated_North_Arrow, 335
rule-based, 107
Rule-based labeling, 125
rules of ordering, 111

Salare proprietăt,i, 140
Salvare stil, 140
Scară, 38
Scară grafică

Map_Scalebar, 327
Secured_OGC_Authentication, 200
semne de carte, 47
semne de carte spat,iale

vedet,i marcajele, 47
SFS, 193
shp2pgsql, 88
Simbol proport,ional, 105
Simbologie, 102, 181
SLD, 202
SLD/SE, 202
Spatialite, 90
Spatialite_Manager, 91
SQLite, 90
SRS, 197
ST_Shift_Longitude, 89
Statistic, 35
Stil, 93
Style, 33, 102

Tolerant,a de acros, are, 162
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Toleranţa de Acros, are, 162
Topologia, 377
Topologie, 373
Transparenţă, 186

Undo, 35
Unelte de analiza, 368
Unelte de cercetare, 368
Unelte de georeferent,iere, 378

Validitate geometrie, 373
Valori Separate prin Virgulă, 82
variabilă, 53
variabile, 53
Verificator de Geometrie, 373
Vertecs, i, 166
Vertex, 166
virtual field, 156
Virtual Fields, 156
Virtual_Layers, 176
vizibilitatea stratului, 32

WCS, 193, 201
Web Coverage Service, 201
WFS, 193, 201
WFS-T, 201
WFS_Transactional, 201
WKT, 69, 167
WMS, 193
WMS-C, 198
WMS_1.3.0, 201
WMS_client, 193
WMS_identify, 198
WMS_layer_transparency, 197
WMS_metadata, 199
WMS_properties, 199
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